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Preface

The Sun Management Center 3.6 User’s Guide provides instructions on how to use the
Sun™ Management Center system management solution.

Note – The Solaris™ 10 release supports systems that use the SPARC® and x86 families
of processor architectures: UltraSPARC®, SPARC64, AMD64, Pentium, and Xeon
EM64T. The supported systems appear in the Solaris 10 Hardware Compatibility List at
http://www.sun.com/bigadmin/hcl. This document cites any implementation
differences between the platform types.

In this document the term “x86” refers to 64-bit and 32-bit systems manufactured
using processors compatible with the AMD64 or Intel Xeon/Pentium product families.
For supported systems, see the Solaris 10 Hardware Compatibility List.

Who Should Use This Book
This book is intended for use by system administrators who have experience working
with networks and understand networking terminology and technology.

Using UNIX Commands
This document does not contain information about basic UNIX® commands and
procedures, such as shutting down the system, booting the system, or configuring
devices.
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See one or more of the following sources for this information:

� Solaris Handbook for Sun Peripherals
� Online documentation for the Solaris Operating System (Solaris OS) (available at

http://docs.sun.com)
� Other software documentation that you received with your system

How This Book Is Organized
This book contains the following information:

Chapter 1 provides an overview of the Sun Management Center 3.6 product and
defines essential concepts.

Chapter 2 explains how to use administrative domains.

Chapter 3 describes how to create individual managed objects for the Sun
Management Center topology database.

Chapter 4 explains how to automatically identify managed objects and add them to
the topology database.

Chapter 5 introduces the Java™ user interface.

Chapter 6 describes the details window.

Chapter 7 explains how to view information about your managed network.

Chapter 8 describes how to monitor specific data properties.

Chapter 9 explains how to view information about data properties in a graphical
format.

Chapter 10 describes how to monitor and change data property attributes.

Chapter 11 explains how to work with modules.

Chapter 12 describes how to create and respond to alarms.

Chapter 13 describes how to work with groups of managed objects rather than
individual ones.

Chapter 14 describes how to work with dataviews.

Chapter 15 introduces the web-based user interface.

Chapter 16 describes how to create and respond to alarms using the web-based user
interface.
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Chapter 17 describes how to monitor data property attributes in the web-based user
interface.

Chapter 18 explains how to setup and administer security for this product.

Chapter 19 explains how to import and export topology information.

Chapter 20 identifies the capabilities of the command-line interface.

Appendix A contains additional information and troubleshooting procedures that do
not clearly fit elsewhere.

Appendix B explains how routing affects network management.

Appendix C describes information about standard modules.

Appendix D identifies standard alarm rules.

Appendix E lists alternative methods for accessing Java Console functions.

Appendix F lists the modules, add-ons, and commands supported by the Linux agent.

Glossary is a list of words and phrases found in this book and their definitions.

Product Information
Information about this product is available at the Sun Management Center web site at
http://www.sun.com/sunmanagementcenter/.

The Sun Management Center 3.6 product includes open source software. To view
license terms, attribution, and copyright statements for the open source software, see
the copyright file available in the media.

27

http://www.sun.com/sunmanagementcenter/


Documentation, Support, and Training

Sun Function URL Description

Documentation http://www.sun.com/documentation/ Download PDF and HTML
documents, and order
printed documents

Support and
Training

http://www.sun.com/supportraining/ Obtain technical support,
download patches, and
learn about Sun courses

Typographic Conventions
The following table describes the typographic changes that are used in this book.

TABLE P–1 Typographic Conventions

Typeface or Symbol Meaning Example

AaBbCc123 The names of commands, files, and
directories, and onscreen computer
output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have
mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 Command-line placeholder: replace with
a real name or value

The command to remove a file
is rm filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized

Read Chapter 6 in the User’s
Guide.

Perform a patch analysis.

Do not save the file.

[Note that some emphasized
items appear bold online.]
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Shell Prompts in Command Examples
The following table shows the default system prompt and superuser prompt for the
C shell, Bourne shell, and Korn shell.

TABLE P–2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell prompt $

Bourne shell and Korn shell superuser prompt #
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CHAPTER 1

Introduction to Sun Management
Center

This chapter provides an overview of the Sun Management Center 3.6 product, its
component layers, and the relationships among the layers.

This chapter includes the following topics:

� “Sun Management Center Overview” on page 31
� “Important Changes in Sun Management Center 3.6 Software” on page 32
� “Sun Management Center Architecture” on page 33
� “Sun Management Center Concepts” on page 37
� “Sun Management Center Management and Monitoring Features” on page 40
� “Sun Management Center Software Environments” on page 44
� “Installing Sun Management Center Software” on page 45
� “Getting Started With Sun Management Center Software” on page 45
� “Additional Information” on page 46

Sun Management Center Overview
Sun Management Center software is an open, extensible system monitoring and
management solution.

Sun Management Center has the following features.

System Management
Monitors and manages the system at the hardware and operating system levels.
Monitored hardware includes boards, tapes, power supplies, and disks.

Operating System Management
Monitors and manages operating system parameters that include load, resource
usage, disk space, and network statistics.
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Application and Business System Management
Provides enabling technology to monitor business applications such as trading
systems, accounting systems, inventory systems, and control systems.

Scalability
Provides an open, scalable, and flexible solution to configure and manage multiple
management administrative domains. These domains consist of many systems and
span across an enterprise. Administrators can configure the software in a
centralized or distributed fashion so that the product supports multiple users.

This solution uses Simple Network Management Protocol (SNMP), the Java™ Remote
Method Invocation (RMI), and the Hypertext Transfer Protocol (HTTP). These tools
enable Sun Management Center to provide integrated, comprehensive enterprise-wide
management of Sun products and their subsystems, components, and peripheral
devices.

Important Changes in Sun Management
Center 3.6 Software
Version 3.6 of the Sun Management Center product includes the following significant
changes:

� Agent and console layers are available in Linux Operating System (OS). The agent
layer is available for Red Hat, SuSE/JDS Linux kernel version 2.4.20 and later. For
a list of modules, add-ons, and commands supported by the Linux agent, see
Appendix F.

� On Solaris 10, you can handle hardware and software faults effectively. You can
view a fault report and a message article. For information about this, see Table 11–1
and “Fault Manager Module Version 1.0” on page 419.

� On Solaris 10, you can monitor the services running on a host. You can view the
details of a service, enable a service, or disable a service. You can also view the
processes in the selected service. For information about this, see Table 11–1 and
“Service Management Facility Module Version 1.0” on page 429.

Note – On Solaris 10, when Sun Management Center is installed and set up, the
services run as Service Management Facility (SMF) services.

� You can access the Sun N1™ System Manager server (System Manager) from the
Sun Management Center software. You can also monitor a set of properties
managed by this server. For information about this, see Table 11–1 and “Volume
System Monitoring Module Version 1.0” on page 354.
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� On Solaris 10, you can configure the agent inside a global zone. You For
information about this, see “(On Solaris 10) Monitoring a Zone Using Sun
Management Center” in Sun Management Center 3.6 Installation and Configuration
Guide.

� On Solaris 10, you can run Dynamic Tracing (DTrace) scripts. For information
about this, see Sun Management Center 3.6 System Reliability Manager User’s Guide.

� You can use Solaris™ Container Manager 3.6 for resource allocation, service
performance monitoring, and accounting. For information about installing and
using this add-on, see Installing and Administering Solaris Container Manager 3.6.

� The Sun Management Center agents can securely communicate with third-party
management applications by using SNMPv3.

� Many enhancements have been made to the command-line interface (CLI). For
information about this, see Chapter 20.

� Documentation for Sun Management Center is not installed with the product. The
documents are available at http://docs.sun.com/app/docs/coll/810.4.

� Many bugs and requests for enhancements (RFEs) have been addressed in this
release.

Sun Management Center Architecture
Sun Management Center software includes three component layers: console, server,
and agent. The product is based on the manager and agent architecture:

� The console layer provides the user interface that you use to initiate management
tasks. This layer includes a Java Console, a web console, and a command-line
interface (CLI).

� The server (manager) executes management applications and sends requests to
agents to perform management tasks on your behalf.

� The agents that execute on the managed nodes access the management
information, monitor local resources, and respond to manager requests.

The following figure illustrates the three component layers.
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AgentAgent

FIGURE 1–1 Sun Management Center Component Layers

The major Sun Management Center layers and their functions are described next.

Console Layer
The Sun Management Center console layer is the interface between you and the other
component layers of Sun Management Center software. This layer includes a Java
Console, a web console, and a CLI. You can have multiple consoles, serving multiple
users, for the same Sun Management Center server. The consoles provide these
features:

� Visual representations of the managed objects, for example, hosts and networks

� The ability to manipulate attributes and properties that are associated with the
managed objects, for example, create alarm thresholds

� The ability to initiate management tasks, for example, dynamic reconfiguration

Server Layer
The server layer accepts requests through the console and passes these requests to the
appropriate agent. The server then relays the response from the agent back to the
console.

For example, if you request information on the number of users that are accessing a
host, the server layer receives this request from the console. The server layer then
sends the request to the agent on that host. The agent finds the answer and sends the
answer back to the server, which forwards the information to the console.

Similarly, if an error condition is created on one of the hosts, the agent on that host
notifies the server. The server forwards the information to the console as an alarm.

In addition, the server layer provides the console with a secure entry point to interface
with the agents.

The server layer includes the following components, as illustrated in Figure 1–2:
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� Sun Management Center server
� Sun Management Center web server
� Topology manager
� Trap handler
� Configuration manager
� Event manager

Configuration
manager

Topology
manager

Console

Server

Remote
SNMP agent

Local
SNMP agent

SNMP SNMP

Event
manager

Trap
handler

RM

Sun Management Center server layer.

FIGURE 1–2 Sun Management Center Server Layer

The server component is the core of the server layer. The server component consists of
two servers: a Java server and a web server. Both the Java server and the web server
are multi-threaded. These servers can handle multiple data requests from various Sun
Management Center users.

The topology manager provides services that include managing user administrative
domains and arranging managed object topology.

The trap handler is a centralized SNMP trap receptor that logs and forwards traps to
interested components. This server layer component is responsible for receiving all
alarm notifications.

The configuration manager provides security services to the server and the agents.

The event manager receives event information from the agents. These events can trigger
alarms, which are forwarded to the console.
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Agent Layer
The agent layer monitors, gathers information about, and manages objects on the
nodes that the Sun Management Center software manages. The server layer uses
SNMP to interact with the agent layer to gain access to the managed objects.

Sun Management Center agents are scalable, extensible, and SNMP-based. The agents
monitor and manage objects by loading modules that focus on a specific aspect of the
system, as well as application health and performance. These objects represent
hardware, operating systems, and applications.

The agents use rules to determine the status of the managed objects. When the
conditions that a rule specifies become true, the software automatically generates
alarms and performs actions as the rule specifies.

Server Context
The server layer and agent layers together are referred to as a Sun Management Center
server context. When you start the console, you log in to a particular server context. The
managed objects whose agents send information to that server belong to the same
server context.

A managed object can belong to the same server context or to a remote server context. A
managed object in a remote server context sends information to a different server. A
managed object in the same server context sends information to the server host that is
connected to your console.

By default, the Sun Management Center software manages an object in the same server
context but only monitors an object in a remote server context. For more precise
definitions of “manage” and “monitor,” see Glossary. For more information about
server contexts and security, see “Sun Management Center Remote Server Access”
on page 263.

Console

Server

Agent Agent

Server context 1

Server

Agent

Server context 2

FIGURE 1–3 Console Logs Into a Server Context
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Sun Management Center Concepts
The following concepts are fundamental to understanding Sun Management Center
software:

� Administrative domains
� Management information base (MIB)
� Modules
� Alarms and rules

Note – In this document, “domain” refers to a Sun Management Center administrative
domain. This term should not be confused with uses of the term “domain” related to
other Sun products or documentation. See Chapter 2 for more information.

Administrative Domains
An administrative domain is a hierarchical collection of resources that you want to
monitor and manage. The resources can include a complete campus, individual
buildings, hosts, networks, subnets, links, and so on. Each administrative domain
consists of these resources, which can be combined with other resources to form
groups within a administrative domain. Each of these groups can contain additional
groups of resources, providing a multilevel, hierarchical administrative domain.

You can create one or more administrative domains that are based on your business
needs. For example, you might create a lab administrative domain that contains all the
lab machines. Similarly, you might create an accounting administrative domain that
contains all the machines that are used for accounting.

The Sun Management Center software displays the administrative domain and its
members in a visual representation. Figure 1–4 shows an example.

In the following example, the host, Payroll2, belongs to the Building B group,
which belongs to the Payroll Servers 1 administrative domain.
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FIGURE 1–4 Java Console Window Showing an Administrative Domain and Its Members

Linux hosts are identified by a generic Linux icon. Zone agents are identified by a
generic icon having a “Z” symbol in the middle.

Management Information Base (MIB)
A management information base (MIB) is a hierarchical database schema that
describes the data that are available from an agent. Sun Management Center agents
use the MIB to store monitored data that can be accessed remotely.

Sun Management Center Modules
Unlike most agents, the Sun Management Center agents do not implement the MIB in
a monolithic code that contains a wide variety of functions in a single program.
Instead, Sun Management Center software uses several components, that are called
modules, for each agent. Each module implements its own MIB. Therefore, the Sun
Management Center agent MIB is the cumulative total of all the modules and their
individual MIBs, as illustrated in the following figure.
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FIGURE 1–5 Sun Management Center Agent MIB

Sun Management Center modules monitor and manage the resources of systems,
applications, and network devices. The modules enable you to isolate and monitor
specific system components. For example, separate modules are available for
monitoring the kernel, for monitoring printers, and for monitoring processes. The
modules are primarily used to monitor and to notify you through alarms when error
conditions occur or when performance tuning is required. For more information about
alarms, see “Alarms and Rules” on page 39.

Each module consists of one or more properties that you can monitor. For example,
one of the default modules that is loaded during installation is the Kernel Reader. This
module monitors the kernel properties. These properties include user statistics, disk
statistics, file system usage, and so on.

Note – You can add or remove modules dynamically. This feature enables you to
customize the modules that are loaded on each agent (object), based on your need.

Alarms and Rules
An alarm is a notification of an abnormal event. Sun Management Center software
enables you to monitor your system using alarms that have differing severities. The
thresholds that generate these alarms are defined in the modules. The software enables
you to set the thresholds that trigger simple alarms.

For example, one of the properties of the Kernel Reader module is the number of user
sessions. The software enables you to set a threshold number of user sessions that,
when exceeded, generates an alarm. For example, you might tell Sun Management
Center software to generate a critical alarm when there are seven or more user
sessions. Similarly, you might tell the software to generate a cautionary alarm when
there are five or six user sessions.
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The software is configured with default alarm conditions. You can set and define your
own alarm thresholds for simple alarms, such as those alarms that are based on the
simple rCompare (comparison) rule.

Complex rules also generate alarms. For example, one complex rule generates an alert
alarm when a disk is more than 75 percent busy, the average queue length is over 10
entries, and the wait queue is increasing. This rule combines three conditions:

� Percentage of the disk that is busy
� Average queue length
� Wait queue

Unlike simple rules, these complex rules are predefined. You cannot modify complex
rules. Consequently, you cannot set thresholds for complex alarms.

When an alarm is generated, the software notifies you through the main console
window, and through an alarm action. The alarm action can include a message sent to
a specified email address or activation of a script. You can also write a customized
program that notifies you in other ways that an alarm condition has occurred.

For more information about alarms, see Chapter 12. For more information about rules,
see Appendix D.

Sun Management Center Management
and Monitoring Features
Sun Management Center software includes the following management and
monitoring features:

� “Autonomous Agents” on page 41
� “User Security” on page 41
� “Discovery Feature” on page 41
� “Main Console Window” on page 42
� “Hierarchy and Topology Views” on page 42
� “Topology Import and Export Features” on page 43
� “Graph Feature” on page 43
� “Dataviews Feature” on page 43
� “Manage Jobs Feature” on page 44
� “Module Configuration Propagation (MCP) Feature” on page 44

General Support Features
The features that are described in this section provide support for managing and
monitoring your environment.
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Autonomous Agents
Sun Management Center agents work autonomously by actively sampling key data on
host systems. These agents can be polled through SNMP get requests for the current
status of the monitored data.

When an agent gathers data for a monitored resource, the agent checks the data
against the alarm threshold set for the resource. The agent then determines whether
the data values constitute an alarm condition. If the monitored data meets the alarm
threshold, the agent performs the action that is associated with the alarm condition.
Agents send asynchronous messages (SNMP traps) to the server, which delivers
notification of the change in the status of the monitored data.

User Security
The Sun Management Center security feature authenticates user login and access
control privileges for users and groups. The software enables users to set security
permissions at the administrative domain, group, host, and module levels.

You can restrict access by setting different permissions. For example, you might
determine that one group of users can view and modify properties on a host, while
another group of users can only see the host. For more general information about Sun
Management Center security, see Chapter 18.

You can access Sun Management Center security features from the Attribute Editor
within the console or from the CLI. For more information about the Attribute Editor,
see Chapter 10. For more information about the CLI, see Chapter 20.

Specific Management and Monitoring Features
The features that are described in this section provide specific monitoring and
management functionality. These features can be accessed through the consoles. Some
of these features can also be accessed through the CLI.

Discovery Feature
The Sun Management Center includes a discovery feature. This feature enables you to
automatically find network resources for Sun Management Center to monitor and
manage. The discovery feature allows to specify discovery criteria based on several
values such as IP range, host name, loaded modules, operating system, hardware type,
or some combination of these values. For more information, see Chapter 4.
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Main Console Window
Sun Management Center software provides Java and web interfaces that enable you to
view, monitor, and interact with the software. You can monitor multiple
administrative domains, spanning different locations, through multiple console
windows. For more information about the Java Console, see Chapter 5. For
information about the web console, see Chapter 15.

Note – The web console provides a subset of the functions that are available in the Java
Console. Most of this document describes the functions that are available in the Java
Console. Information that is specific to the web console is expressly identified.

Hierarchy and Topology Views
Sun Management Center software offers the following views:

� Hierarchy and topology views for every administrative domain
� Hierarchy and contents views for every object

The hierarchy view enables you to navigate through the administrative domain or
host to find the object of interest. The topology view or contents view displays the
members of the object that is selected in the hierarchy.

For an administrative domain, the hierarchy and topology views are displayed in the
main console window. In addition, you can customize the administrative domain
topology view by adding a background or creating a connection between objects in the
administrative domain.

For an object, the hierarchy and contents views are displayed in the Details window.
The Details window consists of a series of tabs. The available tabs depend on the type
of object that is selected. For example, the following tabs would be displayed for a
typical host object:

� Info
� Module Browser
� Alarms
� View Logs
� Applications
� Hardware

The View Logs, Applications, and Hardware tabs are described briefly in the sections
that follow. For more information about the Details window, see Chapter 6.

View Logs Tab Overview

The View Logs tab enables you to view informational messages, including error
messages, about your host.
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Applications Tab Overview

The Applications tab enables you to view and select detailed information about
processes running on the selected host or node. If you have any custom or third-party
applications installed, this tab also enables you to view detailed information about
processes running in the selected applications. The displays are continually updated.

Hardware Tab Overview

The physical view from the hardware tab provides you with photo-realistic front,
back, and side views of the host. You can click individual components of the host to
see detailed information about that component. For example, you can click a board in
a server to see detailed information about that board, such as CPUs, memory, and
board temperature.

Note – Physical views are available only for some hardware platforms.

Sun Management Center software also provides a logical view of the overall hardware
configuration of the host. Similar to the physical view, you can click a single
component to obtain detailed information about that hardware component.

Note – Logical views are available only for some hardware platforms.

Topology Import and Export Features
The topology import and export features enable you to import and export the
topology database from or to an ASCII file that uses XML markup. These features
provide a convenient way to migrate management domains from one Sun
Management Center server to another server or to backup information for a server.
For more information, see Chapter 19.

Graph Feature
Sun Management Center software enables you to create a two-dimensional graph of
any monitored data property that has a numerical value. For more information, see
Chapter 9.

Dataviews Feature
The Attribute Editor window is used to browse management properties from a single
agent by selecting an individual management object type. Sun Management Center
also provides a dataviews feature that enables you to create a customized view or
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dashboard. In this customized view, you can put together a screen that shows
individual properties that belong to different Sun Management Center modules that
are loaded on separate Sun Management Center hosts. For more information, see
Chapter 14.

Manage Jobs Feature
The Manage Jobs window enables you to create persistent jobs for topology objects.
This feature provides a way to manage a collection of agents (or group) with the same
ease as a single agent. Use the Manage Jobs window to define the objects to include,
the specific tasks to run, and a schedule on which to run the job. For more
information, see Chapter 13.

Module Configuration Propagation (MCP) Feature
MCP support enables you to make a persistent snapshot of an individual agent
configuration. When you combine MCP support with the Manage Jobs feature, you
can easily distribute agent configuration to multiple agents. For more information, see
“To Create a Configuration Task” on page 213.

Sun Management Center Software
Environments
You can deploy Sun Management Center software in two different environments:

� Production environment
� Developer environment

The production environment is an active environment in which you manage and
monitor your hardware, including subsystems, components, and peripheral devices.

In contrast, the developer environment is a test, or demonstration, environment that
developers can use to develop and test modules to work with the Sun Management
Center software. While the developer environment might appear to be a production
environment, its sole purpose is to be an environment in which developers create Sun
Management Center modules.
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Installing Sun Management Center
Software
For information about installing Sun Management Center 3.6 , see the Sun Management
Center 3.6 Installation and Configuration Guide.

After you install Sun Management Center software, spend some time moving among
the various windows and testing their functions. Once you explore and test the
software, you will have a better understanding of how you can customize Sun
Management Center software to aid in your system monitoring.

Getting Started With Sun Management
Center Software
This section describes a suggested approach to setting up and using the Sun
Management Center software. This process includes a summary of some typical tasks
and the order in which you should do them. Each task is referenced to a section in the
manual, which provides detailed, step-by-step directions. Your actual steps will vary
according to your business needs.

The task sequence presumes that you explore and learn the software before you set up
your actual monitoring environment.

1. Install Sun Management Center software. See Sun Management Center 3.6
Installation and Configuration Guide for more information about installing and
configuring the software.

2. Identify users and privileges for using the Sun Management Center software, as
described in “Using Access Control” on page 265. For general information about
security, see Chapter 18.

3. Start the Sun Management Center console. The console provides a graphical
interface to managing and monitoring your network. To start the Java Console
from a terminal window, type the following command:
/opt/SUNWsymon/sbin/es-start -c. For more information, see Chapter 5. To
access the Web console, type the appropriate URL in your browser. For more
information, see Chapter 15.

4. Define a collection of network objects for the software to manage and monitor, as
explained in “To Create Administrative Domains” on page 53.

5. Add servers, routers, and other network objects to the administrative domain in
the Sun Management Center database. For information about creating objects
manually to populate the domain, see Chapter 3. For information about using the
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Discovery Manager to populate the domain, see Chapter 4.

6. Familiarize yourself with the console window and navigate through the hierarchy
and topology views as explained in Chapter 5 or Chapter 15.

7. View detailed information about a managed object, as explained in Chapter 6 and
Chapter 7. More information about viewing specific data properties is explained
further in Chapter 8, Chapter 9, and Chapter 10.

8. Customize the monitoring capabilities of the software by adding or removing
module functions, as described in Chapter 11. For information about the modules
that are available within the product, see Appendix C.

9. Define conditions that should generate and alarm and specify actions to occur
when the condition is met, as described in Chapter 12. For information about the
predefined rules that relate to alarms, see Appendix D.

10. Create management and monitoring functions that relate to a user-defined group
of objects, as explained in Chapter 13.

Note – For additional information specific to your hardware, see your supplement.

Additional Information
This documentation includes a description of basic and advanced features that are
available in the Sun Management Center 3.6 product. The features that are available in
your environment might include additional software modules or specific hardware
information.

Related Hardware Information
Sun Management Centersupports multiple hardware platforms. See the “Supported
Platforms” in Sun Management Center 3.6 Installation and Configuration Guide for more
information about the supported hardware platforms.

This book describes the software capability that is common to all the supported
hardware platforms. Platform-specific information is included in the platform-specific
supplements available at http://docs.sun.com.
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Note – For complete information about how you can use the Sun Management Center
software to manage and monitor your machines, read both this guide and the
appropriate hardware supplements.

Add-on Products
Your Sun Management Center environment might be enhanced by several products.
See the related documentation for more information.

� Sun Management Center 3.5 Update 2 Performance Reporting Manager User’s Guide
� Sun Management Center 3.6 System Reliability Manager User’s Guide
� Sun Management Center 3.5 Service Availability Manager User’s Guide
� Installing and Administering Solaris Container Manager 3.6
� Hardware-specific documentation or platform supplements

Product Documentation
The documentation for Sun Management Center 3.6 is not available on the software
CD. The English documents and localized documents are available at
http://docs.sun.com.
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CHAPTER 2

Using Sun Management Center
Administrative Domains

A Sun Management Center administrative domain is an arbitrary collection of
resources that can include a complete site, individual buildings, hosts, networks,
subnets, links, and so on. The organization of an administrative domain collection is in
a hierarchy.

Note – In this document, administrative domain refers to a Sun Management Center
administrative domain. This term should not be confused with other uses of the term
domain related to other Sun products or documentation.

This chapter describes the following topics:

� “Administrative Domains Concepts” on page 50
� “To Start Sun Management Center” on page 51
� “To Set the Home Administrative Domain” on page 52
� “To Create Administrative Domains” on page 53
� “Populating Administrative Domains” on page 54
� “To View Information About an Administrative Domain” on page 55
� “To Set Security for an Administrative Domain” on page 56
� “To Delete an Administrative Domain” on page 58
� “Monitoring Remote Administrative Domains” on page 58
� “To View Information From a Remote Administrative Domain” on page 60
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Administrative Domains Concepts
Sun Management Center software can monitor a multitude of hosts. To enable you to
perform your monitoring tasks in an efficient manner, Sun Management Center
software organizes hosts into groups. The largest, highest-level grouping is an
administrative domain. An administrative domain is an arbitrary grouping of hosts,
subnets, networks, buildings, and so on.

You can create one or more administrative domains. Each administrative domain
consists of one or more members that are arranged in a hierarchy. For example, you
might decide that an administrative domain consists of all the hosts in one building.
Or, you might decide that an administrative domain consists of all the hosts in a
campus. Note the following characteristics that apply to domains.

� Each domain name must be unique.
� Domain names cannot be changed.
� Users who belong to the group esdomadm can create administrative domains,

create groups within administrative domains, and perform similar tasks. For more
information about security, see Chapter 18.

For example, you might set up three administrative domains, one for production, one
for testing, and one for integration testing. Alternatively you might set up domains
that are based on hardware platform, such as a domain for x86 machines and a
domain for Sun Blade 1000s. If you set up a domain for each hardware platform, you
might also set up a group within that domain for the machines of that hardware
platform with a specific patch applied

Tip – Spend some time planning how you want to organize your hosts into different
administrative domains.

Decide whether you need additional groups below the administrative domain to
organize your hosts. For example, if there are several hundred hosts, placing your
hosts individually in one administrative domain is impractical.

You might decide to break the administrative domain into a set of smaller groups, for
example, campuses. The Headquarters administrative domain might consist of several
campus locations. Each of these campus locations might be broken into smaller
groups, for example, buildings. Similarly, each building might be broken into smaller
groups, such as networks, subnets, and groups. Finally, each group contains
individual hosts.

In this particular example, the hierarchical order, from highest level to lowest level, is
as follows:

1. Administrative domain
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2. Campus
3. Building
4. Network
5. Subnet
6. Group
7. Individual host

For detailed information about creating administrative domains, see “To Create
Administrative Domains” on page 53.

The home domain is the administrative domain that is displayed when you log into a
specific server.

Starting Sun Management Center
Software
The Sun Management Center server software automatically starts upon completion of
installation and when the server system reboots. You use a console to access the server.

� To Start Sun Management Center

1. To start the Sun Management Center console, type the following command:

% installed-root-directory/sbin/es-start -c

where the default installed root directory is /opt/SUNWsymon.

The login screen appears.

Note – You can also access some Sun Management Center features from a browser.
For more information, see Chapter 15.

2. Type a valid user name, password, and server host name in the appropriate
fields.

The user account must be listed in the /var/opt/SUNWsymon/cfg/esusers file
on the Sun Management Center server.

Steps
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Tip – To change the server port number or the communications security level for
this console session, click Options.

3. Press the Return key, or click the Login button.

The Set Home Domain window appears if you have not previously logged in to
this server or if you have not set a home domain. The home domain is the
administrative domain that is displayed when you log in to a specific server. This
dialog box appears each time you start the console until you set a home domain.

During installation, a default administrative domain that is named Default Domain
is created for you. The Default Domain initially consists of one object, your server
host. To use the default administrative domain, select Default Domain and click the
Go To button. For information about setting the home domain, see “To Set the
Home Administrative Domain” on page 52.

At this time, you might want to populate your administrative domain or perform
other tasks.

� To create objects in your administrative domain, see “Populating
Administrative Domains” on page 54.

� To explore the main console window, see Chapter 5.
� To explore monitoring features, see Chapter 8.
� To create additional administrative domains, see “To Create Administrative

Domains” on page 53.

� To Close a Session of Sun Management Center

� Choose Close from the File menu in the main console window.

The console appears so that you can login again.

� To Set the Home Administrative Domain

1. To access the Set Home Domain window, choose Set Home Domain from the
File menu in the main console window.

Tip – The Set Home Domain window appears automatically if you have not
previously logged in to this server or if you have not set a home domain.

Step

Steps
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2. In the Set Home Domain window, select the name of the administrative domain
that you want to set as your home domain.

The selected administrative domain is highlighted.

3. Click the Set Home button.

You see the following message at the bottom of the Set Home Domain dialog box.

Setting Home Domain...Please wait

When the home domain has been set, the message changes.

Home domain successfully set.

Your default administrative domain is set as your home domain. Information about
the home domain appears in the main console window. For more information, see
“Administrative Domains Concepts” on page 50.

Tip – Click the Go To button to use an administrative domain without setting the
domain as the home domain. The selected administrative domain appears in the
main console window. In this case, your home domain is not set, and the Set Home
Domain window appears the next time that you start the console.

4. Click the Close button.

The selected home domain appears in the main console window.

Creating Administrative Domains
Use the Domain Manager window to create Sun Management Center administrative
domains.

� To Create Administrative Domains

1. Choose Domain Manager from the File menu in the main console window.

The Domain Manager appears.

2. In the Domain Manager, click the Add button.

The Create Domain dialog box appears, as shown in the following figure.

Steps
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FIGURE 2–1 Create Domain Dialog Box

3. Type the name of the new administrative domain in the Domain Name field.

4. If you do not want your administrative domain to be populated now, deselect
the Populate Now check box.

The default choice is for Sun Management Center software to display a dialog box
that enables you to start the Discovery Manager immediately after creating an
administrative domain. For more information about the Discovery Manager, see
Chapter 4.

5. To create the new administrative domain, click the Create button.

To close the window without creating the administrative domain, click the Cancel
button.

If you do not have the proper security permissions to create an administrative
domain, an error message is displayed. See Chapter 18 for more information about
security.

Populating Administrative Domains
Once you have created your administrative domains, you can begin to populate these
administrative domains and their subordinate groups.

Note – To populate an administrative domain, you must have esdomadm privileges.
See “Sun Management Center Groups” on page 259 for more information.

To add hosts and other resources to an administrative domain collection, use one of
these methods:

� Populate with the Discovery Manager
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The Discovery Manager is the default method for populating a newly created
administrative domain. Discovery Manager searches the network for resources.
The search can be time-consuming, but you can shorten the search by setting limits.
See Chapter 4 for more information.

� Populate with the Discovery Manager at scheduled intervals by using the
Scheduling feature

The scheduling feature enables you to search periodically for new managed objects
on the network. You can set the search to occur hourly, daily, weekly, or monthly.
See “Making and Modifying Discover Requests” on page 79 for more information.

� Manually populate with the Create an Object menu option

To add objects individually, use the Create an Object option. This option is useful
for adding a small number of known resources. For example, if you have installed
a new host, you can use Create an Object to add the host to the local administrative
domain immediately. See Chapter 3 for more information.

Managing Administrative Domains
Once you have created Sun Management Center administrative domains, you can
manage those domains.

� To View Information About an Administrative
Domain
You can list administrative domains through the Domain Manager window or the Sun
Management Center main console window.

1. Access the Domain Manager from the main console window in one of the
following ways:

� Choose Domain Manager from the File menu.
� Click the Sun Management Center Administrative Domains pull-down menu.

The current list of administrative domains is displayed.

2. Select the administrative domain that you want to view.

The main console window displays the selected administrative domain. The Sun
Management Center Administrative Domains button changes to display the name
of the administrative domain that you selected.

Steps
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� To Set Security for an Administrative Domain
The administrative domain Attribute Editor provides additional information about the
selected administrative domain and about the rules that govern its behavior. Use the
Attribute Editor to edit security information for the administrative domain.

Note – Each Attribute Editor displays one or more tab buttons depending on the type
of selected object.

1. Access the Attribute Editor in either of the following ways:

� From the hierarchy view in the main console window, press mouse button 3 on
the administrative domain icon. Then, choose Attribute Editor from the pop-up
menu.

� From the main console window, choose Domain Manager from the File menu.
Then, choose an administrative domain and click the Security button.

2. If not already selected, click the Security tab in the Attribute Editor window.

The security information appears in the Attribute Editor window, as illustrated in
the following figure.

Steps
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FIGURE 2–2 Attribute Editor for an Administrative Domain

3. Type the names of user and administrator groups in the appropriate fields.

See Chapter 18 for more information about users and groups.

4. To accept your changes and close the Attribute Editor window, click the OK
button.
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� To Delete an Administrative Domain

Caution – When you delete an administrative domain, you also delete all the members
of that administrative domain.

1. In the Domain Manager window, select the name of the administrative domain
that you want to delete.

Note – To delete an administrative domain, you must have the appropriate security
permission. For more information about Sun Management Center security, see
Chapter 18.

2. Click the Delete button.
The Confirm Domain Deletion dialog box is displayed.

There are two versions of the Domain Deletion dialog box. One version is for any
administrative domain. The other version is for the administrative domain that you
are currently viewing.

3. To verify that you want to delete the selected administrative domain, click the
Delete button.
The Confirm Domain Deletion dialog box displays the following message.

Deleting domain...Please wait.

When the administrative domain has been successfully deleted, the dialog box is
removed and the Domain Manager updates the list of administrative domains.

4. To close the Domain Manager window, click the Close button.

Monitoring Remote Administrative
Domains
Remote administrative domains are Sun Management Center administrative domains
that are created in a different Sun Management Center server context. See “Server
Context” on page 36 for a description of server context.

If you are interested in an object in a different server context, you can still monitor the
remote resource. To monitor the remote resource, reference the remote administrative
domain in your local administrative domain. To manage the remote resource, log out of

Steps
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your current Sun Management Center server context and log into the remote server
context. You can manage monitored properties on a resource only if the agent is
managed by the server to which your console is connected. By default, Sun
Management Center security gives you “read-only” privileges for remote
administrative domains. For more information about security, see Chapter 18.

Note – You can reference a remote administrative domain to monitor resources in that
administrative domain. You cannot manage monitored properties on a remote
resource.

For example, your current Sun Management Center server context might be based in
the Headquarters administrative domain. A second, remote Sun Management Center
server context might be based in Regional Office 1. When workers are absent from
Regional Office 1, you can monitor the regional office administrative domains from
Headquarters by referencing these remote administrative domains in the
Headquarters server context. If an emergency occurs, administrators in Headquarters
can notify a Regional Office 1 administrator immediately.

Note – Remote administrative domains enable you to monitor critical resources
continuously.

Figure 2–3 illustrates how remote monitoring works. Administrative Domain A
monitors objects 1 and 2, which are assigned to Domain A. Administrative Domain A
remotely monitors objects 3 and 4, which are assigned to Domain B. Note that
administrative Domain A cannot monitor objects 3 or 4 without going through remote
administrative Domain B.

Domain A

Object 1 Object 2

Domain B

Object 3 Object 4

FIGURE 2–3 Remote Administrative Domain

Do not create an administrative domain that refers to itself. For example, do not create
an administrative domain A that references another administrative domain B which in
turn, contains a reference to administrative domain A.

If two administrative domains must monitor each other, avoid creating a circular
domain reference. Instead, create a domain member, for example a group, under
Domains A and B as shown in the following figure.
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Domain A

Object 1 Object 2

Domain B

Group 1 Group 2

Object 3 Object 4

FIGURE 2–4 Setting Up Successful Cross-Monitoring for Remote Administrative Domains

Now when making a remote reference, Domain A can reference Group 2 under
Domain B, while Domain B can reference Group 1 under Domain A.

� To View Information From a Remote
Administrative Domain

1. In the main console window, choose Remote Domain Manager from the File
menu.

The Remote Domain Manager dialog box is displayed.

2. Type the name of the remote server in the Host field.

3. If applicable, type the port number for the remote Topology manager in the Port
field

By default, the Topology manager is installed on the server on port 164.

4. Click the List Domains button.

A list of administrative domains on the remote server is displayed.

5. Select the administrative domain that you want to reference.

The selected administrative domain is highlighted.

6. Click the Reference button.

The selected administrative domain is created as a reference administrative domain
in the currently selected administrative domain in the main console window.

Steps
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CHAPTER 3

Manually Adding Objects to the
Topology Database

This chapter describes how to manually create objects that are added to the Sun
Management Center topology database. For information about using the Discovery
Manager to automatically populate the topology database, see Chapter 4.

This chapter discusses the following topics:

� “Managed Objects Concepts” on page 61
� “To Create a Node” on page 64
� “To Create a Module Object” on page 66
� “To Create a Group” on page 67
� “To Create a Composite Object” on page 68
� “To Create a Segment” on page 70
� “To Connect Objects in the Topology View” on page 71
� “To Copy an Object” on page 71
� “To Copy a Group of Objects” on page 72
� “To Modify an Object” on page 73
� “To Cut and Paste Objects” on page 74
� “To Delete Objects” on page 75

Managed Objects Concepts
Sun Management Center objects represent parts, or nodes, of a network. These objects
include hardware and software components such as hosts (workstations and servers),
printers, routers, modules, and so on. Even a segment of the network itself can be an
object.
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Note – For additional information, refer to your hardware supplement. The
supplement contains important hardware-specific information about creating an
object.

To monitor or manage an object, you create a node in the topology database to
represent the object in an administrative domain or group. If the group does not yet
exist, you must first create the group.

You can create and one or more administrative domains that contain nodes for
multiple objects, such as the workstations and other devices that are connected to the
server. Once these administrative domains exist, you can monitor or manage them. For
information about administrative domains, see Chapter 2.

Managed Object Categories
Sun Management Center supports the following object categories:

� Node – A node object generally refers to a hardware component, such as a
workstation or server, printer, or router. See “To Create a Node” on page 64.

� Composite – A composite object refers to a collection of related objects that you
want to monitor as a single entity. A composite object can also be a service object. A
service object is a specific type of composite object that enables you to monitor
services. An example of a composite object could refer to a hardware system on
which multiple instances of the Solaris operating environment are running. See “To
Create a Composite Object” on page 68.

� Group – A group object refers to a collection of objects that fall into one of two
categories: General or IP-based. General groups are based on geography, such as a
building, whereas IP-based groups are based on networks or subnets. See “To
Create a Group” on page 67.

� Segment – A segment object refers to portions of the network that link together the
nodes or groups. See “To Create a Segment” on page 70.

� Module – A module object refers to a collection of modules for the purpose of
enabling a common monitoring method. See “To Create a Module Object” on page
66.

Agents and Monitors
When you create a node, you can choose from the following types of monitoring
approaches.

Sun Management Center Agent – Host
Monitor and manage a host that has an active agent that is installed and running.
The status of the agent on the host can be monitored. The Details window of the
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Sun Management Center agent host contains tabs such as Info, Browser, Alarms,
and so forth. The Entity Polling Type in the Info tab is ahost.

Sun Management Center Agent – Platform
For more information, see your platform supplement.

Sun Management Center Agent - Module
Monitor and manage a module that has an active Sun Management Center agent
that is installed and running. The status of the Sun Management Center module on
the agent host can be monitored. The Details window contains Info, Module
Browser, and Alarms tabs. The Entity Polling Type in the Info tab is amod.

SNMP Proxy
Monitor and manage the device through a Sun Management Center agent that is
running a Sun Management Center proxy module for that device. (The proxy
module must have been previously loaded into the agent. See “To Load a Module”
on page 169.) Communication between the Sun Management Center Topology
manager and the agent is SNMPv2 usec. Communication between the Sun
Management Center agent and the remote device is SNMPv1, SNMPv2, or
SNMPv3, depending on the proxy module. The Proxy Monitoring module data are
displayed. The Details window contains the Info and Browser tabs. The Entity
Polling Type in the Info tab is aprox.

SNMP Ping
Monitor the device by using the SNMP ping command. The Sun Management
Center Topology manager communicates with the device using SNMPv1. No
management capabilities are provided for devices that are monitored by the SNMP
ping command. The availability of the SNMP agent on the device can be
monitored. The Details window contains only the Info tab. The Entity Polling Type
in the Info tab is snmp.

ICMP Ping
Monitor the device by using the Internet Control Message Protocol (ICMP) ping
command. No management capabilities are provided for devices that are monitored
by the ICMP ping command. The accessibility of the device can be monitored. The
Details window contains only the Info tab. The Entity Polling Type in the Info tab is
ping.

Non-Monitored
Created node is for display only. The node status is not monitored. No aspects of
the device are monitored. The Details window contains only the Info tab. The Entity
Polling Type in the Info tab is dummy.
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Creating Objects
The general process that you follow to create objects is similar for all categories. The
specific steps differ as described.

� To Create a Node
You create nodes through the Create Object function on the Edit menu in the main
console window.

Note – An administrative domain must exist before you can create a node. For
information about how to create an administrative domain, see “To Create
Administrative Domains” on page 53.

1. In the hierarchy view of the main console window, select the administrative
domain in which to create the new object.

Select the lowest level group of the administrative domain where the new object
should be created. For example, to create a node in a building that is in one of the
campuses of a administrative domain, select the building in the administrative
domain as the lowest level group.

2. In the main console window, choose Create Object from the Edit menu.

The Create Object window is displayed. By default, the Node tab is selected.

3. In the upper half of the Create Object window, set up the new node.

a. Use the Monitor Via combo box to select the software or agent to monitor the
new node.

There are seven categories of agents and monitors. If an agent is not available
for your selected object, SNMP Ping usually works. If you do not select an
available agent or ping command, the creation fails. The following choices are
available:

� Sun Management Center Agent – Host
� Sun Management Center Agent – Platform
� Sun Management Center Agent - Module
� SNMP Proxy
� SNMP Ping
� ICMP Ping
� Non-Monitored

Steps
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Note – To create an agent object, the MIB-II module must be loaded. If it is not,
the agent can be created only as a ping host or as an SNMP host.

For more information about these monitoring choices, see “Agents and
Monitors” on page 62. For information about creating an object for your specific
platform, see the appropriate platform supplement.

b. If applicable, select a type from the pull-down menu in the Type field.

The Type field displays only if SNMP Ping, ICMP Ping, or Non-monitored is
selected in the Monitor Via field.

The following Type choices are available:

� Server
� Workstation
� PC
� Router
� Printer
� Concentrator

c. If applicable, scroll and select an object in the Create Object window.

For some types of monitoring, the right side of the Create Object window
displays the set of icons for the object you have selected. The icons are
displayed in the hierarchy and topology views in the main console window
when the node is created.

d. (Optional) Create a unique name in the Node Label field.

The default label is the host name.

e. (Optional) Type a description of the node.

4. In the lower half of the Create Object window, type the requested information.

The questions in the lower half of the window vary with the agent or monitor that
you selected in Step a. The Non-Monitored selection does not require further
information, but most agent or monitor selections ask you to provide the following
information:

� Node host name
� Node IP address

You can provide the host name, the IP address, or both. If there is a conflict
between the host name and the IP address, the host name takes precedence.

Other agent or monitor selections might also ask for one or more of the following
items:

� Sun Management Center agent port number (default is 161)
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� Proxy host name and IP address if Monitor Via is SNMP Proxy

� Read and write SNMP communities if Monitor Via is SNMP Ping (The default
read community is public; The default write community is private.)

� Module name

5. To add the new node to your topology and close the Create Object window, click
the OK button.

The following message is displayed at the bottom of the Create Object window:

Creating Node... Please Wait.

� If the request is completed successfully, the main console window is updated,
and the new node is displayed.

� If the creation fails, an error message is displayed at the bottom of the Create
Object window. The cause of the error might be one of the following reasons:

� You do not have permission to create this node.
� You must start a Sun Management Center agent on the node.
� You provided incorrect agent host or port information.

Note – When you create a node on the current Sun Management Center server
context, ownership of that node defaults to your login identity. When you create
a node on a remote server context, ownership of that node defaults to a general
user identity. This situation is normal. The general user identity is imposed for
security of transactions between Sun Management Center server contexts. For
more information, see “Sun Management Center Remote Server Access”
on page 263.

For information about how to change the new node, see “Changing Objects”
on page 71.

� To Create a Module Object
To monitor several module objects on several hosts, you might create module objects
for each host and put the module objects in a common location. For example, you
might put the module objects in the same group or administrative domain. The
procedure for creating a module object is similar to the procedure for creating a node.

1. In the hierarchy view of the main console window, select the administrative
domain in which to create the new object.

2. In the main console window, choose Create Object from the Edit menu.

3. Select the Node tab in the Create Object window.
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66 Sun Management Center 3.6 User’s Guide • December 2005



4. Select Sun Management Center Agent – Module in the Monitor Via field.

5. (Optional) Type a node label.

6. (Optional) Type a description.

7. Type a host name or IP address.

You can provide either the host name, the IP address, or both. If there is a conflict
between the host name and the IP address, the host name takes precedence.

8. Verify or change the port number.

9. Click the Get Modules button to view a list of modules that are currently loaded
on the host.

The module list is displayed.

If the module that you want to use is not loaded, see “To Load a Module” on page
169. If the module that you want to use is not enabled, see “To Enable a Module”
on page 172.

10. Select the module to monitor.

The module list closes.

11. To add your module to the topology and close the Create Object window, click
the OK button.

� To Create a Group
You can create two types of groups: General and IP-based. General groups are based
on geography, such as campus or building. IP-based groups are based on networks or
subnets.

Note – To create a group, you must have esdomadm privileges. See “Sun Management
Center Groups” on page 259 for more information.

1. In the hierarchy view of the main console window, select the administrative
domain in which you want the new group.

For example, to create a group in a building that is in a campus of an
administrative domain, click the building icon in the administrative domain.

2. In the main console window, choose Create Object from the Edit menu.

The Create Object window is displayed.

3. In the Create Object window, click the Group tab.
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4. Change the Type field, if desired (General or IP-Based).

General groups are based on geography, such as campus or building. IP-based
groups are based on networks or subnets.

5. Select the object type (Building, Campus, or General).

The right side of the window is updated with an icon corresponding to the object
type.

6. Create a new group Label.

7. (Optional) Type a description in the Description field.

8. For an IP-based group, specify the IP address and the subnet mask.

The creation of an IP-based group results in the creation of an empty network or
subnet “container.” You can populate the container as explained in Step 10.

9. To add the group to your topology view and close the Create Object window,
click the OK button.

The following message is displayed at the bottom of the Create Object window:

Creating group... Please Wait.

If the request ends successfully, the main console window is updated and the
group is displayed.

If the request fails, an error message is displayed at the bottom of the Create Object
window. The cause of the error might be that you do not have permission to create
this group.

For information about how to change the new group, see “Changing Objects”
on page 71.

10. Add components to your group using one of the following methods:

� Use the Create Object window. See “To Create a Node” on page 64.
� Copy and paste objects from other groups into the new group. See “To Copy an

Object” on page 71.

� To Create a Composite Object
A composite object is a group of related objects that you want to monitor collectively.
This term refers to hardware with multiple instances of the Solaris operating
environment running inside a single chassis.

1. In the hierarchy view of the main console window, select the Sun Management
Center administrative domain in which to create the composite object.

Select the lowest level group of the administrative domain where the new
composite object should be created.
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2. In the main console window, choose Create Object from the Edit menu.

The Create Object window is displayed. By default, the Node tab is selected.

3. Click the Composite tab in the Create Object window.

The window changes to display the settings that are available for composite
objects.

4. Select an object in the Create Object window.

For some types of monitoring, the right side of the Create Object window displays
the set of icons for the object you have selected. The icons are displayed in the
hierarchy and topology views in the main console window when the composite
object is created.

5. Create a unique name in the Label field.

6. (Optional) Type a description for the composite object.

7. In the lower half of the Create Object window, type the requested information.

� Agent Hostname
� Agent IP Address
� Sun Management Center agent port number (the default is 161)

You can provide the host name, the IP address, or both. If there is a conflict
between the host name and the IP address, the host name takes precedence.

8. To add this composite object to your topology and close the Create Object
window, click the OK button.

The following message is displayed at the bottom of the Create Object window:

Creating Composite Object... Please Wait.

� If the request is completed successfully, the main console window is updated
and the new composite object is displayed.

� If the creation fails, an error message is displayed at the bottom of the Create
Object window. The cause of the error might be one of the following reasons:

� You do not have the permission to create this object.
� You must start a Sun Management Center agent on the object.

Note – When you create a node on the current Sun Management Center server
context, ownership of that node defaults to your login identity. When you create
a node on a remote server context, ownership of that node defaults to a general
user identity. This situation is normal. The general user identity is imposed for
security of transactions between Sun Management Center server contexts. For
more information, see “Sun Management Center Remote Server Access”
on page 263.
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For information about how to change the new composite object, see “Changing
Objects” on page 71.

� To Create a Segment
To complete your view of an administrative domain, you can include segments of the
networks that link the nodes in the administrative domain. A segment object is a line
in the hierarchy of the topology view.

1. In the main console window, in the left window pane, select a location in the
administrative domain where the new segment should be created.

The segment is created at the selected level. For example, to create a segment in a
building that is in a campus of an administrative domain, select the building in the
administrative domain.

2. In the main console window, choose Create Object from the Edit menu.

The Create Object window is displayed.

3. In the Create Object window, click the Segment tab.

4. Change the Type field, if desired (Bus or Ring).

5. Select the object type.

The list of choices (Ethernet or IPX) changes with your selection in the Type field.

A panel in the Create Object window displays large and small icons that
correspond to the type of object you have selected. The icons are displayed in the
topology view in the main console window when the segment is created.

6. Type a new segment label.

7. (Optional) Type a description in the Description field.

8. Type the IP address for this segment.

9. Type a subnet mask for this segment.

10. To add the segment to your topology and close the Create Topology window,
click the OK button.

The following message is displayed at the bottom of the Create Object window:

Creating segment... Please Wait

� If the request is completed successfully, the Create Object window closes. The
main console window is updated and the view is displayed.

� If the request fails, an error message is displayed in the Create Object window.

For information about how to change the new segment, see “Changing Objects”
on page 71.
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� To Connect Objects in the Topology View
To make the view in Sun Management Center more closely resemble the real-world
network, you can connect objects.

1. Select two objects in the topology view.
To select two objects, select the first object in the topology view. Hold down the
Shift key and click the second object.

2. Choose Create a Connection from the Edit menu.
A link is displayed between the objects.

Changing Objects
To move an object from one location in the topology view to another location, use the
Edit commands: Cut and Paste. To copy an object into other topology views and leave
the original object in its current location, use Copy instead of Cut. The copy, cut, and
paste functions are available in the topology view. The copy and cut functions are also
available in a pop-up window by clicking mouse button 3 (typically the right mouse
button) on the object.

Note – Sun Management Center 3.6 software does not support drag and drop as an
operation for moving objects.

For example, you can create an administrative domain that contains some of the
objects that already exist in another administrative domain. To do this, create a new
administrative domain as explained in “Creating Administrative Domains” on page
53. Then, copy existing objects into the new administrative domain as described in “To
Copy an Object” on page 71.

You can also copy a group, which is an object that contains other objects. In this case,
the software does not create an independent, completely new group. Rather, the
software creates a symbolic link to the existing group. Thus, every copy is a different
“view” of the same group.

For more information about the main console window, see Chapter 5.

� To Copy an Object
This procedure is for a single object. For information about how to copy a group, see
“To Copy a Group of Objects” on page 72.

Steps
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1. In the main console window, select the object to copy in the topology view.

Tip – To select multiple objects, hold down the Shift key while using the mouse
button.

2. At the top of the main console window, choose Copy from the Edit menu, or
press mouse button 3 on the object and choose Copy from the pop-up menu.

The following message is displayed at the bottom of the main console window:

Copy successful

3. Open the destination group or administrative domain.

The destination group is displayed in the topology view.

4. At the top of the main console window, choose Paste from the Edit menu.

The pasted object is displayed in the destination group or administrative domain.
The following message is displayed at the bottom of the main console window:

Paste successful

� To Copy a Group of Objects

1. In the topology view, select the objects to be copied.

To copy all objects in the topology view, choose Select All from the Edit menu in
the main console window.

To copy two or more objects selectively:

a. Click the first object to select it.

b. Hold down the Shift key, and click one or more additional objects.

2. Choose Copy from the Edit menu in the main console window, or press mouse
button 3 on one of the selected objects and choose Copy from the pop-up menu.

When the objects are copied, the following message is displayed at the bottom of
the main console window:

Copy Successful

3. In the hierarchy view, select the new group or administrative domain where the
group is to be placed.

4. Choose Paste Into from the Edit menu in the main console window.

Alternatively, you can press mouse button 3 on the destination administrative
domain and choose Paste Into from the pop-up menu.

Steps

Steps

72 Sun Management Center 3.6 User’s Guide • December 2005



Caution – If you select Paste instead of Paste Into, the objects might be pasted into
the wrong group. If this occurs, select the duplicate objects and choose Delete
Object/Connection from the Edit menu.

� To Modify an Object
Once you have created or have copied an object, you can change the object through
the Modify Object window. The changes affect only the description of the object in the
Sun Management Center server database and do not modify the object itself.

1. Select the object in the main console window.

2. Choose Modify from the Edit menu in the main console window.

The Modify Object window is displayed. The appearance of the window varies,
depending on whether the object is a group, node, composite object, or segment.

3. Edit the characteristics as needed.

If you are modifying a group object, the following characteristics are available:

� Type: General or IP-Based
� Object: Building, Campus, or General
� Group Label
� Description
� IP Address (for IP-Based only)
� Subnet Mask (for IP-Based only)

For a node, the following characteristics are available:

� Monitor Via

This field is described in more detail in “To Create a Node” on page 64.
� Node Label
� Description
� Additional characteristics such as host name, IP address, or port might be listed,

depending on the type of node

For a segment, the following characteristics are available :

� Type: Bus or Ring
� Object: Ethernet or IPX for bus type, or FDDI for ring type
� Segment Label
� Description
� IP Address
� Subnet Mask

For a composite object, the following characteristics are available:

Steps
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� Object
� Label
� Description
� Agent host name
� Agent IP address
� Port

See your hardware supplement for more information.

4. Click the OK button to save your changes, or click the Cancel button to leave the
characteristics unchanged.

� To Rename an Object
If you have changed an object’s name in the real world, you can easily modify the
managed object name in the topology database to match.

1. In the main console window, select the object name to change.

2. Choose Rename Object from the Edit menu in the main console window, or
press mouse button 3 on the object, then select Rename from the pop-up menu.

The Rename Object window appears. The Current Label shows the existing
managed object name.

3. Type a new name in the New Label field.

4. To apply the new name for this object in the topology database, click the OK
button.

To exit from the Rename Object window without changing the name, click the
Cancel button.

� To Cut and Paste Objects
You can cut and move, or permanently delete objects from the topology view in the
main console window. An object that is cut is saved temporarily in memory. Then, the
cut object can be pasted immediately into one or more areas. An object that is deleted
cannot be recalled. For instructions on deleting objects, see “To Delete Objects”
on page 75. For more information about the main console window, see Chapter 5.

Cut and paste functions work the same for all kinds of objects: hosts, modules, and
groups.
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Note – Sun Management Center 3.6 software does not support “drag and drop” as an
operation for moving objects.

1. Select an existing object in the topology view.

If you have not selected an object, the Cut and Delete functions are unavailable and
appear dimmed.

2. Choose Cut from the Edit menu in the main console window, or press mouse
button 3 on the object and choose Cut from the pop-up menu

A dashed line is displayed around the selected object. The object does not
immediately disappear, but remains active until it is pasted into a new location.
This strategy protects objects, such as processes, that should not be interrupted.
The object remains visible until it has been successfully pasted.

Tip – To cancel a Cut operation, click the object again.

When the Cut operation succeeds, the following message is displayed at the
bottom of the main console window:

Cut successful

3. Navigate to the destination location in the topology view.

4. Choose Paste from the Edit menu.

The object appears in the new location. The object disappears from the previous
location.

� To Delete Objects
The Delete function removes an object completely from the topology database. To
move an object to another location, see “To Copy an Object” on page 71 or “To Cut
and Paste Objects” on page 74.

For more information about the main console window, see Chapter 5.

Note – To delete an administrative domain, use the Delete button in the Domain
Manager window. See “To Delete an Administrative Domain” on page 58.

1. Select an existing object in the topology view.

If you have not selected an object, the Delete function is unavailable and appears
dimmed.
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2. Choose Delete Object/Connection from the Edit menu in the main console
window.

You are prompted to confirm or cancel the deletion.

If the Delete operation succeeds, the object is removed. The following message is
displayed at the bottom of the main console window:

Delete successful
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CHAPTER 4

Adding Objects to the Topology
Database Using the Discovery
Manager

You can use the Discovery Manager to populate administrative domains
automatically. Automatically populating administrative domains is very useful if you
have a large network. For information about how to add members manually with the
Create Topology Object window, see Chapter 3.

The following topics are described in this chapter:

� “Discovery Manager Concepts” on page 77
� “To Start the Discover Objects Window” on page 79
� “To Define and Initiate a Discover Objects Request” on page 79
� “To Set Preferences for a Discover Objects Request” on page 83
� “To Limit a Discovery Process by Hardware, Software, or Object Names” on page

84
� “To Schedule a Discover Objects Request” on page 86
� “To Modify a Discover Objects Request” on page 86
� “To Start, Stop, or Delete a Discover Objects Request” on page 87
� “To View the Discover Objects Log” on page 87

Discovery Manager Concepts
The Discovery Manager can find hosts, routers, networks, and subnets as explained in
“Overview of IP Addressing” on page 347. The Discovery Manager also discovers
objects where a Sun Management Center agent is configured to a different server
context as described in “Sun Management Center Server Context and Security”
on page 264.

The Discovery Manager can also find and group topology objects. These objects can be
related either to a single hardware platform or to a group of cooperating hardware
platforms. This discovery and grouping feature enables convenient management of
the related objects. This technique is described in the add-on supplement for those
machine architectures that have this grouping requirement.
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Note – For additional information, refer to your platform supplement. The supplement
contains important platform-specific information about discovering objects.

You can create one or more discover requests. Each request runs as a separate process
and adds the discovered objects to the administrative domain. The Discovery feature
is supported only for administrative domains and not for any subordinate groups. You
can add requests only for an administrative domain.

You can also schedule requests to look periodically for new hosts.

Note – Every discover request is assigned a Request ID. This ID is a unique Sun
Management Center internal identifier of the request. The Request IDs might not be in
sequential order. The Request ID displays in the Request Details portion of the
Discover Requests Window.

About the Discover Objects Window
The Discover Objects window contains the fields that are described in the following
table.

TABLE 4–1 Fields in the Discover Objects Window

Field Description

Name A name that you create for the request. You can have multiple requests
with the same name.

Scheduled “Yes” if the request is scheduled, “No” if not scheduled

Status Reflects the current state of the discover request. The status can be one of
the following states:
� New – A new request was added but not processed.
� Queued – A request has been sent to the server but processing has not

yet started.
� Running – The request is currently being processed.
� Succeeded – The request has been successfully processed.
� Failed – Processing of the request has failed.
� Stopped – The user has stopped the process.
� 0 Hosts Added – The request did not find any hosts that passed the

filter limits.

Request Details Provides summary information about the selected discover request.

The Discover Objects window contains the buttons that are listed in the following
table.
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TABLE 4–2 Buttons in the Discover Requests Window

Button Action

Add Create a new discover request through the New Discover Request
window.

Modify Change the selected discover request.

Duplicate Create a copy of the selected discover request.

Delete Delete the selected discover request.

Start Start the selected discover request. The selected request must not be
running and must not be scheduled to run.

Stop Stop running the selected discover request. The selected request must be
running.

Log View a log of the results that the selected discover request generated.

Making and Modifying Discover
Requests
This section describes how to initiate and change a discover request.

� To Start the Discover Objects Window

� Start the Discover Objects window in one of two ways:

� When you create an administrative domain through the Create Domain dialog
box, select the Populate Now option.

For more information about creating administrative domains, see “Creating
Administrative Domains” on page 53.

� Select the administrative domain in the Sun Management Center
Administrative Domains pull-down menu, then choose Discover Objects from
the Tools menu in the main console window.

The Discover Objects window appears.

� To Define and Initiate a Discover Objects Request
You can discover hosts by using the ping command or by using routing tables.

Step
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Before you initiate a discover request that uses routing tables, read Appendix B. The
appendix explains the basic concepts of routing, network classes, and netmasks.

Note – You must have esdomadm privileges to perform any operations on a Discover
Request. For more information, see Chapter 18.

1. Open the Discover Objects window as explained in “To Start the Discover
Objects Window” on page 79.

2. Click the Add button in the Discover Objects window.

The New Discover Request window is displayed. The Discover tab is selected by
default.

Tip – To copy an existing discover request, select the existing request and click the
Duplicate button in the Discover Objects window. For information about how to
edit the settings for the new discover request, see “To Modify a Discover Objects
Request” on page 86.

3. Type a new name for your discover request in the Request Name field.

Multiple requests are listed in the Discover Objects window, which enables you to
select a request and to edit the related search pattern.

4. In the Discover Using field, select the method that should be used for
discovering the network.

The discovery methods are either Ping or Routing Table.

� If you select Ping, the discovery process uses both ICMP and SNMP ping
commands. The discovery process searches for hosts, routers, and composite
objects in the specified IP address range. The process then places the hosts in
the appropriate networks and appropriate subnets based on the netmask.

Note – A composite object includes various groupings of hardware and
software, such as Sun Fire™ systems. These objects do not appear within a
subnet or similar structure, but are instead visible at the root level of the
domain.

� If you select Routing Table, the discovery process starts from the Sun
Management Center server host . The process then goes through the specified
number of hops to report subnets and hosts n hops away. The number of hops
limits the “distance” of destination hosts from the host on which the Topology
manager or Sun Management Center server is running.
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Note – Routing Table discover requests assume that you run an SNMP agent at
port 161. The agent can be a Sun Management Center agent, snmpdx, or any
SNMP agent provided by your network management package. To use a
different port number, see Step 9.

For more information about routing tables, see Appendix B.

5. Type the IP address from which to begin the discovery process in the Start IP
Address field.

6. Type the IP address at which to stop the discovery process in the End IP Address
field.

Note – You only need to do this step if you selected Ping as the discovery method.

7. Type a netmask value in the Netmask field.

Note – You only need to do this step if the following criteria apply:

� You selected Ping as the discovery method.
� You need to use a netmask other than the default value (255.255.255.0).

8. Type a number in the Number of Hops field.

The term hop refers to the number of routers through which a packet passes before
the packet reaches its destination. For example, a value of 0 (zero) would limit the
discovery process to the current subnet.

Note – You only need to do this step if the following criteria apply:

� You selected Routing Table as the discovery method.
� You want to limit the size of the discovery process.

9. To use a port number other than the default (161), enter a port number in the
Also Check Port field.

Tip – To check only the port number that you enter, deselect Use Default Port.
When you select Use Default Port and you add a number in the field, the discovery
process checks both the default port number and the port number that you provide.
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Tip – If Sun Management Center agent runs on non-default port, say 1161, and non
Sun Management Center agent runs on default port (161), deselect Use Default
Port. Otherwise, the discovery process discovers the non Sun Management Center
agent and ignores the Sun Management Center agent.

10. To start the discovery process, click the OK button.

A confirmation window appears.

To customize your discover request, see the following sections:

� “To Set Preferences for a Discover Objects Request” on page 83
� “To Limit a Discovery Process by Hardware, Software, or Object Names”

on page 84
� “To Schedule a Discover Objects Request” on page 86

11. To run the discover request immediately, click the Yes button.

When you start the discovery process, the following events occur:

� The discovery process finds all nodes that are running the Sun Management
Center agent, including agent nodes that belong to another Sun Management
Center server context. Nodes that are running Sun Management Center agents
in a remote Sun Management Center server context are included. Extensive
information is gathered for Sun Management Center agent nodes.

� The discovery process finds all nodes that are running an SNMP agent. Limited
information is gathered for SNMP agent nodes.

� The discovery process finds all nodes that are running neither a Sun
Management Center agent nor an SNMP agent. These are listed as ping hosts.
Very little information is gathered for ping hosts.

12. If a Sun Management Center server or agent is incorrectly reported to be a ping
host or is not discovered, rerun the discovery process with larger timeout and
retry values.

Note – If a host is extremely busy, a discovery process that is gathering data for that
host might time out. If a timeout occurs for a host that is a Sun Management
Center agent, the host might be reported as a ping host . Alternatively, the host
might not be discovered at all. If a timeout happens, you might want to increase
the ping and SNMP timeout periods and re-initiate the discovery process. See “To
Set Preferences for a Discover Objects Request” on page 83 for more information.

82 Sun Management Center 3.6 User’s Guide • December 2005



� To Set Preferences for a Discover Objects Request

1. In the New Discover Request window or the Edit Discover Request window,
click the Preferences tab.

2. To stop writing discover request information to a log file, deselect the Log
Discover Request Progress check box.

By default, information is written to a log that you can access from the Discover
Objects window. For more information, see “To View the Discover Objects Log”
on page 87.

If you disable the log feature, information about the discover request process status
still appears in the main Discover Objects window.

3. If needed, edit the information in the Timeout field in the Ping section of the
Preferences.

This field enables you to increase the amount of time in seconds that the Discovery
Manager waits for a response to a ping request. By default, the Discovery Manager
waits for one second for a response before the Discovery Manager times out.

4. If needed, edit the information in the Retries field in the Ping section of the
Preferences.

This field enables you to increase the number of times that the Discovery Manager
sends a ping request to a potential managed object. By default, the Discovery
Manager pings each potential object one time.

5. If needed, edit the information in the Timeout field in the SNMP section of the
Preferences.

This field enables you to increase the amount of time in seconds that the Discovery
Manager waits for a response to an SNMP request. By default, the Discovery
Manager waits for three seconds for a response before the Discovery Manager
times out.

6. If needed, edit the information in the Retries field in the SNMP section of the
Preferences.

This field enables you to increase the number of times that the Discovery Manager
sends an SNMP request to a potential managed object. By default, the Discovery
Manager sends one SNMP request to each potential object.

7. If needed, edit the information in the Community String field in the SNMP
section of the preferences.

This field enables you to change the default community string for SNMP. The
default value is public. To change this value, add one or more character strings
separated by a pipe (|) character.
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8. If needed, edit the value in the Maximum Hosts field in the General section of
the preferences.

This field enables you to limit the number of objects that can be added to the
topology database. The default value is 256.

9. If needed, edit the value in the Maximum Time field in the General section of
the preferences.

This field enables you to limit the amount of total time that the discovery process
runs. The default value is 1000000 seconds, or approximately 280 hours or slightly
more than 11 days.

10. Click the OK button.

Your preferences are applied. The New Discover Request window closes. The
discovery process starts.

� To Limit a Discovery Process by Hardware,
Software, or Object Names
You can choose to include or exclude managed objects by host name, operating
system, or platform type. Filtering uses the grep command to search for the supplied
value.

1. In the New Discover Request window, click the Filters tab.

2. To filter managed objects based on the object name, select Host Name or Label.

a. Type a text string in the Host Name or Label field.

b. Click the Add button to add the text string to the filtering criteria.

c. Determine whether to include managed objects that contain this string.

To include objects that contain this string, click the Include button.

To exclude objects that contain this string, click the Exclude button.

To remove a name filter, click the text string in the list on the right, then click the
Remove button.

3. To filter managed objects based on the object platforms, select Platform Types.

Platforms include both hardware objects and composite objects that contain a
logical grouping of hardware and software.

a. In the Platform Types list on the left, select a platform type on which to filter
.

b. Click the Add button to add the platform type to the filtering criteria.
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c. Determine whether to include managed objects for this platform.

To include objects for this platform, click the Include button.

To exclude objects for this platform, click the Exclude button.

To remove a platform types filter, select the platform type in the list on the right,
then click the Remove button.

4. To filter managed objects based on the operating environment, select Operating
Systems.

a. In the Operating Systems list on the left, select an operating environment on
which to filter.

b. Click the Add button to add the operating environment to the filtering
criteria.

c. Determine whether to include managed objects for this operating
environment.

To include objects for this operating environment, click the Include button.

To exclude objects for this operating environment, click the Exclude button.

To remove an operating environment filter, select the operating environment in the
list on the right, then click the Remove button.

5. To filter managed objects based on the Sun Management Center modules that
reside on those objects, select Modules.

a. In the Modules list on the left, select a module on which to filter.

b. Click the Add button to add the module to the filtering criteria.

c. Determine whether to include managed objects for this module.

To include managed objects for this module, click the Include button.

To exclude managed objects for this module, click the Exclude button.

To remove a module filter, select the module in the list on the right, then click the
Remove button.

6. Click the OK button.

Your filters are applied. The New Discover Request window closes. The discovery
process starts.
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� To Schedule a Discover Objects Request

1. In the New Discover Request window, click the Schedule tab.

2. To define a schedule, select Schedule Discovery Request.

3. To set the request to run on a day other than today, provide a date in the Start
Date field.

You can edit the information in the Start Date field manually, or you can click a
date in the calendar to select the date.

4. Select an hour and minutes from the Start Time pop-up menus.

Hours are based on a 24–hour clock. For example, 16:30 is the same as 4:30 PM.

5. Choose how often the request should run from the pop-up menu next to Repeat
Interval.

Choosing a Repeat Interval enables you to automatically update the database
according to your defined schedule. For example, if your network environment
changes often, you might want to run your discover request on a weekly basis to
keep your database current.

6. To exit from the New Discover Request window, click the OK button.

The discover request is placed in a queue according to your defined schedule

� To Modify a Discover Objects Request
If you have previously created a periodic discover request, you can change the
parameters for that discover request through the Edit Discover Request window.

1. Choose Discover Objects from the Tools menu in the main console window.

The Discover Objects window is displayed.

2. Select the name of the discover request that you want to modify.

3. Click the Modify button.

The Edit Discover Request window is displayed. The top bar of the window
displays the ID of the request, and the Request Name field displays the name of the
request.

4. Select the Discover, Preferences, Filters, and Scheduling tabs and change
settings as needed.

Settings are the same as the settings that you created or changed when you defined
the discover request. For more information, see:

� “To Define and Initiate a Discover Objects Request” on page 79
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� “To Set Preferences for a Discover Objects Request” on page 83
� “To Limit a Discovery Process by Hardware, Software, or Object Names”

on page 84
� “To Schedule a Discover Objects Request” on page 86

5. To exit from the Edit Discover Request window and to accept any changes that
you made, click the OK button.

A dialog box appears, offering several choices for running the modified discover
request.

� To start the discover request and to run the request immediately, click the Yes
button.

� To schedule the discover request but not run the request immediately, click the
No button.

� To cancel the running of the discover request entirely, click the Cancel button.

� To Start, Stop, or Delete a Discover Objects Request
If you have previously created a discover request, you can start, stop, or delete the
request through the Discover Objects window.

1. Choose Discover Objects from the Tools menu in the main console window.

The Discover Objects window is displayed.

2. Select the name of the discover request that you want to start, stop, or delete.

3. Click the Start, Stop, or Delete button.

� To View the Discover Objects Log

1. In the Discover Objects window, select the name of the discover request whose
log you want to view.

2. Click the Log button.

The log file appears in a read-only window.

Tip – If the log file is longer than the visible part of the window, use the side scroll
bar to view the rest of the file.

3. If the request is running, click the Refresh button to update the log file view.
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4. To exit from the log file, click the Close button.
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CHAPTER 5

Managing Objects in Sun Management
Center

Note – This chapter provides an overview of the Java Console. Although some tasks
are described, most of the procedures used to manage and monitor your system are
described elsewhere in this document. For information about logging into the Java
Console, including logging in automatically by using a configuration file, see the
“Starting the Console” in Sun Management Center 3.6 Installation and Configuration
Guide.

The following topics are described in this chapter:

� “Overview of Main Console Window” on page 90
� “To Use the Menu Bar” on page 90
� “To Access a Pop-Up Menu” on page 91
� “To View a Tool Tip” on page 92
� “To Find a Managed Object” on page 92
� “To View a Different Administrative Domain” on page 93
� “Administrative Domain View” on page 93
� “To Navigate the Hierarchy View” on page 95
� “To Navigate the Topology View” on page 96
� “To Change the Topology Layout” on page 97
� “To Provide a Background Image for the Topology View” on page 98
� “To Remove the Background Image From the Topology View” on page 98
� “To Connect Objects in the Topology View” on page 99
� “To Remove a Connection Between Managed Objects” on page 99
� “Administrative Domain Status Summary” on page 100
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Overview of Main Console Window
The main console window is the primary user interface for Sun Management Center.
The window provides the following features:

� Visual representations of the managed objects, for example, hosts and networks
� Ability to manipulate attributes and the properties that are associated with the

managed objects, such as creating alarm threshold conditions

The features that are shown in the following figure are mentioned in this chapter.

FIGURE 5–1 Main Console Window

� To Use the Menu Bar
The menu bar at the top of the console window provides access to common Sun
Management Center features and tools. If a menu name or function appears dimmed,
that option is not available for you to use. This state might mean that you need to
select an appropriate managed object first.
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1. To access a menu, click the menu label.

The menu contents appear.

Tip – Once you have displayed a menu, you can scroll or use the right and left
arrow keys on your keyboard to move among the menus.

2. To choose a menu option, click the menu option label.

� To Access a Pop-Up Menu
Pop-up menus are available for all objects in the hierarchy and topology views. The
contents of a menu vary according to the capability of the selected object.

1. Press mouse button 3 (typically the right mouse button) on the object.

The pop-up menu is displayed.

2. To choose a menu item, click mouse button 1 (typically the left mouse button).

The following list describes the common items in the approximate order in which
the items are displayed in the pop-up menus. Some items are not displayed in all
menus.

Cut Cuts the selected object. The cut object is enclosed in a dashed
box until the object is pasted into a new location. To cancel the
cut operation, click the object.

Copy Copies the selected object.

Rename Displays the Rename Object window.

Modify Displays the Modify Object window.

Attribute Editor Displays the Attribute Editor. For more information, see
Chapter 10.

Load Module Displays the Load Module dialog box. For more information,
see “To Load a Module” on page 169.

Details Displays the Details window. For more information, see
Chapter 6.

Alarm Action Displays the Alarm Action window in which you can define
actions to take when an alarm occurs. For more information,
see Chapter 12.

Steps

Steps
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� To View a Tool Tip
As you move the mouse cursor over various areas in the main console window, tool
tips are displayed momentarily. A tool tip is a description of the selected object or a
description of a property and value column of any data property table. Data property
tables are described in Chapter 8. Property tables provide information about the
monitored property. These tables are described in Appendix C.

� To see a Tool Tip, place your mouse cursor over an object.

After a brief delay, a tool tip provides a short description of that object.

� To Find a Managed Object

1. From the main console window, click the Search icon or choose Search from the
Go menu.

The Search window appears.

2. To find a specific object name, type the managed object name to find in the
Object Label field.

You can provide a complete name or a partial name.

3. To find a managed object based on filtering criteria, click the button next to Filter
Name. Then, select a filter from the Filter Name menu.

You define a filter using the filtering mechanism in the Manage Jobs window. To
access the Manage Jobs window, select Manage Jobs from the Tools menu in the
main console window. For more information, see “Using Filters” on page 216.

4. Click the Search button.

A list of matching names is displayed in the Search Results section.

5. To see information about a managed object, select the name from the Search
Results list. Then, click the Go To button.

The topology view of the main console window changes to show information
about the selected object.

Step

Steps
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� To View a Different Administrative Domain

1. In the main console window, click the Sun Management Center Administrative
Domains button.

The current list of administrative domains appears.

2. Select the administrative domain that you want to view.

The main console window updates to show the selected administrative domain.
The Sun Management Center Administrative Domains button changes to display
the name of the administrative domain that you selected.

For more information about defining and working with administrative domains,
see Chapter 2.

Administrative Domain View
Once you have created an administrative domain and have populated it with objects,
you can see the administrative domain and its objects in the hierarchy (tree) view and
the topology (regional) view of this administrative domain.

The administrative domain view enables you to build collections of objects that
support your monitoring and management tasks. You can group your host sets by
buildings, subnets, or other group objects. You can view all objects in the
administrative domain, or view only selected objects, such as the servers that support
a specific function that interests you.

The administrative domain view shows you the objects that are contained in an
administrative domain. The objects are the administrative domain, and any groups
and hosts that are contained in the administrative domain.

The following figure illustrates an example of an administrative domain. In this
example, Payroll Servers 1 represents an administrative domain that consists of all the
host machines in the Payroll office. The host machines are found in two geographic
sites: Campus A and Campus B. Campus B has one building (Building B), which
contains two host machines, Payroll 1 and Payroll 2.

Steps

Chapter 5 • Managing Objects in Sun Management Center 93



FIGURE 5–2 Sample Administrative Domain

You can choose to create a similar type of administrative domain. For example, you
can group your machines by subnet, rather than by building. You should create an
administrative domain and its subordinate groups in a hierarchy that best supports
your monitoring activities.

For more information about administrative domains, see Chapter 2.

The main console window displays two views of an administrative domain and its
members. The left side of the administrative domain view is the hierarchy view. The
right side is the topology view.

� Hierarchy (tree) view

The hierarchy view displays the relationship between an administrative domain
and its members. Some objects in the hierarchy view contain other objects that can
be a group of objects or a single object.

In Figure 5–2, Building B is an object that is contained in the Headquarters
administrative domain, but is also a group. Building B contains the network
194.150.151.52, the subnet mpk12-238-n, GROUPA, and hosts machineA and
machineB.

For more information, see “Hierarchy View” on page 95.

� Topology view
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The topology view displays the members of an object selected in the hierarchical
tree.

For more information, see “Topology View” on page 96.

Hierarchy View
Two types of windows contain hierarchy views:

� Domain view in the main console window, as illustrated in Figure 5–1
� Browser view in the Details window, as illustrated in Figure 6–7

The administrative domain hierarchy view displays the administrative domain and its
members.

The Browser hierarchy view displays the host and its modules. This view is part of the
Browser Details window, which is described in Chapter 7.

Both the administrative domain hierarchy view and the Browser hierarchy view
behave in the same manner. In both windows, the hierarchy view is on the left side of
the window.

� To Navigate the Hierarchy View

1. To view details about a host, double-click the host icon in the main console
window.

� If the selected object is a host, the Details window appears.

� If the object contains other managed objects, the topology view displays the
members of the selected object.

2. To view the contents of a managed object, click the expansion icon to the left
of the object icon.

The icon looks like a handle. The icon changes to a darker color, and the
subordinate objects appear in the hierarchy view.

If an object has an expansion icon next to it, the object contains additional
information. You can obtain more information about the object by examining its
subordinate objects.

3. To view more information about a managed object, double-click the object icon.

Steps
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� If the managed object is a container icon, such as a domain or group object, and
is not expanded, the icon changes to a darker color. The hierarchy view and the
topology view expand to display the contents of the object.

� If the managed object is a container icon and is expanded, the hierarchy view
and the topology view compress so that the subordinate contents are removed.

� If the managed object is a lowest-level icon, for example, a host, the Details
window appears. This window provides more information about the managed
object. For more information, see Chapter 6.

4. To access the pop-up menu for an object, press mouse button 3 on the object
icon.

For more information about pop-up menus, see “To Access a Pop-Up Menu”
on page 91.

Topology View
The topology view displays the members of the object selected in the hierarchy view.
You can customize the topology view in the following ways:

� Change the way in which an object is displayed, as described in “To Change the
Topology Layout” on page 97. For example, you can view an object as a grid, a
network, or a ring.

� Connect objects together, as described in “To Connect Objects in the Topology
View” on page 99.

� Add a background picture or a map, as described in “To Provide a Background
Image for the Topology View” on page 98.

There are two types of windows that contain topology views:

� Domain view in the main console window, as illustrated in Figure 5–1
� Browser contents view in the Details window, as illustrated in Figure 6–7

Both the administrative domain and the browser contents views behave in the same
manner.

� To Navigate the Topology View

1. To view details about a host, click or double-click the host icon.

� If the selected object is a host, the Details window appears.

� If the object contains other managed objects, the topology view expands to
display the members of the selected object.

Steps
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2. To access the pop-up menu for an object, press mouse button 3 on the object
icon.

For more information about pop-up menus, see “To Access a Pop-Up Menu”
on page 91.

3. To select an object, click the object icon.

� To Change the Topology Layout
In the topology view, you can choose to view an object using one of several layout
types. For example, you can simply view the objects as a list, or you can view the
objects as a ring network.

1. To change the topology layout, choose Topology Layouts from the View menu in
the main console window.

A selection list appears.

2. Click the layout that you want to use.

You can choose one of the following layout types:

� Network (default) – Shows the objects arranged in one of the following ways:

� Across the window in the order in which the objects were discovered or
added to the database

� As arranged by the console user

� Grid – Shows the objects arranged in an organized grid in the order in which
the objects were discovered or were added to the database

� List – Shows the objects in a vertical list in the order in which the objects were
discovered or were added to the database

� Bus – Shows the objects linked together by a series of lines that mirror the view
of a network bus

� Star – Shows the objects in a star to indicate the parent object is a star network

� Spoked Ring – Shows the objects in a ring to indicate the parent object is a ring
network

The topology layout changes within a few seconds of when you select a type.

Steps
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� To Provide a Background Image for the Topology View
You can select background images to place your managed objects in the approximate
locations where the physical network components exist. This ability can be useful if
you have managed objects that are located in various states or countries. Once you
have set the backgrounds and placed the objects where they reside, if a problem
occurs, you would be able to respond more quickly because you know where the
managed object is.

1. To choose a background for the current topology view, choose Set Topology
Background from the View menu in the main console window.

The Set Topology Background window appears.

2. Click the name of the geographical location that you want to use.

Tip – Use the scroll bar at the right side of the window to move up and to move
down in the list.

3. Determine how many instances of the background image to display.

� To apply just a single instance of the background image, make sure that Tile
with this image is not selected.

� To apply multiple instances of the background image, make sure that Tile with
this image is selected.

4. To apply your changes and close the Set Topology Background window, click
Set.

� To Remove the Background Image From the Topology
View

1. To remove a background for the current topology view, choose Set Topology
Background from the View menu in the main console window.

The Set Topology Background window appears.

2. Click the Unset button.

The Set Topology Background window closes. The topology view is redrawn
without any topology background image.

Steps

Steps
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� To Connect Objects in the Topology View
To make the topology view of your network more realistic, you can create a
representation of the network connections between objects.

1. In the topology view, click the icon for the first managed object that you want to
connect.

A selection box appears around the selected object.

2. Press the Shift key, and click the icon for the second managed object that you
want to connect.

A selection box appears around the selected object. At this point, both objects
should have selection boxes.

3. To create the connection, choose Create Connection from the Edit menu in the
main console window.

The Create Connection window appears.

4. In the Create Connection window, click the type of network connection to use.

Values include the following types:

� General – Indicates either that you do not know the type of network connection
or that the connection does not fit any other category

� RS–232 – Indicates an RS-232 connection

� T1 – Indicates a T1 connection

� T3 – Indicates a T3 connection

5. Type a label for the connection.

For example, Print Client-Print Server.

6. (Optional) Type an additional description for the connection.

7. To create the connection and close the Create Connection window, click OK.

A line appears in the topology view, connecting the objects.

� To Remove a Connection Between Managed Objects

1. Click the line that indicates the connection in the topology view.

Caution – Make sure to click the connection line carefully. If you also select an
object, you might inadvertently remove that object.

Steps
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2. Choose Delete Object/Connection from the Edit menu in the main console
window.

The topology view updates.

Administrative Domain Status Summary
The administrative domain status summary displays the number of managed objects
that have unacknowledged open alarms, by level of severity, in the selected
Administrative Domain. An example is shown in Figure 5–3.

Note – If a host has multiple alarms at several different severity levels, the host is
represented at only the highest severity level for that host.

For more information about the administrative domain status summary, see “To View
Alarms From the Main Console Window” on page 184.

FIGURE 5–3 Domain Status Summary
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CHAPTER 6

Viewing Detailed Information About a
Managed Object

The Sun Management Center Details window provides detailed information about a
selected object. The following subjects are described in this chapter:

� “Overview of the Details Window” on page 101
� “To Start the Details Window” on page 115
� “Info Tab” on page 103
� “Module Browser Tab” on page 103
� “Alarms Tab” on page 104
� “Module Manager Tab” on page 104
� “View Logs Tab” on page 104
� “To View the System Log File Messages” on page 117
� “To Filter Your Log Request” on page 117
� “To Monitor Log Messages” on page 119
� “To Find a Log Message” on page 120
� “To View the Sun Management Center Log File Messages” on page 120
� “To Refresh Log Messages” on page 120
� “To View Other Log File Messages” on page 121
� “Applications Tab” on page 105
� “Hardware Tab” on page 108

Overview of the Details Window
The details view is a subset of the Domain view. The highest hierarchical object in a
details view is the host machine or module object. For more information about module
objects, see “To Create a Module Object” on page 66. Unlike the administrative
domain view, the details view enables you to see modules and the various monitored
properties and statistics contained in the modules.

The Details window displays several tabs. The commonly seen tabs are shown in Table
6–1.
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Click a tab to view the named information.

The tabs that appear in the Details window depend on the type of selected object. For
example, the Hardware tab appears only if the Config-Reader module is supported on
your system. For additional information about the tabs for your specific hardware
object, see your platform supplement.

TABLE 6–1 Common Details Window Tabs

Tab Description

Info Provides general information about the managed object including name,
IP address, polling type, and so on. This information is collected at the
time the object is created. Info is the default view if the managed object is
being monitored through SNMP or ICMP or if the object is in a
non-monitored status.

Module Browser Enables you to navigate through the hierarchy and contents views of the
hardware, operating system, local applications, and remote systems.
Module Browser is the default view if the managed object is being
monitored through a Sun Management Center agent.

The Module Browser is described in Chapter 7.

Alarms Displays alarm status messages and the alarm controls for the current host
or node. Enables you to acknowledge or delete alarms.

Alarms are described in Chapter 12.

Module Manager Displays available modules and identifies which modules are loaded,
scheduled, and enabled. Also indicates any modules that are
multi-instance modules. Enables you to load, enable, disable, and unload
modules.

View Logs Displays information from log files, including error messages, for your
host. Enables you to search, monitor, and examine system, Sun
Management Center, and other log messages.

Applications If Advanced System Monitoring add-on is installed, displays a list of
applications. These applications can include the processes that are running
on the host, other installed applications, and hardware information.
Process information appears only if the Solaris Process Details module is
loaded. Hardware information appears only if the Hardware Diagnostics
Suite software is enabled. For more information about the Hardware
Diagnostic Suite, view its online help.

Hardware Displays hardware configuration information about your host for selected
hardware platforms. Configuration information might include the physical
and logical view of your host. This tab appears only if the hardware
platform is supported by the Config-Reader module.
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Info Tab
The Info tab shows the properties table for the current managed object. The properties
table is the only information that is available from the Details window for objects that
are monitored through SNMP or ICMP. The general properties are listed in the
following table.

TABLE 6–2 General Properties in the Info Tab of the Details Window

Property Description

Entity Desc Label you selected when you created the node.

Entity Full Desc Optional description that you entered when you created the node.

Hostname Machine name 1

IP Address IP address 2

Netmask Netmask associated with the host

Operating System Operating system type and version

Entity Family Hardware architecture

Entity Trap
Destination

Host IP address of Sun Management Center server that receives this host’s
trap information

Entity Event
Destination

Host IP address of Sun Management Center server that receives this host’s
events information

Entity Polling
Type

Agent or SNMP

Target Hostname Host name of the target

Target IP Address IP address of the target

Agent Version The version number for the agent software, or 0.0 if polling type is SNMP

Time zone The time zone in which the managed object resides
1 The host name in this property table does not change if you change the host name on the host device. To update the

information, either modify the host object, or delete the existing host object and re-create the object with the new
name. See “To Modify an Object” on page 73.

2 When a Sun Management Center entity is added to the topology, the Topology Agent queries the entity for its
configured IP address and port for the Trap Handler and Event Manager components. However, the information
stored in the topology will be incorrect if the entity is ever reconfigured to correct a misconfiguration or to change
the entity server-context. If the information that is shown here for the Trap Handler and Event Manager is
compared with the expected configuration of the entity and does not match, remove the entity from the topology
and re-enter it.

Module Browser Tab
The Module Browser tab displays the hierarchy and contents views for managed
objects that are monitored through Sun Management Center agents. These objects
represent hardware, operating system, local applications, and remote systems.
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See Chapter 7 for detailed information about using the Module Browser tab.

Alarms Tab
The Alarms Details window displays the alarms for the host. For detailed information
about using the Sun Management Center Alarm Manager, see Chapter 12.

Module Manager Tab
The Module Manager tab displays the loaded modules. This tab also lists those
modules that are available to your system but are not currently loaded or scheduled to
be loaded. You can perform the following tasks:

� Unload a module
� Load a module
� Edit module parameters
� Enable a module
� Disable a module
� Display module rules
� Schedule a module for loading at a later time

For detailed information about using the Module Manager tab, see Chapter 11.

View Logs Tab
The View Logs tab enables you to view several types of messages:

� System log messages stored in the /var/adm directory
� Sun Management Center error messages
� Other messages

By default, only the system log messages in /var/adm are displayed. File names for
these system log messages start with the word messages.

If you select the Sun Management Center Log option on the Log File menu, a list of
log file choices is displayed.

The View Logs window has two scrollable panes: Messages For and Monitored
Messages.

� The Messages For area contains the filtered messages that you select using the
Filter button. You can locate specific messages in this area by using the Find
Message feature.

� The Monitored Messages area contains the messages that you select using the
Monitor button. New messages in this field are highlighted.
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Note – If no messages match the Filter criteria, the following message appears at the
bottom of the View Logs window.

No matches found for this log file

Applications Tab
The Applications tab enables you to view and select detailed information about
processes running on the selected host or node. If you have any custom or third-party
applications installed, this tab also enables you to view detailed information about
processes running in the selected applications. The displays are continually updated.

View Processes
The View Processes application in Figure 6–1 enables you to view and select detailed
information about processes running on the selected host or node.

The Solaris Process Details module must be loaded to use the Process Viewer. For
instructions, see “To Load a Module” on page 169. If the Solaris Process Details
module is not loaded when you click the Applications tab, you must do the following:

1. Close the Details window.
2. Load the Solaris Process Details module.
3. Reopen the Details window.
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FIGURE 6–1 Process Viewer

The following table lists the properties that are available in the Process Viewer.

TABLE 6–3 Process Viewer Properties

Property Description

PID Process Identifier

PPID Process ID of the parent process

UID Effective user ID number

User Effective user login name

EUser Effective user ID

Group ID Group ID of the user
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TABLE 6–3 Process Viewer Properties (Continued)
Property Description

EGroup Effective group ID of the user

Session ID Process ID of the session leader

PGroup Process ID of the process group leader

Tty Terminal that controls the process. A question mark (?) is printed when
there is no controlling terminal.

Start time Time that the process started, in hours, minutes, and seconds. The start
time for a process that is more than 24 hours old is given in months and
days.

Time Cumulative execution time for the process

State State of the process

Wait Channel Address of an event for which the process is sleeping. If blank, the process
is running.

Class Scheduling class of the process

Address Memory address of the process

Size Size in pages in main memory for the image of the swappable process

Priority Priority of the process

Nice Decimal value of the system scheduling priority of the process

CPU% Ratio of CPU time used recently to CPU time that was available in the
same period, expressed as a percentage

Memory% Ratio of the process’s resident set size to the physical memory on the
machine, expressed as a percentage

Command Command name

CommandLine Full command name and its arguments, up to a limit of 80 characters

Process Statistics Window

The Output For Process ID window displays the statistics for either pmap, pstack,
pfiles, or pldd for any highlighted process in the Process View window.

pmap Prints the address space map of each process

pstack Prints a stack trace for each lightweight process (lwp) in each process

pfiles Reports fstat and fcntl information for all open files in each process

pldd Prints dynamic libraries for the process
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Process Summary Field

The Process Summary field lists statistics for all processes, active or inactive.

Custom or Third-Party Applications

Note – To develop custom applications, you need the Sun Management Center
Developer Environment and documentation. See your Sun authorized sales
representative for more information.

If you have any custom or third-party applications installed on your system, they are
listed below Applications - View Processes in the left side of the Applications Details
window. Select the application if you do not want to view process detail information
for a host or node.

After you select an application, the selected properties for the application are
displayed in the right side of the Applications Details window. The properties that are
shown depend on the application that is selected.

Hardware Tab

Note – The Hardware tab does not appear if this feature is not supported on your
system.

The Hardware Details window, which is shown in Figure 6–2, provides three choices
for system information:

� Hardware Summary
� Physical View
� Logical View

Note – For additional information about the Hardware tab for your specific hardware
object, see your platform supplement.
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FIGURE 6–2 Hardware Details Window

The Views menu provides access to the available hardware information.

Hardware Summary
The Sun Management Center software displays a table of hardware resources of the
selected host. The following list shows some typical values displayed in the Hardware
Summary.

Total Disks Total number of disks that are connected to the host

Total Memory Total amount of memory that is connected to the host

Total Processors Total number of processors that are connected to the host

Total Tape Devices Total number of tape devices that are connected to the host

Your summary might appear different. The resources vary, depending on the type of
object that is displayed in the detail view.

Note – The Total Disks field displays the number of internal disks only. This number
does not include the disks that are part of enclosures.
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Physical View
When you select the Physical view - system option, the software displays a
photo-realistic picture of the selected host, if available. Pictures are not available for
some system types.

Note – This feature is usable only if the host is monitored by a Sun Management
Center agent.

As you move the mouse pointer over the picture of the system being viewed, some of
the components are highlighted. The detailed component information displays in the
right section of the viewing window. The path name of the component is displayed in
the Component field at the bottom of the window.

If a component has an alarm, a colored line appears around the component to indicate
the alarm severity. This line enables you to identify quickly the faulty component.

FIGURE 6–3 Hardware Configuration Physical View With Component Details
(Property/Value View)
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Rotate Current View Menu

For some systems, you can select alternate front, rear, and side views through the
Rotate Current View pull-down menu. Pictures are not available for some system
types.

For some systems, pictures of components such as CPU boards and I/O boards might
also be available. As you move the mouse pointer over the system picture, the pointer
changes from an arrow to a hand icon when there is an individual component picture.

Click a highlighted component to display the detailed picture of the component. When
you are finished viewing component details, click Up to return to the parent system
view.

Physical View When a Sun StorEdge Device is Connected

If a Sun StorEdge™ A5000, A5100, A5200, or T3 system is connected to the selected
component, the Views pull-down menu lists the devices that are connected. The
connected devices are listed under the system to which they are connected. The Sun
StorEdge A5000-series devices are displayed on this menu as sena(0), sena(1), and
so on.

You can select and view any of these storage devices from the Views menu.

History Menu

Use the History pull-down menu to revisit a view that you had selected previously.

Refresh Details Button

Click the Refresh Details button to update the Property/Value information in the right
side of the Details window for the selected physical component. Otherwise, the
information does not change from when you first opened the physical view.

Dynamic Reconfiguration Button

The Dynamic Reconfiguration button appears in the physical view and in the logical
view only for certain platforms. Refer to your hardware supplement for more
information.
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Logical View
The software displays a logical view configuration of a host, if the host is monitored
by a Sun Management Center agent, as illustrated in the following figure. Logical
views are not available for ping hosts.

FIGURE 6–4 Hardware Configuration Logical View

Search Button

Click the Search button to display the Search window. Use the Search window to
search for components in the Logical View topology on the left side of the viewing
window. The located component is highlighted in the topology view. The name of the
component displays in the Component field in the bottom right section of the screen.
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The Search function is case-sensitive. If the search does not locate the component in
your system, the following error message appears at the bottom of the Details
window.

Node not found

The Search function stops at the first instance found. For example, if you enter the
word board, Search always stops at board(0). To find the next hit, click the Next
button. To find a specific instance of a name, type a more complete name. For example,
board(2).

Expand All

Click the Expand All/Recover Default button to decompress and recompress all the
component icons in the topology area (left side) of the window. The compressed view
is shown in the following figure.

FIGURE 6–5 Compressed Topology of Components in Logical View

Press the Expand All button to display the expanded topology view, as shown in the
following figure.

Chapter 6 • Viewing Detailed Information About a Managed Object 113



FIGURE 6–6 Expanded Topology of Components in Logical View

The button label toggles to Recover Default. When you press Recover Default, the
topology recompresses all the component icons in the topology area of the window.

Refresh Details and Dynamic Reconfiguration

The Refresh Details and Dynamic Reconfiguration features in the Logical View are the
same as the features described for the Physical View in “Refresh Details Button”
on page 111 and “Dynamic Reconfiguration Button” on page 111.
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Navigating the Details Window
Some tabs can display many levels of detail. Double-click icons in the Details window
to see additional levels of information. A category can have many subcategories.

If information in a table cell is too long to display completely, hold the mouse pointer
in the cell for several seconds. The complete text that is contained in that cell appears
in a pop-up window.

To expand or compress the hierarchy, use the expansion icon.The hierarchy is
compressed when the icon “handle” is pointing right. The hierarchy is expanded
when the icon “handle” is pointing down.

� To Start the Details Window

1. Start the Details window in either of the following ways:

� Double-click an object icon in either the hierarchy view or the topology view.

� Press mouse button 3 on an object icon, and choose Details from the pop-up
menu.

Tip – Be sure to select an object, not an administrative domain. The Details window
is not available for administrative domains.

The Details window appears, as illustrated in the following figure.

Steps
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FIGURE 6–7 Details Window for a Selected Object

2. Click a tab to view detailed information for that category.

Viewing Log Files
You can view log files or portions of log files. You can also monitor log messages as
the messages are added to the log files.
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� To View the System Log File Messages

1. In the Details window, click the View Logs tab.

2. Choose System Log from the Log File menu.

3. Click the Log File field, and select Syslog.

The System Log messages are displayed.

To refresh the display and view any new messages, click Reload.

� To Filter Your Log Request
You can apply a filter to display only those messages that match the date range and
text pattern that you specify. In addition, you can limit the size of the search by
specifying the maximum number of matches to report.

1. With the View Logs tab selected in the Details window, click the Filter button.

The Message Filter Options dialog box is displayed, as shown in the following
figure.

Steps

Steps
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FIGURE 6–8 Message Filter Options Dialog Box

2. Select the start date for the first log message that you want to view.

3. Select the start time for the first log message that you want to view.

4. Select the end date for the last log message that you want to view.

5. Select the end time for the last log message that you want to view.

6. Type the text pattern to be matched in the Text Pattern to Match field.

Use a text pattern that is unique to the type of message in which you are interested.

7. Select Forward or Backward to specify the direction of the message search
through the log file.

To begin searching from the end of the log file, select Backward. To search from the
beginning, select Forward.
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8. (Optional) Type the maximum number of log messages that should be matched
in the Maximum matches to report field.

If you enter zero (0), all matching messages are reported, up to a maximum of 100
messages.

9. To filter and reload your log messages and close this window, click the OK
button.

� To Monitor Log Messages
Monitoring enables you to view new log messages as the messages occur. Each new
message that arrives is highlighted.

1. Click the Monitor button on the View Logs screen.

The Monitor Filter Options dialog box is displayed, as shown in the following
figure.

FIGURE 6–9 Monitor Filter Messages Dialog Box

2. Select Enable Log File Monitoring to enable log file monitoring.

3. To display only currently monitored log messages, select Clear Old Monitored
Messages.

4. Type the text pattern to be matched in the Text Pattern to Match field.

You can use a UNIX regular expression. For information about regular expressions,
refer to the regex(1F) man page.

Use a text pattern that is unique to the type of message in which you are interested.

Steps
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5. To monitor your log messages and close this window, click the OK button.

� To Find a Log Message
You can search for a specific character sequence within a set of messages after the set
has been loaded and displayed in the Messages For area.

1. Click the View Logs tab in the Details window.

2. Type the specific character sequence that you want to find in the Find field.

Note – Wildcard searches using an asterisk (*) character, are not supported in the
View Logs find feature. To search for a message that contains the asterisk character,
precede the character with a backslash (\), for example, \*.

3. Press Return to search the log messages for that sequence.

The first matching message is highlighted.

4. Click the down arrow or up arrow to continue your search and find additional
occurrences of the matching sequence.

� To View the Sun Management Center Log File Messages

1. With the View Logs tab selected in the Details window, choose Sun
Management Center Log from the Log File menu.

A list of log files displays as a submenu.

2. Select the Sun Management Center log file that you want to view.

The messages for the selected log file are displayed.

3. To apply filters to the information, click the Filter button. Then, provide the filter
parameters in the Message Filter Options dialog box.

The information is displayed using the filter that you selected.

� To Refresh Log Messages

� To refresh and reload the currently filtered set of log messages, click the Reload
button.

Steps

Steps
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� To View Other Log File Messages

1. With the View Logs tab selected in the Details window, choose Other Log from
the Log File menu.

Note – The Other Log option is available only if the Logview ACL module (Local
Applications) is loaded.

2. To filter the log information, click the Filter button. Then, provide the filter
parameters in the Message Filter Options dialog box.

The information is displayed using the filter that you selected.

Viewing Application and Process Information
You can view information about an application. You can also view information about a
specific process, such as the amount of memory or CPU currently in use.

Note – The Solaris Process Details module must be loaded to view process information.
For instructions, see “To Load a Module” on page 169.

� To View Information About a Specific Application

1. From the Details window, click the Applications tab.

The Applications panel appears showing a list of available applications. By default,
if the Solaris Process Details module is loaded:

� The View Processes application is selected in the left side of the window.
� Process information appears in the right side of the window.

2. To view information about another application, click on the application name in
the list on the left side of the window.

For example, you could view information about the Hardware Diagnostic Suite.
The right side of the window is updated with the selected application.

Steps
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� To Display Additional Properties in the Process Table
By default, the View Process table displays the following information:

� Process identifier (PID)
� User that is running the process
� Amount of CPU used for the process
� Amount of memory that is used for the process
� Command line for the process

To add additional information to the table, follow these steps:

1. In the Details window, click the Applications tab.

If the Solaris Process Details module is loaded, the View Process table appears.

2. Click the View Columns button above the Process table to see a list of available
process properties.

A check mark appears next to columns that currently are in the table.

3. To add information about a property to the table, select the property that you
want to add.

The selected property appears in a new column to the right of the existing columns
in the table.

4. To add more properties to the table, repeat the preceding steps.

Tip – To view all process properties, select the All button at the bottom of the View
Columns list.

� To Sort Columns in the Process Table
You can sort the processes (rows) by the properties (column headers) in ascending or
descending order. For example, you can sort the CPU% column starting with either
the smallest or the largest value first.

1. To sort columns in ascending order, click the property in the table column
header.

The processes (rows) are updated in ascending order for that property.

2. To sort columns in descending order, click the property in the table column
header while holding down the Shift key.

The processes (rows) are updated in descending order for that property.

Steps

Steps
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� To Reorder Columns in the Process Table
You can rearrange the order of columns.

1. To select a column, press mouse button 1 on a column header.

2. To move the column, drag the column header to the desired position and release
the mouse button.

Viewing Hardware Information

Note – If you load or unload the Config-Reader or Dynamic Reconfiguration modules
while the Details window is open, you must close and reopen the Details window to
see the results.

� To View a Hardware Configuration

1. In the Details window, click the Hardware tab.

The Hardware panel appears and displays a summary of hardware information.

2. Select the configuration in which you are interested.

The window is updated, and the selected feature is displayed.

� To Reconfigure the System

1. Open the Details window for the selected system.

2. Select the Module Manager tab in the Details window, and verify that the
Dynamic Reconfiguration (dr) module is loaded.

Load the module if necessary. For information about loading modules, see “To
Load a Module” on page 169.

3. Select the Hardware tab in the Details window.

4. From the Views Menu, choose “system” in either the Physical View or the
Logical View category.

The view changes, and a Reconfiguration button appears at top of the display.

Steps
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5. Click the Reconfiguration button.

� If the Reconfiguration module is not loaded, a pop-up window displays an
error message.

� If the Reconfiguration module is loaded, the Dynamic Reconfiguration pop-up
window appears.

6. Select a board slot or memory bank.

Dynamic Reconfiguration buttons are not available for operations that are not
permitted for the selected board or memory and appear dimmed.

7. Click the desired function button for the selected memory or board.

Function Action

Configure Adds the selected board or memory to the system configuration. Turns
on power to the board, if the board was not previously in the
Connected state.

Unconfigure Removes the selected board or memory from the system configuration.
Electrical power to the board is maintained.

Connect Turns on electrical power to the board. Basic tests of the board are run,
but the board is not automatically added to the system configuration.

Note – The Configure function includes this function.

Disconnect Turns off power to the board. The board is ready to remove when the
yellow Service LED is lit, and the Power and Cycling LEDs are off.

Test Memory Tests the selected memory.

Note – Memory tests can be time-consuming. These tests might last an
hour or longer for large-capacity DIMMs.
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CHAPTER 7

Browsing Information About a
Managed Object

This chapter describes the following topics:

� “Overview of Module Browser Tab” on page 125
� “To Apply the Alarms Filter to All Tables” on page 130
� “To Set Security for a Host or Module” on page 131

Overview of Module Browser Tab
When you open the Details view for a host managed object, the Module Browser tab is
selected. The Module Browser tab shows the hierarchy and contents view for a host.
These views provide additional information about the host hardware, operating
system, local applications, and remote systems.

Tip – To see alarm status information for a node, hold the mouse pointer over the
object in the right side of the screen for several seconds. A tool tip shows alarm status
information about the object. Tool tips are also displayed for data property table cells
and are useful if information in a table cell is too long to display completely.

You can expand or compress the hierarchy view by using the expansion icon. The
hierarchy is compressed when the “handle” is pointing right. The hierarchy is
expanded when the “handle” is pointing down.

Sun Management Center software uses modules to monitor hosts. Modules are
software components that monitor data pertaining to the health indicators and
resources of systems, applications, and network devices. The information that the
Module Browser tab provides depends on the modules that are loaded for that host.
The Sun Management Center modules belong to one of the four categories that are
shown in the Module Browser tab view. For more information about modules, see
Appendix C.
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Note – Depending on how your system is configured, you might not have access to all
of the modules described in this section.

Figure 7–1 is an example of the host view. The left side of the host view is the
hierarchy (tree) view and the right side is the contents view. The host hierarchy view
displays the relationship between the host and its modules. In this example, the
loaded operating system modules are the MIB-II System (Simple) and the Kernel
Reader (Simple) modules.

Through the Browser Details window, you can set alarm thresholds and view and
graph monitored data properties for your host.

FIGURE 7–1 Browser Details Window
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Hardware Monitoring
Depending on the modules that are loaded on the system, you can monitor the
following information about the hardware environment of the host:

� Config-Reader module

The Config-Reader module monitors the host configuration. This configuration
includes information and status for power supplies, key switch, fans, remote
console, the system in general, and so on. There are different Config-Reader
modules for different hardware platforms. If your system is supported by a
Config-Reader module, that module is loaded automatically during installation.
For more information about the Config-Reader module for your hardware
platform, refer to your platform supplement and Appendix C.

� Sun StorEdge A5x00 system

� Sun StorEdge T3 system

For more information about specific hardware features, see the platform supplement
for your system.

Operating System Monitoring
Depending on the modules that are loaded on the system, you can monitor the
following information about the operating environment of the host:

� Directory Size Monitoring
� File Monitoring
� Kernel Reader (Simple)
� Kernel Reader
� MIB-II Instrumentation
� NFS File Systems
� NFS Statistics
� Simple MIB-II
� Solaris Process Details

Local Applications Monitoring
Depending on the modules that are loaded on the system, you can monitor the
following information about the local applications on the host:

� Agent Statistics
� Data Logging Registry
� Dynamic Reconfiguration
� File Scanning
� Health Monitor
� Print Spooler
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� Process Monitoring

Remote Systems Monitoring
Depending on the modules that are loaded on the system, you can monitor the
following information about the remote systems that the host recognizes:

� MIB-II Proxy Monitoring module
� HP JetDirect module, which monitors HP printers equipped with a JetDirect card

Browser Icons
The Browser Details window includes a row of icons at the top of the panel. These
icons provide access to additional functions.

Module Icon
Click the module icon to see a list of module-related functions:

� Load Module adds a module to the host. If a host is not selected, this option is
unavailable and is dimmed. For more information, see “To Load a Module”
on page 169.

� Edit Module enables you to change module parameters. If a module is not selected,
this option is unavailable and is dimmed. For more information, see “To Modify
Module Parameters” on page 176.

� Enable Module enables a module. If a module is not selected, this option is
unavailable and is dimmed. For more information, see “To Enable a Module”
on page 172.

� Disable Module disables a module. If a module is not selected, this option is
unavailable and is dimmed. For more information, see “To Disable a Module”
on page 173.

� Unload Module unloads a module from the host. If a module is not selected, this
option is unavailable and is dimmed. For more information, see “To Unload a
Module” on page 173.

Options Icon
Click the options icon to view a list of the following functions:

� Copy enables you to copy a module. You can paste the copied module in the
topology or hierarchy view of the main console. The copy function enables you to
monitor the module properties without having the Details window open. For more
information, see “To Create a Module Object” on page 66.
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� Copy to Dataview Clipboard enables you to copy a data property to a clipboard,
and then paste into a dataview window.

� Create Dataview opens an automatically populated dataview window.

� Copy To Graph Clipboard enables you to add another data property with the same
units to an existing graph. This function is used with Add From Graph Clipboard
menu item in graphing window. See “To Create a Graph of Two or More Data
Properties” on page 145.

� Alarms Filter Enabled enables you to apply global filters to alarms on the Details
window Alarms tab. See Chapter 12 for more information.

� Add Row adds a row to a data property table. See “To Add a Row to a Data
Property Table” on page 139.

� Edit Row enables you to edit information for a row in a data property table.

� Disable Row disables a row in a data property table.

� Delete Row deletes a row in a data property table.

Attributes Icon
Click the attributes icon to display the Attribute Editor for the selected object. The
Attribute Editor provides additional information about the selected object and about
the rules that govern its behavior. Use the Attribute Editor to edit information about
the object. For more information about the Attribute Editor, see Chapter 10.

Set Property Value Icon
Click the set property value icon to add property values to a multi-instance task.

Graph Icon
Click the graph icon to create a graph of the selected monitored data property. For
more information, see Chapter 9.

Probe Icon
Click the probe icon to run selected commands on the monitored data property.

Refresh Icon
Click the refresh icon to update the information in the displayed data property table.
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Note – When the command is not appropriate for the selected object, the icons are
unavailable and are dimmed.

Alarms Filter
You can use alarm states to filter tables. For example, you can choose to see only rows
that are in a critical (red) state. These filter settings apply only to the current Module
Browser tab in the current session. The settings do not persist across sessions.

The default state for the Alarms filter is that all options are selected, and Alarms Filter
Enabled is set to On.

� To Apply the Alarms Filter to All Tables

1. In the Details window, click the Module Browser tab.

2. From the Options menu, choose Alarms Filter Enabled.

A selected check box indicates that filters apply to all tables. A blank check box
indicates that filters apply only to the specific table for which the alarm filter is
defined.

Host Security
In the Details window, Sun Management Center software offers security at two levels:
the host and the module. You might set security at the host level only. In this case,
anyone with the appropriate security can load modules, set alarm thresholds,
acknowledge alarms, and so on.

You might also set security permissions at the module level. In this case, only those
users with the appropriate module permissions can perform actions on the module.
Module security can be used as a subset of host security.

For example, at the host level, you can set security permissions so that users A, B, and
C can load modules and create alarm thresholds. User A loads the Health Monitor
module and creates customized alarm thresholds. However, users B and C can change
user A’s work unless security permissions have also been set at the Health Monitor
module level, enabling only user A to set alarm thresholds for that module.

Steps
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Note – When security is set at both levels, the security permissions at the module level
take precedence over the security permissions at the host level.

For more information about security, see Chapter 18.

� To Set Security for a Host or Module

1. Open the Attribute Editor for a host or module in either of the following ways:

� Press mouse button 3 on the host or module and choose Attribute Editor from
the pop-up menu.

� Click the Attributes button.

2. Click the Security tab.

3. Type the names of user and administrator groups in the appropriate fields.

For more information about the security fields, see Chapter 18.

4. To accept your security settings and close the window, click the OK button.

Steps
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CHAPTER 8

Monitoring Data Properties

The Sun Management Center product enables you to monitor specific data properties
for your managed objects. You can view these properties in tabular format or in
graphical format. This chapter describes how to use tables to monitor data properties.
The chapter includes the following information:

� “Data Property Concepts” on page 133
� “To Display a Data Property” on page 136
� “To Refresh Displayed Data” on page 137
� “To Select a Row” on page 137
� “To Select Multiple Contiguous Rows” on page 138
� “To Select Multiple Row Ranges” on page 138
� “To Monitor Directory Size” on page 138
� “To Add a Row to a Data Property Table” on page 139
� “To Add a Printer to Be Monitored” on page 140
� “To Probe a Property” on page 142

For information about how use graphs to view data properties, see Chapter 9.

Data Property Concepts
Use the Details window to view the current values for specific data properties, such as
the amount of memory being used on a host. You navigate through the hierarchy (tree)
view to find the appropriate data property. The lowest-level object in the host
hierarchy is the monitored property. By default, information about a monitored data
property is displayed in table form. For information about viewing that information in
a graph, see Chapter 9.

Once the data has been displayed, you can refresh the view. In addition, you can
simultaneously graph up to five data properties. These actions are described in the
following sections.
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Standard Table Features
Sun Management Center property tables use a standard format to display information.
The format includes the following elements:

� A property table label
� Column headings
� Individual table cells organized into rows and columns

Editable and Noneditable Cells
Sun Management Center tables contain two types of cells: editable and noneditable.

� Information in an editable cell can be changed. This type of cell has a white
background with black text.

If you edit information in the cell and you provide an invalid value, an error
window appears. Click OK to close the error window. Then, re-enter an
appropriate value in the table cell.

� Information in a noneditable cell is display-only. This type of cell has a colored
background with black text. The default background color for noneditable cells is
light gray.

Cell Editors
Editable cells have one of the following types of cell editors:

� Text Cell Editor

The text cell editor is invoked if the cell is a string type. Once the cell is selected,
the text cursor is activated at the end of the text string. If there is no text, the cursor
is aligned left in the cell. To save the information in the cell, press Return.

� Check Box Cell Editor

A check box is a component with only two choices:

� On
� Off

� Combo Box Cell Editor

The combo box cell editor has a drop-down menu that displays an associated list of
options. The current choice appears in the combo box. As you move the cursor
over the list, each option is highlighted. The option that you choose from the list
replaces the current selection.

134 Sun Management Center 3.6 User’s Guide • December 2005



Modules That Enable You to Manipulate Rows
For selected modules, the software enables you to add, delete, enable, or disable rows
for the data property tables. When these modules are initially loaded, the data
property tables are empty, except the Directory Size Monitoring and Print Spooler
modules. For the File Monitoring, File Scanning, and Directory Size Monitoring
modules, you must add a row to monitor the data property. The following table lists
the modules that allow you to add rows.

TABLE 8–1 Sun Management Center Modules to Which You Can Add Rows

Module Name Description

Directory Size
Monitoring

Enables you to define another directory for monitoring

File Monitoring Defines the file to be monitored

File Scanning Defines the pattern that must be matched within the monitored file

Print Spooler Enables you to define another printer for spooler monitoring

Process
Monitoring

Defines the pattern that must be matched from all the processes that are
running on the agent object

For more information about the directory size monitoring, file monitoring, file
scanning, print spooler, and process monitoring modules, see Appendix C.

Row Context Menu
The row context menu provides access to various row-related functions, such as
enabling you to add rows to a table that allows this behavior. To activate a row context
menu, press mouse button 3 in the appropriate row.

Table Sorting
Information in tables can be sorted by column. If a column header has a triangle that
points up or down, you can change the order of the table display based on that
column. Depending on the data in the column, the sort uses one of the following keys:

� Alphabetical string
� Numeric
� Date

To change between an ascending and descending sort, double-click the header of the
sorted column.
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Working With Large Data Property Tables
In large data property tables, you can see only one page of rows at a time. To navigate
through additional pages of the table, use the icons that are displayed above the table.

The icons enable you to navigate as follows:

� Return to the first page
� Return to the previous page
� Go to the next page
� Go to the final page

In addition, a pull-down menu to the right of these icons enables you to go to a
specific page.

Probing Properties
On selected module properties, the software enables you to use predetermined UNIX
commands including list files, the vmstat command, and so on. The Probe button is
available only for selected properties. Otherwise, the button is unavailable and is
dimmed.

Note – The available Probe commands can sometimes be difficult to distinguish. As an
example, consider the Filesystem Usage properties in the Kernel Reader module. The
Find All Recent Files probe commands find only files that were created or modified
less than 24 hours ago. The Find All Files probe commands find all files regardless of
the date and time that the files were created or modified. For more information about
the Filesystem Usage properties, see “File System Usage Table” on page 386.

Working With Data Property Tables
This section describes how to display and manipulate data property tables.

� To Display a Data Property

Note – The following example uses the Kernel Reader module.
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1. In the Browser Details window, double-click the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and topology
views.

2. Double-click the Kernel Reader icon in the topology view, or click the expansion
icon next to the Kernel Reader icon in the hierarchy view.

The Kernel Reader statistics are displayed.

3. Double-click the System Load Statistics icon in either the hierarchy or the
topology view.

The monitored properties are displayed in a property table.

� To Refresh Displayed Data

� To refresh displayed data, use either of the following methods:

� Press mouse button 3 in the data property table row and choose Refresh from
the pop-up menu.

� Click the Refresh Now button.

The current table is updated with the latest information.

Note – You can also set up a refresh interval that tells the Sun Management Center
software to update your monitored data at your designated time interval. For
information about accomplishing this task, see “To Set a Refresh Interval” on page
158.

� To Select a Row

� Press mouse button 1 in the first cell of the row that you want to select.

When you select a row, the anchor cell has the focus.

The color of the cells in a row is determined by whether the cell is editable or
noneditable. The maximum number of rows that can appear on one page in a table
is 20.

Steps

Step

Step
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� To Select Multiple Contiguous Rows

1. Click in the first target row to highlight the entire row.

2. Select additional rows in one of the following ways:

� Drag to the last row that you want to select and release the mouse button.
� Move your cursor to the last row that you want to select, press the Shift key and

click again.

All rows between the last and first anchor points are selected.

� To Select Multiple Row Ranges

1. Select the first range of a single or contiguous group of rows by completing the
procedure “To Select Multiple Contiguous Rows” on page 138.

2. Place the cursor in a row and press the Control key.

This step adds a new row to the selection.

3. To extend the range of selected rows, press the Shift key.

This step extends the range from the row that you selected with the Control key in
the previous step.

Example Procedures
The following procedures provide examples of typical data property tasks.

� To Monitor Directory Size
The following example procedure uses the Directory Size Monitoring module. This
module enables you to monitor the size and size change rate of a directory and its
subdirectories. If this module is not loaded, see “To Load a Module” on page 169.

1. In the Browser Details window, double-click the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and topology
views.

Steps

Steps

Steps
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2. Double-click the Directory Size Monitoring icon in the topology view, or click
the expansion icon next to the Directory Size Monitoring icon in the hierarchy
view.

The Directory Size Monitoring Status folder is displayed.

3. Double-click the Directory Size Monitoring Status folder in either the hierarchy
or the topology view.

The Directory Monitoring property table is displayed.

4. Add a row to the table in one of the following ways:

� Press mouse button 1 in a table row or column header, and choose New Row
from the pop-up menu.

� Select the table. Then choose New Row from the Options icon menu.

The Row Adder window is displayed.

5. Type the appropriate information in the text fields.

a. In the Instance field, type a name that uniquely identifies this instance of the
Directory Size Monitoring module.

b. In the Directory field, type the complete path to the directory that you want to
monitor.

6. To add the row to the table and close the Row Adder window, click the OK
button.

The added row is displayed in the topology view.

� To Add a Row to a Data Property Table

Note – You can use the steps in this procedure to add a row to the Directory Size
Monitoring, File Monitoring, File Scanning, and Process Monitoring modules.

The following example procedure uses the File Monitoring module which enables you
to monitor a file’s size, modification date, and rate of growth. If this module is not
loaded, see “To Load a Module” on page 169.

1. In the Browser Details window, double-click the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and topology
views.

Steps
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2. Double-click the File Monitoring icon in the topology view, or click the
expansion icon next to the File Monitoring icon in the hierarchy view.

The File Monitoring Status folder is displayed.

3. Double-click the File Monitoring Status folder in either the hierarchy or the
topology view.

An empty property table is displayed.

4. Add a row to the table in either of the following ways:

� Press mouse button 3 in a table row or column header, and choose New Row
from the pop-up menu.

� Select the table. Then choose New Row from the Options icon menu.

The Row Adder window is displayed.

5. Type the appropriate information in the text fields.

Note – This example shows the fields for the File Monitoring module. Fields differ
depending on the module that you are modifying.

� Name is a unique name for this instance of the File Monitoring module.

The name should be a single word that might contain alphanumeric characters
and an underscore (_).

� Description is a text description for this particular instance.
� Filename is the complete path to the file that you want to monitor.

6. To add the table row and close the Row Adder window, click the OK button.

The added row is displayed in the topology view.

� To Add a Printer to Be Monitored
The Print Spooler module enables you to monitor the status of the printer daemon,
print queues, and other printer devices on your network. The following example
procedure uses the Print Spooler module. If this module is not loaded, see “To Load a
Module” on page 169.

1. In the Details window with the Module Browser tab selected, double-click the
Local Applications icon in the hierarchy (tree) view.

The local applications modules are displayed in both the hierarchy and topology
views.

2. Double-click the Print Spooler icon in either the hierarchy or the topology view.

Three property tables are displayed: Lpsched Status, Printer Devices Table, and
Printer Queues Table.

Steps
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FIGURE 8–1 Print Spooler Property Tables

3. Add a printer device row to the table in either of the following ways:

� Press mouse button 3 in the Printer Devices table row, and choose the New Row
command from the pop-up menu.

� Click the Printer Devices table, and choose New Row from the Options pop-up
menu at the top left of the Details window.

The Add Row window is displayed.

4. Type the name of the printer and a description for the printer in the appropriate
fields.

5. To add the printer to the table and close the Add Row window, click the OK
button.

The added row is displayed in the topology view.
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� To Probe a Property
This example procedure explains how to probe a property in the Directory Size
Monitoring module. If you have not done so already, load this module by following
the procedure “To Load a Module” on page 169.

1. In the Browser Details window, double-click the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and topology
views.

2. Double-click the Directory Size Monitoring icon in the topology view, or click
the expansion icon next to the Directory Size Monitoring icon in the hierarchy
view.

The Directory Monitoring Status folder is displayed.

3. Double-click the Directory Monitoring Status folder icon in either the hierarchy
or the topology view.

The monitored data properties are displayed in a property table.

4. List or recursively list files in either one of the following ways:

� Press mouse button 3 in the Directory Monitoring table row and choose the List
Files or Recursively List Files command from the pop-up menu.

� Click the Probe icon, select the appropriate command in the Probe Select dialog
box, and click the OK button.

A window appears that displays the files.

Steps
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CHAPTER 9

Viewing Data Properties in a Graph

The Sun Management Center product enables you to monitor specific data properties
for your managed objects. You can view these properties in tabular format or in
graphical format. This chapter describes basic capabilities that Sun Management
Center provides for using graphical formats to monitor data properties. The chapter
includes the following information:

� “Overview of Graphs” on page 144
� “To Create a Graph of a Monitored Data Property” on page 144
� “To Create a Graph of Two or More Data Properties” on page 145
� “To Save Graphing Parameters” on page 147
� “To View an Existing Graph” on page 147
� “To Apply a Graph Template” on page 148
� “To Change Graph Type” on page 148
� “To Add or Modify Legends and Labels” on page 149
� “To Change X-Axis and Y-Axis Values” on page 150
� “To Modify the Border for the Graph or the Data Section of the Graph” on page 150
� “To Modify the Data View” on page 151
� “To Enlarge an Area of a Graph” on page 152
� “To Translate a Graph” on page 152

The Performance Reporting Management (PRM) product provides advanced graphing
features, such as saving graph definitions for multiple hosts and properties, saving
graphs as images, and creating graphs that are based on historical data. For more
information, see Sun Management Center 3.5 Update 2 Performance Reporting Manager
User’s Guide.

For information about viewing data properties in a table, see Chapter 8.
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Overview of Graphs
Use the Details window to view the current values for specific data properties, such as
the amount of memory being used on a given host. You can navigate through the
hierarchy (tree) view to find the appropriate managed object. The lowest-level object
in the host hierarchy is the monitored property.

By default, information about a monitored data property is displayed in table form. In
some instances, viewing that information in a graph can be useful. For example, to see
when memory usage is highest, you might create a graph of the memory usage as a
function of time.

Working with Graphs
Sun Management Center software enables you to create graphs for most monitored
data properties.

� To Create a Graph of a Monitored Data Property

� From the Details window, display the Graphing window in either of the
following ways:

� Press mouse button 3 in any table cell that contains a data property, and choose
Open Graph from the pop-up menu.

� Select the desired data property, and click the Graph button at the top of the
Details window.

The Graphing window opens. The values of the property are plotted as a function
of time. The plotting is dynamic. Values continue to be plotted even if you
minimize the Graphing window. Plotting stops, however, if the window is closed.

The following figure shows a typical Graphing window.

Step
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FIGURE 9–1 Graph of System Load Statistics Average Over the Last Five Minutes

� To Create a Graph of Two or More Data Properties

1. Click in the data property table cell.

For example, if you followed the hierarchy from Operating System to Kernel
Reader (Simple) to System Load Statistics, you could select the Load Averages
Over the Last 1 Minute table cell.

2. Copy the cell to the graph in one of the following ways:

� Click mouse button 3 in the table cell, and choose the Copy to Graph Clipboard
command from the pop-up menu.

� In the Details window, choose Copy to Graph Clipboard from the Options icon
menu.

Steps
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Note – The Copy to Graph Clipboard command works only when the units of the
data item are the same. Also, Copy to Graph Clipboard places the data on a
clipboard. The data is not actually placed on the graph until you complete the
following steps.

3. Go to the graphing window in which you want the additional property to be
plotted.

4. Choose Add From Graph Clipboard from the Graph menu.

The second data property is added, as shown in Figure 9–2.

Note – You can graph up to five data properties at one time on a single graph.

FIGURE 9–2 Load Averages Over the Last One and Five Minutes
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� To View an Existing Graph

1. Choose Open Saved Graph from the Graph menu in the Graphing window.

The Open Graph dialog box appears.

2. Select a saved graph from the list.

3. To view the selected graph, click the OK button.

Note – When you save a graph request, the graph parameters are saved but not the
data. Thus, when you open a graph, the graph starts plotting fresh data.

� To Save Graphing Parameters
The Save Graph Request As function enables you to save the host name and the data
property or properties that have been graphed. Once saved, a graph of this property
on this host can be pulled up quickly from inside the Graphing window. You can also
access a saved graph from the Tools menu in the main console window. A newly
opened graph starts plotting fresh data.

1. To save properties for your graph, choose Save Graph Request As from the
Graph menu in the Graphing window.

2. Type the name for this graph in the Enter Graph Name field.

3. Click the Save button.

� To Define a Graph Template
You use graph templates to define the appearance of graphs. To create a graph
template, you define the visuals for one graph and save the template for that graph.
When you save the graph template, only the data properties, host information and the
template gets saved. The actual graph state at the time of saving is not saved. To apply
that template to new graphs so that they have the same look, see “To Apply a Graph
Template” on page 148.

1. Save the properties for a graph as explained in “To Save Graphing Parameters”
on page 147.

Steps

Steps

Steps
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2. To save the custom features that you have applied to your graph, choose Save
Template from the Graph menu in the Graphing window.

The Save Template function enables you to save any custom features that you have
added to your graph. These features can include axis labeling, headers, footers,
legend, and so on.

3. Type the name for this template in the Enter Template Name field.

4. Click the Save button.

� To Apply a Graph Template
You use graph templates to define the appearance of the graphs. Once you have
defined a graph template as described in “To Define a Graph Template” on page 147,
you can apply that template to multiple graphs.

1. Choose Apply Template from the Graph menu in the Graphing window.

The Apply Template dialog box is displayed. This dialog box enables you to apply
saved custom features to the current graph.

2. Select a saved template from the list.

3. To apply the template to the current graph, click the OK button.

� To Change Graph Type
By default, a graph displays as a line graph. You can choose to view data in a bar chart
or area graph.

1. In the Graphing window, choose Chart Type from the Edit menu.

2. Select the type of graph to display.

� For a bar chart, select Bar.
� For an area chart, select Area.
� For a line chart, select Line.

3. Click the OK button.

The Graphing window shows the data using the selected graph type.

Steps

Steps
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� To Add or Modify Legends and Labels

1. In the Graphing window choose Main Titles from the Edit menu, then choose
the appropriate label to modify.

Choose from the following options:

� To add or modify the header, choose Header.

� To add or modify the footer, choose Footer.

� To add or modify the data legend, choose Legend.

� To add or modify the label for the X-Axis along the bottom of the graph, choose
X-Axis Title.

� To add or modify the label for the Y-Axis along the side of the graph, choose
Y-Axis Title.

Each option provides a dialog box that enables you to set similar parameters.

2. To adjust the title text, type or modify the information in the Text field.

3. To change the style of the title, select the style that you want to use in the Style
section.

By default, most text is in plain style. You can also choose to have the text appear
in bold or italic.

4. To choose the font family type to apply to the title, select the font family
description in the Name section.

By default, most titles appear in a Serif font. You can also choose SansSerif or
Monospaced.

5. To choose the size of the title, select the size in the scrolling list in the Size
section.

Default sizes differ by title type. Many sizes are in the 10–14 point range. However,
you can choose sizes anywhere from 6 to 26.

6. To change the orientation of the title, select the appropriate box in the
Orientation section.

The default orientation differs by title type. For example, an X-Axis title is most
likely to be oriented horizontally. You can choose any of the following orientations:

� Horizontal – Reads left-to-right
� Upsidedown – Reads right-to-left and flipped
� Vertical – Left-facing, reads bottom-to-top
� Verticalflip – Right-facing, reads top-to-bottom

7. To provide a border around the title, choose a style from the Border Style menu.

Steps
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� To Change X-Axis and Y-Axis Values

Caution – When you edit axes, be careful to choose the correct values. If you choose
values for Min and Max that are impossible to plot, the dialog box usually gives you
an error message that describes the problem. However, if you choose values that are
possible but that result in the plotted points no longer being visible, no error message
appears.

1. To modify the values to be used for the X-axis, choose Axes from the Edit menu
in the Graphing window.

The Axes Editing window appears.

2. To disable automatic X-axis values, deselect Auto-Scaling.

Numbers replace the word Auto in the window fields.

3. Provide appropriate values in the Minutes to display, Tick Spacing, and Grid
Spacing fields.

4. To modify the values to be used for the Y-axis, from the Axes Editing window,
click the Y-Axis tab.

5. To disable automatic Y-axis values, click the check box next to Auto-Scaling.

Numbers replace the word Auto in the window fields.

6. Provide appropriate values in the Range Min, Max, Major Tick, Minor Tick, and
Grid Spacing fields.

7. To apply your changes and close the Axes Editing window, click the OK button.

� To Modify the Border for the Graph or the Data
Section of the Graph

1. To access the Border window, choose Border from the Edit menu in the Graphing
window.

The Border window that appears has two sections:

� Chart Area applies to a border around the entire graph.
� Plot Area applies to a border around the data portion of the graph.

2. To modify the border on the entire graph, select a border type from the Border
Type list in the Chart Area section.

There are several types of borders available.

Steps

Steps
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3. To modify the border on the data portion of the graph, select a border type from
the Border Type list in the Plot Area section.

There are several types of borders available.

4. To apply your border changes and close the Borders window, click the OK
button.

� To Modify the Data View
The View menu in the Graphing window enables you to show or hide various graph
components and to change the display of your data. Although the following steps are
presented sequentially, you can show or hide components in any sequence you desire.

1. To enable or disable the display of live (current) data, select or deselect Live
Data in the View menu in the Graphing window.

� If live data is enabled, the graph continually updates as new data is provided.
� If live data is disabled, the graph is static. The graph does not update with new

data until you re-enable live data.

2. To show or hide the header, select or deselect Show Header from the View menu
in the Graphing window.

3. To show or hide the footer, select or deselect Show Footer from the View menu
in the Graphing window.

4. To show or hide the X-axis and Y-axis titles, select or deselect Show Axis Titles
from the View menu in the Graphing window.

5. To show or hide the X-axis and Y-axis labels, select or deselect Show Axes from
the View menu in the Graphing window.

6. To show or hide the grid lines, select or deselect Show Grids from the View
menu in the Graphing window.

7. To show or hide the data legend, select or deselect Show Legend from the View
menu in the Graphing window.

8. To rotate the graph, follow these steps:

a. Choose Rotate Graph from the View menu in the Graphing window.

b. Select the appropriate rotation value from the secondary menu.

9. To change the order of the data display, follow these steps:

a. Choose Flip from the View menu in the Graphing window.

b. Select either X-Axis or Y-Axis from the secondary menu

Steps
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When you flip the X-axis, the Y-axis moves to the other side of the graph. The time
sequence reverses. In other words, instead of the oldest data appearing on the left
of the graph, the newest data appears on the left of the graph.

When you flip the Y-axis, the X-axis moves to the top of the graph. The data
sequence reverses. In other words, smaller values appear at the top of the graph
rather than on the bottom of the graph.

10. To reset the rotation and flip values, choose Reset View from the View menu in
the Graphing window.

� To Enlarge an Area of a Graph

1. To zoom in on a specific section of a graph, choose Zoom from the Tools menu in
the Graphing window.

2. Hold down the Shift key and drag mouse button 1 to outline the area to zoom.

3. Release the mouse button to view the enlarged area.

4. To restore the graph to its original, unzoomed view, choose Restore from the
Tools menu in the Graphing window.

� To Translate a Graph
Graphs typically show the current information. You can translate information on the
graph, for example, to show information from an earlier time.

1. To translate a specific section of a graph, choose Translate from the Tools menu
in the Graphing window.

2. Hold down the Control key and drag mouse button 1 to outline the area to
translate.

3. Release the mouse button to enable the translation.

4. To restore the graph to its original, untranslated view, choose Restore from the
Tools menu in the Graphing window.

Steps

Steps
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CHAPTER 10

Monitoring Data Property Attributes

This chapter describes the following topics:

� “Overview of Attribute Editor” on page 153
� “Info Tab in the Attribute Editor” on page 154
� “Alarms Tab in the Attribute Editor” on page 154
� “Actions Tab in the Attribute Editor” on page 155
� “Refresh Tab in the Attribute Editor” on page 156
� “History Tab in the Attribute Editor” on page 157
� “To Open the Attribute Editor for a Specific Data Property” on page 157
� “To Open the Attribute Editor for a Data Property Column” on page 158
� “To Set a Refresh Interval” on page 158
� “To Set a History Interval” on page 159

Overview of Attribute Editor
The module data properties provide additional information about Sun Management
Center modules. The Attribute Editor enables you to customize the following
monitoring criteria for these properties:

� Set alarm thresholds for defined alarms
� Specify actions to take when alarm conditions occur
� Change the interval at which data updates on the screen
� Define schedules for creating log files of historical data points

The Attribute Editor has one or more tabs at the top of the window that enable you to
switch between different panels. These tabs differ depending on the selected object.
The following tabs are available and are described in the identified sections:

� Info – “Info Tab in the Attribute Editor” on page 154
� Alarms – “Alarms Tab in the Attribute Editor” on page 154
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� Actions – “Actions Tab in the Attribute Editor” on page 155
� Refresh – “Refresh Tab in the Attribute Editor” on page 156
� History – “History Tab in the Attribute Editor” on page 157

Info Tab in the Attribute Editor
The Info panel shows additional information about the selected object. The specific
information differs depending on the selected object.

Alarms Tab in the Attribute Editor
The Alarms tab enables you to set alarms thresholds only for those data properties
that have associated simple alarms. Simple alarms use the rCompare rule, which is
described in Appendix D. For information about simple alarms, see Table 10–1.

Simple alarms are based on thresholds. A monitored data property is greater than, less
than, not equal to, or equal to a single threshold value. By contrast, complex alarms
occur when a set of conditions becomes true. For more information about defining,
acknowledging, and working with alarms in Sun Management Center, see Chapter 12.

Note – You need the appropriate security permission to set an alarm threshold. See
Chapter 18 for more information.

The following table shows common simple alarm limits for monitored properties. The
alarm limits are also displayed in the Parameter Description field. You can set
thresholds for one or more of these alarm limits for selected data properties.

TABLE 10–1 Common Simple Alarm Limits in Sun Management Center Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if a value exceeds the limit in
this field.

Alert Threshold (>) Alert (yellow) alarm occurs if a value exceeds the limit
in this field.

Caution Threshold (>) Caution (blue) alarm occurs if a value exceeds the limit
in this field.

Critical Threshold (<) Critical (red) alarm occurs if a value is below the limit
in this field.
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TABLE 10–1 Common Simple Alarm Limits in Sun Management Center Software
(Continued)
Alarm Limit Description

Alert Threshold (<) Alert (yellow) alarm occurs if a value is below the limit
in this field.

Caution Threshold (<) Caution (blue) alarm occurs if a value is below the limit
in this field.

Alarm Window Alarm occurs only during this time period. For
example, if you type day_of_week=fri, an alarm
occurs only if the alarm condition exists on a Friday. If
an alarm condition exists on Tuesday, no alarm is
registered.

Actions Tab in the Attribute Editor
The Actions tab appears only if you can define alarm actions for the current data
property. The Actions panel enables you to instruct the software to perform a
predetermined action if an alarm occurs.

Note – Acceptable actions include sending an email or executing scripts that are stored
in the /var/opt/SUNWsymon/bin directory. These scripts execute with root
permissions.

For example, you might define an action so that an email is sent to a system
administrator whenever a critical alarm is generated for the Load Average Over the
Last Five Minutes data property.

As illustrated in Figure 10–1, you can define specific actions to occur in any of the
following instances:

� When a particular alarm severity (critical, alert, caution, or intermediate) occurs

� When an alarm closes

� When any change in alarm condition happens

Note – The check boxes to the right of the Action buttons enable you to specify
automatic or manual execution of a specific alarm action. By default, all actions are set
for automatic execution.
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FIGURE 10–1 Attribute Editor Actions Panel for a Monitored Property

When you click the Actions button, the Action Dialog Selection window appears. This
window enables you to create or modify the registered alarm actions. You can perform
one of the following actions:

� Send an email
� Execute a script
� Clear the alarm

For more information about defining an alarm action, see “To Register an Alarm
Action” on page 194.

Refresh Tab in the Attribute Editor
The Refresh panel enables you to set the refresh interval for the selected object. The
refresh interval is the interval between the times when the Sun Management Center
agent samples the monitored property.
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Note – Only some data properties enable you to modify the refresh interval.

For information about setting the refresh interval, see “To Set a Refresh Interval”
on page 158.

History Tab in the Attribute Editor
The History panel enables you to save older data for a monitored property. For
example, a history of data points could be recorded every 120 seconds, as specified in
the Sample Interval field. You can store this information in one of two places:

� Disk file

There are two types of disk files: circular and text. These files are located in the
/var/opt/SUNWsymon/log directory.

� Memory cache

If you store information in the memory cache, you must also indicate how many
data points should be saved in the Max Size (sample) field.

Note – You can view the history data in a graph by opening the graph for the selected
monitored property. If you have selected memory cache, the graph is displayed with
the historical data.

Using the Attribute Editor
The Attribute Editor provides features that support various activities. Some of these
activities use other features in addition to the Attribute Editor. Information about
performing simple Attribute Editor-only functions, such as defining intervals for
history logs and screen refreshes, is provided here. Detailed information about
alarm-related functions is provided in Chapter 12.

� To Open the Attribute Editor for a Specific Data
Property
You can open the Attribute Editor for a specific data property value. For some data
properties, you can also access the Attribute Editor for a column of values. For more
information, see “To Open the Attribute Editor for a Data Property Column” on page
158.
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1. Navigate through the topology or hierarchy view until you have accessed a data
property table.

2. Place your cursor in the value section of the table and use either of the following
methods:

� Press mouse button 1 and choose Attribute Editor from the pop-up menu.
� Click the Attributes icon.

The Attribute Editor window shows specific information about the selected data
property. The displayed tabs depend on the specific data property that you
selected.

For information about defining alarm thresholds for the selected data property, see
“Managing and Controlling Alarms” on page 190 and “Alarm Management
Examples” on page 198.

� To Open the Attribute Editor for a Data Property
Column
Choosing a data property column, rather than a specific data property value, enables
you to define attributes for all values in that column. For example, consider the CPU
Utilization Table. If you open the Attribute Editor for the column % CPU User Time,
you could define alarm thresholds and actions for all CPUs. If you open the Attribute
Editor for a specific % CPU User Time value, such as the value that applies to CPU 1,
any alarm threshold or action that you defined would apply only to that specific CPU.

1. Navigate through the topology or hierarchy view until you have accessed a data
property table.

2. Click the column heading for the column in which you are interested.

3. To access the Attribute Editor, use one of the following mechanisms:

� Press mouse button 1 and choose Attribute Editor from the pop-up menu.
� Click the Attributes icon.

The Attribute Editor window shows specific information about the selected data
column. For information about defining alarm thresholds for the selected data
column, see “Managing and Controlling Alarms” on page 190 and “Alarm
Management Examples” on page 198.

� To Set a Refresh Interval
The refresh interval indicates, in seconds, how frequently an agent acquires data. The
following example illustrates how to set a refresh interval for a property in the System
Load Statistics module.

Steps

Steps

158 Sun Management Center 3.6 User’s Guide • December 2005



1. Click the Module Browser tab in the Details window.

2. Click the expansion icon next to the Operating System icon in the hierarchy tree
view.

The Operating System modules are displayed.

3. Click the expansion icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Select the table cell for Load Averages Over the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Refresh tab button.

The refresh panel is displayed.

8. Type a value in seconds in the Refresh Interval field or click the Advanced
button.

For example, 300 seconds equates to five minutes.

9. To apply the refresh interval and close the Attribute Editor window, click the OK
button.

Data for System Load Statistics are acquired every five minutes.

Note – The agent uses less CPU cycles if you provide a larger refresh interval.

� To Set a History Interval

1. Open the Attribute Editor for the data property on which you want to set the
history information.

For example, follow these steps to access the Attribute Editor for Load Averages
Over the Last 5 Minutes:

a. Click the Module Browser tab in the Details window.

b. Click the expansion icon next to the Operating System icon in the hierarchy
tree view.

c. Click the expansion icon next to the Kernel Reader icon.

d. Double-click the System Load Statistics icon.

Steps

Steps

Chapter 10 • Monitoring Data Property Attributes 159



e. Select the table cell for Load Averages Over the Last 5 Minutes.

f. Click the Attributes button.

2. Click the History tab.

The history panel is displayed.

3. Type a value in seconds in the Sample Interval field or click the Advanced
button.

For example, to collect a history data point every two minutes, type 120 in the
Sample Interval field.

4. Select Save History as Disk File or Save History in Memory Cache.

5. To save history as a disk file:

a. Determine the file type, either circular or text.

� A circular file has a predefined length of 1000 lines. If the amount of data
that is written to the file exceeds that length, then the file rewrites from the
beginning.

� A flat text file has no predefined length. Information is appended to the flat
file until you stop the process or until the disk space is exceeded. Use this
feature if you need to keep history files for data warehousing purposes.

b. For a text file, type the file name in the Text File Name field.

If you do not choose a file name for your text file, data are saved automatically
in the /var/opt/SUNWsymon/log/agent_default.history file.

The file name cannot contain special characters, such as / or #.

6. To save history in a memory cache, type the number of history data points in the
Max Size (sample) field.

For example, if you set this field to 1000, only the most recent 1000 data points are
stored in the memory cache. Any older data points are discarded. These data
points can be graphed. See “To Create a Graph of a Monitored Data Property”
on page 144 for more information.

7. To apply your history file changes and close the History panel, click the OK
button.
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CHAPTER 11

Managing Modules

This chapter describes the following topics:

� “Sun Management Center Module Concepts” on page 161
� “To View Module Status” on page 168
� “To Load a Module” on page 169
� “To Return a Module to Its Default Settings” on page 170
� “To Set a Module Schedule” on page 171
� “To Load a Scheduled Module” on page 172
� “To Enable a Module” on page 172
� “To Disable a Module” on page 173
� “To Unload a Module” on page 173
� “To Set Security Permissions for a Module” on page 174
� “To View Module Rules” on page 174
� “To Modify Module Parameters” on page 176
� “Monitoring Modules as a Group” on page 176

Sun Management Center Module
Concepts
Sun Management Center modules are responsible for collecting data from specific
monitored resources. These modules can be dynamically loaded, enabled, disabled,
and unloaded into a Sun Management Center agent.

� When you load a module, the module icon appears in the Browser Details window.
In addition, the module managed object and its data properties are defined. Data
acquisition for that module begins. The data properties for the managed object are
displayed in the Details window. The data display is periodically refreshed.

� When you enable a module, data acquisition restarts if the module was disabled
previously. The data display for the managed object periodically refreshes in the
Details window.
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� When you disable a module, data acquisition stops temporarily for the managed
object until the module is enabled. While a module is disabled, the data is not
refreshed. Also, the data does not trigger an alarm even if you do a manual refresh.
Alarms are not triggered until the module is re-enabled.

� When you unload a module, data acquisition stops for the managed object. The
managed object and data properties are undefined. The module icon is removed
from the Browser Details window.

Note – Some modules, such as the File Scanning Module, can be loaded more than
once on a host. These modules are referred to as multi-instance modules. If the module
is a multi-instance module, a special icon is displayed in the Details window.

Default Modules
Some or all of the following modules are loaded by default when you install the
software:

� Agent Statistics
� Kernel Reader (Simple)
� Simple MIB-II
� Config-Reader (for supported hardware platforms only)
� File Scanning [System Log]

Module List
Table 11–1 lists generic modules that you can load and use. The list of modules that is
displayed for your system depends on your platform type and any add-on products
that you have installed. See your supplement for more information about
platform-specific modules, including the Config-Reader and Dynamic Reconfiguration
module. For information about the other Sun Management Center modules, see
Appendix C.

TABLE 11–1 Sun Management Center Modules

Module

Module
Version
Number Add-on Description

Agent Statistics 2.0 Provides information about the health of the
agent installed on a host by monitoring the
objects, processes, and execution of
processes by the agent.
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TABLE 11–1 Sun Management Center Modules (Continued)

Module

Module
Version
Number Add-on Description

Agent Update 1.0 Enables you to use the Agent Update
process to update software on agent
systems.

Config-Reader 1.0 Config-Reader Provides the hardware configuration of the
host. This module is available only if the
hardware platform is supported and either
the Workgroup or Desktop add-on products
are installed. Both the physical view and the
logical view require that this module be
loaded.

Data Logging
Registry

2.0 Provides information about agent data
logging, such as log destination, module
name, logging interval, and buffer length.
Multiple copies of this module can be
loaded.

Directory Size
Monitoring

2.0 Advanced System
Monitoring

Enables you to isolate and monitor the size
of any directory and its subdirectories on a
host where a Sun Management Center agent
is installed. Multiple copies of this module
can be loaded, or you can add additional
directories for monitoring by adding a row
in the properties table.

Dynamic
Reconfiguration

2.0 Dynamic
Reconfiguration
for Sun Fire
High-End and
Midrange
Systems

Enables you to perform dynamic
reconfiguration operations on DR-enabled
monitored hosts.

Fault Manager 1.0 Advanced System
Monitoring Note – This module can be installed only on

Solaris 10.

Handles hardware and software faults
effectively. Displays a detailed fault report or
a message article for the selected fault. For
instructions about viewing a fault report and
a message article, see “To View a Fault
Report” on page 420 and “To View a
Message Article” on page 420
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TABLE 11–1 Sun Management Center Modules (Continued)

Module

Module
Version
Number Add-on Description

File Monitoring 2.0 Advanced System
Monitoring

Monitors selected files on a host. Monitored
parameters include file size and timestamps.
Multiple copies of this module can be
loaded. This module requires you to add
rows in the data property table. For more
information, see “To Add a Row to a Data
Property Table” on page 139.

File Scanning 2.0 Advanced System
Monitoring

Scans files on a host for specified patterns.
This module also scans multi-line fault
messages that are written to the syslog file.
Multiple copies of this module can be
loaded. This module requires you to add
rows in the data property table. For more
information, see “To Add a Row to a Data
Property Table” on page 139.

HP JetDirect 2.0 Advanced System
Monitoring

Monitors the status of HP printers that are
equipped with a JetDirect card. Multiple
copies of this module can be loaded.

Health Monitor 2.0 Advanced System
Monitoring

Enables you to monitor various resources
usage in your host such as CPU, disk, NFS,
and SNMP.

Kernel Reader 2.0 Advanced System
Monitoring

Provides kernel statistics, such as CPU
details, system call, faults, streams, disk
information, and page information.

Kernel Reader
(Simple)

1.0 Provides kernel statistics, such as load
statistics, swap statistics, and streams
statistics. Also, provides software rules
information.

Logview ACL 1.0 Advanced System
Monitoring

This module supports viewing and
monitoring of the system log, Sun
Management Center log, and other log files,
using the Modules tab on the Details
window.

MIB-II
Instrumentation

1.0 Advanced System
Monitoring

Provides the system, interfaces, IP, Internet
Control Message Protocol (ICMP),
Transmission Control Protocol (TCP), and
User Datagram Protocol (UDP) Management
Information Base (MIB-II) group
information of the monitored host.
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TABLE 11–1 Sun Management Center Modules (Continued)

Module

Module
Version
Number Add-on Description

MIB-II Proxy
Monitoring

2.0 Advanced System
Monitoring

Provides proxy management of hosts that
are running non-Sun Management Center
MIB-II SNMP agents. Multiple copies of this
module can be loaded.

MIB-II (Simple) 1.0 Provides the system Group, interfaces
Group, IP Forwarding, IP Route Table
information of the standard MIB-II
(Management Information Base) group
information of the monitored host. This
module is a scaled-down version of the
MIB-II Instrumentation module.

Note – The MIB-II module identifies an
agent. If this module is not loaded, the agent
can be created only as a ping host or as an
SNMP host.

NFS File Systems 2.0 Advanced System
Monitoring

Provides information about the NFS file
systems on monitored hosts by monitoring
the amount of disk space occupied by
mounted or unmounted file systems and the
amount of used and available space as well
as the file system’s remaining total capacity.

NFS Statistics 2.0 Advanced System
Monitoring

Monitors the number of NFS calls and RPC
(remote procedure calls) received by the
server, and monitors the status of the
transaction activity on the monitored host.
Multiple copies of this module can be
loaded.

Print Spooler 3.0 Advanced System
Monitoring

Monitors the status of the printer daemon,
the print queue, and the printer devices that
are installed on the monitored host.

Process
Monitoring

2.0 Advanced System
Monitoring

Monitors one or more processes on the host.
Specifies monitored processes by matching
patterns. Multiple copies of this module can
be loaded. This module requires you to add
rows in the data property table. For more
information, see “To Add a Row to a Data
Property Table” on page 139.
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TABLE 11–1 Sun Management Center Modules (Continued)

Module

Module
Version
Number Add-on Description

Service
Management
Facility

1.0 Advanced System
Monitoring Note – This module can be installed only on

Solaris 10.

Monitors and displays the services running
on a host. This module also displays
dependencies for the selected service and
displays services that depend on the
selected service. This module also displays
the processes in the selected service. For
more details, see “Service Management
Facility Module Version 1.0” on page 429.

Solaris Process
Details

2.0 Advanced System
Monitoring

Displays detailed information of Solaris
processes running on a host where the Sun
Management Center agent has been
installed. The Process Details window
requires that this module be loaded.

Storage A5x00 1.0 Monitoring and
Management of
A5x00 and T3
Devices

Enables you to monitor the state of A5000,
5100, and 5200 storage devices, and manage
alarms on these devices.

Sun StorEdge T3 1.0 Monitoring and
Management of
A5x00 and T3
Devices

Enables you to monitor the state of T3
storage devices, and manage alarms on
these devices.
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TABLE 11–1 Sun Management Center Modules (Continued)

Module

Module
Version
Number Add-on Description

Volume System
Monitoring

1.0 Volume System
Monitoring The agent layer of this add-on can be

installed only on hosts that has the Sun N1
System Manager server (System Manager)
installed. In addition, the setup of this
add-on requires the root user to be a valid
System Manager user with permissions to
create and delete System Manager event
notifications.

Monitors a set of attributes managed by the
System Manager agent and displays them in
the Module Browser. This module also
listens for traps from the System Manager
agent and performs appropriate actions.
This module also generates warning, error,
or information alarms based on the values of
specific attributes.

You can also access the System Manager
server from this module. However, you have
to log in and authenticate explicitly with the
System Manager server. For instructions
about accessing the System Manager server
through the web console and through SSH,
see “To Access the System Manager Server
Through Web Console” on page 354 and “To
Access the System Manager Server Through
SSH” on page 354.

For more information about modules, see Appendix C.

Note – The Config-Reader and Dynamic Reconfiguration modules are supported only
on specific hardware platforms. For more information, refer to your platform
supplement.

Depending on your system hardware, additional modules might be supported. For
more information, refer to the Sun Management Center web site at
http://www.sun.com/sunmanagementcenter/.
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Working With Modules
The procedures in this section describe how to load, unload, enable, and disable
modules. These procedures also explain other module-related tasks.

� To View Module Status
You can find out what modules are loaded or are scheduled to be loaded on a given
agent or server system. In addition, you can find out what other modules are available
on that system and if any of the currently loaded modules are disabled. To view the
status of modules on a given system, follow these steps.

1. Select a server or agent managed object.

2. Open the Details window for the selected object.

3. From the Details window, click the Module Manager tab.

The modules status view appears. This view has two main sections:

� The “Modules with Load Status” section lists modules that are loaded or are
scheduled to be loaded on the host. For each module, this section identifies the
following information:

� The module name, including a specific instance identifier if applicable
� Whether the module is loaded
� Whether the module is scheduled to be loaded
� Whether the module is enabled

� The “Available Modules” section lists modules that can be loaded for this host.
This section includes modules that are listed in the “Modules with Load Status”
section when there can be more than one instance of that module on the host.
For each module, this section identifies these characteristics:

� The module name

� Whether the module can be loaded more than once on the host (also referred
to as a multi-instance module)

For information about how to change the status of a module, see the following
sections:

� “To Load a Module” on page 169
� “To Load a Scheduled Module” on page 172
� “To Enable a Module” on page 172
� “To Disable a Module” on page 173
� “To Unload a Module” on page 173

Steps
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� “To View Module Rules” on page 174
� “To Modify Module Parameters” on page 176

� To Load a Module

1. To select the host machine on which the module will be loaded, click the host
machine icon.

Note – If you attempt to load a module without selecting a host, you cannot access
the Load Module option in the Tools menu.

2. To open the Load Module dialog box, use one of the following mechanisms:

� Press mouse button 1 on the selected host icon, and select Load Module from
the pop-up menu in the hierarchy view or the topology view.

� In the main console window, choose Load Module from the Tools menu.

� Open the Details window, and choose Load Module from the Module menu
(the first icon at the top left of the Module Browser window).

� Open the Details window, click the Module Manager tab, select a module to
load from the list of Available Modules, and click the Load button.

Note – In this case, the Module Loader window appears. Go to Step 5.

The Load Module dialog box appears.

The Load Module dialog box provides a list of Sun Management Center modules.
A number next to the module name indicates the number of existing instances of
that module on your host.

Note – Some modules can have multiple instances loaded on a host.

3. Select the name of the module that you want to load.

4. Click the OK button.

The Module Loader window appears. The contents of the Module Loader window
depend on the selected module.

Steps
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Tip – You can also double-click a module name in the Load Module dialog box to
load that module.

5. If there can be more than one instance of this module, type the instance name in
the Instance field.

The instance name is used within the Sun Management Center agent to identify
uniquely a particular module or a row within a module. You must specify a unique
name for each instance when multiple instances of the same module are loaded.

An instance name is a single word or alphanumeric string. The only special
character allowed in an instance name is the underscore (_).

If you do not type information for a necessary field, the software responds with an
error message and the module is not loaded.

6. (Optional) Type or change the information in the Description field.

For some modules, the Description field is the only field that you can edit.

7. Decide whether to load the module now or at a scheduled time.

� To accept the Load Parameters and load the module immediately, click OK.

� To set a time to load and enable the module, click the Schedule tab and follow
the instructions in “To Set a Module Schedule” on page 171.

� To Return a Module to Its Default Settings
You can change information for a module and later return the module to its default or
original settings. For example, if you deleted some rows from the File Scanning
module for the system log, you could reload that module to retrieve the deleted
default rows. If you modified some alarm thresholds or defined alarm actions in a
module, you could return those attributes to their default values.

1. Select the module to load.

2. If there can be more than one instance of this module, provide any required
information in the Module Loader window.

Information that you provide in the Module Loader window must exactly match
the original module. For example, in the case of the File Scanning module for the
system log, you would need to supply the instance name syslog, the file name
/var/adm/messages, and the description System Messages.

3. In the Module Loader window, click the Default Settings button.

The selected module will reload with all default information.

Steps
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� To Set a Module Schedule
You can set a schedule that determines when a module should be active. For example,
you might schedule a module to run between 8:00 AM and 5:00 PM every day. At all
other times, the module is inactive, even if an alarm condition exists.

1. From the Module Loader window, click the Schedule tab.

2. To set the load schedule, select Scheduler next to the Module Load Schedule
field.

a. To load this module starting on a day other than today, select a Start Date.

You can edit the information in the Start Date field manually, or you can click
on a date in the calendar to select the date.

b. Select an hour and minute for the Start Time.

Hours are based on a 24–hour clock. For example, 16:00 is the same as 4:00 PM.

c. Select an hour and minute for the End Time.

d. (Optional) To set this module to load more than once, choose how often the
module should load from the Repeat Interval menu.

For example, to schedule a module to load weekly, you would select Weekly.

e. (Optional) To prevent a module from loading indefinitely at the specified
interval, type a number in the Repeat Limit field.

For example, to load this module weekly for one month, you would type 4 in
the Repeat Limit field.

Note – The module loads indefinitely if you do either of the following:

� You select a Repeat Interval of One Time and you do not provide an End
Time.

� You select a Repeat Interval other than One Time and you do not provide a
value in the Repeat Limit field.

f. Click OK to set this schedule, or click Cancel to exit from the scheduler
window.

3. To set the module enable schedule, select Scheduler next to the Module Enable
Schedule field.

The Scheduler works the same for this feature as other schedulers throughout the
product. See the preceding step for more information.

Steps
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4. To load and enable the module as specified, click OK.

If you need to enter load parameters and have not done so, an error message tells
you what you must do.

� To Load a Scheduled Module

1. In the Details window, click the Module Manager tab.

2. Select a module that is currently scheduled but not loaded from the Modules
with Load Status list.

Tip – Look for a “No” in the Loaded column and a “Yes” in the Scheduled column.

3. Click the Load Now button.

The Load Now confirmation dialog box appears.

4. Determine whether to load the module at the scheduled time.

� To load the module now and at the scheduled time, click Preserve Schedule.
Then click the OK button.

The module loads. The Loaded column changes to Yes and the Scheduled
column remains Yes, so that the module loads again at the scheduled time.

� To load the module now, but not at the scheduled time, click Clear Schedule.
Then click the OK button.

The module loads. The Loaded column changes to Yes and the Scheduled
column changes to No.

� To Enable a Module

1. Open the Details window for the host on which the module is loaded.

2. Enable a currently loaded but not enabled module in one of the following ways:

� Click the Module Manager tab, select a module from the Modules with Load
Status list, and click the Enable button.

� Press mouse button 1 on the module that you want to enable, and choose
Enable Module from the pop-up menu.

When the module has been enabled, the following message is displayed at the
bottom of the window.

Module successfully enabled.

Steps
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� To Disable a Module

1. Open the Details window for the host on which the module is loaded and
enabled.

2. Disable a currently loaded and enabled module in one of the following ways:

� Click the Module Manager tab, select a module from the Modules with Load
Status list and click the Disable button.

� Press mouse button 1 on the module that you want to disable, and choose
Disable Module from the pop-up menu.

When the module has been disabled, a small icon with an X attaches to the module
icon. The following message is displayed at the bottom of the window.

Module successfully disabled.

If the disabled module is the Solaris Process Details module, the following message
is displayed at the bottom of the Details window.

Solaris Process Details module disabled. Process data may not be current.

Caution – Because data is not being refreshed for a disabled module, the data does
not trigger an alarm until you re-enable the module. The data does not trigger an
alarm even if you manually refresh the data.

� To Unload a Module

1. Open the Details window for the host on which the module is loaded.

2. Unload a currently loaded module in one of the following ways:

� Click the Module Manager tab, select the module that you want to unload from
the Modules with Load Status list, and click the Unload button.

� Press mouse button 1 on the module that you want to unload, and choose
Unload Module from the pop-up menu.

The Confirm Module Unload dialog box is displayed.

3. To remove the module, click the Unload button in the Confirm Module Unload
window.

The module is unloaded.

Steps
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� To Set Security Permissions for a Module
You can set security permissions for some individual modules. The security
permissions for a module override the default security permissions for its parent
object or host. For example, if a user has administrator privileges for a module, but
only general privileges for the host, the user still retains administrator privileges for
the module. For further information about privileges, see Chapter 18.

1. Open the Details window for the host on which the module is loaded. Then,
select the Module Browser tab.

2. Use one of these methods to access the Attribute Editor for the module on which
you want to set security:

� Select a module in the left side of the browser. Then, click the Attribute Editor
icon (the first icon above the right side of the window).

� Select a specific data property in the right side of the window, press mouse
button 1 and choose Attribute Editor from the pop-up menu.

3. Click the Security tab.

Note – The Security tab is not available if you cannot set security on the selected
module.

4. Type the names of user and administrator groups in the appropriate fields.

5. To accept your security changes and close this window, click the OK button.

� To View Module Rules

1. In the Details window, click the Module Manager tab.

2. In the Modules with Load Status list, select the module of interest and click
Rules.

The Threshold Summary of Module screen is displayed, containing the name of the
selected module after the colon (:). In this example, the Kernel Reader (Simple)
module is shown.

Steps
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FIGURE 11–1 Threshold Summary of Module Screen

A module rules window contains the following information:

Attribute Name Identifies the data property.

Rule Name Shows the rule name. If the rule is simple, the threshold
value appears. If the rule is complex, a “-” appears.
Click on the “-” to view threshold values in the
Threshold list at the bottom of the window.

Critical The most severe alarm state.

Alert The mid-point alarm state.

Caution The least severe alarm state.

Rule Description Displays a rule description for the selected attribute.

Thresholds Displays threshold values for the selected attribute.

Parameter Description Describes the parameters that are shown in the
Thresholds field.

3. After you view the information, click Close to return to the Module status
screen.
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� To Modify Module Parameters

1. Open the Details window for the host on which the module is loaded.

2. To change information about a module, such as its description, perform one of
the following:

� Click the Module Manager tab, select the module that you want to change, and
click the Edit button.

� Press mouse button 3 on the module that you want to change, and choose Edit
Module from the pop-up menu.

The Module Parameter Editor appears.

3. To change the module information, type new information in the editable fields.

For some modules, the only information that can be changed on this screen is the
module description.

Tip – A editable field has a white background, while a read-only (not editable) field
has a gray background.

4. To accept the changes that you made and close the Module Parameter Editor
window, click the OK button.

Monitoring Modules as a Group
To monitor one type of module on several hosts, you can create module objects for
each host and place these objects in the same group or administrative domain. To
create a module object, see “To Create a Module Object” on page 66.
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CHAPTER 12

Managing Alarms

An alarm is a notification that is triggered by an abnormal event, such as exceeding a
certain percentage of memory usage. The Alarm Manager software monitors your
hardware and software and triggers alarms when defined conditions occur.

This chapter describes the following topics:

� “Alarm Concepts” on page 178
� “Alarms Table” on page 182
� “To View Alarms From the Main Console Window” on page 184
� “To Access an Alarm for a Specific Managed Object” on page 185
� “To Access Alarms From the Details Window” on page 186
� “To Sort the Domain Status Alarms” on page 187
� “To Sort the Alarms Table” on page 187
� “To Update the Alarms Table” on page 188
� “To Filter the Alarms Table” on page 188
� “To View a Log of Alarm Activity” on page 189
� “To Acknowledge New Alarms” on page 190
� “To Delete Alarms” on page 190
� “To Add an Alarm Note” on page 191
� “To View and Add Suggested Fixes” on page 192
� “To Select an Action” on page 196
� “To Notify Users When a Host or Agent Is Down” on page 192
� “To Register an Alarm Action” on page 194
� “To Run a Registered Alarm Action” on page 195
� “To Modify Pending Alarm Actions” on page 196
� “To Define an Alarm Action Script” on page 197
� “Example: To Define and Respond to an Alarm” on page 198
� “Example: To Send an Email” on page 200

Note – The messages in the Alarms page of the Details window are always in English.
These messages are not translated into other languages. However, the text in all dialog
boxes and in suggested fixes is internationalized.
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Alarm Concepts
The Alarm Manager software displays alarm information for managed objects. You
can view object alarm information in an administrative domain in the main console
window and in the Details Alarm window.

Note – The Sun Management Center agent is configured so that only one server
receives alarm information from that agent.

The Sun Management Center 3.6 Alarm Manager enables you to do the following
tasks:

� View alarms in pages from a database

� Manually run the currently registered action after an alarm has been triggered

� Set and change the currently registered action from a list of all installed actions

� Sort alarms

� Read the factory default suggested fix for a rule

� Create a new user-suggested fix for a rule

� Keep a running record of user notes for an alarm instance

� Acknowledge alarms when they occur

� Delete closed alarms from the database

Alarm Definitions
An alarm is a notification that is triggered by an abnormal event. Sun Management
Center has two types of alarms:

� Predefined alarm conditions included in the software modules, such as notification
when the CPU usage exceeds a certain percentage. These alarms are triggered by
conditions outside of a preset range or by Sun Management Center rules. Default
alarm conditions and rules are included in the modules. For some predefined
alarms, you can change the threshold at which the alarm is triggered. In addition,
you can modify the action to take when the alarm occurs and add information to
the suggested fixes. For a list of Sun Management Center rules, see Appendix D.

� User-defined alarm conditions. You define what causes an alarm to occur, what
action to take, and a suggested fix, if desired.
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Alarm Indicators
The Alarm Manager software uses several different methods to alert you to an
unacknowledged open alarm condition:

� Colored icons in the Domain Status Summary on the main console
� Colored icons in the hierarchy (tree) view
� Colored icons in the topology (contents) view
� Colored relevant row or relevant column in the property table (contents view)

The type and color of alarm icon identify the severity of the alarm. For example, a red
alarm icon indicates that a critical condition has developed and that corrective action
is required immediately. By contrast, a blue alarm icon indicates a potential or an
impending service-affecting fault.

You can acknowledge, delete, and manage the object alarms by using the Alarms
Details window. For more information, see “Managing and Controlling Alarms”
on page 190.

Figure 12–1 shows an unacknowledged, open critical alarm in the Swap Statistics
properties table Used KB row. The row is red, which indicates a critical alarm. The
alarm information propagates up the hierarchy tree view, from the individual module
up to the host. You would also see a red alarm icon on the following objects:

� Swap Statistics properties table
� Kernel Reader module
� Operating System
� Host

You also see a red alarm icon on the corresponding host, group (if any), or
administrative domain in the main console window. The only exception would occur
if an unacknowledged open black alarm of higher severity exists.
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FIGURE 12–1 Swap Statistics Alarm in the Details Window

You can select Critical Alarms, Alert Alarms, and Caution Alarms simultaneously for a
module table. A tick mark appears when these alarms are selected.

Note – Unacknowledged alarms take precedence over acknowledged alarms. If the
hierarchy has two or more types of alarms, the color of the more severe
unacknowledged alarm is propagated up the tree. For example, if there is a yellow
unacknowledged alarm in CPU usage and a red unacknowledged alarm in Disk
Statistics, only the red alarm icon propagates. However, if there is a yellow
unacknowledged alarm in CPU usage and a red acknowledged alarm in Disk
Statistics, only the yellow alarm icon propagates.

Alarm Severity Levels
The following alarm severities are supported:

Down Alarms A down alarm indicates that a service-affecting condition
has occurred that requires immediate corrective action. An
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example of this condition is the following: A required
resource that is defined by a managed object has gone out of
service. A specific example of this condition is a module that
has gone down.

Critical Alarms A critical alarm indicates that a service-affecting
condition has developed that requires an urgent corrective
action. An example of this condition occurs when a severe
degradation in the capability of an object has occurred and
you need to restore the object to full capability.

Alert Alarms An alert alarm indicates that a non-service-affecting
condition has developed. Corrective action should be taken
to prevent a more serious fault.

Caution Alarms A caution alarm indicates the detection of a potential or
impending service-affecting fault before any significant
effects have occurred. You should diagnose further if
necessary and correct the problem before it becomes a
serious service-affecting fault.

Off/Disabled Alarms A disabled alarm indicates that a resource for a managed
object is disabled. For example, a module is disabled.

Indeterminate State
Objects with black star icons are objects with indeterminate states, not to be confused
with alarms. A black star or “splat” icon in the main console window means that a
data acquisition failure occurred in that object. The failure is not the result of a rule
infraction, so no alarm is associated with the failure.

Note – When you view the data property table for an object, a pink row also indicates
an indeterminate object state.

Domain Status Summary
The Domain Status Summary section of the main console window provides a brief
view of managed object status. The colored icons designate the severity of the alarms.

Tip – To see a definition for a status summary icon, place your cursor over the icon.
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Numbers next to the alarm icons in the Domain Status Summary indicate the
managed objects for which the highest severity open, unacknowledged alarm is

represented. For example, a 1 next to the alert alarm icon (center) indicates that
there is one managed object for which the highest severity alarm is alert.

The Domain Status Summary displays the number of managed objects in the
administrative domain that have at least one unacknowledged open alarm of a specific
severity.

Note – If multiple types of alarms exist in the host, the icon that indicates the more
severe unacknowledged open alarm appears in the Domain Status Summary.

If the most severe alarm on one host is critical and the most severe alarm on

another host is alert , a 1 appears on both alarm icons.

Alarms Table
The alarms table contains a statistical summary of all alarm data for the managed
object that you select.

Note – If the object is a platform, see your platform supplement for more information.

You can filter and sort this table to display only the alarms that you want to see in a
preferred sequence. You filter and sort alarms from the alarms table. For additional
details, see “To Filter the Alarms Table” on page 188 and “To Sort the Alarms Table”
on page 187.

Alarm Display Pages
The maximum number of alarms that can be displayed on a page is 20. The current
page number and total number of alarms for the selected object in the database are
displayed at the top of the table.
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When new alarms occur, the currently displayed alarms table does not change, even if
these alarms affect the current page. Instead, the Refresh button displays a two-state
icon. This icon indicates that new alarms have arrived, and you should update the
table to include the new alarms soon.

When you delete alarms, the table is updated immediately. The deleted alarms no
longer appear in the table. When another user deletes alarms, you might see blank
rows in the alarms table. A refresh request recomputes the pages and updates the table
to remove the deleted alarms. Only one page of alarms is displayed per request. You
can see additional pages by using the page navigation buttons above the alarms table.

Navigation for the Alarm Table Page
The Alarms Details window contains navigation buttons that enable you to move
through the alarm pages. Informational messages inform you when the first and last
pages of the table are displayed. A scrollbar enables you to scroll through each page of
the table.

Alarm Categories
The alarms table presents different categories of detailed alarm information. The
following information always appears in the alarms table.

Severity Indicates the severity of the alarm. Black is most severe. Grey is least
severe. A green check mark in this column indicates that the alarm was
acknowledged.

Start time Date and time that the alarm occurred

State Indicates the state of the alarm: open, a “ringing” bell icon, or closed, a
“silent”bell icon

Action Indicates the action taken by the user or the program in response to the
alarm condition

Message Abbreviated message that describes the alarm

The following information appears on the bottom of the page when an alarm row is
selected. This information is only displayed for closed or acknowledged alarms.

Alarm Ended On Date and time that the alarm condition was fixed

Alarm Acknowledged On Date and time that the alarm was acknowledged, and
the user ID of the person who acknowledged the alarm

Select an alarm row to display any available additional information that is associated
with the alarm. The additional information includes the following data:
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� The alarm end time
� The acknowledgment date and time
� The user ID of the user who acknowledged the alarm

Alarm States
A bell icon in the State column of the alarms table indicates the state of each alarm.
Each alarm has two states: open and closed.

An open alarm is an alarm for which the condition that caused the alarm still exists. A
closed alarm means the condition no longer exists. Open alarm icons show a “ringing”
bell. Closed alarm icons show a “silent” bell.

Alarm Action Status
The Action column of the alarms table indicates the status of each alarm.

Each alarm can have one of three action conditions:

� No action – An action has not been registered for that alarm.

� Pending action – The action is manual. Click the Run button to execute the action.

� Executed – The action is automatic. The Alarm Manager software has already
performed the action.

Viewing Alarm Information
The Alarm Manager software displays alarm information for managed objects. You
can view object alarm information in an administrative domain in the main console
and the Details Alarm windows.

� To View Alarms From the Main Console Window
When an alarm condition occurs, a colored alarm indicator appears in the console
window. For more information about the alarm indicators, see “Alarm Severity
Levels” on page 180.

To view more information about an alarm:
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1. To see a summary of current alarms, click one of the Domain Status Summary
buttons in the main console window.

A list of objects appears in the Domain Status Details window. This list includes
those objects that have at least one open, unacknowledged alarm for which the
highest severity matches the icon on the button. For more information about these
icons, see “Alarm Severity Levels” on page 180.

From the Domain Status Details window, you can do the following tasks:

� Change the sort order of the displayed alarms, as described in “To Sort the
Domain Status Alarms” on page 187.

� Access detailed information about a specific alarm, as described in Step 2.
� Update the Domain Status Details window by clicking the Refresh Now button.

2. To view details about a specific alarm, use one of the following methods:

� Double-click the desired row in the Domain Status alarm table.
� Click the desired row to select the row, and then click the Details button.

The Details window for the applicable managed object appears with the Alarms
tab selected and alarm information displayed. From this window, you can do the
following tasks:

� Acknowledge the alarm, as described in “To Acknowledge New Alarms”
on page 190.

� View and modify the suggested fix for the alarm, as explained in “To View and
Add Suggested Fixes” on page 192.

� View and add user notes about the alarm, as described in “To Add an Alarm
Note” on page 191.

� Modify a defined alarm action, as explained in “To Modify Pending Alarm
Actions” on page 196.

� Delete the alarm, as described in “To Delete Alarms” on page 190.

� To Access an Alarm for a Specific Managed Object
When an alarm icon appears next to a managed object icon in the main console
window, you can view the alarms for that specific object.

1. Double-click the managed object icon.

The Details window for that managed object appears with the Module Browser tab
selected.

2. Click the Alarms tab.

The Details window changes to show all open alarms for the current managed
object.
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� To Access Alarms From the Details Window

1. Press mouse button 3 on a host icon in the main console window, and choose
Details from the pop-up menu.

The Details window appears.

2. Click the Alarms tab.

The Alarms Details window appears.

Note – A bold header identifies the column on which the alarms table is sorted. A
down or up arrow indicates the order on which the column is sorted. For example,
the alarms table shown in Figure 12–2 is sorted in descending order (newest to
oldest alarm) based on the start date and time. This order is the default sort order
for the table.

FIGURE 12–2 Alarms Details Window
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For information about changing the sort order, see “To Sort the Alarms Table”
on page 187.

� To Sort the Domain Status Alarms
By default, alarms in the Domain Status Details window are sorted from newest to
oldest.

1. In the Domain Status Details window, click the Sort button.

The Sort Options window appears.

2. Determine whether to sort the alarms alphabetically or by time received:

� To sort alphabetically by status message, click Status Message (alphabetically).

� To sort the alarms by time received, newest to oldest, click Time (newest to
oldest).

3. Click the OK button.

The Domain Status Details window updates with any order changes as
appropriate.

� To Sort the Alarms Table

� Double-click any column header in the alarms table.

� If the alarms table is currently sorted in ascending order, the table is
redisplayed immediately in descending order, based on the column that you
select.

� If the alarms table is currently sorted in descending order, the table is
redisplayed immediately in ascending order, based on the column that you
select.

If the table contains many alarms, changing the sort order might take several
seconds.

The column headers have an down or up arrow to the right of the header. These
arrows indicate the order in which the table is sorted, descending (down arrow) or
ascending (up arrow). The arrow indicator and the selected column header are
boldface to identify current sort order. The following list identifies the default sort
order for each column heading in the alarm table.

Severity Alarms are sorted from highest severity (down) to lowest severity
(off or disabled).
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Start Time Alarms are sorted from newest to oldest.

Action Alarms are sorted as follows:

a. Alarms that have completed and executed actions
b. Alarms that have pending actions
c. Alarms that have no actions

State Alarms are sorted from open to closed.

Message Alarms are sorted alphabetically.

� To Update the Alarms Table
As new alarms are entered into the database, the currently displayed alarms table does
not change. This behavior is true regardless of whether these alarms affect the
currently displayed page. As existing alarms are deleted, the alarms table is updated
automatically.

� To update the alarms table, click the Refresh button.

The alarms table is updated to reflect the new alarms. The program recomputes the
division of pages to add the new alarms. The date and time of refresh are
displayed in the Last Refresh field.

� To Filter the Alarms Table

1. With the Alarms tab selected in the Details window, choose View Alarms from
the Options menu.

The View Specific Alarms dialog box appears.

Step
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FIGURE 12–3 View Specific Alarms Dialog

2. To select the items to include in the alarms table, click the boxes next to the
items.

A check mark is displayed in each box that you select. You can select the severity,
state, and acknowledgement status of the alarms displayed in the table.

3. Accept your selections.

� To accept your selections and close the View Specific Alarms dialog box, click
the OK button.

� To accept your selections and continue to display the View Specific Alarms
dialog box, click the Apply button.

The alarms table is filtered. The table is redisplayed to reflect your selections.

� To View a Log of Alarm Activity
The Sun Management Center software can show alarm activity in a log file. To view
the log, follow these steps:

1. In the Details window for the Sun Management Center server, click the View
Logs tab.

2. From the Choose Log File Type menu (the left-most icon at the top of the page),
select Sun Management Center Log.
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3. From the Sun Management Center Log list, select eventHistory.log.

The eventHistory.log file contents display in the window.

Managing and Controlling Alarms
You can manage and control the alarms displayed in the alarms table.

� To Acknowledge New Alarms
If you acknowledge alarms when the alarms occur, you can more easily track new
alarms. Unacknowledged alarms continue to be displayed in several locations:

� Domain Status Summary
� Hierarchy (tree) view
� Contents view
� Topology view
� Relevant row or relevant column in the property table (contents view)

1. In the Details Alarms window, select the appropriate alarm row.

The selected row is highlighted.

Tip – To select multiple rows in the table, use the Shift key or drag the cursor. To
select multiple, non-contiguous rows from the table, use the Control key.

2. Click the acknowledge button, which looks like a check mark.

The user ID, date, and time of acknowledgment are registered. A green check mark
appears next to the alarm icon in the Severity column. Information appears in the
Alarm Acknowledged On section of the Additional Alarm Information pane.

� To Delete Alarms
You should delete closed alarms to conserve space and to keep the alarms database
current.
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You can delete open alarms. If you delete open alarms, alarm information in the
Alarms windows might differ from alarm information in the hierarchy and topology
views. The alarms are removed from the view in the alarms table, but the alarm
condition might still exist. You should delete open alarms only if those alarms are
orphaned. An example of when this action might be required would be in the case of an
unloaded module. If the module has triggered alarms that were not closed before the
module was unloaded, the alarms are orphaned. If orphaned alarms remain in view,
you need to be delete those alarms manually.

Caution – You should only delete open alarms when there is no other way to remove
these alarms.

1. To delete all closed alarms, choose Delete All Closed Alarms from the Options
menu.

2. To delete only specific alarms:

a. With the Alarms tab selected in the Details window, click the appropriate
rows in the alarms table.

Tip – To select multiple rows in the table, use the Shift key or drag the cursor. To
select multiple, non-contiguous rows from the table, use the Control key.

b. Choose Delete Alarms from the Options menu.

A confirmation alert appears.

� To Add an Alarm Note
You can track the history of an alarm by adding notes to an expanding list of notes for
a specific alarm.

1. With the Alarms tab selected in the Details window, choose Edit Note from the
Options menu.

The Edit Alarm Note window appears. The window shows any existing notes.

2. Click the Add button.

The Add window appears.

3. Type your note in the text field of the Add window.
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4. Click the OK button to accept your changes and close the Add window.

The Edit Alarm Note window displays the following information:

� The date and time that you added the note
� The login identity that added the note
� The text of the note

� To View and Add Suggested Fixes
A default suggested fix might be displayed when a specific alarm is selected in the
alarms table. You can also provide your own suggested fix to accompany the default
suggestion.

1. With the Alarms tab selected in the Details window, select an alarm in the
alarms table.

2. Choose Edit Suggested Fix from the Options menu.

The Edit Suggested Fix window appears. If a Sun Management Center suggested
fix exists for this alarm, it is listed without a user identifier in the operator field.

3. To view the suggested fix, select the suggested fix in the Add window. Then,
click the View Alarms button.

A read-only window appears that displays the text for the suggested fix. To close
this window, click the Cancel button.

4. To add your own suggested fix for this alarm, click the Add button in the Edit
Suggested Fix window.

The Add window appears.

5. Type your suggested fix in the text field of the Add window.

The length of the suggested fix text is limited to 4000 bytes.

6. Click the OK button to accept your changes and close the Add window.

� To Notify Users When a Host or Agent Is Down
By default, the Sun Management Center software checks whether a host or agent is
not responding. However, no default action is defined in response to these conditions.

1. Select the managed object on which you want this action performed.
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Tip – To apply this action to all children of a managed object, select the parent
managed object. For example, to apply the action to all objects within a particular
subnet, select the subnet.

2. Press mouse button 3 and select Alarm Action from the pop-up menu.

The Alarm Action window appears.

3. To define an action for host not responding, click the Actions button next to Host
Not Responding.

The Action Selection window appears. To select or define an action, see “To Select
an Action” on page 196.

Tip – The Actions buttons are at the right side of the window. If you have made
your window smaller than expected, you might need to scroll to the right or
enlarge the window to access the button.

4. To define an action for agent not responding, click the Actions button next to
Agent Not Responding.

The Action Selection window appears. To select or define an action, see “To Select
an Action” on page 196.

5. (Optional) If the current managed object is the child of an object for which an
alarm action has been defined, choose whether to include group actions.

By default, host not responding and agent not responding actions apply to all
children. You can choose that a particular child should not share the group action.
Click the appropriate checkbox to disable the inherited action.

Note – The Include Group Actions section of the Alarm Action window appears
only for applicable child managed objects.

6. (Optional) To set the alarm action to apply only during certain times (for
example, during business hours only), click the Scheduler button.

a. To run the alarm action starting on a day other than today, provide a date in
the Start Date field.

You can edit the information in the Start Date field manually, or you can click
on a date in the calendar to select the date.
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b. Select an hour and minute from the pop-up menus next to Start Time.

Hours are based on a 24–hour clock. So, 16:00 is the same as 4:00 PM.

c. Select an hour and minute from the first pop-up menus next to End Time.

d. To allow this alarm action to occur more than once, choose how often it can
occur from the Repeat Interval pop-up menu.

For example, to permit an alarm action to occur only on weekdays, select
Mon-through-Fri.

e. (Optional) To limit how long the alarm action can be repeated, type a number
in the Repeat Limit field.

For example, to run this alarm action for a month, type 4 in the Repeat Limit
field when the word next to the field says “Weeks.” The word next to the
Repeat Limit field depends on your Repeat Interval choice.

Note – The alarm action is available indefinitely if you do both of the following:

� You select a Repeat Interval other than One Time.
� You do not provide a value in the Repeat Limit field.

f. Click OK to set this schedule, or click Cancel to exit from the Scheduler
window.

7. To complete the alarm action definition and exit from the Alarm Action window,
click the OK button.

� To Register an Alarm Action
Although alarms are defined, you need to tell Sun Management Center what to do
when the alarm condition is met. For example, you might want to have the software
send email notification to appropriate system administrators.

Note – You need to perform this procedure on the managed object (host) that you are
monitoring, not on system running the Sun Management Center server layer.

1. In the Attribute Editor, click the Actions tab.

The Attribute Editor Actions window is displayed.

2. Click the Actions button next to the action to be registered.

The Action Selection dialog box is displayed.
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3. Select the type of alarm action that you want to register.

� To send an email, follow these steps:

a. Select the Email button. Then, type the user name or alias to which to send
the message.

Tip – To send to more than one user name, separate the user names with a
space.

b. Type the message text.

� To perform an action other than sending an email, follow these steps:

a. Define a script that specifies the action. For more information, see “To Define
an Alarm Action Script” on page 197.

b. Select the Other button.
c. Choose a script to run from the list of available scripts.
d. Type any parameters that the script needs into the Arguments field.

� To clear the alarm, select Clear.

4. To set the action as you defined and close the Action Selection window, click the
OK button.

5. Click the OK button to accept the entries and close the Alarm Action dialog box.

The entry is displayed in the corresponding Action field of the Actions dialog box.

� To Run a Registered Alarm Action
You can initiate some alarm actions manually after an alarm occurs.

� Select one or more alarms with pending actions in the alarms table and click
Run.

The currently registered alarm actions for the alarm are started. The action state in
the alarms table changes from pending to executed. For additional details, see “To
Modify Pending Alarm Actions” on page 196.

Note – Several seconds can be needed for the action state in the alarm table to
update.
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� To Modify Pending Alarm Actions
For alarms with no registered actions, a “no action” icon is displayed in the Actions
column of the alarms table. For alarms with a manual action, the “pending” icon is
displayed until the user runs the action. Then, the “executed” icon is displayed. For
alarms with an automatic action, the “executed” icon is always displayed.

1. With the Alarms tab selected in the Details window, select an alarm that has a
pending action in the Alarms table.

2. Choose Modify Action from the Options menu.

The Action Selection dialog box is displayed. Only alarms that are pending manual
action can be modified.

3. Select the action that you want to modify and make the necessary changes as
described in “To Select an Action” on page 196.

� To Select an Action
When an alarm condition is met, you can choose to send an email, perform some other
action, or clear the alarm.

1. To send an email, follow these steps:

a. Select the Email button.

b. Type the user name or alias to which to send the email message in the To
field.

Tip – To send to more than one user name, separate the user names with a
space.

c. Type the message text in the Message field.

2. To perform an action other than sending an email, follow these steps:

a. Select the Other button.

b. Select a script to run from the list of available scripts.

For information about creating a script to run, see “To Define an Alarm Action
Script” on page 197.

c. Type any parameters that the script needs into the Arguments field.
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3. To set the alarm to be cleared as the action, select the Clear button.

4. To set the action as you defined and close the Action Selection window, click the
OK button.

� To Define an Alarm Action Script
The following procedure describes how to customize an alarm action to notify a user
when an alarm condition occurs.

1. Create your custom alarm action script, using the following optional arguments:

%statusfmt The alarm severity, such as Warning, Critical, and so on.

%statusstringfmt The complete alarm string, including severity. For
example: Critical: Machine A Kernel Reader Number of
User Sessions > 10.

2. At the command-line level, become superuser.

# su -

3. Install the script in the home Sun Management Center directory.

The default is the /var/opt/SUNWsymon/bin/ directory. For example:

# cp custom-alarm-script /var/opt/SUNWsymon/bin/

4. Click the Module Browser tab in the Details window.

5. Set the alarm threshold.

For more information, see “Example: To Define and Respond to an Alarm” on page
198.

6. Open the Attribute Editor for the property to which you want this script to apply.

7. Click the Actions tab.

The action rows are displayed.

8. Type custom-alarm-script %statusstringfmt in the Critical Action field of the
Actions panel.

9. Ensure that the Automatic check box on the Critical Action line is selected.

By default, your script will execute automatically.

10. To apply this action script and close the Attribute Editor window, click the OK
button.
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Alarm Management Examples
There are many methods that you can use to define and manage alarms. Here are a
few examples to better illustrate how you might perform these functions in your
environment.

� Example: To Define and Respond to an Alarm
This example illustrates how to create and acknowledge a simple critical alarm when
the memory usage on the specified system exceeds 50%.

1. Access the Details window for the managed object on which you want to define
the alarm.

2. Click the Module Browser tab in the Details window.

3. Click the expansion icon next to the Operating System icon in the hierarchy tree
view.

The Operating System modules are displayed.

4. Click the expansion icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

5. Double-click the Memory Usage Statistics icon.

The Memory Usage Statistics properties table is displayed in the contents view.

6. Select the table cell for % Memory Used.

Tip – If the Attributes button is unavailable and is dimmed when you select the
table cell, verify that you selected the data cell not the label cell.

7. Click the Attributes button.

The Attribute Editor window is displayed.

8. Click the Alarms tab.

The Alarms panel appears on which you can define threshold values for Critical,
Caution, and Alert alarms.
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9. Type 50 in the Critical Threshold (>) field.

A critical alarm will be generated when the memory usage exceeds 50% on the
selected managed object.

Note – This example uses a low threshold to create an alarm immediately.
Normally, you might generate alarms according to the following criteria:

� An alert alarm when the usage exceeds 50%
� A caution alarm when the usage exceeds 65%
� A critical alarm when the usage exceeds 80%

10. Click the OK button to apply your changes and close the Attribute Editor
window.

Almost immediately, the % Memory Used data field in the table turns red. In
addition, red alarm icons are displayed on the Operating System, Kernel Reader,
and Memory Usage Statistics folders and icons. If the red icon does not appear,
verify whether your system has an open, unacknowledged black alarm.

11. Click the Alarms tab in the Details window.

The alarm that you created is listed in the alarms table. See Chapter 12 for more
information.

12. Click the Acknowledge button to acknowledge this alarm.

Tip – The Acknowledge button looks like a check mark.

13. Create additional alarm thresholds, and familiarize yourself with their
operation.

Once you have created these alarms, you can set up security permissions so that
another Sun Management Center software user cannot change your alarm
thresholds. For more information about security, see Chapter 18.

Note – You do not need to fill in alarm information for all alarm thresholds. For
example, you might choose to create only a critical alarm threshold.

This example illustrates creating a situation where an alarm is registered if a value
exceeds the alarm limit. Table 10–1 lists other common alarm limits in the software.
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� Example: To Send an Email
This example sets up an email to be sent when the system load average exceeds the
threshold.

When an alarm condition is met, sending an email message is a good solution in most
situations. However, if a router or an uninterruptible power supply (UPS) is down,
your email message would not be sent.

You might consider setting up a pager alarm to send an alarm message to a terminal
and to a pager through a modem for such failures. For more information, investigate
quick paging or instant paging solutions.

1. Click the Module Browser tab in the Details window.

2. Click the expansion icon next to the Operating System icon in the hierarchy tree
view.

The Operating System modules are displayed.

3. Click the expansion icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Select the table cell for Load Averages Over the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Actions tab.

The Action Selection screen appears.

8. Click the Email radio button to activate the To and Message fields.

9. Type the usernames in the To field and the message in the Message field.

10. Click OK to accept the changes that you made and close this window.

The following email is sent to the usernames whenever the load averages alert
alarm occurs.

Date: Wed, 30 Jun 2000 15:25:39 -0800
From: root@MachineB (0000-Admin(0000))
Subject: Sun Management Center - Alert Alarm Action
Mime-Version: 1.0

Sun Management Center alarm action notification ... {Alert:
machineB Kernel Reader Load Average Over The Last 5 Minutes > 0.01Jobs}

Before You
Begin
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CHAPTER 13

Managing Group-related Jobs

The Manage Jobs function enables you to define a task request or collection of
attribute settings that applies to a user-defined group of objects. The following topics
are described in this chapter:

� “Job Management Concepts” on page 201
� “To Define a Job” on page 203
� “To View Job Status” on page 204
� “Using Filters” on page 216
� “To Define a Task” on page 207
� “To Create a Module Task” on page 208
� “To Create a Data Property Task” on page 210
� “To Create a Module Table Task” on page 212
� “To Create a Configuration Task” on page 213
� “To Update the File Set for a Configuration Task” on page 214
� “To Create an Agent Update Task” on page 215
� “To Schedule a Job” on page 205
� “To Modify a Task” on page 216
� “To Modify a Filter” on page 219
� “To Suspend a Running Job Request” on page 206
� “To Delete a Job Request” on page 206
� “To Delete a Task” on page 216
� “To Delete a Filter” on page 219

Job Management Concepts
A job consists of a task or activity and a set of filtering criteria used to define the
objects to which that task applies. You can submit a job to run when you define the
job. Alternatively, you can schedule a job to run at a specific time or on a repeating
schedule. For example, you might define a job that sets several attributes for several
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data properties that apply to several modules. Another example of a job might be to
set a single attribute for several hosts within a domain. The remainder of this chapter
describes how to define, schedule, and manage jobs.

Manage Jobs Window
You use the Manage Jobs window to define and schedule jobs. For any defined jobs,
the Manage Jobs window displays the following information:

� Job name

� Date and time that the task was added to the server database

� Domain to which the job applies

� Name of any filter that applies to the job

� Indication of whether the job is run at user request or according to a periodic
schedule

� Current state of the job

Features in the Manage Jobs window enable you to define and modify jobs. For more
information, see the following tasks:

� “To Define a Job” on page 203
� “Using Filters” on page 216
� “To Define a Task” on page 207
� “To Create a Module Task” on page 208
� “To Create a Data Property Task” on page 210
� “To Create a Module Table Task” on page 212
� “To Create an Agent Update Task” on page 215
� “To Schedule a Job” on page 205
� “To Modify a Task” on page 216

Creating and Managing Jobs
A job consists of a task or activity and a set of filtering criteria used to define the
objects to which that task applies. This section describes how to define, schedule,
suspend, and delete jobs.
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� To Define a Job

Note – This procedure describes the main steps that you follow to create a job request.
Individual steps are explained in further detail in the referenced procedures.

1. Choose Manage Jobs from the Tools menu in the main console window.

2. Type a unique name for the job in the Job Name field.

The name should describe the job. For example, if the job is to load the Directory
Monitoring module, the name could be Load Directory Monitoring.

3. Specify the initial set of managed objects to which this job applies.

� To apply this job to all objects within the current domain, select All Objects in
Domain.

� To select objects manually, select Selected Objects in Main Window.

Note – You can select objects before you define the job. Alternately, you can go
to the topology area of the main console window to select the objects now. In
either case, you must select topology objects before you submit this job.

� To use objects that were selected previously for this job, select Objects
Previously Selected in Main Window.

Note – This feature applies only to jobs that are being modified. For new jobs,
this feature is unavailable and is dimmed.

4. To limit the managed objects even further, specify a filter.

� Click the New Filter button to limit this task to objects that use a specific
operating system version, platform, or other specified criteria.

The New Filter window appears from which you define the filter. See “Using
Filters” on page 216 for more information.

� Choose a defined filter from the Filter menu.

5. To see what objects would be selected by the defined filter, click Preview
Objects.

6. Specify the action for the job to execute.

� Click New Task to define a task.
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The New Task window appears from which you define the task. See “To Define
a Task” on page 207 for more information.

� Choose a defined task from the Task menu.

7. Determine whether to run the job immediately or to schedule the job.

� To run this job when you have finished defining it, click the radio button next to
Run Job Immediately.

� To schedule this job to run, click the radio button next to Schedule Job, then
click Set Schedule to access the scheduling function.

For more information about scheduling a job, see “To Schedule a Job” on page
205.

8. To complete the definition of this job, click Add Job.

Tip – To clear all fields in the job, click Reset Form.

� To View Job Status
The Jobs section of the Manage Jobs window shows a brief status for current jobs.

1. To view more detailed job status, select the job from the Jobs section of the
Manage Jobs window.

2. Click the View Log button.

A window appears that displays detailed information about the selected job.

Tip – If the View Log window is mostly empty, the job probably has not finished.
Exit from the View Log window. Wait until the status in the Manage Jobs window
no longer says “Running” before you reopen the View Log window.

The View Log window provides the following information about the selected job:

� The name, type, and description for the task
� The domain in which the job was run
� The date and time that the job was run
� The overall job status
� The length of time it took for the job to run
� The user name of the user that requested the job
� A list of managed objects to which the job applies
� For each managed object in the job, information about job activities and status
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3. To view more information about the job status for a specific managed object,
select the object in the Domain Object Status section of the View Log window.

Specific information about the job status as it relates to the selected object appears
in the Domain Object Status Details section of the window.

� To Schedule a Job
A similar Scheduler window is used for defining schedules for module loading and
enabling, group-related jobs, alarm monitoring, and Discovery requests.

1. To set this job to begin on a day other than today, type a date in the Start Date
field.

To select a date from the calendar, click the date. To change the month, use the left
and right arrows at the top of the calendar.

2. Select an hour and minutes from the Start Time menu.

Hours are based on a 24–hour clock. For example, 16:00 is the same as 4:00 PM.

Note – You cannot schedule two jobs with MCP configuration tasks at the same
time. If you are scheduling a job with an MCP configuration task, make sure the
scheduled time is different from any previously scheduled jobs with MCP
configuration tasks. If you schedule two jobs for the same time, the job scheduled
first is executed. The second job scheduled for the same time is ignored.

3. (Optional) Choose how often the action should occur from the Repeat Interval
menu.

You can schedule a task to occur more than once. For example, to schedule a task
to run weekly, you would select Weekly.

Note – Repeat Interval values differ by scheduling activity.

4. (Optional) Select an appropriate time reference from the Repeat Interval menu.
Then, type a number in the Repeat Interval field.

You can run the action for a specific number of repeated intervals. For example, to
run a task for the next two months, select Months from the Repeat Interval menu
and type 2 in the Repeat Interval field.
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Note – Some time intervals, such as Weekly, do not allow you to specify Repeat
Intervals. In those cases, you cannot type a value in the Repeat Interval field.

5. Click OK to set this schedule.

� To Suspend a Running Job Request
You can stop a job from running and restart the job later. For example, if you have
major system maintenance that is going to be performed, you might want to
temporarily disable some alarm processing.

1. In the Manage Jobs window, select the task request that you want to suspend
from the list of jobs.

2. Click the Suspend Job button.

� If the job is running, the value in the State column changes to Suspended.

� If the job is not running (for example, the current State is Queued), nothing
appears to happen.

3. To restart a suspended job, select the job and click the Resume Job button.

� To Delete a Job Request

1. In the Manage Jobs window, select the job that you want to delete from the list
of jobs.

2. Click the Delete Job button.

A Delete confirmation window appears to remind you that deleting the job is a
permanent action.

3. To permanently delete the job, click the Delete button.
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Creating and Modifying Tasks
A task is the actual action that you want to have performed for the job. This section
describes how to create, change, and delete tasks.

� To Define a Task

1. Choose Manage Jobs from the Tools menu in the main console window.

The Manage Jobs window appears.

2. Click New Task.

The New Task window appears.

3. Type a name for the task in the Task Name field.

The task name should describe the task. For example, if you are defining a task to
load a specific module, the task name might be Load Directory Monitoring
Module.

4. Select the type of task that you want to create from the Task Type menu.

The task type that you select determines the remaining information on the New
Task window.

5. Follow the steps as appropriate for your task type.

The following task types are available:

� Module task – Load, enable, disable, unload, or change security settings for
modules. See “To Create a Module Task” on page 208.

� Data Property task – Set alarm thresholds and actions, set intervals for
refreshing data or write the data to history logs. See “To Create a Data Property
Task” on page 210.

� Module Table task – Add, remove, or change information in module tables. See
“To Create a Module Table Task” on page 212.

� Configuration task – Copy a set of module configuration files and scripts from a
source host to others. See “To Create a Configuration Task” on page 213.

� Agent Update task – Update agents by using an update image file. See “To
Create an Agent Update Task” on page 215.

6. (Optional) Type a description for this task.

7. To confirm the definition of this task, click Add Task.

You remain in the New Task window to define additional tasks.
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To redefine the task, click Clear Form.

8. When you have finished defining your tasks, click Close to close the New Task
window.

� To Create a Module Task
A module task enables you to schedule the following actions for a group of modules:

� Load
� Unload
� Enable
� Disable
� Change security settings

Note – A single module task can include module actions for several modules.

1. In the New Task window, type a name for the task in the Task Name field.

The task name should describe the task. For example, if you are defining a task to
load a specific module, the task name might be Load Directory Monitoring
Module.

2. Choose Module from the Task Type menu.

3. Choose a module name from the Module menu.

If the selected module is a multi-instance module, a window appears in which you
type the module instance name.

The instance name is used within the Sun Management Center agent to identify
uniquely a particular module or a row within a module. You must specify a unique
name for each instance when multiple instances of the same module are loaded.

An instance name is a single word or alphanumeric string. The only special
character allowed in an instance name is the underscore (_).

4. Choose an action to perform for this module from the Module Action menu.

The following actions are available, depending on the current state of the selected
module:

� None – Enables you to modify the security for the selected module
� Load – Loads the module
� Enable – Enables the module
� Disable – Disables the module
� Unload – Unloads the module
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The action that you choose determines which buttons to the right of the module
task table are active (bold font) or inactive (grayed out). In addition, the Load
Parameters window appears automatically when you choose to load a module.

� Load Parameters – Active only if Load is the selected Action
� Set Schedule – Active if Load or Enable is the selected Action
� Set Security – Active if Load or None is the selected Action
� Delete Entry – Always active

5. To define the load parameters for the module, click the Load Parameters button.

The Module Loader window appears. Appropriate information is displayed for the
selected module. For more information, see Chapter 11.

Note – This button is active only if Load is the selected action.

6. To set a time to perform the requested module action, click the Set Schedule
button.

The Scheduler window appears, in which you define the schedule for loading and
enabling this module. For more information, see “To Schedule a Job” on page 205.

Note – You can also set the schedule for when the overall task is to be performed in
the Manage Jobs window. The Scheduler window differs slightly when scheduling
a module task as opposed to scheduling a job. For a module task, you must specify
an end time. Also, you use slightly different Repeat Interval values for the module
task.

This button is active only if the selected action is either Load or Enable.

7. To define security parameters for the selected module, click the Set Security
button.

The Attribute Editor window appears. Current security information is displayed
for this module. For additional information about the Attribute Editor, see
Chapter 10. For more information about security, see Chapter 18.

Note – This button is active only if the selected action is either Load or None.

8. (Optional) Because a module task can include actions for several modules,
repeat the preceding five steps until you have identified all the modules and
their associated actions for this task.
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Tip – To remove a module and its associated actions from the module list for this
task, select the module and click Delete Entry.

9. (Optional) Type a description for this task.

10. To confirm the definition of this task, click Add Task.

You remain in the New Task window to define additional tasks.

To clear the data for the existing task so that you can define another task, click
Reset Form.

11. When you have finished defining your tasks, click Close to close the New Task
window.

� To Create a Data Property Task
A data property task enables you to set a threshold for a particular data property, for
example alarm thresholds and actions, across a group of objects.

1. In the New Task window, type a name for the task in the Task Name field.

The task name should describe the task. For example, if you are defining a task to
set some alarm thresholds, the task name might be Set threshold for memory
usage alarm.

2. Choose Data Property from the Task Type menu.

3. Click Select Property.

The Select Property window appears.

4. Select a data property from the list.

Note – The initial list of data properties is a hierarchical list. You need to expand the
list several levels to get to an individual selectable data property.

The content of the Select Property window differs according to the property that
you select. The next series of steps explains the different possible items that you
might need to specify.

a. If there can be more than one instance of this module, type the instance name
in the Module Instance field.

The instance name is used within the Sun Management Center agent to identify
uniquely a particular module or a row within a module.
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An instance name is a single word or alphanumeric string. The only special
character allowed in an instance name is the underscore (_).

b. If the data property can apply to more than one object of the same type,
determine whether the task applies to all indices of the selected property or
only to a specific index value of the selected property.

c. To apply the task to a Specific Property Index, provide a unique value in the
property index field.
The labels and fields beneath the selection buttons differ according to the
specific data property. In some instances, you might have one field in which
you can enter one index. In other instances, you might have multiple fields in
which to enter a range of index values.

For example, if you choose the CPU Number data property and you have an
environment in which you have several CPUs, you might want to apply the
task only to a specific CPU number. If you do not specify an index, the property
updates on all CPUs.

On the other hand, if you choose the TCP Connection property, you have four
fields in which to enter data. You must supply values in all four fields to enable
this task.

5. When you have provided all the information for this data property, click Apply.
Continue to add properties until you have identified all the data properties that
you want to use.

6. To close the Select Property window, click Close.
The data properties are added to the selected properties table. The Select Property
window closes. You return to the New Task window.

7. To define additional attributes for the specified data properties, select the data
property entry in the table in the New Task window. Then, click Set Attributes.
The Attribute Editor appears. You can define alarm, alarm action, refresh interval,
or history log behavior. For more information, see Chapter 10 and Chapter 12.

8. To remove a data property from the selected properties table, select the data
property entry in the table. Then, click Delete Entry.
A confirmation window appears from which you can accept or reject the removal.

9. (Optional) Type a description for this task.

10. To confirm the definition of this task, click Add Task.
You remain in the New Task window to define additional tasks.

To clear the data for the existing task so that you can define another task, click
Reset Form.

11. When you have finished defining your tasks, click Close to close the New Task
window.
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� To Create a Module Table Task
Some Sun Management Center modules can only monitor an entity once the data
parameters for that entity have been made known to the module. For example, for the
File Monitoring module to function appropriately, you need to identify several specific
items:

� The name of the file to be monitored
� A description of the file
� A table row index for displaying that information in the File Monitoring table

A module table task enables you to add entries as table rows to a group of module
tables.

1. In the New Task window, type a name for the task in the Task Name field.

The task name should describe the task. For example, if you are defining a task to
monitor specific file, the task name might be Add monitoring for .cshrc
file.

2. Choose Table from the Task Type menu.

3. Select the module to which this task applies from the Module Table menu.

If the selected module is a multi-instance module, a window appears in which you
type the module instance name.

4. Add a row, or modify or delete a row.

� To add a row to a table, choose Add Row from the Table Action menu, and
provide required values in the Add Row window as needed.

For example, you might need to provide a Name (for example, CheckLog),
Description (for example, log file), and a Filename (for example,
/var/opt/SUNWsymon/cfg/sfix.log).

� To modify a row in a table, choose Edit Row from the Table Action menu and
modify values in the Edit Row window as needed.

For example, you might need to change the name of the file that is being
monitored.

Note – The index value that you provide here must match an index value for an
existing row in the table. If the value does not match, nothing will match to be
modified.

� To remove a row, choose Delete Row from the Table Action menu.

In the Delete Row window, provide name, description, and file name
information that exactly matches the row as the row currently exists in the
table.
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5. (Optional) Type a description for this task.

6. To confirm the definition of this task, click Add Task.

You remain in the New Task window to define additional tasks.

To clear the data for the existing task so that you can define another task, click
Reset Form.

7. When you have finished defining your tasks, click Close to close the New Task
window.

� To Create a Configuration Task
A Configuration task enables you to copy scripts and module configuration files from
one host to another host or to a group of hosts.

Note – To copy these files, you must be authorized as an Module Configuration
Propagation (MCP) user. By default, any server esadm group member is an MCP user.
To limit script propagation through MCP to specific users, you need to add users to
the es-mcp-users file. To add users to the file, use the following command on the
agent systems:

# es-config -m

1. In the New Task window, type a name for the task in the Task Name field.

The task name should describe the task. For example, if you are defining a task to
copy just scripts from one host to several, the task name might be Copy scripts
from myhost.

2. Choose Configuration from the Task Type menu.

The New Task window changes to display appropriate information for a
Configuration task.

3. Type the source host from which you want to copy in the Source Host Name
field.

The source host must be an agent in the current server context. You can identify the
source host either by its name as known to the server or by its IP address.

4. To define the files to be copied, click Edit File Set.

The New File Set window appears.

a. To add the configuration files for a specific module to be copied, select the
module name from the list of Available Modules. Then, click Add.

The selected module name moves from the list of Available Modules to the list
of Selected Modules.
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b. To add a script to be copied, select the script name from the list of Available
Scripts, then click Add.

The selected script name moves from the list of Available Scripts to the list of
Selected Scripts.

c. When you have added all the modules and scripts that you want included in
this set of files, click OK.

5. To specify which parts of the source configuration are to be copied, click Set
Options.

The Set Options window contains a series of radio buttons, grouped by related
pairs. You can select one option of a related pair. For example, you can use the
module security settings either from the source host or the destination host, but not
both.

By default, the following options are selected:

� Deploy to all destination hosts
� Load on all destination hosts
� Use module parameters on destination host
� Use module schedule on source host
� Use module security settings on source host

6. When you have set the options, click OK to close the Set Options window.

7. (Optional) Type a description for this task.

8. To confirm the definition of this task, click Add Task.

You remain in the New Task window to define additional tasks.

To clear the data for the existing task so that you can define another task, click
Reset Form.

9. When you have finished defining your tasks, click Close to close the New Task
window.

� To Update the File Set for a Configuration Task
The data in the file set that is defined for a configuration task is stored on the server.
Over time, the various files that comprise a file set on a given source host might
change.

1. From the Manage Jobs window, click New Task.

2. Select the Configuration task for the source host for which you want to update
data.

3. Click the Synchronize File Set Content button.
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Note – This button is disabled until a file set is defined.

The file set on the server is resynchronized with the file set on the source host.

Note – Resynchronizing the file set does not propagate the changed contents. To
distribute the changed file set to the target hosts, you must re-run the task.

� To Create an Agent Update Task
An Agent Update task enables you to define and schedule software updates to agent
systems.

1. Create an Update Image file.

Use the es-imagetool or es-gui-imagetool utilities as described in Sun
Management Center 3.6 Installation and Configuration Guide.

2. In the New Task window, type a name for the task in the Task Name field.

The task name should describe the task. For example, if you are defining a task to
install the latest version of the software on all agents, the task name might be
Update agents to latest management center software.

3. Choose Agent Update from the Task Type menu.

4. Choose an image file from the Image File menu.

Note – If choices in this menu are unavailable, there are no Update images defined.
See Step 1.

When you chose an image file, information about its contents appears in the Image
Contents section of the New Task window.

5. (Optional) Type a description for this task.

6. To confirm the definition of this task, click Add Task.

You remain in the New Task window to define additional tasks.

To clear the data for the existing task so that you can define another task, click
Reset Form.

7. When you have finished defining your tasks, click Close to close the New Task
window.
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� To Modify a Task

1. In the Manage Jobs window, select New Task.

2. In the New Task window, select the name of the task that you want to change in
the Tasks list.

3. Make the necessary changes.

The task types are described in the following sections:

� “To Create a Module Task” on page 208
� “To Create a Data Property Task” on page 210
� “To Create a Module Table Task” on page 212
� “To Create a Configuration Task” on page 213
� “To Create an Agent Update Task” on page 215

4. To save your changes, click Update Task.

5. To close the New Task window, click Close.

6. To apply the changed task, click Update Job in the Manage Jobs window.

� To Delete a Task

1. In the Manage Jobs window, click New Task.

2. In the New Task window, select the task that you want to delete from the list of
Tasks.

3. Click the Delete Task button.

A Delete confirmation window appears to remind you that deleting the task is a
permanent action.

4. To permanently delete the task, click Delete.

5. To exit from the New Task window, click Close.

Using Filters
Filters enable you to act on objects according to some criteria that you define, rather
than having to explicitly select those objects.
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� To Define a Filter

1. Click the New Filter button in the Manage Jobs window.

The New Filter window appears.

2. Type a name in the Filter Name field.

This name should describe the filter, such as Solaris8.

The next several steps explain how to define various filtering criteria. These criteria
are used together to select the objects. For example, if you define a platform filter
and an operating system filter, the managed object would need to match both
criteria to be selected.

3. To choose objects based on their labels, select Filter on Object Label and type a
text string to be matched.

To control the level of matching that occurs, use one of the following keywords:

� Contains – Equivalent to *text*, matches any object whose label contains the
specified string. Contains is the default behavior.

� Starts with – Equivalent to text*, matches any object whose label starts with
the specified string.

� Ends with – Equivalent to *text, matches any object whose label ends with the
specified string.

Tip – For an exact match, type the text string, then click Exact Match.

4. To choose objects based on the hardware platform, select Filter on Platform
Types.

a. Select the platform type from the list on the left.

b. To add this type to the filtering criteria, click the Add button.

c. To exclude rather than include objects based on the platform type, select
Exclude.

d. To remove a platform filter, select the platform type in the list on the right,
then click the Remove button.

5. To choose objects based on the operating environment, select Filter on Operating
Systems.

a. Select the operating environment from the list on the left.

For example, to include all systems that are running Solaris 2.6, select SunOS
5.6.
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b. To add this operating environment to the filtering criteria, click the Add
button.

c. To exclude rather than include objects based on the operating environment,
select Exclude.

d. To remove an operating environment filter, select the operating environment
from the list on the right. Then, click the Remove button.

6. To choose objects based on the modules that are loaded on that system, select
Filter on Modules Loaded.

a. Select the module from the list on the left.

For example, to include all systems on which the Kernel Reader is loaded, select
Kernel Reader (Simple).

b. To add this module to the filtering criteria, click the Add button.

c. To exclude rather than include objects based on the loaded modules, select
Exclude.

d. To remove a module filter, select the module from the list on the right, then
click Remove.

7. To choose objects based on their IP addresses, click the box next to Filter on IP
Addresses.

a. Type an IP address from which to start including objects.

For example, to include only those objects whose IP address is between
186.255.255.240 and 186.255.255.254, you would type 186.255.255.240.

b. Type an IP address at which to stop including objects.

For example, to include only those objects whose IP address is between
186.255.255.240 and 186.255.255.254, you would type 186.255.255.254.

8. (Optional) Type a description for this filter.

9. To confirm the definition of this filter, click Add Filter.

You remain in the New Filter window to define additional filters.

To clear the data for the existing filter so that you can define another filter, click
Reset Form.

10. When you have finished defining your filters, click Close to close the New Filter
window.
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� To Modify a Filter

1. In the Manage Jobs window, click the New Filter button.

2. In the New Filter window, select the filter that you want to change in the Current
Filters list.

3. Make the necessary changes.

See “Using Filters” on page 216 for more information about filters.

4. To save your changes, click Update Filter.

5. To close the New Filter window, click Close.

6. To apply the changed filter, click Update Job in the Manage Jobs window.

� To Delete a Filter

1. In the Manage Jobs window, click New Filter.

2. In the New Filter window, select the task that you want to delete from the list of
Current Filters.

A deletion confirmation window appears to remind you that deleting the filter is a
permanent action.

3. To permanently delete the filter, click Delete.
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CHAPTER 14

Dataviews

This chapter provides the following information:

� “Dataview Contents” on page 222
� “Creating a Dataview” on page 222
� “Working With Dataviews” on page 225
� “Navigating Through a Dataview Window” on page 222
� “Types of Dataviews” on page 226

Overview of Dataviews
Dataviews are customized data property tables. You can create dataviews for any of
the following data:

� One type of data from several different hosts within a single domain
� Several types of data from one host
� Several types of data from different hosts within a single domain

An example of the first concept is a dataview that monitors CPU usage in group of
hosts. An example of the second concept is a dataview that monitors disk space and
CPU usage on one host.

Note – Dataviews allow you to combine information from different hosts within a Sun
Management Center domain; however, you cannot create a dataview that combines
data from different domains.
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Dataview Contents
The data that is used to create a dataview is copied from different sources, including:

� Tables
� Modules
� Hosts

Dataviews are an excellent way of monitoring a collection of unrelated information.
Because these views are presented in a table, a variety of data can be easily compared.
Dataviews are created once and are refreshed automatically. Dataviews have all the
features of module tables, except that cells cannot be edited. In dataviews, alarm status
is correctly propagated. Cells that have triggered a critical alarm appear in red.

When you create a dataview, the dataview is stored in the database. The dataview
persists until you explicitly delete the dataview. In addition, because dataviews are
stored in the database, dataviews can be shared. Any dataview that is built on a
particular Sun Management Center server can be viewed by all authorized users on
that server.

Navigating Through a Dataview Window
The dataview window contains the following main menu items:

� File, which enables you to save the current dataview to a name or to close the
current dataview

� Edit, which enables you to paste a dataview from the clipboard or to delete
selected rows

� Tools, which provides direct access to the Attribute Editor for the selected cell

� Help, which displays online help

Creating a Dataview
From the Details and console windows, there are two options to create a dataview:

� Create a Dataview
� Copy to the Dataview Clipboard
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� To Create a Dataview From the Context Pop-up
Menu

1. Open the Details window for the host in which you are interested.

The Module Browser view appears in the Details window.

2. Click the expansion icon next to the items in the hierarchy down to the desired
data property.

3. Press mouse button 3 on a row or cell in the data property table. Then, choose
Create Dataview from the pop-up menu.

4. Select Cell or Row(s) as appropriate.

An automatically populated dataview window appears.

� To Create a Dataview From the Options Menu

1. Open the Details window for the host in which you are interested.

The Module Browser view appears in the Details window.

2. Click the expansion icon next to the items in the hierarchy down to the desired
data property.

3. In the data property table, select a row or a cell.

4. From the Options icon menu, choose Create Dataview.

Tip – The Options icon menu is the second from the left icon above the hierarchy
view. This icon looks like a list with a check mark.

5. Select Cell or Row(s) as appropriate.

An automatically populated dataview window appears.

� To Copy to the Dataview Clipboard From the
Details Window

1. Press mouse button 3 on a row or data cell in a data property table. Then, choose
Copy to Dataview Clipboard from the pop-up menu.

2. Select Cell or Row(s) as appropriate.
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3. To add the copied information to an existing dataview, follow these steps:

a. Open an existing dataview as explained in “To Open an Existing Dataview”
on page 225.

b. From the Edit menu, choose Paste from Clipboard.

4. To add the copied information to a new dataview, follow these steps:

a. In the Details window, click the Dataview icon.

Tip – The Dataview icon is the third icon from the right above the data property
table.

An empty Dataview window appears.

b. From the Edit menu, choose Paste from Clipboard.

� To Copy to the Dataview Clipboard From the
Console Window

1. Select a row or data cell in a data property table.

2. Press mouse button 3 and choose Copy to Dataview Clipboard from the pop-up
menu.

3. Select Cell or Row(s) as appropriate.

4. To add the copied information to an existing dataview, follow these steps:

a. Open an existing dataview as explained in “To Open an Existing Dataview”
on page 225.

b. From the Edit menu, choose Paste from Clipboard.

5. To add the copied information to a new dataview, follow these steps:

a. In the Console window, choose Dataview Manager from the Tools menu.

The Dataview Manager window appears.

b. Click the Create button.

An empty Dataview window appears.

c. From the Edit menu, choose Paste from Clipboard.

Steps

224 Sun Management Center 3.6 User’s Guide • December 2005



Working With Dataviews
The procedures in this section explain how to open, save, or delete a dataview.

� To Open an Empty Dataview Window

1. In the console window, choose Dataview Manager from the Tools menu.

The Dataview Manager window appears.

2. Click the Create Button.

An empty Dataview window appears.

� To Open an Existing Dataview

1. In the Dataview Manager window, select the name of the dataview that you
want to open.

2. Click the Open button.

� To Delete a Dataview

1. In the Dataview Manager window, select the name of the dataview that you
want to delete.

2. Click the Delete button.

Note – A Delete confirmation window appears to remind you that deleting a
dataview is a permanent action.

� To Save a Dataview

1. In the Dataview window, choose Save from the File menu.

The Save Dataview window appears. You can type an optional description in the
Description field.

2. Click the Save Dataview button.

Steps
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Note – If the name that you have chosen for this dataview exists, a Warning
window appears.

Types of Dataviews
There are two types of Dataviews:

� Scalar
� Vector

Scalar Dataviews
A scalar dataview is created from scalar data items, which are single cells from scalar
or vector tables. A scalar dataview includes the following three columns:

� Host Name

� Data Property Name

� Value

Note – The Data Property Name column contains the name of the property for the
data item in the following format: module/object/property.

� To Create a Scalar Dataview
The following example uses the CPU Utilization table.

1. In the Details window, navigate to the CPU Utilization table.

2. Select a data cell in the table.

3. Copy the data cell to the dataview clipboard in either of the following ways:

� From the Options menu, choose Copy to Dataview Clipboard Cell(s) or Create
Dataview Cell(s).

� In the Details window, press mouse button 3 on the table and select Copy to
Dataview Clipboard Cell(s) from the pop-up menu.

For additional information about the Copy to Dataview Clipboard and the Create
Dataview options, see “Creating a Dataview” on page 222.

Steps
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Vector Dataviews
The vector dataview contains one or more rows from a vector module table. You can
simultaneously select one row or multiple rows from a vector table. You can select
multiple rows that are not contiguous. For example, you could select the following
rows:

� Row number 1
� Row number 3
� Row number 4
� Row number 6

You cannot select partial rows.

Caution – Do not paste rows from vector and scalar tables into the same dataview
window.

� To Create a Vector Dataview
The following example uses the CPU Utilization table.

1. In the Browser Details window, navigate to the CPU Utilization table.

2. Select a row in the table.

Tip – To select multiple rows in the table, use the Shift key. To select multiple,
non-continuous rows from the table, use the Control key.

3. To copy the data rows to the dataview clipboard, proceed with one of the
following:

� From the Options menu, choose Copy to Dataview Clipboard Row(s) or Create
Dataview Row(s).

� In the Details window, press mouse button 3 on the table and select Copy to
Dataview Clipboard Row(s).

For additional information about the Copy to Dataview Clipboard and the Create
Dataview options, see “Creating a Dataview” on page 222.
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Caution – You can only paste compatible data types. If you try to paste an
incompatible data type, an error dialog box appears.
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CHAPTER 15

Managing Objects Using the Web
Console

The Sun Management Center web console provides many of the same host
management functions as the Sun Management Center Java Console provides. You can
use the web console to monitor and manage alarms and modules. You can also use the
web console to navigate the managed object topology. This chapter covers the
following topics:

� “Web Console Features and Functions” on page 229
� “Overview of Main Web Console Page” on page 230
� “To Start the Sun Management Center Web Console” on page 232
� “To View Detailed Information About a Host” on page 234
� “To Load a Module” on page 235
� “To View a Specific Log File” on page 236
� “Host Details Browser Page” on page 236
� “Attribute Editor in the Web Console” on page 238

Web Console Features and Functions
The Sun Management Center web console is a web-based management interface for
the Sun Management Center platform. This host management system uses the secure
HTTPS protocol to provide easy access to Sun Management Center management
information. You can access the web console across the firewall to monitor and
manage Sun Management Center information from any location. You can use widely
available browsers, such as Mozilla™1.4 or higher, Netscape Navigator™ 4.5.1 or
higher, and Internet Explorer 5.0 or higher.

The web console is an optional Sun Management Center component. The web console
depends on the Sun Management Center server for retrieving and manipulating
managed objects. For information about configuring the web server, see Sun
Management Center 3.6 Installation and Configuration Guide.
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The following table identifies the functions that the web console provides and relates
the functions to the Java Console.

TABLE 15–1 Web Console Functions

Function Web Console Information
Related Java Console
Information

View the objects in the database “Overview of Main Web
Console Page” on page
230

Chapter 5

View details about a specific managed
object

“Host Details Browser
Page” on page 236

Chapter 6

View more information about a specific
managed object

“Info Tab in the Web
Console” on page 236

“Info Tab” on page 103

Browse information about modules for
a managed object

“Browser Tab in the Web
Console” on page 237

“Module Browser Tab”
on page 103 and
Chapter 7

View system logs “Log Tab in the Web
Console” on page 238

“View Logs Tab” on page
104

Define and respond to alarm
conditions

Chapter 16 Chapter 12

View and modify data property
attributes

Chapter 17 Chapter 10

Load, unload, enable, or disable
modules

“Modules Tab in the Web
Console” on page 237

Chapter 11

Overview of Main Web Console Page
The main web console page provides similar features to the main Java Console
window. The left side of the page provides the hierarchy (tree) view for the current
administrative domain. The right side of the page provides additional details about
the item that is selected in the tree view.

From the main console page, you can perform the following tasks:

� Select another administrative domain to monitor or manage by choosing a domain
from the Domain pop-up menu.

� View a summary of current alarms in the Status Summary section of the page.

� Expand the hierarchy to view additional levels of information within the current
domain. For more information, see “To View and Expand the Topology Hierarchy”
on page 233.
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� Access detailed information about the currently selected managed object. For more
information, see “To View Detailed Information About a Host” on page 234.

� Set options for automatically updating the contents of the main page by choosing
from the Auto Refresh pop-up menu.

� Manually update the contents of the main console page by clicking the Refresh
button.

� Exit from the web console by clicking the Logout button.

� View online information about the web console by clicking the Help button.

� Define and access alarms for a specific managed object. For more information, see
Chapter 16.

� View and edit attributes for a specific data property. For more information, see
Chapter 17.

By default, the object hierarchy tree for the Default Domain is displayed. Each tree
node represents a managed object in the topology. All tree nodes are displayed with
their associated icons, such as a topology type icon, an alarm icon, or an expansion
icon for a group object. A triangle next to a node indicates that the managed object
contains additional child objects. To view those child objects, click the triangle.

If any alarms apply to the domain, a status icon for the domain alarm state is
displayed next to the domain icon. A timestamp display above the domain name
shows when the current page was loaded from the server.

When you select a host object in the hierarchy view, information about that object
appears in the right side of the page. The right side of the page displays general
information about the selected host, including the state of the machine and a
timestamp. To view additional information about the host object, click the Go to
Details link. The Host Details page provides additional object and module monitoring
information and management capabilities. For more information, see “Host Details
Browser Page” on page 236.

The following table lists the buttons on the main console and Host Details pages and
describes their functions.
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TABLE 15–2 Buttons on the Main Console and Host Details Windows

Button Function

Auto Refresh Disables and enables the auto refresh feature. The Auto Refresh menu
contains the following choices:
� Disable
� 1 Minute
� 2 Minutes
� 3 Minutes
� 5 Minutes
� 10 Minutes

The display refreshes according to the item that is selected. These options
can be configured on the server through a configuration file.

Refresh Refreshes the page display immediately.

Main Page Redisplays the main console page.

Logout Close the Sun Management Center application. After logging out, the
Login page reappears.

Help Displays the online help for this panel in another browser window.

Status Summary
The status summary displays the number of managed objects that have
unacknowledged open alarms, by level of severity, in the selected administrative domain.

If a host has multiple alarms at several different severity levels, the host is represented
at only the highest severity level for that host.

For more information about he status summary, see “To View Alarms From the Main
Console Window” on page 184.

Using the Web Console
This section provides information about main console tasks. Detailed procedures for
working with alarms and data properties are in Chapter 16 and Chapter 17.

� To Start the Sun Management Center Web Console

1. Start your browser.Steps
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Note – You do not have to be superuser to run the Sun Management Center from
your browser.

2. Go to the Sun Management Center web server at http://server-name:8080.

The Sun Management Center server and web server are on the same host. By
default, the server runs on port 8080. However, when you achieve secure access,
the secure port changes to 8443.

The Sun Management Center Login page appears.

3. Type a user ID and password for a valid UNIX account, then click the Login
button.

This account must be listed in the /var/opt/SUNWsymon/cfg/esusers file on
the Sun Management Center server.

After you log in successfully, the main console page appears and displays the
Default Domain.

Note – The web console pop-up windows are designed to be viewed using a
12–pixel font. Because the web console runs in your browser, you can change the
font size. However, if you select a very large font, some pop-up windows might be
too small to display all contents correctly. You can enlarge the windows to display
them properly.

Tip – To reload the page and all frames, click the browser Reload button.

� To View and Expand the Topology Hierarchy
The topology view for the web console appears along the left side of the main console
page.

1. If necessary, select a domain from the Domain menu.

When you first open the web console page, the Default Domain displays.

2. To expand information about a managed object, click the right-facing triangle
next to the managed object.

The topology view expands to show any children of the managed object and the
triangle changes to an upside-down triangle.

Steps
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When the topology is fully expanded, you see a list of managed objects for which
you can view detailed information. For more information, see “To View Detailed
Information About a Host” on page 234.

3. To collapse information about a managed object, click the upside-down triangle
next to the managed object.

The topology view collapses and the triangle changes to a right-facing triangle.

� To View Detailed Information About a Host

1. If necessary, select a domain from the Domain menu.

When you first open the web console page, the Default Domain displays.

2. If necessary, expand the hierarchy until you see the object that you want.

Tip – Click the triangle to show an object’s child nodes.

3. Click the name of the host for which you want to see more information.

The right side of the page displays the general information and the system status
for the selected managed object.

4. Click the Go to Details link.

By default, the Host Details page replaces the Main Console page.

Tip – Many browsers enable you to open a link in a new window, instead of
replacing the current page. For example, in Netscape Navigator, press mouse
button 3 on a link. Then, choose “Open Link in New Window” from the pop-up
menu.

For a managed object on which a Sun Management Center agent is installed, the
default Details view is the module Browser view. In addition, the following links
display at the top of the page: Info, Browser (disabled when currently shown),
Alarms, Modules, and View Log. For other managed objects, the default Details
view is the Info view. These tabs have the same basic functions as the Details
window for the Java Console, which is described in Chapter 6.

Steps
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� To View Additional Host Properties

� Click the Info link at the top of the Host Details page.

The Info page displays general information about the object, such as IP address
and operating system. The Info page provides the same information as the Details
Info window for the Java Console, which is described in “Info Tab” on page 103.

� To View Alarms for a Host

� Click the Alarms link at the top of the Host Details page.

The Host Details Alarms page is similar to the Java Console functionality that is
described in Chapter 12. The Alarms page enables you to perform the following
tasks that are described in Chapter 16:

� View current alarms for the selected host
� Acknowledge open alarms for the current host
� Define or run an action for an alarm
� Delete a specific alarm or all closed alarms
� Add a note or a suggested fix to an alarm
� View additional alarm information for an alarm

� To Load a Module

1. On the Host Details page, click the Modules link.

The Modules page appears. From this page, you can do the following tasks:

� Load a new module.
� Enable a loaded, but not enabled, module.
� Disable a currently enabled module.
� Unload a module.

2. To load a module, click the appropriate Load link in the Action column of the
Modules Available for Loading table.

The Module Loader dialog box appears.

3. Click OK to load the selected module.

Step

Step
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� To View a Specific Log File
The Sun Management Center product maintains several types of log files.

1. On the Host Details page, click Log.

The Log page appears. By default, the System Log is displayed.

2. To view another log file, choose a log file to view from the Log File Type pop-up
menu.

The Log page updates with the selected log file.

3. To limit the information displayed from the selected log file, click Filter.

The Filter dialog box appears. Use the following criteria to limit information:

� Specific dates and times
� Specific text
� Sequence in which the log file displays
� Number of entries to display

Host Details Browser Page
For any managed object on which the Sun Management Center agent is installed, you
can view the information described in the following sections:

� “Info Tab in the Web Console” on page 236
� “Browser Tab in the Web Console” on page 237
� “Alarms Tab in the Web Console” on page 237
� “Modules Tab in the Web Console” on page 237
� “Log Tab in the Web Console” on page 238

For managed objects that do not have the agent installed, the only choice is the Info
tab.

Info Tab in the Web Console
The Info page displays general information about the object, such as IP address and
operating system. This page provides the same information as the Details Info
window for the Java Console, which is described in “Info Tab” on page 103.

Steps
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Browser Tab in the Web Console
The Browser tab enables you to browse information about the modules that are loaded
for the current managed object. This information is similar to the Module Browser
window, which is described in Chapter 7.

This page has Auto Refresh, Refresh, Main Page, Logout and Help buttons, which are
described in Table 15–2.

Alarms Tab in the Web Console
The Alarm Manager for the web console is similar to the Alarm Manager that is
described in Chapter 12.

The Host Details Alarms page enables you to perform the following tasks:

� View current alarms for the selected host
� Acknowledge open alarms for the current host
� Define or run an action for an alarm
� Delete a specific alarm or all closed alarms
� Add a note or a suggested fix to an alarm
� View additional alarm information for an alarm

For details about performing these tasks, see Chapter 16.

Modules Tab in the Web Console
The Modules page displays all available modules and their status. The following
module status values can appear:

� Loaded
� Unloaded
� Enabled, only applies if Loaded
� Disabled, only applies if Loaded

Note – Only authorized users can perform module actions. You must have the
appropriate security permission to load, unload, enable, or disable a module. For more
information, see Chapter 18.

The Host Details Modules page is similar to the Module Manager window that is
described in “Working With Modules” on page 168. In some cases, you can edit
information on the Host Details Modules page.

This page also has Auto Refresh, Refresh, Main Page, Logout and Help buttons, which
are described in Table 15–2.
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Log Tab in the Web Console
The Log page displays system log information. The Log page contains the following
features:

� Log File Type menu that enables you to choose the log to view

� Text area that displays the content of the selected log file

� Filtered Messages button that enables you to filter the messages in the text area by
criteria such as starting and ending date and time

The Log page is similar to the View Logs window for the Java Console, which is
described in “Viewing Log Files” on page 116.

Attribute Editor in the Web Console
The module data properties provide additional information about the modules. The
Attribute Editor enables you to view additional information about the data properties
and to customize the following monitoring activities:

� Set alarm thresholds for simple alarms
� Specify actions to take when alarm conditions occur
� Change the interval at which data updates on the page
� Define schedules for creating log files of historical data points

The Attribute Editor contains some or all of the following tabs: Info, Alarms, Actions,
Refresh, and History. For more information about working with the Attribute Editor in
the web console, see Chapter 17.

Note – Some of the more advanced features of the Attribute Editor in the Java Console
are not provided by the Attribute Editor in the web console.
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CHAPTER 16

Managing Alarms Using the Web
Console

You use the web console to manage alarms in much the same way as you use the Java
Console, which is described in Chapter 12. However, some functions are different.
Some advanced functions, such as alarm sorting, are not available in the web console.
This chapter describes the functional differences, and provides additional instructions
for using the web console to manage alarms.

This chapter covers the following topics:

� “Alarm Concepts for the Web Console” on page 239
� “To View a Summary of Alarms” on page 241
� “To View Alarms for a Selected Host” on page 242
� “To Display a Subset of Alarms for a Host” on page 242
� “To See When an Alarm Ended or Was Acknowledged” on page 243
� “To Create an Alarm Condition” on page 243
� “To Acknowledge Open Alarms” on page 244
� “To Add a Note to an Alarm” on page 245
� “To View or Provide a Recommended Response to an Alarm” on page 245
� “To Delete Alarms” on page 245

Alarm Concepts for the Web Console
This section describes the web console status summary panel, alarm categories, and
alarm table navigation.
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Status Summary Panel
The Status Summary panel displays the number of managed objects in the selected
domain that have at least one unacknowledged open alarm of a specific severity. This
panel is similar to the Domain Status Summary that is described in Chapter 12.
However, the web console icons are not buttons. You cannot click these icons to
display the Domain Status page.

FIGURE 16–1 Main Web Console with Status Summary Panel

Alarm Categories in the Web Console
The Host Detail Alarms page presents a table of different categories of detailed alarm
information. Except for the first column, the categories and information are the same
as the categories that are described in “Alarm Categories” on page 183.

The first column in the Host Details Alarms page enables you to select the alarm row.
You can select multiple alarm rows by holding down the Control key and clicking in
this column. A check mark indicates that the column is selected.
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Some alarm information is always displayed in the alarms table. Additional
information is displayed on the bottom of the page when an alarm row is selected.
This information is only displayed for closed or acknowledged alarms.

Alarms Table Navigation
Almost all alarm actions on the Host Details Alarms page function the same as the
actions on the Alarms Details page described in Chapter 12. However, you cannot sort
the alarms table by double-clicking on the column headers. A confirmation request is
displayed when you delete an alarm.

Notifying Users When a Host or Agent Is Down
You can configure the Sun Management Center software to send an email notification
if a host or agent is down. However, to define this notification, you must use the Java
Console rather than the web console. For more information, see “To Notify Users
When a Host or Agent Is Down” on page 192.

Viewing Alarm Information in the Web
Console
Alarms information is displayed in the alarms table on the Host Details Alarms page.
For additional details, see Chapter 12.

� To View a Summary of Alarms
To see a summary of alarms in another domain, choose a domain from the Domain
menu.

� Open the main console page.

The Status Summary section shows the number of alarms for the current domain.
For each severity level, the summary indicates how many unacknowledged open
alarms exist.

Step
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Note – If a host has multiple alarms at several different severity levels, the host is
represented at the highest severity level for that host.

For more information about the status summary, see “To View Alarms From the
Main Console Window” on page 184.

� To View Alarms for a Selected Host

1. Click a host icon in the main console page.

The host description and status are displayed in the right side of the main console
page.

2. Click the Go to Details link.

The Host Details Browser page appears.

3. Click the Alarms link.

The Host Details Alarms page appears. From this page, you can do the following
tasks:

� See all current alarms for the selected host, or view a subset of alarms, as
explained in “To Display a Subset of Alarms for a Host” on page 242.

� Acknowledge open alarms for the current host, as described in “To
Acknowledge Open Alarms” on page 244.

� Delete a specific alarm or all closed alarms, as described in “To Delete Alarms”
on page 245.

� Add a note or a suggested fix to an alarm, as illustrated in “To Add a Note to an
Alarm” on page 245 and “To View or Provide a Recommended Response to an
Alarm” on page 245.

� View additional alarm information for an alarm, as explained in “To See When
an Alarm Ended or Was Acknowledged” on page 243.

� To Display a Subset of Alarms for a Host

1. From the Host Details Alarms page, choose View Alarms from the Options
menu, and click the Go button.

The View Specific Alarms dialog box appears. By default, all open alarms are
selected.

2. Click the boxes next to the items to select or deselect the items.

A check mark is displayed in each box that you select.

Steps
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3. Click OK to accept your changes and close the dialog box.

The alarms table is filtered. The table is redisplayed to reflect your selections.

� To See When an Alarm Ended or Was
Acknowledged

1. From the Host Details Alarms page, click the first column of the alarm that you
want to view.

A check mark is displayed in the first column.

Note – You can view additional information only for one alarm at a time.

2. Choose Additional Alarm Information from the Options menu, and click the Go
button.

The Additional Alarm Information section at the bottom of the page updates with
appropriate information, if applicable.

� If the alarm has been acknowledged, the Alarm Acknowledged field indicates
who acknowledged the alarm. This field also tells you when the alarm was
acknowledged.

� If the alarm has ended, the Alarm Ended field indicates when the alarm ended.

Creating and Responding to Alarms
This section illustrates how to work with simple alarms in the web console. To work
with more complex alarm conditions, use the Java Console functions described in
Chapter 12.

� To Create an Alarm Condition
The following example procedure shows how to create a simple alarm. This example
creates an alarm condition when the system load over the past five minutes exceeds a
specified value.

1. Select a data property table from the Host Details Browser page.

For this example, select the System Load Statistics table in the Kernel Reader
(Simple) module.
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2. Choose a specific data property in the data property table.
For this example, select the value for the Load Average Over Last 5 Minutes
property.

The Attribute Editor appears for the selected data property.

3. Click on the Alarms tab in the Attribute Editor window.
The Alarms page appears.

4. In the Critical Threshold (>) field, type an appropriate value.
For this example, type .050. This value is probably lower than what you would
normally use, but will most likely generate an alarm to illustrate the process.

5. Click OK to apply your changes and close the Alarms tab page.
In a few moments, the Load Average Over the Last 5 Minutes data field in the
System Load Statistics data properties table turns red. In addition, red alarm icons
appear on the following folders and icons, unless your system has an open,
unacknowledged black (down) alarm:

� Operating System
� Kernel Reader
� System Load Statistics

Click Reset to reset the Attribute Editor to the default parameters.

6. Click the Host Details Alarms tab.
The alarm that you created is reflected in the alarms table when the table is
refreshed.

7. Acknowledge this alarm.

8. Create additional alarm thresholds. Then, familiarize yourself with their
operation.
Once you have created these alarms, you can set up security permissions so that
another Sun Management Center software user cannot change your alarm
thresholds. For more information about security, see Chapter 18.

Tip – You do not need to fill in alarm information for all alarm thresholds. For
example, you can choose to create only a critical alarm threshold.

� To Acknowledge Open Alarms

1. Open the Host Details Alarms page for the managed object.

2. Select the alarm that you want to acknowledge.

Steps
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3. Click the Acknowledge button.

� To Add a Note to an Alarm
Alarm notes contain an expanding list of notes for a specific alarm. You can add notes
over the life of the alarm to track its history.

1. Open the Host Details Alarms page for the managed object.

2. Select the alarm to which you want to add the note.

3. Choose Add Note from the Options menu, and click the Go button.

The Add Note window appears.

4. Type text in the note.

5. Click OK to close the Add Note window.

The note that you entered displays

� To View or Provide a Recommended Response to
an Alarm
The Suggested Fix feature enables you to provide a recommended correction to an
alarm condition.

1. Open the Host Details Alarms page for the managed object.

2. Select the appropriate alarm.

3. Choose Suggested Fix from the Options menu, and click the Go button.

The Suggested Fix window appears. Any default software-provided information
appears in the Suggested Fix section of the window. Any existing user-provided
information appears in the User Suggested Fix section of the window.

4. Type your recommendation for responding to the alarm condition in the User
Suggested Fix section of the window.

5. To close the Suggested Fix window, click OK.

� To Delete Alarms
To conserve space and to keep the database current, you should delete alarms after the
alarms have been closed. A closed alarm means that the condition no longer exists.
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1. Open the Host Details Alarms page for the managed object.

2. Select the alarm that you want to delete.

3. Choose Delete Alarms from the Options menu, and click the Go button.

Tip – To delete all closed alarms, choose Delete All Closed Alarms from the Options
menu, and click the Go button.

Steps
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CHAPTER 17

Managing Data Property Attributes
Using the Web Console

This chapter explains the following topics:

� “Overview of Module Data Properties” on page 247
� “To Access Specify Data Property Attributes” on page 251
� “To Define an Alarm Condition” on page 253
� “To Define a Response for an Alarm” on page 254
� “To Define and Use an Alarm Action Script” on page 255
� “To Modify Alarm Actions” on page 256
� “To Specify How Often the Data Display Updates” on page 252
� “To Change How Often History Data is Collected” on page 252

Overview of Module Data Properties
The module data properties provide additional information about the modules. The
Attribute Editor in the web console provides the same capabilities as the Attribute
Editor in the Java Console, which is described in Chapter 10. You can use the Attribute
Editor to customize the monitoring criteria for the module data properties. Specifically,
the Attribute Editor enables you to perform the following tasks:

� Set alarm thresholds for defined alarms
� Specify actions to take when alarm conditions occur
� Change the interval at which data updates on the screen
� Define schedules for creating log files of historical data points

The Attribute Editor in the web console has one or more tabs at the top of the page
that enable you to switch between different panels. These tabs differ depending on the
selected object. The possible tabs are described in the following sections:

� “Info Tab in the Web Console Attribute Editor” on page 248
� “Alarms Tab in the Web Console Attribute Editor” on page 248
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� “Actions Tab in the Web Console Attribute Editor” on page 249
� “Refresh Tab in the Web Console Attribute Editor” on page 250
� “History Tab in the Web Console Attribute Editor” on page 250

Note – Each Attribute Editor displays one or more of these tabs, depending on the
specific object to which an instance of the Attribute Editor applies.

Info Tab in the Web Console Attribute Editor
The Attribute Editor Info page provides additional information about the selected
object, such as:

� Module name, version, and description for the selected module
� Host name for the host on which the module resides
� Other information about the specific module, such as folder and variable in which

data property information is stored

Alarms Tab in the Web Console Attribute Editor
The Alarms tab enables you to set alarm thresholds only for those data properties that
have associated simple alarms. These simple alarms use the rCompare rule, which is
described in Appendix D. The Attribute Editor Alarms page enables you to set alarm
thresholds for simple alarms only.

Note – To set an alarm threshold, you must have the appropriate security permission.
For more information, see Chapter 18.

The alarm management software offers you the following flexibility in setting your
alarms:

� Determine the thresholds that trigger an alarm of a particular severity
� Determine when alarms are sounded, for example, only on weekdays

Simple alarms are based on thresholds. A monitored data property is greater than, less
than, not equal to, or equal to a single threshold value. By contrast, complex alarms
are based on a set of conditions. For more information about alarm rules, see
Appendix D.

The following table lists common simple alarm limits for monitored properties. The
alarm limits are also displayed in the Parameter Description field. You can set
thresholds for one or more of these alarm limits for selected data properties.
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TABLE 17–1 Common Simple Alarm Limits in Sun Management Center Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if the value exceeds the limit
that is entered in this field.

Alert Threshold (>) Alert (yellow) alarm occurs if the value exceeds the
limit that is entered in this field.

Caution Threshold (>) Caution (blue) alarm occurs if the value exceeds the
limit that is entered in this field.

Critical Threshold (<) Critical (red) alarm occurs if value is below the limit
entered in this field.

Alert Threshold (<) Alert (yellow) alarm occurs if value is below the limit
entered in this field.

Caution Threshold (<) Caution (blue) alarm occurs if value is below the limit
entered in this field.

Alarm Window Alarm occurs only during a specified time period. For
example, if the value is day_of_week=fri, an alarm
occurs only if the alarm condition exists on a Friday. If
an alarm condition exists on Tuesday, no alarm is
triggered.

Actions Tab in the Web Console Attribute Editor
The Attribute Editor Actions page enables you to instruct the software to perform a
predetermined action if an alarm occurs.

Note – Acceptable actions include scripts that are stored in the
/var/opt/SUNWsymon/bin directory. These scripts execute with root permissions.

For example, you can provide the name of a script in the critical action field. This
script might send an email to a system administrator whenever a critical alarm is
generated for the Load Average Over the Last 5 Minutes data property.

You can set separate actions for different alarm conditions. You can also define a single
action to occur when any change happens to any of the alarm conditions. To define
actions, you use the Action buttons on the Actions page.
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Note – The check boxes that are to the right of the Action buttons enable you to specify
automatic or manual execution of a specific alarm action. By default, all actions are set
for manual execution. Only manual actions can be modified.

Use the Alarm Action Modification dialog box to modify the registered alarm actions.
Two buttons in the dialog box (Email and Generic) allow you to choose one of two
options for an alarm action.

Email Enables you to specify an address, subject, and message to be sent as email

Generic Enables you to select generic shell scripts that are installed on the
managed node

Refresh Tab in the Web Console Attribute Editor
Use the Refresh page in the Attribute Editor to set the refresh interval for this object.
The refresh interval is the interval between the times when the Sun Management
Center agent samples the monitored property. For more information, see “To Specify
How Often the Data Display Updates” on page 252.

History Tab in the Web Console Attribute Editor
Use the History page in the Attribute Editor to save older data for a monitored
property. For example, you might choose to record a history of data points every 120
seconds as identified in the sample interval. You can also specify whether to store this
information in a disk file or in the memory cache.

The two types of disk files are circular, which has a maximum of 1000 lines, and text.
These files are located in the /var/opt/SUNWsymon/log directory in the file that is
specified in the Text File Name field.

A circular disk file is automatically saved under the name history.log. If you do
not choose a file name for your text file, data are automatically saved under the name
agent_default.history.

If you select memory cache, you must indicate in the Max Size (sample) field the
number of data points to save. For example, if you set this field to 1000, only the most
current 1000 data points are stored in the memory cache. Any older data points are
discarded. These data points can be graphed. See Chapter 9 for more information.
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Note – You can view history data in a graph by opening the graph for the specific
monitored property. If you have selected memory cache, the graph is displayed with
historical data.

Using the Attribute Editor in the Web
Console
The procedures in this section explain how to view specific attributes, change the
refresh interval, and modify history information in the web console attribute editor.

� To Access Specify Data Property Attributes

1. Navigate through the hierarchy to a data property table.

For example, to view information about the memory on a host, follow these steps:

a. Select a managed object in the main console page.

b. Click the Go to Details link.

The Host Details page appears.

c. In the Host Details page, click the expansion icon to the left of Operating
System.

d. Click the expansion icon to the left of Kernel Reader (Simple).

e. Click Memory Usage Statistics.

The data property table for Memory Usage Statistics appears.

2. Select the value in the data property table whose attributes you want to view or
modify.

The Attribute Editor appears in a separate window.

Steps
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� To Specify How Often the Data Display Updates
The following example shows how to set a refresh interval in the System Load
Statistics module.

1. Select a data property, for example, System Load Statistics, on the Host Details
Browser page.

2. Select the Value column for Load Averages Over the Last Five Minutes.

The Attribute Editor Info page is displayed.

3. Click the Refresh tab.

The Refresh page is displayed.

4. Type a value in seconds in the Refresh Interval field.

For example, if you type 300, the page updates every five minutes.

5. To change the refresh interval and exit from the Attribute Editor, click the OK
button.

When the properties table for System Load Statistics is displayed, the values in the
table are refreshed every five minutes.

Tip – The agent uses less CPU cycles if you use a larger refresh interval.

� To Change How Often History Data is Collected
The Sample Interval on the History page controls how frequently history data is
captured.

1. Select a data property, for example, System Load Statistics, on the Host Details
Browser page.

2. Select the Value column for a specific property, for example, Load Averages Over
the Last Five Minutes.

The Attribute Editor Info page is displayed.

3. Click the History tab.

The History page is displayed.

4. Type a value in seconds in the Sample Interval field.

For example, to collect a history data point every two minutes, you would type 120
in the Sample Interval field.

Steps

Steps
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5. Click the OK button to set the history interval and exit from the History page.

Working With Alarms in the Web
Console Attribute Editor
The procedures in this section explain how to create and respond to alarms using the
web console attribute editor.

� To Define an Alarm Condition
The following example procedure shows how to create a simple alarm. This example
creates an alarm threshold in the Kernel Reader module.

1. Select a data property, for example, System Load Statistics, from the Host Details
Browser page.

2. Click the Alarms tab.

The Alarms page is displayed.

3. In the Critical Threshold (>) field, type a value that is less than the current value.

Providing this value creates a critical alarm.

4. Click OK to apply your changes and close the Alarms page.

In a few moments, the Load Average Over the Last One Minute data field in the
data properties table for System Load Statistics turns red. In addition, red alarm
icons are displayed on the following folders and icons unless your system has an
open, unacknowledged severity one black alarm:

� Operating System
� Kernel Reader
� System Load Statistics

5. Click the Host Details Alarms tab.

The alarm that you created is reflected in the alarms table when the table is
refreshed. For more information about this subject, see Chapter 16.

6. Click the acknowledge button, which looks like a check mark, to acknowledge
this alarm.

Steps
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7. Create additional alarm thresholds. Then, familiarize yourself with their
operation.

Once you have created these alarms, you can set up security permissions so that
another Sun Management Center software user cannot change your alarm
thresholds. For more information about security, see Chapter 18.

Note – You do not need to fill in alarm information for all alarm thresholds. For
example, you can choose to create only a critical alarm threshold.

� To Define a Response for an Alarm
The following procedure describes how to define an action to take when an alarm
occurs.

1. Select a data property, for example, System Load Statistics, from the Host Details
Browser page.

2. Select an appropriate item in the Value column, for example, the value
associated with Load Average Over Last Five Minutes .

The Attribute Editor Info page is displayed.

3. Click the Actions tab.

The Actions page is displayed.

4. Click the Action button for the alarm level for which you want to define the
action.

A window appears on which you choose the type of action and provide
appropriate information.

� To notify users through an email, click the Email radio button. Type a
comma-separated list of email addresses and a message.

� To run a script, click the Other radio button. Choose a script from the list of
available scripts. Then, supply appropriate arguments as needed. See “To
Define and Use an Alarm Action Script” on page 255.

� To clear the alarm, click the Clear radio button.

Steps
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5. Click OK to apply your changes and close this page.

If you choose to send an email, a message is sent to the specified users whenever
the specified alarm occurs. This message might be similar to the following
message.

Date: Wed, 30 Jun 1999 15:25:39 -0800
From: root@MachineB (0000-Admin(0000))
Subject: Sun Management Center - Alert Alarm Action
Mime-Version: 1.0

Sun Management Center alarm action notification ...
{Alert: machineB Kernel Reader Load Average Over The Last 5 Minutes > 0.01Jobs}

� To Define and Use an Alarm Action Script
The following procedure describes how to customize an alarm action to automatically
notify a user when an alarm condition occurs.

1. Create the script using the following arguments:

%statusfmt The alarm severity, such as Warning, Critical, and so on.

%statusstringfmt The complete alarm string, including severity. (For
example: Critical: Machine A Kernel Reader Number of
User Sessions > 10)

2. At the command-line level, become superuser.

# su -

3. Install the script in the home Sun Management Center directory.

The default is the /var/opt/SUNWsymon/bin/ directory. For example:

# cp custom-alarm-script /var/opt/SUNWsymon/bin/

4. Click the Host Details Browser tab.

5. Set the alarm threshold.

For more information, see “To Define an Alarm Condition” on page 253.

6. Click the System Load Statistics icon.

The properties table for System Load Statistics is displayed in the contents view of
the Host Details Browser page.

7. Select the Value column for Load Average Over Last Five Minutes.

The Attribute Editor Info page is displayed.

Steps
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8. Click the Attribute Editor Actions tab.

The Actions page appears.

9. Click the Action button for the Critical Actions field.

The Alarm Action Modification dialog box appears.

10. Click the Other button.

11. Select custom-alarm-script from the Available Scripts menu.

12. Type the following string in the Arguments field:

%statusstringfmt

13. Click OK to apply your changes and close this page.

The script file name is displayed in the Critical Action field on the Actions page.

� To Modify Alarm Actions

1. Click the Action button for the alarm action that you want to modify.

The Alarm Actions modification dialog box is displayed.

2. Select the type of alarm action that you want to modify (Email or Other).

3. Make your changes in the fields of the selected action.

4. Click OK to accept the changes and close the page.

The change is displayed in the corresponding Action field of the Actions page.

Steps
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CHAPTER 18

Sun Management Center Security

This chapter discusses security features, users and groups, and their privileges. The
chapter describes the following topics:

� “Sun Management Center Security Concepts” on page 257
� “Access Control Categories” on page 258
� “Default Privileges” on page 261
� “Access Control Definitions and Limitations” on page 263
� “To Add Sun Management Center Users” on page 265
� “To Control Access to a Module” on page 265
� “To Add a User-Defined Group to an ACL” on page 267
� “To Grant a User esadm, esops, or esdomadm Privileges” on page 267
� “To Delete Sun Management Center Users” on page 267
� “To Override Default Agent Privileges” on page 268
� “SNMP Encryption (Privacy)” on page 268
� “SNMP Communication” on page 272
� “SNMPv3” on page 273

Sun Management Center Security
Concepts
Security in Sun Management Center software is based on Java™ security classes and
SNMPv2usec (SNMP version 2, user-based security model) security standards.

The software offers the following layers of security:

� Only valid Sun Management Center users can operate the software.

� The software enables you to set security permissions or access control list (ACL)
categories. The security features provide control at the administrative domain,
group, host, and module levels.
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� The software authenticates users and access control for individual managed
properties.

Access Control Categories
The software offers the following ACL categories:

� Admin, like the superuser (root) in UNIX
� Operator, as an operator who runs and monitors the system
� General, like guest access with read-only viewing privileges

To understand ACL categories, you first need to understand Sun Management Center
software users and groups. The following sections explain users and groups.

Sun Management Center Users
Sun Management Centerusers are valid UNIX users on the server host. As such, the
system administrator has to add valid users into the file
/var/opt/SUNWsymon/cfg/esusers. If a user’s name is not in this file, that user
cannot log into the Sun Management Center software.

General Users

The administrator has to add the list of user IDs for all users who need to log into Sun
Management Center software. All users in this file have general access privileges, by
default, unless the users are given additional privileges using the procedures
described in “To Grant a User esadm, esops, or esdomadm Privileges” on page 267.

Any user who is part of the esusers file is known as a general user. Sun
Management Center general users can, by default, perform the following functions:

� Log into the software
� View the administrative domains, hosts, and modules that are created
� View events
� Trigger manual refreshes
� Run ad hoc commands
� Graph data

Sun Management Center Superuser

The Sun Management Center superuser automatically belongs to all the groups that
are described in the following sections. The Sun Management Center superuser has
administrator privileges as described in “Sun Management Center Administrators or
esadm” on page 259.
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Sun Management Center Groups
The following groups are created by default on the server host during the Sun
Management Center server setup:

� esops
� esadm
� esdomadm

In addition, all the Sun Management Center users belong to a hypothetical group,
called ANYGROUP.

The listed groups must be defined on the machine where the Sun Management Center
server layer is running. These groups do not need to be defined on other machines.
These groups are described in greater detail in the sections that follow.

Note – The listed groups are defined in the /etc/group file.

Sun Management Center Operators or esops

Sun Management Center software users that belong to the group esops are usually
operator users. These operators run, monitor, and to some extent, configure
parameters on the managed systems. esops can perform operations, including some
operations that are allowed for general users:

� Disable or enable modules
� Set alarm limits
� Set rule parameters
� Run alarm actions
� Run ad hoc commands
� Set the refresh interval
� Acknowledge, delete, or fix events
� Enable or disable history logging
� Set logging history parameters

Sun Management Center Administrators or esadm

Software users that belong to the group esadm can perform administrator operations.
Administrator operations are a superset of the operations that can be performed by
operator users as described in “Sun Management Center Operators or esops”
on page 259. In addition to all the operations that operator users (esops) can perform,
these administrator users (esadm) can perform the following operations:

� Load or unload modules
� Set ACL users and groups
� View administrative domains, hosts, or modules
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Sun Management Center Domain Administrators or esdomadm

The users that belong to the group esdomadm can perform the following domain
administrator operations:

� Create administrative domains
� Create groups within administrative domains
� Add objects to groups or administrative domains
� View administrative domains, hosts, or modules

Note – Other than the privileges listed above, a user that belongs to esdomadm is just a
general user, unless configured otherwise.

Administrator, Operator, and General Functions
The following table lists the different types of functions that users can do by default. A
mark in a given cell indicates that the specified user can perform the listed function.

This table applies to all modules. Individual modules can also have specific
restrictions, which are under the control of the module.

TABLE 18–1 Domain Admin, Admin, Operator, and General Functions

Function Domain Admin Admin Operator General

Load modules x

Unload modules x

Create administrative
domains

x

Create groups within
administrative domains

x

Add objects to groups or
administrative domains

x

View administrative domains,
hosts or modules

x x x x

Set ACL users or groups x

Disable or enable modules x x

Set module active time
window

x x

Set alarm limits x x
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TABLE 18–1 Domain Admin, Admin, Operator, and General Functions (Continued)
Function Domain Admin Admin Operator General

Set rule parameters x x

Run alarm actions x x

Run ad hoc commands x x

Set the refresh interval x x

Manually trigger a refresh x x x x

Enable or disable history
logging

x x

Set logging history
parameters

x x

Acknowledge, delete, or fix
events

x x

View events x x x x

In Sun Management Center software, the above categories maintain inclusive
relationships. This means that a user who has esadm privileges can do anything that a
user who has esops privileges can do. An administrator can change the default
permissions so that a user who has esops privileges can do more than a esadm user.
Inclusive relationships mean that there is nothing in the software that makes one of
esops, esadm, or esdomadm more powerful than either of the others.

For more information about how to override default privileges, see “To Override
Default Agent Privileges” on page 268.

Default Privileges
Administrative domains are manipulated by the Topology manager. This section
describes the default privileges for the Topology manager, for other agents, and for
other modules.

Default Privileges for the Topology Manager
The default privileges for Topology manager, where administrative domains are
maintained, are listed in the following table.
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TABLE 18–2 Default Privileges for Topology Manager

Topology Manager Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public

List of Admin Groups esdomadm

List of Operator Groups esops

List of General Groups ANYGROUP

Other Sun Management Center Component and Module
Default Privileges
The default privileges for components and modules not in the Topology manager are
listed in the following table.

TABLE 18–3 Sun Management Center Component and Module Default Privileges

Components and Modules Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin Groups esadm

List of Operator Groups esops

List of General Groups ANYGROUP

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public

The keyword ANYGROUP is not a true UNIX group, but is a special keyword that
means that any user who can log into Sun Management Center software is given general
access to the objects.
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Access Control Definitions and
Limitations
The esadm group can specify ACL features for users and groups for the following
components:

� Administrative domains
� Groups within administrative domains
� Hosts
� Modules

Admin, Operator, and General Access
An ACL specification consists of establishing or defining one or more of the following
parameters:

� Administrator users and administrator groups – A list of users and groups who can
perform administrator operations. By default, these users are esadm or esdomadm,
wherever applicable.

� Operator users and operator groups – A list of users and groups who can perform
operator operations. By default, these users are esops.

� General users and general groups – A list of users and groups who can perform
general operations. By default, this category is a hypothetical group that is called
ANYGROUP.

� Communities for administrators (SNMP) – A list of SNMP communities that can
perform administrator operations that use SNMP.

� Communities for operators (SNMP) – A list of SNMP communities that can
perform operator operations that use SNMP.

� Communities for general (SNMP) – A list of SNMP communities that can perform
general operations that use SNMP.

Sun Management Center Remote Server Access
Users can access and view data from sessions that are running on remote Sun
Management Center servers. When a user tries to gain access to such information, that
user is provided access as a general user with read-only privileges. The behavior of
Sun Management Center sessions that are running on different servers is defined in
terms of each session’s server context. See “Sun Management Center Server Context
and Security” on page 264 for more information.

As a user, you can access and set up a different server context for a variety of reasons:
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� To enable each server context to have different users and different administrators,
and yet remain accessible to each other

� To allow for physical separation between elements, as in the context of a wide area
network (WAN)

� To increase performance by enabling many hosts to be handled by one set of
central components

By linking to a different server context, you can view the top level status of the objects
in the other server context.

Sun Management Center Server Context and Security
A server context is a collection of Sun Management Center agents and the particular
server layer to which the agents are connected. The agents and hosts within a server
context share a single set of the following central components:

� Sun Management Center server
� Topology manager
� Event manager
� Trap handler
� Configuration manager

Every Sun Management Center component or agent is configured at installation to
know the location of its trap handlers and event managers. Sun Management Center
software identifies the trap handlers and the event managers by their IP and port
addresses. To determine whether you are within your server context, you need to
know the respective IP and port addresses of the servers that you access. Different
server contexts have different port numbers.

A remote server context refers to a collection of remote agents and a particular server
layer with which the remote agents are associated.

An agent receives security configuration from the server layer. This information
enables the agent to authenticate the management request that is sent to the agent.
Then, the agent can perform access control on the requested operation as part of the
management request.

Limitations When Crossing Servers
Some security restrictions apply when a user tries to communicate across server
contexts.

In the current Sun Management Center environment, you can access information from
another server with a few limitations:

� If you try to access a remote server context, the server give you general user access.
Thus, you can access data but cannot modify or use the objects within the different
server. You are restricted to viewing only the remote server objects.
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� You can view data in another context as a general user, but you cannot perform
control actions, such as setting alarm thresholds and other similar functions.

� Edit functions work differently in a remote server. For example, you can copy and
paste between contexts. You cannot cut and paste between contexts.

Note – In the console, the fact that you are accessing a different server context might
not be obvious. To identify whether you are accessing a different server, check the
server’s IP port number or address in the Info tab of the Details window.

Using Access Control
The following sections describe how to perform the following key access control
functions:

� “To Add Sun Management Center Users” on page 265
� “To Control Access to a Module” on page 265
� “To Add a User-Defined Group to an ACL” on page 267
� “To Grant a User esadm, esops, or esdomadm Privileges” on page 267
� “To Delete Sun Management Center Users” on page 267
� “To Override Default Agent Privileges” on page 268

� To Add Sun Management Center Users

1. Become superuser on the Sun Management Center server host.

% su -

2. Edit the file /var/opt/SUNWsymon/cfg/esusers.

3. Add the user name on a new line.
Make sure that the user name is the user name of a valid UNIX user.

4. Save the file and exit the editor.
Users that are added to the users list have default privileges. See “Default
Privileges” on page 261 and “To Override Default Agent Privileges” on page 268
for more information.

� To Control Access to a Module

1. Access the Attribute Editor in either of the following ways:

Steps

Steps
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� Press mouse button 3 on the selected object, and choose Attribute Editor from
the pop-up menu.

� Choose Attribute Editor from the Tools menu in the main console window.

The Attribute Editor is displayed. The buttons at the bottom of the window are
inactive, with the exception of the Cancel and Help buttons. The remaining buttons
become active when you modify any field in the window.

2. Select the Security tab in the Attribute Editor window.

3. Change the values as required.

The following list explains the data in each field and provides sample values.

Administrator Users A list of users. jim is a user who can perform
administrator operations.

Operator Users A list of operators. john and others are users
who can perform operator operations. Note
that their entries are separated by one or more
spaces.

General Users A list of general users. nick and richie are
users who can perform general operations.

Administrator Groups All the users that belong to administrator
groups can perform administrator operations.
By default, the users are esadm or esdomadm,
as applicable.

Operator Groups All users that belong to esops can perform
operator operations.

General User Groups ANYGROUP is a hypothetical group that can
perform general operations. All Sun
Management Center users belong to this
hypothetical group.

Communities for Administrators This field is empty, denoting that there is no
SNMP community that can perform
administrator operations that use SNMP.

Communities for Operators This field is empty, denoting that there is no
SNMP community that can perform operator
operations that use SNMP.

Communities for General Users By default, public is an SNMP community
that can perform general operations that use
SNMP.

Use spaces or commas between multiple entries as illustrated in the entries for
“Operator” under “Users.”
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For more information about security privileges, see “Access Control Categories”
on page 258.

� To Add a User-Defined Group to an ACL

1. Become superuser on the Sun Management Center server host.

2. Use the groupadd command to create a group.

# /usr/sbin/groupadd groupname

3. Add users to the newly created group.

a. In the /etc/group file, add users to the group.

b. Save the file and exit the editor.

4. Add the new group to the ACL.

See “To Control Access to a Module” on page 265 for more information.

� To Grant a User esadm, esops, or esdomadm
Privileges

1. Become superuser on the Sun Management Center server host.

2. If needed, add the user name to the /var/opt/SUNWsymon/cfg/esusers file.

3. In the /etc/group file, add the user to one of the following lines as applicable:
esadm, esops, or esdomadm.

4. Save the file and exit the editor.

� To Delete Sun Management Center Users

1. Become superuser on the Sun Management Center server host.

2. In the file /var/opt/SUNWsymon/cfg/esusers, delete the line corresponding
to the user name you want to delete.

3. Save the file and exit the editor.

Steps

Steps

Steps
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4. Delete the user names from Sun Management Center groups.

Note – After a user is deleted from the list of Sun Management Center users, the
user can no longer log into the Sun Management Center server. Make sure to delete
that user from all the ACLs.

� To Override Default Agent Privileges
In Sun Management Center software, only administrators can override default
privileges using the Attribute Editor to modify the ACL lists for that particular object.

1. Access the Attribute Editor for the specific managed object on which you need to
change the privileges.

2. To view and change security information, click the Security tab in the Attribute
Editor window.

3. Change the information as needed.

4. To apply the security changes and close the Attribute Editor window, click OK.

To leave the Attribute Editor window open and apply the security changes, click
Apply.

SNMP Encryption (Privacy)
Sun Management Center supports encryption of SNMP communications between
server and agent components of Sun Management Center. SNMP encryption support
uses the CBC-DES symmetric encryption algorithm.

You can enable SNMP encryption on Sun Management Center servers using the
es-config script. By using this script, you can turn on or off the auto-negotiate
feature. For details, see “Enabling SNMP Encryption” on page 270.

Steps
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Encryption on Solaris 9 or Earlier
For systems running Solaris 9 or earlier, encryption is based on the package SUNWcry.

Note the following conditions for systems that run Solaris 9:

� SNMP encryption on both the Sun Management Center server and agent hosts
depends on the SUNWcry package, which contains the
/usr/lib/libcrypt_d.so encryption library. You must install this package
separately.

� SNMP encryption is not supported on Sun Management Center 3.5 and earlier
servers and agents even if SUNWcry is installed.

� SNMP encryption support is automatically configured during agent or server setup
if the SUNWcry package is detected.

Encryption on Solaris 10
For systems running Solaris 10, encryption is based on Public Key Cryptographic
Standard (PKCS#11).

PKCS#11 specifies an API, called Cryptoki, to devices which hold cryptographic
information and perform cryptographic functions. For more information on the RSA
defined PKCS#11, see http://www.rsasecurity.com/rsalabs.

Note the following conditions for systems that run Solaris 10:

� SNMP encryption on both the Sun Management Center server and agent hosts
depends on the SUNWcsl package, which contains the /usr/lib/libpkcs11.so
encryption library. This package is installed by default.

� SNMP encryption is not supported on Sun Management Center 3.5 and earlier
servers and agents even if SUNWcsl is installed.

� SNMP encryption support is automatically configured during agent or server setup
if the SUNWcsl package is detected.

Encryption on Linux
For systems running Linux, encryption is based on Public Key Cryptographic
Standard (PKCS#11).

SNMP encryption depends on the PKCS11_API.so encryption library. This library is
not installed by default. You must provide this library in /usr/lib/pkcs11 and
enable the pkcs_slot daemon to enable encryption.
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Auto-Negotiate Feature
Sun Management Center 3.6 servers that support encryption can be set up to support
agents dynamically regardless of whether those agents support encryption. This
feature is called auto-negotiate and can be set to on or off.

When you set the auto-negotiate feature to off, you ensure that the server always uses
encryption when initiating communication with agents. Environments with strict
security policies might prefer this set up. If you set auto-negotiate to off:

� If the agent supports encryption, the agent understands the encrypted SNMP
messages.

� If the agent does not support encryption, the agent does not understand the
encrypted message. Thus, a timeout occurs and a console message states, “Agent is
not responding.” The timeout is recorded in the agent log.

When you set the auto-negotiate feature to on, the server encrypts its SNMP
communication with an agent only if the agent supports encryption. As a result, one of
the following events occurs:

� If the agent supports encryption, the agent understands the encrypted SNMP
messages.

� If the agent does not support encryption, the SNMP messages are only authenticated
and not encrypted.

Enabling SNMP Encryption
To find the current state of SNMP encryption, run the es-config command with no
arguments.

� To Enable SNMP Encryption for Server Installations

1. Check whether the package is installed.

� (For systems running Solaris 9 or earlier) Make sure the SUNWcry package,
which contains the /usr/lib/libcrypt_d.so encryption library, is
installed on the system by typing:

% pkginfo | grep SUNWcry

If the package is installed, the system shows:

application SUNWcry

Steps
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Note – The SUNWcry package is part of the Solaris Encryption Kit. To obtain the
Solaris Encryption Kit, see your Sun sales representative. For important
information about administering secure systems, see your Solaris system
administration documentation.

� (For systems running Solaris 10) Make sure the SUNWcsl package, which
contains the /usr/lib/libpkcs11.so encryption library, is installed on
the system by typing:

% pkginfo | grep SUNWcsl

If the package is installed, the system shows:

application SUNWcsl

� (For systems running Linux) Make sure you provide the PKCS11_API.so
encryption library in /usr/lib/pkcs11 and enable the pkcs_slot
daemon.

2. Type the following command as superuser from the server host:

# es-config -r

The system detects the presence of the appropriate package and automatically
stops all Sun Management Center components. The script then asks for the security
seed.

3. Type the security seed.

The script asks for the SNMPv1 community string.

4. When asked whether you want to initiate encrypted communication, type y to
initiate encrypted communication or n to decline.

5. When asked whether you want to enable the auto-negotiate feature, type y to
enable or n to decline.

For details on the auto-negotiate feature, see “Auto-Negotiate Feature” on page
270.

Chapter 18 • Sun Management Center Security 271



SNMP Communication
Sun Management Center agents can communicate with the server using SNMPv1,
SNMPv2c, and SNMPv2usec. These communications are enabled by default. You can
disable the SNMPv1 and SNMPv2c communications by editing the
domain-config.x file. However, you cannot disable the SNMPv2usec
communication.

� Disabling SNMPv1 Communication

1. Become superuser on the Sun Management Center agent.

% su -

2. Open the file /var/opt/SUNWsymon/cfg/domain-config.x.

3. Add the following lines to the file.

agent =
{

agentServer = "agentHostName"
snmpPort = "161"
SNMPv1 = off

}

Where agentHostName is the host name where the agent is installed.

� Disabling SNMPv2c Communication

1. Become superuser on the Sun Management Center agent.

% su -

2. Open the file /var/opt/SUNWsymon/cfg/domain-config.x.

3. Add the following lines to the file.

agent =
{

agentServer = "agentHostName"
snmpPort = "161"
SNMPv2c = off

}

Steps
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Where agentHostName is the host name where the agent is installed.

SNMPv3
SNMPv3 is an industry-standard protocol that was introduced to overcome the
limitations of SNMPv2usec. SNMP messages that are generated by SNMP version 3,
user security model (SNMPv3 usm) are more structured than the messages generated
by SNMPv2usec.

Sun Management Center 3.6 software supports SNMPv3. SNMPv3 enables Sun
Management Center agents to communicate with third-party management
applications securely.
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CHAPTER 19

Importing and Exporting Topology
Information

The topology import and export utilities enable you to import and export the topology
database from or to an ASCII file that uses XML markup. The import utility enables
you to read data from a file and update the topology database and the data of the
topology agent object. The export utility reverses this operation.

This chapter explains the following topics:

� “Topology Import and Export Concepts” on page 275
� “Topology Import and Export Architecture” on page 276
� “Exporting Topology Information” on page 277
� “Importing Topology Information” on page 278
� “Import and Export CLI Interface” on page 279
� “Import and Export File Contents” on page 284

Topology Import and Export Concepts
The topology import and export utilities are used to do the following tasks:

� Dump the topology data as backup regularly.
� Transfer data between different topology servers.
� Restore the data from backup if the topology data is damaged.
� Convert the data into another file format, and load the data into another

management system in a third-party management platform.

You can access these functions from the Sun Management Center console main
window or the CLI. You must specify the complete topology data and the domains to
be imported or exported. The tool supports several methods of data handling,
including overwrite and append.

� The import and export utilities support domain level operation. You can specify
one domain to export or the whole topology hierarchy.
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� You can recover backup data through the import utility.

� You can import objects of any domain to one domain.

� You can back up existing data through the export utility.

� You can export data in incremental mode.

� You can export topology information from the main console window only when
the current topology hierarchy contains data.

Topology Import and Export
Architecture
The topology import and export utilities communicate with the Sun Management
Center server through client APIs. The import and export ASCII file resides on the
console system. This file provides information through the client APIs to the server.
The server sends that information to the topology agent which interacts with the
topology database. The following figure shows the software structure that supports
these utilities.

import/export tool

Client APIs xml.jar

import/
export file

Sun Management Center Server

Topology Agent

RMI

SNMP

Console side
Server side

Database

FIGURE 19–1 Software Structure for Importing and Exporting Topology

For export, two modes are provided: Append and Overwrite. In Overwrite mode, the
dumped data replaces the contents of an existing file. In Append mode, the dumped
data is added to the end of the file.
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For import, two modes are provided to process the domain information that is
contained in the dumped file. The first mode is to ignore the domain information. All
objects are created in the specified or home domain. The second mode is to import
domain information together with all other objects. In this case, new domains can be
created. All nondomain objects are created in the corresponding domain.

Exporting Topology Information
You can start the topology export utility from the main console window or the CLI,
which is described in “Import and Export CLI Interface” on page 279.

� To Export Topology Data From the Main Console
Window

1. Choose Export Topology from the Tools menu in the main console window.

The Export Topology dialog box appears.

2. Select a domain from the Export Domain Name list.

The list shows all domains managed by the topology agent. You can select one
domain to export. To export multiple domains, you can repeat the preceding
operation to export another domain in the append mode.

3. Type the name of the file to be exported, or select an existing file by using the
Browse button.

To export a file, you must have permission to write to the file or to create the file.
Otherwise, an error message is displayed and the operation exits.

4. Determine whether to append data to or overwrite data in an existing file.

Append mode appends the data at the end of the file. Overwrite mode overwrites
the file. When Append mode is used in the export, a more restrictive check is
performed on the file. The existing file must be a valid import and export data file.
A valid data file is a well-formed XML file with correct import and export file
document type declaration (DTD).

5. Choose the number of days for which the data is valid from the Valid for Days
menu.

You can choose from the following values:

� 7 days
� 15 days

Steps
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� 30 days
� 90 days

By default, topology export data is valid for an unlimited number of days.

6. (Optional) Provide comments about this export function.

7. Click OK to export the data to the specified file and close the Export Topology
window.

Importing Topology Information
You can start the topology import utility from the main console window or the CLI,
which is described in “Import and Export CLI Interface” on page 279.

� To Import Topology Data From a File

1. Select Import Topology from the Tools menu in the main console.

The Import Topology window appears.

2. Type the full path name to the file that contains topology data to import.

Tip – You can also use the Browse button to find the file.

3. Determine whether to import everything in the topology or only groups and
entities.

� Follow – Imports groups and domain information. The groups and entities are
created in the domain contained in the file.

� Ignore – Ignores the domain information and imports only groups and entities
to the target domain that you specify.

4. Select the domain to which to import the data from the Name list.

All data is imported into the home domain by default.

Note – You can specify the location in the topology hierarchy to which the data will
import only if you chose the Ignore option in the previous step.

Steps
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5. Click OK to import the data and close the Import Topology window.
The import utility updates the topology database. Therefore, a warning dialog box
allows you to confirm the operation before the data is imported.

The warning dialog box tells you when the input file was generated and who
generated the file. This warning helps you to ensure that the correct data file is
being used.

Several additional checks are performed:

� Exported data files include information about the validity time of the file. If you
are trying to import an out-of-date file, you receive an error message and the
operation stops.

� The import utility checks that the file exists and that the file is readable. If these
checks fail, you receive an error message, and the operation stops.

� For the import utility to analyze the import file, the file format must be correct.
If the file is formatted incorrectly, the import utility generates an error message.

� If the entity exists in the current topology hierarchy, another warning dialog
box asks whether the entity should be replaced. Select one of the following
options:

Replace Replaces the conflicting data with new values.

Replace All Replaces all conflicting data. The dialog box does not appear
when the data conflict occurs again, and the old value is
replaced

Ignore Do not update the conflicting data.

Ignore All The dialog box does not appear when another data conflict
occurs. All conflicts are ignored and are left unchanged.

Cancel Import Stops the import operation.

Import and Export CLI Interface
You can invoke the import and export utilities from CLI with the following
commands:

# /opt/SUNWsymon/sbin/es-cli
> login
Host: servername
Login: username
Password: password
Login successful!
> export parameter
> import parameter
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See “Import Command Parameters” on page 280 and “Export Command Parameters”
on page 282 for information about appropriate command parameters.

Topology Import Utility
The import command retrieves previously exported topology data for the specified
domain from a file.

Import Command Parameters
The import command takes the following parameters:

domain The value of the domain parameter is the name of the domain whose
topology is to be imported. If no domain is specified, all domains are
imported.

domainmode The value of the domainmode parameter determines whether new
domains are created from the imported topology. If the value is
follow, then group and domain topology are imported into the
current topology, and new domains can be created. If the value is
ignore, then only groups and entities are imported to the specified
target domain.

filename The value of the filename parameter is the name of the file from which
the topology information should be retrieved.

nodemode The value of the nodemode parameter determines whether the imported
topology replaces the existing topology. If the value of the nodemode
parameter is replace, then conflicting data is replaced with the
imported values. If the value of the nodemode parameter is ignore,
then conflicting data is not updated.

The explicit assignment in the command line overrides the same assignment in the
parameter file. For example, if mode=ignore is assigned in the command line and
mode=follow is assigned in the parameter file, then mode=ignore is used.

EXAMPLE 19–1 Importing Topology Data from a File

In the following example, previously exported topology is imported from the file
/home/examples/snapshot. New domains are created as necessary, and conflicting
data is replaced by the imported topology.

> import filename=/home/examples/snapshot domainmode=follow \

nodemode=replace
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Confirmation Messages
The import utility prompts you to answer the following items before the operation is
done or when the data conflicts:

� Warning message for confirmation – The following message asks you to confirm
the import operation.

The data being used is exported by <user name> on <mm/dd/yyyy>.
The import operation will modify your topology database, are you sure you want to do this?
[Yes/No]

Enter y for Yes or n for No.

Output Messages for the Import Command
This section describes the messages that might appear as a result of the import
command.

import: Results 1/1

State=Success

Message=The topology data is successfully imported.
Cause: Success.

Description: The operation completed successfully.

filename: No such file.
Cause: File does not exist.

Description: The specified file does not exist. The command line might use two
files: a data file that provides the import data source, and a parameter file that
provides a parameter list.

import: Cannot open filename.
Cause: Permission denied.

Description: The file cannot be opened for reading.

import: File format is not supported.
Cause: Format wrong.

Description: The source file is not a valid database file for exporting data.

import: File out-of-date (xx days).
Cause: Data out-of-date.

Description: You are using out-of-date data.
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import: Authentication failed.
Cause: Authentication failed.

Description: The current user has no authority to create objects in the topology
hierarchy.

import: Wrong parameter file.
Cause: Parameter file error.

Description: The parameter file should be a list of name = value pairs. If the format is
not correct, the application generates an error message and stops.

import: illegal parameter - <para>.

Use -h option to get usage.
Cause: Illegal parameter.

Description: An illegal parameter has been passed to the import operation. Use
import -h to view the available options and the available parameters.

Topology Export Utility
The export command saves the topology data for a domain, or for all domains, to a
file.

Export Command Parameters
The export command takes the following parameters:

comment The value of the comment parameter is an annotation to be included in the
file.

domain The value of the domain parameter is the name of the domain whose
topology is to be exported. If no domain is specified, all domains are
exported.

filename The value of the filename parameter is the name of the file to which the
topology information should be exported.

mode The value of the mode parameter determines how the topology information
is incorporated into the file. If the value is append, then the data is
appended to the contents of the file. If the value is overwrite, then the
previous contents of the file are replaced by the new data.

validity The value of the validity parameter is the length of time in days for which
the data is valid. The following values are legal values for the validity
parameter:
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� Unlimited
� 7
� 15
� 30
� 90

EXAMPLE 19–2 Exporting Default Domain Topology to a File

In the following example, the Default Domain is saved to a file that is named
snapshot. The original contents of snapshot are overwritten by the new data. The
new data is assumed to be valid for an unlimited period of time. The comment
specifies that this data is for the system testing group.

> export filename=/home/examples/snapshot \
domain="Default Domain" mode=overwrite validity=Unlimited \

comment="System Test Group"

Output Messages for the Export Command
The following list shows the messages that might appear as a result of the export
command.

Export: Results 1/1

State=Success

Message=The topology data is successfully exported.
Cause: Success.

Description: The operation completed successfully.

export: Cannot open file.
Cause: File does not exist.

Description: The parameter file does not exist.

filename: Permission denied.
Cause: File error.

Description: The file cannot be created or be opened for writing.

export: File format not supported.
Cause: Format wrong.

Description: The error occurs when appending the export data to a file that is not a
valid export data file.
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export: The domain <domainname> does not exist
Cause: Object error.

Description: The domain that you want to export does not exist.

export: Wrong parameter file.
Cause: Parameter file error.

Description: The parameter file contains a list of name = value pairs. If the file format
is not correct, the application notifies you and stops.

export: The current user is different from the last one.
Cause: User conflict.

Description: The error occurs when you try overwrite or append the data to an
existing data file created by others. You cannot modify or overwrite export data
that another user created.

export: Data is out-of-date.
Cause: Data is too old.

Description: You are using an out-of-date export file. This message only occurs
when you export data in append mode.

export: illegal parameter - <para>.

Please use -h option to get usage.
Cause: Illegal parameter.

Description: An illegal parameter was passed to the export operation.

Import and Export File Contents
The following list identifies the topology data that the import and export utilities
process.

Entity information The record information about every domain, group and
host.

Adornment information The adornment information about domains and groups.
The adornment information contains only the layout and
background index instead of the background content. For
example, the information about background only
contains the GIF file name, not the GIF file.
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Relationship information The relationship information describes the topology
hierarchy, entity background and layout.

File Format Description
The Import/Export file describes the import and export data. You can use any text
editor to edit this file. The file includes information about every entity in the topology
hierarchy. Because the append export mode can append more object information to the
file, the format is easy to extend and analyze. The exported data is saved in XML
format.

File Format Design
The file is separated into four parts:

� Magic information
� DTD (Document Type Declaration)
� Header information
� Data blocks

Magic Information
The magic information identifies that the file is an XML format file. Typically, this
information appears as follows:

<? XML version = 1.0 ?>

DTD (Document Type Declaration)
The DTD information defines the structure of the document. The DTD of an export file
resembles the following example.

EXAMPLE 19–3 Import and Export File DTD

<!ELEMENT ENTITY (ENTITY* ADORNMENT*)>
/* Entity element describes a entity. If it is a group, it may

contain groups and adornment. */
<!ATTLIST ENTITY /* Entity attributes */

desc CDATA
full_desc CDATA
hostname CDATA
ip CDATA
netmask CDATA
architecture CDATA
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EXAMPLE 19–3 Import and Export File DTD (Continued)

family CDATA
polling_type CDATA
url CDATA
x_coord CDATA
y_coord CDATA
topology_type CDATA
event_dest CDATA
trap_dest CDATA
target_host CDATA
target_ip CDATA
read_info CDATA
write_info CDATA>

<!ELEMENT ADORNMENT>
<!ATTLIST ADORNMENT

x_coord CDATA
y_coord CDATA
type CDATA
configuration CDATA>

]>

Header Information
The header information is used to record the general information, such as the
following:

� User
� Data
� Version
� Platform
� Product

Data Blocks
Data blocks contain the topology hierarchy architecture and entities.

Topology and Export File Example
The following figure illustrates the topology for the My New domain.
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FIGURE 19–2 My New Topology Example

EXAMPLE 19–4 Export File for My New Domain

This example shows a topology export file for the My New domain.

<?xml version="1.0" encoding="UTF-8"?>
<DOCUMENT>
<HEAD>
<USER>jkang</USER>
<DATE>1/7/1999</DATE>
<VALIDITY>7 days</VALIDITY>
<PRODUCT>Sun Management Center</PRODUCT>
<VERSION>3.6</VERSION>
<COMMENTS>This is an example.</COMMENTS>

</HEAD>
<DOMAIN name="my new">

<ENTITY arch="SunOS 5.8" config="" desc="wizard" entityId="e-1"
family="sun4u-Sun-Ultra-2" fulldesc="wizard" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="ahost" readInfo="" targetHost=""
targetIp="" targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"
type="" writeInfo="" xCoord="23" yCoord="39"

/>
<ENTITY arch="SunOS 5.8" config="" desc="atom" entityId="e-2"
family="sun4u-Sun-Ultra-2" fulldesc="" hostname="u30-1"
ipAddr="129.158.168.113" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="ahost" readInfo=""
targetHost="" targetIp=""
targetUrl="snmp://129.158.168.113:161/sym//base/mibman/modules"
type="" writeInfo="" xCoord="75" yCoord="39"

/>
<ENTITY arch="" config="" desc="campus" entityId="e-3" family="campus-view"
fulldesc="" hostname="" ipAddr="" isPoll="true" isSoftGroupLink="false"
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EXAMPLE 19–4 Export File for My New Domain (Continued)

netMask="" pollType="aview" readInfo="espublic" targetHost="" targetIp=""
targetUrl="snmp://129.158.168.63:164/mod/topology+view-101"
type="" writeInfo="" xCoord="27" yCoord="111">
<ENTITY arch="" config="" desc="building" entityId="e-1"
family="building-view" fulldesc="" hostname="" ipAddr=""
isPoll="true" isSoftGroupLink="false" netMask="" pollType="aview"
readInfo="espublic" targetHost="" targetIp=""
targetUrl="snmp://129.158.168.63:164/mod/topology+view-102"
type="" writeInfo="" xCoord="" yCoord="">
<ENTITY arch="SunOS 5.8" config="" desc="Wizard" entityId="e-1"
family="sun4u-Sun-Ultra-2" fulldesc="" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="ahost" readInfo=""
targetHost="" targetIp=""
targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"
type="" writeInfo="" xCoord="" yCoord=""

/>
<ENTITY arch="SunOS 5.8" config="" desc="aaa" entityId="e-2"
family="sun4u-Sun-Ultra-2" fulldesc="" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="ahost" readInfo=""
targetHost="" targetIp=""
targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"
type="" writeInfo="" xCoord="" yCoord=""

/>
<ENTITY arch="SunOS 5.8" config="" desc="atom" entityId="e-3"
family="sun4u-Sun-Ultra-2" fulldesc="" hostname="u30-1"
ipAddr="129.158.168.113" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="ahost" readInfo=""
targetHost="" targetIp=""
targetUrl="snmp://129.158.168.113:161/sym//base/mibman/modules"
type="" writeInfo="" xCoord="" yCoord=""

/>
</ENTITY>

</ENTITY>
<ENTITY arch="" config="" desc="129.158.0.0" entityId="e-4"

family="network-view" fulldesc="129.158.0.0" hostname="129.158.0.0"
ipAddr="129.158.0.0 isPoll="true" isSoftGroupLink="false"
netMask="255.255.255.0" pollType="aview"
readInfo="espublic" targetHost="129.158.0.0" targetIp="129.158.0.0"
targetUrl="snmp://129.158.168.63:164/mod/topology+view-103" type=""
writeInfo="" xCoord="38" yCoord="181">
<ENTITY arch="" config="" desc="129.158.168.0" entityId="e-1"

family="subnetwork-view" fulldesc="129.158.168.0"
hostname="129.158.168.0" ipAddr="129.158.168.0"
isPoll="true" isSoftGroupLink="false" netMask="255.255.255.0"
pollType="aview" readInfo="espublic" targetHost="129.158.168.0"
targetIp="129.158.168.0"
targetUrl="snmp://129.158.168.63:164/mod/topology+view-104"
type="" writeInfo="" xCoord="" yCoord="">
<ENTITY arch="SunOS 5.8" config="" desc="wizard" entityId="e-1"
family="sun4u-Sun-Ultra-2"
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EXAMPLE 19–4 Export File for My New Domain (Continued)

fulldesc="SUNW,Ultra-2" hostname="wizard" ipAddr="129.158.168.63"
isPoll="false" isSoftGroupLink="false" netMask="255.255.255.0"
pollType="ahost" readInfo="public" targetHost="" targetIp=""
targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"
type="" writeInfo=""
xCoord="" yCoord=""
/>

</ENTITY>
</ENTITY>
<ENTITY arch="" config="" desc="myworkstation" entityId="e-5"
family="nonagent-sun4u-Sun-Ultra30" fulldesc="" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="" pollType="snmp" readInfo="public" targetHost=""
targetIp="" targetUrl="snmp://wizard:1100/oid//1.3.6.1.2.1.1.7.0"
type="" writeInfo="private" xCoord="52" yCoord="253"

/>
<ENTITY arch="SunOS 5.8" config="" desc="System Group" entityId="e-6"
family="base-agent" fulldesc="MIB tree branch" hostname="wizard"
ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
netMask="255.255.255.255" pollType="amod" readInfo=""
targetHost="wizard" targetIp="129.158.168.63"
targetUrl="snmp://129.158.168.63:1100/mod/mib2-simple/system"
type="" writeInfo="" xCoord="52" yCoord="329"

/>
<ADORNMENT Config="bus" Id="adorn-7" Type="layout" XCoord="0" YCoord="0" />
</DOMAIN>

</DOCUMENT>
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CHAPTER 20

Using the Command-Line Interface

The Sun Management Center command-line interface (CLI) is a lightweight,
character-driven console alternative to the Java and web console graphical interfaces
for monitoring and managing your system.

The following topics are discussed in this chapter:

� “Overview of the Sun Management Center CLI” on page 291
� “CLI Parameters” on page 296
� “CLI Commands” on page 301
� “CLI Output” on page 323
� “CLI Procedures” on page 325

Overview of the Sun Management
Center CLI
The Sun Management Center command-line interface (CLI) is a character-driven
console application for monitoring and managing your system. The CLI offers several
useful features:

� Low overhead – Although the CLI provides most of the functionality of the Java
Console and web console, the CLI does not require bitmapped graphics. The CLI
therefore can run on simple data terminal equipment over low-bandwidth
connections. However, features that require a GUI, such as physical views or
graphing, are unavailable through the CLI.

� Batch mode processing – The CLI supports a basic scripting functionality that
enables the CLI to take command input from a file in batch mode.

� Configurable output format – You can configure the format of CLI output. The
plain-text output is compatible with other text-based tools. For extended
commands, you can specify output in XML and HTML.
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� Help – Online help for CLI commands is available from within the CLI.

You can use the CLI to perform the following tasks:

� Create topology objects such as domains, groups, and entities, and retrieve
topology information about these objects.

� Retrieve and manipulate managed object properties or attributes.

� Load, unload, enable, and disable modules on Sun Management Center agents.

� Set and run alarm actions, retrieve alarm information, and acknowledge or delete
alarms on Sun Management Center agents.

Note – (On Solaris) You can automatically log in to the console using the parameters
file. If the parameters file contains user name and password, the permission for that
file must be 400. Otherwise, automatic login through CLI is not possible.

System Requirements
You can access the CLI from a user terminal session on one of the following system
configurations:

� UNIX® workstation running the Solaris 2.6, Solaris 7, Solaris 8, Solaris 9, or Solaris
10 version of the Solaris Operating System.

� UNIX workstation running Red Hat, SuSE/JDS Linux kernel version 2.4 and 2.6.

� PC running Windows 98, Windows 2000, Windows XP, or Windows NT

CLI Interaction Modes
The CLI supports the following two interaction modes:

� Session mode – Session mode is interactive. Once you log in to the Sun
Management Center server, you can enter commands and receive output until you
explicitly log out of the server.

� Batch mode – The CLI connects to the server and executes the commands
contained in filename, where filename is the name of a file that contains CLI
commands.

Configuring CLI Batch Mode
CLI batch mode can be configured by modifying the cli.properties file located at
/opt/SUNWsymon/cli. This file contains nine configurable parameters.

Table 20–1 describes the configurable parameters.
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TABLE 20–1 Parameters to Configure CLI Batch Mode

Parameter Description Default Value

process_time_out When this time expires, CLI
back end processes will be
removed from the system.

Process time-out 24 hrs

process_time_out = 86400
(in seconds)

uds_dgram_wait_time DGRAM client will be waiting
for response from the CLI back
end process. If the client does
not receive any response within
the specified time, an error
message “Error receiving data
from Backend” is displayed.

UDS DGRAM wait time in
seconds

uds_dgram_wait_time =
300

uds_stream_wait_time STREAM client will be waiting
for response from the CLI back
end process. If the client does
not receive any response within
the specified time, an error
message “Error receiving data
from Backend” is displayed.

UDS STREAM wait time in
seconds

uds_stream_wait_time =
180

out_file This file contains the details of
the currently running CLI back
end processes. The format of
this file is

<user>:<hostname>:<C Process
ID>:<Java Process ID>

User & process
information file

out_file =
/var/opt/SUNWsymon/cli/
process-file

socket_pathclnt This file contains the path of
the client broker UDS file. The
output of the processed CLI
commands is sent to this file.

Path to uds file

socket_pathclnt =
/var/opt/SUNWsymon/cli/
broker_uds_client_file

cli_log_path This file contains the path of
the CLI log files.

Location of CLI log file

cli_log_path =
/tmp/sunmclog/cli

cli_log_file Name of the CLI log file. Location of
backend(broker) log file

cli_log_file =
/tmp/sunmclog/cli/
cli-batch-mode-log

uds_file_path This path contains the location
of the STREAM and DGRAM
UDS files.

Path of the uds files

uds_file_path =
/var/opt/SUNWsymon/cli/
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TABLE 20–1 Parameters to Configure CLI Batch Mode (Continued)
Parameter Description Default Value

log_level Specifies the logging level to be
used. Set the log level to ERROR
for the production
environment. Set the log level
to INFO for the debugging
environment.

Batch mode log level
[options : INFO|ERROR]

log_level=ERROR

CLI Command and Parameter Overview
This section provides an overview of CLI commands and parameters.

CLI Command Overview
CLI commands can be divided into two types: basic commands and extended
commands.

� Basic commands are commands that modify the environment in which other CLI
commands are executed. You use basic commands to set parameter values, define
command aliases, check command status, or log in and log out of the server. Basic
commands always execute in the foreground.

� Extended commands are commands that interrogate or modify the topology of
managed objects, their properties, and their attributes. You use extended
commands to perform several functions:

� Locate managed objects in the managed object topology
� Enable or disable modules
� Acknowledge or delete alarms

By default, extended commands run in the background. You can configure extended
commands to run in the foreground.

In session mode, commands execute in either the foreground or the background.

� Foreground – Commands that execute in the foreground run to completion. These
commands send their output directly to the screen unless otherwise redirected.
Only one command at a time can run in the foreground. Basic commands can only
run in the foreground. Extended commands run in the background by default, but
can be configured to run in the foreground.

� Background – Commands that execute in the background run asynchronously and
by default send no output or diagnostic messages to the screen. Output is buffered
and can be displayed later by explicit request. Unlike the UNIX shells, only one
extended command can run in the background at a time. While this command is
running in the background, any number of basic commands can run in the
foreground. By default, extended commands run in the background, although you
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can specify that extended commands run in the foreground. Basic commands
cannot run in the background.

The CLI also supports aliases. You can define a shorthand term or pseudonym for a
more complicated command and its parameters. User-defined aliases persist across
different CLI sessions.

CLI Parameter Overview
CLI parameters are name-value pairs: each parameter has a name and a value. Some
parameters are built-in to the CLI. Their names and the significance of their values are
predefined within the CLI. You can define other parameters, also known as variables.
Some parameters are global in scope. Global parameters affect the execution of all CLI
commands that are run in a particular session. Other parameters are specific to a
certain command or group of commands.

Input and Output Capabilities
The CLI provides several capabilities for input and output.

� Input

� In session mode, the CLI accepts commands interactively from the keyboard.

� In batch mode, the CLI executes commands that are contained in a CLI
command file whose name is specified on the shell command line.

� Output

� For basic commands, output appears on the screen by default.

� For extended commands, output is buffered in the background by default until
you request that output.

� The output of both basic and extended commands can be redirected to a file
that you specify.

� Commands and parameters can be saved in a log file that can later be used as
input to the CLI in batch mode.

Note – To use a log file as input to the CLI in batch mode, you must edit the file.
Remove the time stamps and any messages that appear before the actual
commands and parameters in the log file.

� Format

� You can specify the number of lines for the output display.

� For multi-column output, you can specify which columns to display.
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� In addition to plain-text output, for some commands you can specify XML and
HTML output.

CLI Command Help
The CLI provides online help for each CLI command. CLI help is available from
within the CLI. CLI help does not require a GUI. For each command, the help
provides a synopsis of command usage and a list of the parameters associated with
that command.

CLI Parameters
Most CLI parameters are name-value pairs: each parameter has a name and a value. A
few parameters have names but no values. These parameters are known as flags.

Scope of Parameters
You can specify parameter values at several points in a CLI session:

� CLI startup – You can specify parameters at the command line when you start the
CLI. Parameters that are specified at startup are global to the session. Global
parameters retain their values unless overridden with the set command or
removed from the current session with the unset command.

� CLI commands – You can specify parameters for individual CLI commands
executed during a session. A value specified as part of a command temporarily
overrides the value of a global parameter for the duration of that command.

� Input file – Parameter definitions can be stored in an external file and can be
invoked at any time in a CLI session. Parameter values that are defined in an
external file are overridden by global parameters and by individual command
parameters.

Parameter Syntax
Parameters are specified as name=value pairs:

file=/home/examples/example1

where the parameter name is file and the parameter value is
/home/examples/example1. There must be no whitespace between the equals sign
(=) and the parameter name or parameter value. If the value contains whitespace such
as a space or tab character, the value must be enclosed in double-quote characters
(ASCII character 0x22):
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moduleDesc="Local File Scanning"

Parameter values can be a list of comma-separated values. There must be no
whitespace between the comma-separated values, as shown in the following example.

severity=DIS,DWN,ERR

A parameter list is a sequence of parameters separated by whitespace, as shown in the
following example.

m=kernel-reader moduleDesc="My Kernel Reader"

Examples of Acceptable and Unacceptable Parameter
Syntax
The following parameters have acceptable syntax:

ok1="This is just a test"
ok2=hello
ok3=hello,hi,aloha
ok4="hello,hi,aloha"

The following parameters do not have acceptable syntax:

broken1="How are you?","Who are you?"
broken2="Testing",1,2,3
broken3="Hello
broken4=Hello"

Parameter Input File Format
Parameters can be stored in a file and read when needed. You can create as many
parameter files as needed. Use the built-in i parameter to specify the name of the
desired parameter input file.

Predefined Parameters and Flags
This section describes parameters that have predefined meanings within the CLI.

Note – Several predefined parameters have single-letter names. Some examples include
such as a, f, and o.

-b When included at the command line when the CLI is started, this flag
instructs the CLI to run in batch mode. This flag is ignored in session
mode.
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-h When this flag is used as a parameter to a command in session mode, it
instructs the CLI to display the help text for the command.

-l When this flag is used as a parameter to an extended command in
session mode, it instructs the CLI to retain the parameters from the last
extended command while executing the current command. If the -l flag
is specified, any additional parameters specified for the current
command are ignored. This flag has no effect on basic commands. The
following example illustrates usage of the -l flag:

> getLoadModules a=myHostName
...
...
> getAlarms -l

When the getAlarms command is executed, the command uses the
value of parameter a (myHostName) from the previously executed
getLoadModules command.

a The value of the a parameter is an agent, which is specified as the agent
host and (optional) port number. If you specify the port number,
separate the number from the host name by a colon (:). The general
syntax is a=agentHost[:agentPort]. For example, to specify an agent
running on host example_host and listening to port 12345, you
would use the following syntax:

a=example_host:12345

The value of the a parameter can also be a comma-separated list of agent
specifications: a=agent[,agent]*.

about The about parameter is used with the help command. This parameter
displays the version information for CLI.

append The value of the append parameter is the name of a file to which the
output of a command should be appended. If this file does not exist, the
file is created. If you set the append parameter globally, all command
output for that session is appended to the specified file. You can also set
this parameter for a specific command, as shown in the following
example.

append=/home/examples/cli_output

If both the append and o parameters are set, append takes precedence over
o. Only command results are recorded in the specified file. The actual
command is not recorded. Use the log parameter to record command
information.

columns The value of the columns parameter is the name of one or more columns
of command output to be displayed by the print command. Column
names are case sensitive. Multiple column names are separated by
commas. The following example uses several column names.
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columns="Alarm Id,Node URL,Target Host,Severity"

f The value of the f parameter determines the format of command output.
The current formats are plain and html. See “Command Output
Format” on page 323 for more information. To set the format to HTML,
use the following syntax:

f=html

height The value of the height parameter is the number of lines of command
output to display on the screen. The following example sets the height to
approximately the height of a standard terminal screen:

height=24

history The value of the history parameter is the number of commands to be
stored in the command history. The command history allows the user to
view the previously executed commands. This parameter is used by the
set command.

history=10

i The value of the i parameter is the name of an input file that contains
parameter definitions to be included in the current session. Within the
input file, each parameter definition should be on a separate line. For
example, assume that the following lines are in a
/home/examples/myParams file:

more=off
serverHost=myserver
a=myagent:161

You could include these parameters in the current CLI session by using
the following line:

i=/home/examples/myParams

log The value of the log parameter is the name of a file that records all CLI
commands and the time that the commands were executed. Note that
the log file records only command names and time of execution.
Command output is logged in files specified by the a or o parameters.
Once the parameter is set, all subsequent commands are appended to
the file. If this file does not exist, the file is created. Because the log file is
not overwritten when logging is turned on, specify a different file if you
want a different log. To turn logging off, use the unset command with
the log parameter. The following example starts a log, then later stops
the log.

> log=/home/examples/sunmc-log
...
...
> unset log
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logmode The value of the logmode parameter can be detailed, command, or
from n. The value of detailed stores detailed information of
commands in the command log file. The value of command stores only
the commands and the respective parameters in the command log file.
The value of from n appends all the entries (starting from the nth entry)
in the command history to the command log file. The default value of
the logmode parameter is detailed.

m The value of the m parameter is the name of a Sun Management Center
module. The value can also be a comma-separated list of modules.

m=kernel-reader

more The value of the more parameter controls paging of command output on
your display. Possible values are on and off. If more is set to on, all
subsequent output to the terminal is displayed one screen at a time. The
size of a screen is defined by the height and width parameters. Default
values are off for batch mode and on for session mode.

more=on

ncols The value of the ncols parameter is the maximum number of columns of
command output to be displayed by the print command.

o The value of the o parameter is the name of a file to which command
output should be written. If this file exists, the file is overwritten. You
can use the o parameter to capture the output of a particular command
by specifying the o parameter to that command. You can also set the
parameter globally using the set command to write all subsequent
output to a file.

If both the append and o parameters are set, append takes precedence over
o. Output is appended to the specified file. Only command output is
written to the file. The actual command is not recorded. Use the log
parameter to record command information. The following example
defines a file into which command output is written.

o=/home/examples/sunmc-output

prompt The value of the prompt parameter is used to set a different CLI prompt.

serverPort The value of the serverPort parameter is the server port for login. This
global parameter cannot be set after a login session is established. If this
parameter is not set, the default port of 2099 is used.

style The value of the style parameter determines the style of command
output. The allowed values of this parameter are table, list, and
<custom>. The table value displays the output in a tabular format.
The list value displays the output in a list with the columns separated
by a comma. The <custom> value ensures that the output is displayed
in a user-defined format. Each column is represented by %a. The custom
value can contain special characters such as :, \t, and \n.
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t The value of the t parameter is the name of an object that is managed in
the topology agent. The object can be a domain, a view group, or an
entity. The object name is the fully qualified name at the domain level,
for example, /domain/group/host.

CLI Commands
See “CLI Command and Parameter Overview” on page 294 for an overview of
command types and concepts. For details about the parameters used by the basic CLI
commands, refer to “Predefined Parameters and Flags” on page 297.

Basic CLI Commands
The following list describes the basic CLI commands.

alias Description

The alias command creates an alias for frequently used commands or
for commands that have complicated parameters. An alias cannot have
the same name as an existing CLI command. Whitespace in an alias
definition must be enclosed in double-quotes (", ASCII character 0x22).

When the user quits a CLI session, the aliases that the user has specified
are stored in a file in the aliases directory. These aliases will be
available when the user logs in to the CLI session.

Syntax

alias [<pseudonym>="command [parameters]"]

Examples

> alias assign=set
> alias alarms="getAlarms severity=dwn"

If called without arguments, the alias command prints a list of defined
aliases and their values. The following example shows the result of the
alias command when the command is called without arguments.

> alias
assign - set
alarms - getAlarms severity=dwn
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attrib Description

The attrib command retrieves the attributes of a topological object.

Syntax

attrib [group=groupName [name=attribName] [-key]]

browse Description

The browse command activates the browsing mode of the topology.

Syntax

browse

cd Description

The cd command changes the current topological path. If no path is
specified, the current path will be set to the default domain. If a number
(n) is specified, the current path will be set to the nth child path, as
shown by the list command.

Syntax

cd [path|number]

clear Description

The clear command removes all parameters that were set during the
current session. However, this command will not remove parameters
that were set from the command line. This command is similar to the
unset command but does not require parameter names as arguments.

Syntax

clear

data Description

The data command shows the details of a topological object. If a
number (n) is specified, the path will be set to the nth child path, as
shown by the list command.

Syntax

data [path|number|-key]

end Description

The end command deactivates the browsing mode of the topology.

Syntax
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end

exit Description

The exit command terminates your server connection and the CLI
session.

Syntax

exit [-onError]

Parameter

onError

The onError parameter is used to terminate the CLI session if an
exception occurs in the execution of the previous command. This
parameter is used only in batch mode.

Note – The exit command and the quit command are identical.

goto Description

The goto command navigates to a topological path that matches the
case-sensitive pattern. If more than one matching path is found, the user
is asked to choose a path.

Syntax

goto <pattern>

help Description

The help command displays information about CLI commands and
their parameters. The help information is suitable for displaying on a
terminal screen that is not bitmapped. When help is executed without
an argument, the help displays an alphabetical list and a brief
description of available CLI commands. Basic commands are listed first,
followed by extended commands. When help is called with the name of
a CLI command as an argument, help prints information specific to that
command. When help is called with the about parameter, help
displays the version of Sun Management Center.

Syntax

help [<command>|about]

Parameters
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command and about.

Example

The following example shows help for the getAlarms command.

> help getAlarms
getAlarms [a=host[,host]+] [alarm_filter_list]
- Get alarm information on an agent or a list of agents under a
set of filter conditions. If no agent is provided, all alarms will
be obtained. All the filter conditions are "ANDED" to provide the
result. The filter conditions as specified in alarm_filter_list
comprises:
domain=domain and/or
m=module[+instance] and/or
managed_object=managed_object and/or
property=property and/or
property_instance=property_instance and/or
qualifier=qualifier and/or
severity=[DIS,DWN,ERR,OFF,INF,IRR,WRN] and/or
state=[C,F,O] and/or
ack=[A,N]

history Description

The history command lists or executes the previously entered
commands in the CLI session. When the history command is called
without any argument and history was set earlier, all the previously
entered commands will be listed. When the history command is called
with a numerical argument and history was set earlier, the command
that matches this argument will be executed.

Syntax

history [num]

kill Description

The kill command terminates any commands that are running in the
background.

Syntax

kill

list Description

The list command lists the objects under a path. If a number (n) is
specified, the path will be set to the nth child path as shown by this
command.

Syntax
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list [path|number]

locate Description

The locate command finds all the topological paths that match the
specified pattern. The pattern is case sensitive.

Syntax

locate <pattern>

login Description

The login command establishes a connection to a Sun Management
Center server. You can specify the serverHost and, optionally, serverPort
parameters as arguments. If no host is specified, you are prompted for a
host. If no port is specified, 2099 is used. The login command also
prompts you for your user name and password.

Syntax

login [serverHost=host] [serverPort=portNumber]
[user=userName] [password=userPassword]

Parameters

serverHost, serverPort, user, and password

logout Description

The logout command terminates your connection to the Sun
Management Center server, but does not terminate the CLI session.

Syntax

logout

print Description

The print command directs the output of the last extended command
in the specified format to the specified destination. By default, print
directs this output to the terminal screen in plain text format. If the
parameters append or o are set, the output is directed to the file that is
specified by those parameters. The output is not shown on the screen. if
ncols is not specified, the default number of columns is set to 4.

Note – The print command is not saved in the command history.

Syntax
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print [f=plain|xml|html] [style=table|list|<custom>]
[columns= columnList] [ncols=num] [o=outputFile |
append=appendFile]

Parameters

f, style, columns, ncols, o, and append

quit Description

The quit command disconnects from the server and terminates the CLI
session.

Note – There is no difference between the quit and the exit
commands.

Syntax

quit

reset Description

The reset command restores the values of all parameters that are
specified at the command line to the values that were specified at the
beginning of the CLI session. Parameters that were defined during the
session but not at the command line remain unchanged. If a specific
parameter name is supplied as an argument to reset and the parameter
was specified at the command line, that parameter’s value is restored to
its original value. Otherwise, the parameter’s value remains unchanged.

Note – The reset command is not saved in the command history.

Syntax

reset [<parameter>]*

set Description

The set command enables you to specify parameter values or to display
parameter values. Parameters whose values are specified with the set
command are global to the current session. Global commands are
available to all commands during that session. If you execute set with
no arguments , the value of all parameters that are defined during the
current session are displayed. If you execute set with a parameter that
is specified as an argument, the value of that parameter is displayed.
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Syntax

set [<parameter>[=value]]* [height=num] [history=num]
[log=file] [logmode=detailed|command|"from n"]
[more=on|off] [prompt=prompt]

Example

The following example shows all three variations of this command.

> set height=10
> set
height=10
> set height
height=10

status Description

The status command displays the status of any commands that are
running in the background.

Syntax

status

unalias Description

The unalias command removes the alias or a list of aliases that was
specified as an argument.

Syntax

unalias [<pseudonym>]*

unset Description

The unset command removes the specified parameter(s) from the
current session.

Syntax

unset [<parameter>]*

Note – The unset command is not saved in the command history.

where Description

The where command displays the current topological path.

Syntax
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where

Extended CLI Commands
Several types of extended commands that are available in the CLI are described in
these sections:

� “Module Extended Commands” on page 308
� “Object Attribute Extended Commands” on page 310
� “Alarm Extended Commands” on page 313
� “Topology Extended Commands” on page 317
� Topology import and export commands in “Import and Export CLI Interface”

on page 279

Module Extended Commands
Seven extended commands are available for managing modules.

Parameters for the Module Command

The following parameters can be used by the module commands. For details about the
a and m parameters, refer to “Predefined Parameters and Flags” on page 297.

moduleName The internationalized name of the module

moduleDesc The text description of the module

moduleParams The comma-separated list of module parameters

-default The default settings of the module

Module Commands

disableModule Description

The disableModule command disables a module or
modules in an agent or agents.

Syntax

disableModule a=host[:port][,host[:port]]*
m=module[+instance][,module[+instance]]*

Parameters
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a and m

enableModule Description

The enableModule command enables a module or
modules in an agent or agents.

Syntax

enableModule a=host[:port][,host[:port]]*
m=module[+instance][,module[+instance]]*

Parameters

a and m

getLoadedModules Description

The getLoadedModules command obtains a list of loaded
modules in an agent or agents.

Syntax

getLoadedModules a=host[:port][,host[:port]]*

Parameter

a

getModule Description

The getModule command obtains information for a
particular module in an agent or agents.

Syntax

getModule a=host[:port][,host[:port]]*
m=module[+instance]

Parameters

a and m

getModules Description

The getModules command obtains a list of all available
modules in an agent or agents.

Syntax

getModules a=host[:port][,host[:port]]*

Parameter
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a

loadModule Description

The loadModule command loads a module in an agent or
agents.

Syntax

loadModule a=host[:port][,host[:port]]*
m=module[+instance] [moduleName= name]
[moduleDesc=description] [moduleParams=
key=value[,key=value]*] [-default]

Parameters

a, m, moduleName, moduleDesc, moduleParams, and -default.

unloadModule Description

The unloadModule command unloads one or more
modules in an agent or agents.

Syntax

unloadModule a=host[:port][,host[:port]]*
m=module[+instance][,module[+instance]]*

Parameters

a and m

Module Command Examples

To determine which modules are loaded on a host whose agentHost name is seattle,
you would type the following command at the CLI prompt:

> getLoadedModules a=seattle

To load the kernel-reader module on the host seattle at port 1776, you would
type the following command:

> loadModule a=seattle:1776 m=kernel-reader

Object Attribute Extended Commands
There are four extended commands for managing object attributes and attribute
values.
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Parameters for the Object Attribute Command

The following parameters can be used by the object attribute commands. For details
about the a and m parameters, refer to “Predefined Parameters and Flags” on page
297.

mgtObj The value of the mgtObj parameter is the name of the managed object
whose attributes and properties are being set or retrieved.

property The value of the property parameter is the name of the property whose
attributes and values are being set or retrieved.

propInst The value of the propInst parameter is the name of the instance of the
property whose attributes and values are being set or retrieved.

rowValues The value of the rowValues parameter is a comma-separated list of
name-value pairs. name is the name of a column in the row. value is the
value in that column.

attribute The value of the attribute parameter is a comma-separated list of
attribute names that belong to the property whose attributes and values
are being set or retrieved. When used with the setAttributes
command, each attribute name in the attribute parameter must have a
corresponding value in the value parameter.

value The value of the value parameter is a comma-separated list of values that
correspond to the attributes that are specified in the attribute parameter.
When used with the setAttributes command, there must be a value
for each attribute specified.

Object Attribute Commands

You can set and retrieve object attributes and attribute values with the following
commands:

addRow Description

The addRow command adds a row with the specified values to a
table.

Syntax

addRow a=host[:port][,host[:port]]*
m=module[+instance] mgtObj=managedObject
[property=property] [propInst=propertyInstance]
rowValues=name=value[,name=value]

Parameters

a, m, mgtObj, property, propInst, and rowValues.
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delRow Description

The delRow command deletes a row with the specified values
from a table.

Syntax

delRow a=host[:port][,host[:port]]*
m=module[+instance] mgtObj=managedObject
[property=property] [propInst=propertyInstance]
rowValues=name=value[,name=value]

Parameters

a, m, mgtObj, property, propInst, and rowValues.

getAttributes Description

The getAttributes command retrieves the information for a
property or retrieves specified attributes from an agent or a list
of agents.

Syntax

getAttributes a=host[:port][,host[:port]]*
m=module[+instance] mgtObj=managedObject
property=property [propInst=propertyInstance]
[attribute=attribute[,attribute]*]

Parameters

a, m, mgtObj, property, propInst, and attribute.

setAttributes Description

The setAttributes command sets a property or sets values to
the specified attributes in an agent or a list of agents.

Syntax

setAttributes a=host[:port][,host[:port]]*
m=module[+instance] mgtObj=managedObject
property=property [propInst=propertyInstance]
[attribute=attribute[,attribute]*]
value=value[,value]*

Parameters

a, m, mgtObj, property, propInst, attribute, and value.
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For each attribute specified in the attribute parameter, there must
be a corresponding value in the value parameter.

Examples for the Object Attribute Command

The following command retrieves all attributes for the size property in the
totalstats managed object in the agent-stats module at port 1161 on host
haiku:

> getAttributes a=haiku:1161 m=agent-stats mgtObj=totalstats \
property=size

The following command sets the attribute alarmlimits.error-gt to the value of 2
in the size property specified in the previous example:

> setAttributes a=haiku:1161 m=agent-stats mgtObj=totalstats \
property=size attribute=alarmlimits.error-gt value=2

The following command deletes the row that is specified in rowValues from the
managed object that is specified in mgtObj:

> delRow a=haiku:1161 \
m=filemon mgtObj=filemonstats/filemonTable/filemonEntry \
rowValues="name=test,desc=this,filename=/etc/passwd"

Alarm Extended Commands
There are five extended commands for managing alarms.

Alarm Command Parameters

The following parameters can be used by the extended commands for alarms. For
details about the a and m parameters, refer to “Predefined Parameters and Flags”
on page 297.

ack The value of the ack parameter is a comma-separated list of values that
indicate whether the alarms being managed have been acknowledged.
Legal values for the ack parameter are ACK (Acknowledged) and NOACK
(Not Acknowledged).

command The value of the command parameter is the alarm action to be performed.

domain The value of the domain parameter is the name of the Sun Management
Center domain for which alarms are to be managed. If no domain is
specified, the Default Domain is used.

mgtObj The value of the mgtObj parameter is the name of the managed object for
which alarms are to be managed.
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note The value of the note parameter is a text annotation for the command
being run.

property The value of the property parameter is the name of the property for which
alarms are to be managed.

propInst The value of the propInst parameter is the name of the specific property
instance for which alarms are to be managed.

qualifier The value of the qualifier parameter is the name of the qualifier that is
associated with the managed property whose alarms are to be managed.

severity The value of the severity parameter is a comma-separated list of severity
values for the alarms being managed. The following values are allowed for
the severity parameter:

� ERR — Error
� WRN — Warning
� INF — Informative
� IRR — Irrational
� DWN — Down
� DIS — Disabled
� OFF — Off

state The value of the state parameter is a comma-separated list of state values
for the alarms being managed. Legal values for the state parameter are
Open, Closed, and Fixed.

Alarm Commands

You can examine alarm values and set alarm actions with the following commands:

ackAlarms Description

The ackAlarms command acknowledges alarms in an agent
or a list of agents.

Syntax

ackAlarms a=host[:port][,host[:port]]*
[domain=domain]
[m=module[+instance][mgtObj=managedObject
[property=property [propInst=propertyInstance]
[qualifier=qualifier]]]]
[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN]
[state=OPEN|CLOSED|FIXED] [note=reason]

Parameters
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a, domain, m, mgtObj, property, propInst, qualifier, severity, state,
and note.

If no value is specified for the state parameter, state defaults to
Open.

delAlarms Description

The delAlarms command deletes alarms in an agent or a list
of agents.

Syntax

delAlarms a=host[:port][,host[:port]]*
[domain=domain]
[m=module[+instance][mgtObj=managedObject
[property=property [propInst=propertyInstance]
[qualifier=qualifier]]]]
[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN]
[state=OPEN|CLOSED|FIXED] [ack=ACK|NOACK]
[note=reason]

Parameters

a, domain, m, mgtObj, property, propInst, qualifier, severity, state,
ack, and note.

If no value is specified for the state parameter, state defaults to
Closed.

getAlarms Description

The getAlarms command retrieves alarm information for an
agent or a set of agents.

Syntax

getAlarms a=host[:port][,host[:port]]*
[domain=domain]
[m=module[+instance][mgtObj=managedObject
[property=property [propInst=propertyInstance]
[qualifier=qualifier]]]]
[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN]
[state=OPEN|CLOSED|FIXED] [ack=ACK|NOACK]

Parameters

a, domain, m, mgtObj, property, propInst, qualifier, severity, state,
and ack.
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If no parameters are specified, getAlarms returns all alarm
information.

runAlarmAction Description

The runAlarmAction command runs a manual or delayed
alarm action for all alarms under a domain of an agent or a list
of agents.

Syntax

runAlarmAction a=host[:port][,host[:port]]*
[domain=domain]
[m=module[+instance][mgtObj=managedObject
[property=property [propInst=propertyInstance]
[qualifier=qualifier]]]]
[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN]
[state=OPEN|CLOSED|FIXED] [ack=ACK|NOACK]

Parameters

a, domain, m, mgtObj, property, propInst, qualifier, severity, state,
and ack.

setAlarmAction Description

The setAlarmAction command sets a manual or delayed
alarm action for all alarms under a domain of an agent or a list
of agents.

Syntax

setAlarmAction a=host[:port][,host[:port]]*
command=command [domain=domain]
[m=module[+instance][mgtObj=managedObject
[property=property [propInst=propertyInstance]
[qualifier=qualifier]]]]
[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN]
[state=OPEN|CLOSED|FIXED] [ack=ACK|NOACK]

Parameters

a, command, domain, m, mgtObj, property, propInst, qualifier,
severity, state, and ack.
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Alarm Command Examples

The following command retrieves all alarms with severity of ERR or DWN from the host
haiku:

> getAlarms a=haiku severity=ERR,DWN

Topology Extended Commands
There are nine extended commands for managing topology.

Topology Command Parameters

The following parameters can be used by the extended commands for topology. For
details about the a and t parameters, refer to “Predefined Parameters and Flags”
on page 297.

agentPort The value of the agentPort parameter is the agent port number. If
agentPort is not specified, the default value of 161 is used. The
agentPort parameter is optional. This parameter is only specified if the
url parameter is not specified and if you do not want the default port.

arch The value of the arch parameter is the architecture of the topology
object.

domain The value of the domain parameter is the name of the Sun Management
Center domain that you must specify for the setCurrentDomain
command.

domainmode The value of the domainmode parameter can be follow or ignore. If
the value is follow, the import command imports both the group
and domain information from the file to the specified target domain. If
the value is ignore, the import command ignores the domain
information.

family The value of the family parameter is the object family of the topology
object. If this is not specified, this will be automatically obtained.

filename The value of the filename parameter is the name of the file. This
parameter is used by export and import commands to export and
import topology data.

fullDesc The value of the fullDesc parameter is a text description of the entity or
group being created.

isPolled The value of the isPolled parameter can be true or false. If the value
is true, the entity polls for status information according to the polling
type (pollType). The default value is true.

Chapter 20 • Using the Command-Line Interface 317



mode The value of the mode parameter can be append or overwrite. If the
value is append, the export command adds the topology data to the
end of the file. If the value is overwrite, the export command
overwrites the file with the topology data.

nodemode The value of the nodemode parameter can be replace or ignore. If
there is a mismatch of data in the file and in the domain, the replace
value replaces the data in the domain with data in the file. The
ignore value ignores any mismatch of data.

pollType The value of the pollType parameter is the type of polling for this entity.
The following values are allowed for the pollType parameter:

� agroup – Identifies a group on which an active agent is installed
and running

� ahost – Identifies a host on which an active agent is installed and
running

� amod – Identifies a module that has an active agent
� aprox – Identifies an agent that is running an SNMP proxy

module
� dummy – Identifies a device that is not monitored
� ping – Identifies a host to be monitored using the ICMP ping

command
� snmp – Identifies a host to be monitored using the SNMP ping

command

readInfo The value of the readInfo parameter is the name of the SNMPv1 read
community for SNMP polled objects.

targetHost The value of the targetHost parameter is the name of the target host.

targetIp The value of the targetIP parameter is the IP address of the target host.

topoCfg The value of the topoCfg parameter is configuration information for the
topological representation of a managed entity.

topoType The value of the topoType parameter is the topological representation
type of a managed entity.

url The value of the url parameter is the URL of the entity to be polled.
The value of the url parameter can be specified in the following
formats:

ping://hostname
snmp://hostname:port/oid/#.#.#.#
snmp://hostname:port/[mod,sym]/path

validity The value of the validity parameter is the duration (in days) you want
the exported topology data to be valid. The value of the validity
parameter can be Unlimited, 7, 15, 30, or 90.

writeInfo The value of the writeInfo parameter is the name of the SNMPv1 write
community for SNMP polled objects.
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Topology Commands

There are nine extended commands for managing topology.

createEntity Description

The createEntity command creates a managed entity.

Syntax

createEntity t=topoObject
pollType=ahost|amod|aprox|dummy|ping|snmp
[fullDesc=text] [targetHost=host]
[agentPort=port] [targetIp=ip]
[family=family] [isPolled=true|false]
[topoType=text] [topoCfg=text]
[readInfo=text] [writeInfo=text] [url=url]

Parameters

t, pollType, fullDesc, targetHost, agentPort, targetIp, family,
isPolled, topoType, topoCfg, readInfo, writeInfo, and url.

If the url or agentPort parameters are specified, the default
port of 161 is not used.

createGroup Description

The createGroup command creates a topology domain or
group.

Syntax

createGroup t=topoObject
[family=base|building-view|campus-view|
network-view|subnetwork-view]
[fullDesc=desc]

Parameters

t, family, and fullDesc.

If the entity being created is a group, the family parameter
is mandatory.

If the entity being created is a domain, the family and
fullDesc parameters are ignored.

delTopoObject Description

Chapter 20 • Using the Command-Line Interface 319



The delTopoObject command deletes a managed
topology object in the managed topology hierarchy. All
objects under the specified topology object are deleted as
well.

Syntax

delTopoObject t=topoObject

Parameter

t

export Description

The export command exports topology data in a domain
or domains to a file.

Syntax

export filename=filename domain=domain|"All
Domains" mode=append|overwrite
validity=Unlimited|7|15|30|90 [comment=text]

Parameters

filename, domain, mode, validity, and comment.

getAgentPort Description

The getAgentPort command returns a port number of
the Sun Management Center agent running on the
specified host in a topology domain. If there are multiple
agents, a list of port numbers is returned.

Syntax

getAgentPort a=host[,host]* [t=topoObject]

Parameters

a and t.

If the t parameter is not specified, the default domain is
used.

getAllTopoObjects Description

The getAllTopoObjects command returns a list of all
managed objects in the managed topology hierarchy that
satisfy conditions specified by the arch, family, or pollType
parameters.
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Syntax

getAllTopoObjects t=topoObject [arch=os]
[family=platform]
[pollType=aview|ahost|amod|aprox|dummy|ping|snmp]

Parameters

t, arch, family, and pollType.

getCurrentDomain Description

The getCurrentDomain command returns the name of
the current domain.

Syntax

getCurrentDomain

Parameters

None

getDomains Description

The getDomains command returns a list of all managed
domains in the current server context.

Syntax

getDomains

Parameters

None

getTopoObject Description

The getTopoObject command returns a list of managed
topology objects directly under the topology object
specified by parameter t that satisfy conditions specified by
the arch, family, or pollType parameters.

Syntax

getTopoObject t=topoObject [arch=os]
[family=platform]
[pollType=aview|ahost|amod|aprox|dummy|ping|snmp]

Parameters

t, arch, family, and pollType.
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import Description

The export command imports topology data from a file to
a domain.

Syntax

import filename=filename
domainmode=follow|ignore
nodemode=replace|ignore [domain=domain]

Parameters

filename, domainmode, nodemode, and domain.

setCurrentDomain Description

The setCurrentDomain command sets the home domain
to the value specified in the domain parameter.

Syntax

setCurrentDomain domain=domainName

Parameter

domain

Topology Command Examples

The following command returns a list of all Sun Management Center agent hosts on
the sun4u family in group building12 in the menlo_park domain that are running
SunOS 5.7 software:

> getTopoObject t=/menlo_park/building12 pollType=ahost \
arch="SunOS 5.7" family=sun4u

The following command creates a group that is named building19 under an existing
domain that is named headquarters_test:

> createGroup t=/headquarters_test/building19 \
fullDesc="test headquarters domain" family=building-location

The following command creates a managed entity that is named myHost in the group
building12 in the domain test_domain. The topology object is a host with the
agent running in port 1161.

> createEntity t=/test_domain/building12/myHost \
fullDesc="my test host" family=ultra-2 topoType="" \
topoCfg="" isPolled=false pollType=ahost readInfo="" \
writeInfo="" targetHost=osftserv targetIp="" agentPort=1161
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CLI Output
The CLI provides the following output options:

� Log command execution to a file
� Log command output to a file
� Control appearance of command output on the screen
� Specify output as plain text, XML, or HTML

Note – All commands and log files are available only in English. However, command
descriptions and help text follow the Java internationalization guidelines for
languages other than English.

Command Output Format
The output of basic commands is available only in plain text. Refer to “CLI Command
and Parameter Overview” on page 294 for an explanation of basic and extended
commands.

The output of extended commands is available in three formats:

� Plain text
� XML
� HTML

To specify the output format, set the f parameter to the value of the desired format.
Currently supported values are plain, xml, and html.

You can define a logical screen size for command output by setting the height
parameter to a desired value. You can set the more parameter to display output one
screen at a time. See “Predefined Parameters and Flags” on page 297 for an
explanation of these parameters.

EXAMPLE 20–1 Plain Text Command Output

The following example shows the partial output of the getLoadedModules
command in plain text.

== getLoadedModules: Results 1/16 ===============================
Module Name=Dynamic Reconfiguration
Module Key=dr
Description=Dynamic Reconfiguration (Sunfire)
Agent Name=myhost-dev86
Agent Port=161
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EXAMPLE 20–1 Plain Text Command Output (Continued)

Version=2.0
== getLoadedModules: Results 2/16 ===============================
Module Name=Config-Reader(sun4u/sun4d)
Module Key=Config-Reader4u
Description=Config Reader (sun4u/sun4d)
Agent Name=myhost-dev86
Agent Port=161
Version=1.0
...
== getLoadedModules: Results 15/16 ==============================
Module Name=DNS Synthetic Transaction [dns]
Module Key=dnsST+dnstest
Description=DNS Synthetic Transaction
Agent Name=myhost-dev86
Agent Port=161
Version=1.0

================================================================

CLI Log File
To record CLI commands in a log file, set the log parameter to the name of the file in
which to record the commands. To pass the log file to CLI in batch mode for execution,
set the logmode parameter to detailed, command, or from n. For more details, see
log and logmore in “Predefined Parameters and Flags” on page 297.

The log file has the following format:

DATE & TIME;duration or message;command and parameters

EXAMPLE 20–2 Partial CLI Log File

The following example is an excerpt of the log of the command sequence from which
the previous getLoadedModules command output was obtained.

Fri Dec 21 14:15:12 PST 2001;0 second;set o=\
/home/examples/output.3c23b455
Fri Dec 21 14:15:23 PST 2001;0 second;set f=plain
Fri Dec 21 14:15:45 PST 2001;0 second;set a=smtg-dev21
Fri Dec 21 14:16:08 PST 2001;== START OF THREAD ==;getLoadedModules
Fri Dec 21 14:16:08 PST 2001;2 seconds;getLoadedModules
Fri Dec 21 14:16:12 PST 2001;9 seconds;print
Fri Dec 21 14:21:28 PST 2001;== START OF THREAD ==;getAgentPort
Fri Dec 21 14:21:28 PST 2001;0 second;getAgentPort
Fri Dec 21 14:21:31 PST 2001;0 second;print

Fri Dec 21 14:22:01 PST 2001;0 second;exit
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Accessing the CLI
es-cli Description

The es-cli command is used to access the CLI.

Syntax

es-cli [-h] [-b <filename> -i <parameter-filename>] [-i
<parameter-filename>]

For an explanation of the parameters to es-cli, see “CLI Parameters”
on page 296.

Note – If no option is specified, the CLI runs in session mode.

CLI Procedures
This section describes some common CLI procedures.

� To Access the CLI in the Solaris or Linux Operating
Environment

Note – If the console is not installed in the default /opt directory, the CLI application
will not start. In this case, start the CLI application by either of the following ways:

� After installation, change the location of the add-ons in the cli.properties file
to correctly point to the installed location.

� Create the /opt/SUNWsymon/cli/addons directory.

1. To begin an interactive session, type the command
/opt/SUNWsymon/sbin/es-cli followed by any desired global parameters.

2. Type login in response to the CLI prompt (>).

Before You
Begin

Steps
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3. Type the name of the host to which you wish to connect in response to the Host
prompt.

4. Type your login name and password in response to the Login and Password
prompts.

The result of steps 1-4 resembles the following example:

/opt/SUNWsymon/sbin/es-cli parameters
> login
Host: myhost
Login: mylogin
Password: mypassword
Login is successful.
>

Tip – You can run the CLI in batch mode using a previously prepared file of CLI
commands as input by using the following command:
/opt/SUNWsymon/sbin/es-cli -b file.

� To Access the CLI in Microsoft Windows
Environments

1. After you have installed the Sun Management Center console layer, double-click
es-cli in the CLI folder.

The CLI screen is displayed.

2. Type the login command.

The login process prompts you to specify the desired host name and your login
name.

In the following example, seattle is the host, and susan is the login name:

> login
Host: seattle
Login: susan
Password:
>

� To Access CLI Online Help

1. To obtain a list of all available CLI commands, type help at the CLI prompt.

Steps

Steps
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2. To obtain a more detailed explanation of a particular command, type help
followed by the name of the command.

For example, to obtain additional help about the getLoadedModules command,
you would type:

> help getLoadedModules

� To Control Command Output Screen Size

1. Define a screen size by setting the height parameter to the number of lines to
display.

For example, to define a screen 20 lines high, you would type:

> set height=20

2. To enable output to be viewed one page at a time, set the more parameter to on.

> set more=on

� To Record CLI Commands in a Log File

1. Set the log parameter to the name of the file in which to record the commands.

> set log=/home/examples/log.3c254030

Once the log parameter is set, all subsequent commands are appended to the file. If
this file does not exist, the file is created.

The file is not overwritten, so make sure a new file is created if you want a new set
of records.

2. To stop recording, use the unset command with the log parameter.

> unset log

� To Record Command Output in a File

� To record command output in a file, set the o parameter to the name of the output
file.

> set o=/home/examples/output.3c254030

Steps

Steps

Step
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To stop recording, use the unset command with the o parameter.

> unset o

� To Terminate a CLI Session

� To terminate a CLI session, type exit.

> exit

Step
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APPENDIX A

Miscellaneous Sun Management
Center Procedures

This appendix describes several procedures that do not readily fit into other sections
of this document. Specifically, this appendix includes the following information:

� “Monitoring Topology Manager and Event Manager” on page 329
� “To Create a Server Component as a Monitored Object” on page 330
� “To Increase the Critical Threshold for the Virtual Size Data Property in the

Topology Manager” on page 331
� “To Change the Default Values for Smart Delete in the Event Manager” on page

333
� “Reading Sun Management Center Log Files” on page 334
� “Adding Customized Menu Items” on page 335
� “SNMP MIBs for Sun Management Center Modules” on page 338
� “When an Agent Exits During Startup” on page 339
� “Hanging Main Console Window” on page 341
� “Database Backup and Recovery” on page 342

Monitoring Topology Manager and
Event Manager
There are five components in the server layer:

� Sun Management Center server
� Topology manager
� Trap handler
� Configuration manager
� Event manager

With the exception of the server, the other four components are Sun Management
Center agents that are loaded with specialized modules.
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The default configuration for the Topology manager and the Event manager and all
other Sun Management Center agents is defined by the Agent Statistics module. This
module includes features that guard against errors that can bring down the host. The
default action is for the software to terminate the Topology manager process if
predefined thresholds are exceeded. See “Agent Statistics Module Version 2.0”
on page 410 for more information about the Agent Statistics module.

� To Create a Server Component as a Monitored
Object
You might want to monitor the Topology manager, Trap handler, Configuration
manager, and Event manager to determine their status. The Configuration manager
and the Trap handler are configured so that you do not need to perform any
maintenance procedures. In addition, the default configurations of both the Topology
manager and the Event manager work for most user environments. However, you can
modify the default configurations for specialized environments.

1. In the main console window, choose Create Object from the Edit menu.

The Create Object window is displayed. By default, the tab is set to Node. For more
information, see “To Create a Node” on page 64.

2. Choose Sun Management Center Agent - Host from the Monitor Via menu.

3. Type the name of the server component in the Node Label field.

4. (Optional) Type a description of the server component.

5. Type the name of the Sun Management Center server in the Hostname field.

6. Type the port number for the server component in the Port field.

Sun Management Center software uses the following default port values:

� Agent component : port 161
� Server trap handler: port 162
� Server event manager: port 163
� Server topology manager: port 164
� Server configuration manager: port 165

Note – The server component uses port 2099 by default. However, you cannot
change the server component port number here.

7. Complete this procedure with one of the following actions:

� Click OK to create the server component object and close this window.

Steps
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� Click the Apply button to create the server component object without closing
this window.

� To Change the Registry Port Number
The Sun Management Center server includes a registry feature that enables
value-added products, such as Hardware Diagnostics Suite, to register its existence
with the server. By default, the registry feature uses port 5600. If this port is being
used by another application, the application will fail. To change the registry port,
follow these steps:

1. Change the ServiceRegistryPort value in the
/var/opt/SUNWsymon/cfg/javaserver.properties file.

2. Change the ServiceRegistryPort value in the
/var/opt/SUNWsymon/cfg/javaservice.properties file to match the
value you provided in the previous step.

3. Restart the Sun Management Center server.

Note – When you set up the Sun Management Center server, the installation
process prompts you to provide a different port number for the registry service, if
the default port is in use.

� To Increase the Critical Threshold for the Virtual
Size Data Property in the Topology Manager
The Topology manager enables the main console window to present logical objects in
a topology view. The Topology manager also provides the ability to create a logical
object, such as a group, whose status summarizes the statuses of multiple managed
objects.

Managed objects include networks, hosts, hardware components, and software
components. The total number of objects and the contents of these objects determine
the system resource requirement, for example, Virtual Size, for the Topology manager.
This requirement must be less than the defaults set for the Topology manager.

If the Virtual Size of the Topology manager exceeds the default value, then the
Topology manager exits with the following error message:

error excessive virtual memory use

To solve this error, increase the default virtual size as described in the following steps.

Steps
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1. Evaluate the situation carefully.

2. Create the Topology manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 330.

3. Open the Details window using one of the following methods:

� Press mouse button 3 on the Topology manager object icon. Choose Details
from the pop-up menu in the hierarchy view or the topology view.

� Double-click the Topology manager icon.

� Select the Topology manager icon in the main console window, then choose
Details from the Tools menu.

4. In the Browser Details window, double-click the Local Applications icon in the
hierarchy (tree) view.

5. Double-click the Agent Statistics icon in the contents view, or click the
expansion icon next to the Agent Statistics icon in the hierarchy view.

The Agent Statistics folders are displayed.

6. Double-click the folder icon for the PA Process Statistics.

The monitored properties are displayed in a property table.

7. Select the Virtual Size table cell, then open the Attribute Editor through one of
the following methods:

� Press mouse button 3 in the table row, and choose Attribute Editor from the
pop-up menu.

� Click the Attributes button.

8. Click the Alarms tab button.

The alarm rows are displayed.

9. Type the desired value in the Critical Threshold (>) field.

10. Complete this procedure with one of the following actions:

� Click OK to create a new Critical Threshold value and close this window.

� Click the Apply button to create a new Critical Threshold value without closing
this window.

Steps
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� To Change the Default Values for Smart Delete in
the Event Manager
The Event manager communicates with other server components through SNMP
using the default port 163. Similar to the Topology manager, the Event manager is also
loaded with the Agent Statistics module. In addition, the Event manager is
automatically loaded with a specialized Event Management module. The Event
Management module is displayed in the Browser Details window in the Local
Applications category.

The Event Management module is responsible for the overall maintenance of the event
database. This module’s responsibilities include purging deleted events, renaming the
trash file, and Smart Delete.

Smart Delete means that Sun Management Center software automatically deletes
closed, fixed, and open events from the event database after a set period of time. By
default, the closed or fixed events are removed from the database after 7 days and the
open events are removed after 30 days. To change these defaults, perform the
following steps.

1. Create the Event manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 330.

2. Open the Details window through one of the following methods:

� Press mouse button 3 on the Event manager icon. Choose Details from the
pop-up menu in the hierarchy view or the topology view.

� Double-click the Event manager icon in the hierarchy view or the topology
view.

� Select the Event manager icon in the main console window, then choose Details
from the Tools menu.

3. In the Browser Details window, double-click the Local Applications icon in the
hierarchy (tree) view.

4. Open the Module Editor through one of the following methods:

� Press mouse button 3 on the Event Management module. Choose Edit Module
from the pop-up menu in the hierarchy view or in the contents view.

� Select the Event Management module in the Details window, then choose Edit
Module from the Module menu.

The Module Parameters Editor is displayed. For more information, see “To Modify
Module Parameters” on page 176.

5. Type the new time values into the editable fields.

By default, the closed or fixed events are removed from the database after 7 days.
The open events are removed after 30 days.

Steps
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6. To turn off Smart Delete, choose Disabled from the Smart Delete Enabled
Switch menu.

7. Click OK to accept the changes that you made and close this window.

Reading Sun Management Center Log
Files
The Sun Management Center server and agents write to various log files in the
directory /var/opt/SUNWsymon/log.

These files are circular log files. A circular log file does not grow in size after a certain
limit. As new messages are logged into the file, the oldest messages are removed.

Use the es-run interface with the ctail and ccat commands to view these log files.
The es-run interface sets up the proper environment to run Sun Management Center
utilities. The utilities ccat and ctail display only the relevant data, after sorting the
data in chronological order. The ccat and ctail commands are similar to the UNIX
cat and tail commands, but are intended for use with Sun Management Center
circular log files.

Using ccat to Read Sun Management Center Log
Files
The ccat command reads the specified log file, sorts the messages in chronologically
ascending order, and writes to the standard output. The ccat command takes one
argument, which is the full path to the circular log file.

To use the es-run interface with the ccat command, you type:

# /opt/SUNWsymon/sbin/es-run ccat path_to_file/filename

Using ctail to Read Sun Management Center Log
Files
The ctail command reads the circular log file and by default writes the last 15 lines
of the file to standard output.

The ctail command takes four arguments:
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filename The filename argument is the full path name to the circular log file. The
filename argument is mandatory.

-f The -f option is used to monitor the growth of the log file. As the log file
grows, the messages appended to the file are also written to the standard
output. The ctail -f option is similar to the -f option for the UNIX
tail command.

-l The -l option is used to print the absolute line number at the beginning of
each message.

-n The -n NumOfLines option is used to change the number of lines that are
displayed. By default, only the last 15 lines are printed.

To use the es-run interface with the ctail command, you type:

# /opt/SUNWsymon/sbin/es-run ctail [-f, -l, -n NumOfLines] path_to_file_filename

Adding Customized Menu Items
Sun Management Center software enables you to customize the Tools menu by adding
external, standalone applications that can be launched from the main console window.
The application must be written in the Java programming language. Non-Java
applications can be accommodated by the ExampleSystemCommand Java wrapper
class that executes another program or shell script in a separate process. The
application does not require a selected host object. The application has no further
interaction with Sun Management Center once the application has been launched.

The name of the application is specified in the console-tools.cfg file. The
application name is added to the Tools menu in the main console window below the
standard Sun Management Center menu items. The application is launched in a
separate window.

The console-tools.cfg file is a plain text file that resides on the Sun Management
Center server host. The file may be modified at any time, including while the console
is running. However, changes that are introduced by editing the files do not take effect
until the es-tool script is executed and the console is restarted. The file consists of a
series of lines, each of which describes an application. Blank lines and lines beginning
with the pound sign (#) are ignored. Fields within each line are separated by commas
(,).

Each application that is implemented as a shell script or as an executable binary is
defined by a line with the following format:

menu_label,class [args]
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where:

� menu label is the string that is displayed in the Tools menu. The string can be either
localized or nonlocalized text. Nonlocalized text can contain embedded spaces.
Localized text must be specified as a property-file:key pair, where:

� property-file is the name of the file containing the localizable messages for a
particular locale

� key is the identifier used to locate the string that is displayed in the Tools menu
in the property file

Note that spaces are not allowed in the key.

� class is the fully qualified Java class name.

� args is the list of arguments to the class.

For example, the following file shows entries for three applications to be added to the
Tools menu: Example GUI, rlogin, and ftp.

# Format:
# menu_label, class arguments

Example GUI,exampleApp.ExampleGUITool

Rlogin,com.sun.symon.base.client.console.SMSystemCommand
"/usr/openwin/bin/xterm -e rlogin $host" "start rlogin $host"

exampleApp.ExampleSystemCommand:ftp,exampleApp.ExampleSystemCommand
"/usr/openwin/bin/xterm -e ftp $host" "start ftp $host"

Caution – Each entry must be specified on a single line, even though the text is shown
wrapped in the example.

The Java wrapper class SMSystemCommand enables you to execute an arbitrary shell
command. This class takes two arguments. The first argument is the shell command to
execute.

� If a program name is specified, give a full path name.

� If the command contains embedded spaces, enclose the entire shell command in
double quotes.

The second argument is the command to run on a Microsoft Windows client. The
following line is an example of this command:

com.sun.symon.base.client.console.SystemCommand "<shell command>" "<windows command>"

In this case, the first argument is ignored. Variable substitution is performed on the
arguments if special variable references are present. Two variables are allowed:

� $host, which is replaced with the currently selected agent host name
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� $port, which is replaced with the currently selected port number

� To Customize the Tools Menu

1. Use a standard text editor to add a line to the
/var/opt/SUNWsymon/cfg/console-tools.cfg file.

This line specifies the following items:

� Name to display on the Tools menu
� Fully-qualified Java class name for the application
� Any required class arguments

See the detailed description in the section introduction for more information.

2. Place the Java class files for the applications in the
/opt/SUNWsymon/apps/classes directory.

3. Run the es-tool update script on the Sun Management Center server host.

# /opt/SUNWsymon/sbin/es-tool /var/opt/SUNWsymon/cfg/console-tools.cfg

4. Stop the console by choosing Exit from the File menu on the main console
window.

5. Click the Exit button to exit the application.

6. Restart the console for the application to be added to the Tools menu.

# /opt/SUNWsymon/sbin/es-start -c

Note – Your site’s configuration might also require you to restart the Sun
Management Center server.

Steps
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SNMP MIBs for Sun Management
Center Modules
Sun Management Center software publishes the Simple Network Management
Protocol Management Information Bases (SNMP MIBs) for the modules. The MIB file
is an Abstract Syntax Notation (ASN.1) specification of the data that is modeled, in
this case, by the Sun Management Center module. These MIBs can be used as the data
definition by third-party SNMP-based management stations, such as HP OpenView
and Unicenter™. Sun Management Center has MIBs for the following modules:

� file-scan.mib
� health-monitor-mib.mib
� kernel-reader-mib.mib
� nfsmon-mib.mib
� nfsstat-mib.mib
� print-spool-mib.mib
� process-details-mib.mib
� process-monitor.mib
� trap-mib.mib

The above MIBs are installed by default, in the /opt/SUNWsymon/util/cfg
directory by the Sun Management Center software during installation of the agent
layer. In your installation, your base directory might be different.

� To Use the Sun Management Center SNMP MIBs in
a Third-Party Management Station

1. Preprocess the MIBs.

Some SNMP management stations can read the ASN.1 MIBs. Others require the
ASN.1 MIBs to be converted to some other format in order to be read. For example,
you might need to convert the MIB to a Guidelines for the Description of Managed
Objects (GDMO) format or use a MIB compiler to generate another intermediate
format.

2. Load the MIB.

Load the ASN.1 MIB or a preprocessed format of that MIB into the third-party
management station. This step informs the third-party management station about
the layout and composition of the data that is modeled by the MIB.
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3. Use the MIB information to talk to the Sun Management Center agent.

Once the MIB is successfully loaded into the third-party SNMP agent, you can
communicate with the Sun Management Center agent to get the data from the MIB.
The MIB-II Proxy Monitoring module must be loaded and be enabled in the Sun
Management Center agent.

For example, you can start issuing the SNMP Get commands on some of the
variables in the MIB.

By default, the Sun Management Center modules are enabled for SNMP Get
commands by using the SNMPv1 community public and SNMPv2 user name
public. However, if the Sun Management Center module has different settings,
then you need to use the correct community name and user name to communicate
with the Sun Management Center agent.

Note – Because Sun Management Center agents operate with SNMPv2 usec-based
security, SNMP Set commands on the agent are involved. Refer to the SNMPv2
usec-related Request For Comments (RFCs) for more information.

Accessing Multiple Instance Modules
SNMPv2 uses the term context for the MIBs that can have multiple instances of the
module loaded on the agent. If you use an SNMPv2-based third-party management
station to communicate with this type of agent, be sure that you are using the right
context information. However, if you are using a SNMPv1-based management station,
then add the context information to the SNMP community as follows:

community:context

By adding this context information, you can access data from multiple instances of the
same module running on an agent.

When an Agent Exits During Startup
The Sun Management Center agent has the ability to monitor itself and restrict its
memory usage. Some predefined limits have been set for the memory usage of the
agent process. These limits depend on the following criteria:

� Number of modules loaded
� Type of modules loaded
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� Type of the system being managed

On rare occasions, the limit for default memory usage is exceeded during the agent
startup and when the agent stops running. If this limit is exceeded, the default limits
set for the agent memory size are not enough for your configuration.

To confirm that memory usage is the cause, look in the
/var/opt/SUNWsymon/log/agent.log file for one of the following messages:

Excessive Virtual Memory Use
Excessive Physical Memory Use

If you see one of these messages during the agent startup, reconfigure the memory
usage limits on the agent host using the following procedure.

� To Increase Agent Memory Size

1. Become superuser on the agent host.

# su -

2. Copy the file agent-stats-d.def to /var/opt/SUNWsymon.

# cp /opt/SUNWsymon/modules/cfg/agent-stats-d.def /var/opt/SUNWsymon/cfg/

3. In the /var/opt/SUNWsymon/cfg/agent-stats-d.def file, increase the
alarmlimit:error-gt to the desired value as shown in the following code
segment.

The value is in Kbytes.

procstats = {
size = {

statusActions(error-gt)
= abort

statusService(abort)
= _internal

statusCommand(abort)
= abort "Excessive Virtual Memory Use"

alarmlimit:error-gt = 70000
alarmlimit:warning-gt = 60000
alarmlimit:info-gt =

}
.....
}

4. Save the file and restart the agent.
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Hanging Main Console Window
This section explains how to respond to a hanging console window in certain
circumstances. In this case, the main console window hangs when users attempt to
start a new console window and to connect to the Sun Management Center server.
However, existing console window connections encounter no problems.

The main console window can hang for the following reasons:

� The server memory is used up. Threads that are reading from a socket can hang
when there is a large discrepancy between the read and write rates at either end of
a socket. The memory problem occurs when the Sun Management Center server
has a large amount of buffered data waiting to be sent to its clients. The buffered
data can become so large that the server runs out of memory while trying to write
to the socket. Once the server is out of memory, the server does not recover.

Note – If you are monitoring the server log file, use the following command to
check for messages that the server is out of memory:
/opt/SUNWsymon/sbin/es-run ctail -f
/var/opt/SUNWsymon/log/server.log

� The console memory for the console process is used up. You might be able to
confirm that the console process is out of memory. Choose Sun Management
Center Console Messages from the File menu on the main console window. The
Sun Management Center Console Messages window might display one or more
messages that the console is out of memory.

The method that you use to resolve a hanging main console window depends on
which memory is filled:

� If the server memory is used up, increase the memory that is available to the server
process. The default size is 64 Mbytes.

For example, to double the default memory from 64 Mbytes to 128 Mbytes, use this
command:

# es-start -s -- -Xmx128m

Note – If you typically invoke your server by using the es-start -A command or
by rebooting, you can automatically set the memory size. To customize the default
memory size, change -Xmx64m to the desired size in the
/opt/SUNWsymon/classes/base/server/bin/es-server.sh file.
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� If the console memory is used up, restart the console with a bigger memory size.

For example, to increase the memory to 100 Mbytes, use this command:

# es-start -c -- -Xmx100m

This process allocates more memory to the console for the current session.

Note – To allocate more memory automatically, change the default memory size
from -Xmx64m to the desired size in the
/opt/SUNWsymon/classes/base/console/bin/es-console.sh file.

Database Backup and Recovery
Your Sun Management Center database sometimes needs to be backed up to prevent
loss of data. For example, you should back up your database before you upgrade the
hardware or the operating system. You can back up the Sun Management Center
database in one of these ways:

� Shut down the product and then perform the backup (cold backup)
� Perform the backup while the product is still running (online backup)

Cold Backup
In a cold backup, you shut down the product first and then perform the backup.
Before setting up the online backup feature, perform a cold backup as a contingency.

� Performing the Cold Backup

1. Become superuser.

# /opt/SUNWsymon/sbin/es-backup

Because the script shuts down Sun Management Center, you are prompted to
confirm.

2. Type y and press Enter.

You are prompted for the full directory path to store the backup data files.
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3. Press Enter to accept the default directory or type a new path.

The script creates the backup files and then restarts the product.

Online Backup
This procedure guides you through these tasks:

� Running a cold backup for contingency

� Enabling ARCHIVELOGMODE, which shuts down Sun Management Center and sets
up archiving

� Backing up the database online

Using online backup has these advantages. You can back up the database up to the
current moment without stopping the product. You can disable or enable ARCHIVELOG
mode at any time.

Note – Online backup does not shut down the product.

� Performing the Online Backup

1. (Optional) Perform a cold backup. See “Performing the Cold Backup” on page
342.

2. Enable ARCHIVELOGMODE.

a. Become superuser.

# /opt/SUNWsymon/sbin/es-config -a enable

You are prompted to confirm that you want to enable archiving.

b. Type y and press Enter.

Because the script will shut down Sun Management Center, you are prompted
to confirm.

c. Type y and press Enter.

The script shuts down the product and recommends a cold backup. You are
prompted to confirm that you want to set up the database in
ARCHIVELOGMODE.

d. Type y and press Enter.

You are prompted for the full directory path to store the archive log files.

Steps
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e. Type the full path, for example:

Enter full directory path to store the archive log files:

/var/opt/SUNWsymon/archives

The script creates the directory if it does not exist and enables
ARCHIVELOGMODE. You are prompted to start the agent and server components.

f. Type y and press Enter.

3. Run the online backup.

a. Type this command:

# /opt/SUNWsymon/sbin/es-backup -o

You are prompted for the full directory path to store the backup data files.

b. Press Enter to accept the default or type a different path, for example:

Enter full directory path to store the backup data files [/var/opt/SUNWsymon/backup]:

/var/opt/SUNWsymon/mybackup

Note – If you accept the default directory and later plan to uninstall the product,
your backup files might be deleted. Before uninstalling the product, move the
backup files to another location. Alternatively, use a different path for your
backup files.

� Disabling ARCHIVELOGMODE

If you do not want archiving on, you can disable archiving.

� To disable ARCHIVELOGMODE, type this command:

# /opt/SUNWsymon/sbin/es-config -a disable

Sun Management Center is shut down, the archive log files are removed, and the
product is restarted.

� Shutting Down the Product Before Backing Up

� If you want to shut down the product before doing a backup, you have two
options:

� To run the backup interactively, type this command:

Step
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# /opt/SUNWsymon/sbin/es-backup

� To run the backup in silent mode and use default answers to the script’s
questions, type this command:

# /opt/SUNWsymon/sbin/es-backup -y

The database files are saved in the directory /var/opt/SUNWsymon/backup.

If you need to periodically run the es-backup script, you can set a cron program
for the script to be run on a routine basis. In this case, use the -y option for the
es-backup script so that no interaction is needed.

Note – Both scripts shut down the Sun Management Center processes before
starting the restore or backup. These scripts also restart the processes once the
recovery or backup has been completed.

� Recovering the Database

� If your Sun Management Center database has been inadvertently corrupted due
to a system failure, run the following interactive script as superuser to restore
your database:

# /opt/SUNWsymon/sbin/es-restore

For example, you might want to follow this process if the system failure is due to a
file system problem.

Step
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APPENDIX B

Internet Protocol Routing

This appendix provides an overview of IP routing. The chapter describes the following
topics:

� “Overview of IP Addressing” on page 347
� “Using Subnets” on page 348
� “Using Netmasks” on page 348

Overview of IP Addressing
Internet protocol (IP) addresses are 32 bits long. Thus, there is a possibility of
approximately a total 4 billion addresses for the entire Internet. An IP address is
expressed as a series of octets separated by dots. For example, the address 11111111
00000001 00000101 00001010 is written as 127.1.5.10, or using hexadecimal notation,
7f.1.5.a0.

Because of this vast number of addresses, the network is organized hierarchically into
administrative domains. This organization led to the definition of name administrative
domains and network classes. Since each site can vary in size, IP addresses are divided
into three main types or classes. A large site can reserve a class A address and receive
224 individual addresses. A small site can reserve a class C address and receive 28

individual addresses.

Network Classes
Class A uses the first octet for the network address, and the rest for host addresses
within this network. For example, a site whose network address is 129.0.0.0 would
own the 224 addresses between 129.0.0.0 and 129.255.255.255.
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Network Host

0xxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Class B uses two octets for the network address, and two for the host address. For
example, a site whose network address is 129.123.0.0 would own the 216 addresses
between 129.123.0.0 and 129.123.255.255.

Network Host

10xxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Class C uses three octets for the network address, and one octet for the host address.
For example, a site whose network address is 129.123.56.0 would own the 28 addresses
between 129.123.56.0 and 129.123.56.255.

Network Host

110xxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Using Subnets
Subnetting divides a network into smaller segments, or subnets. This technique is
imperative for Class A and B networks. Routers do not forward packets outside a
subnet if the destination address is within the same subnet. Thus, network traffic is
decreased dramatically by segmenting a large network. For example, suppose a class B
network is segmented into 255 subnets. Unless a packet destination is a host outside
the subnet, a local packet is sent to 255 hosts instead of 256,000.

Using Netmasks
The format of the netmask is a series of 1s followed by a series of 0s. By ANDing an IP
address with a netmask, you can get the address of the subnet.

Routers use netmasks to decide whether to forward a packet to an external subnet. For
example, suppose a machine with an IP address of 129.123.56.95 sends an email to
another machine whose IP address is 129.123.56.100. By ANDing both IP addresses

348 Sun Management Center 3.6 User’s Guide • December 2005



with a netmask (255.255.255.0), the result is 129.123.56.0 for both machines. The router
then concludes that the source machine and the destination machine are in the same
subnet. Therefore, the router does not forward the email to external subnets.

On the other hand, if the destination address is 129.123.67.100, then the resulting
subnet address is 129.123.67.0. The router forwards the email to the external subnet
(129.123.67.0).

Note – Although some of these examples only apply to Ethernet links, the principles
apply regardless of the network type.
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APPENDIX C

Sun Management Center Software
Modules

The Sun Management Center software uses modules to monitor various components
of your system. The modules can be separated into four categories: hardware,
operating environment, local applications, and remote systems. This appendix
provides additional information about the modules that are described in Chapter 11.
In addition, this chapter identifies the modules that are in the four categories.

For more information about other modules that might be applicable to your particular
system, see the Sun Management Center web site:
http://www.sun.com/sunmanagementcenter/.

This appendix describes the following modules:

� Hardware

� “Volume System Monitoring Module Version 1.0” on page 354
� “Sun StorEdge A5x00 Array Module” on page 355
� “Sun StorEdge T3 Array Module” on page 362

� Operating System

� “File Monitoring Module Version 2.0” on page 376
� “IPv6 Instrumentation Module Version 1.0” on page 376
� “Kernel Reader (Simple) Module Version 1.0” on page 382
� “MIB-II Instrumentation Module Version 1.0” on page 394
� “MIB-II (Simple) Module Version 1.0” on page 403
� “NFS File Systems Module Version 2.0” on page 406
� “NFS Statistics Module Version 2.0” on page 406
� “Solaris Process Details Module Version 2.0” on page 408

� Local and Remote Applications

� “Agent Statistics Module Version 2.0” on page 410
� “Data Logging Registry Module Version 2.0” on page 414
� “Logview ACL Version 1.0” on page 415
� “Print Spooler Module Version 3.0” on page 415
� “HP JetDirect Module Version 2.0” on page 417
� “MIB-II Proxy Monitoring Module Version 2.0” on page 417
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� Advanced System Monitoring

� “Directory Size Monitoring Module Version 2.0” on page 418
� “Fault Manager Module Version 1.0” on page 419
� “File Scanning Module Version 2.0” on page 421
� “Hardware Diagnostic Suite Version 2.0” on page 422
� “Health Monitor Module Version 2.0” on page 423
� “Kernel Reader Module Version 2.0” on page 426
� “Process Monitoring Module Version 2.0” on page 427
� “Service Management Facility Module Version 1.0” on page 429

Overview of Module Relationships
Most of the Sun Management Center modules have default monitoring conditions that
generate alarms when system values fall outside of these conditions. You can alter
these default thresholds by creating your own alarm thresholds, as explained in
Chapter 12.

Some modules utilize the Add Row operation to define the data properties to monitor.
These modules start with empty tables. You have to execute an Add Row operation to
activate the specifics for monitoring these modules.

The following table lists the modules described in this appendix. The table identifies
the following information for each module:

� The module name
� The version of the module that applies to the Sun Management Center 3.6 product
� An indication that the module is loaded automatically
� An indication that more than one copy of the module can be loaded
� An indication that the module uses the Add Row operation

TABLE C–1 Module Summary Table

Alphabetical Listing of Modules Version
Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility

Agent Statistics 2.0 X

Agent Update 1.0

Config-Reader1 1.0 X

Data Logging Registry 2.0

Directory Size Monitoring 2.0 X X
1 Refer to your platform-specific supplement for more information about the Config-Reader module.
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TABLE C–1 Module Summary Table (Continued)

Alphabetical Listing of Modules Version
Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility

Dynamic Reconfiguration
Module2

1.0

Fault Manager 1.0

File Monitoring 2.0 X X3

File Scanning 2.0 X4 X5 X6

HP JetDirect 2.0 X

Hardware Diagnostic Suite 2.0

Health Monitor 2.0

IPv6 Instrumentation 1.0

Kernel Reader 2.0

Kernel Reader (Simple) 1.0 X

Logview ACL 1.0 X

MCP Manager 1.0

MIB-II Instrumentation 1.0

MIB-II Proxy Monitoring 2.0 X

MIB-II System (Simple) 1.0 X

NFS File Systems 2.0 X

NFS Statistics 2.0

Print Spooler 3.0 X

Process Monitoring 2.0 X X7

Service Management Facility 1.0 X

Solaris Process Details 2.0

Storage A5x00 1.0

Sun StorEdge T3 1.0

Volume System Monitoring 1.0 X
2 Refer to your platform-specific supplement for more information about the Dynamic Reconfiguration module.
3 Each added row defines which file to monitor.
4 File Scanning is loaded automatically for the System Log file.
5 Each instance identifies the file to be scanned.
6 Each added row defines which pattern within the monitored file to match. The row needs to be added to the Scan

Table table.
7 Each row defines the pattern to match from all the processes that are running on the agent host.

Appendix C • Sun Management Center Software Modules 353



Hardware Modules
When the following modules are loaded, these modules are found under the
Hardware section of the Module Browser tab in the Details window:

� “Volume System Monitoring Module Version 1.0” on page 354
� “Sun StorEdge A5x00 Array Module” on page 355
� “Sun StorEdge T3 Array Module” on page 362

Volume System Monitoring Module Version 1.0
The Volume System Monitoring module monitors a set of attributes managed by the
N1 System Manager (System Manager) agent and displays them in the Module
Browser.

� To Access the System Manager Server Through Web
Console

1. Navigate through the topology or hierarchy view until you have accessed the
System Manager server that has Volume System Monitoring add-on.

2. Press mouse button 3 and choose Launch Webconsole from the pop-up menu.

A browser opens at the following site:

https://<n1smservername>:<n1smserverport>

Where <n1smservername> is the host name of the System Manager server and
<n1smserverport> is the port number on which the System Manager server is
listening.

3. Log in to the System Manager server with appropriate credentials.

� To Access the System Manager Server Through SSH

Secure Shell (ssh) is a program for logging into a remote machine and for executing
commands on a remote machine. This program connects and logs into the specified
hostname. The user must prove the identity to the remote machine using one of
several methods depending on the protocol version used.

1. Navigate through the topology or hierarchy view until you have accessed the
System Manager server that has Volume System Monitoring add-on.

Steps
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2. Press mouse button 3 and choose SSH to Host from the pop-up menu.

The ssh program on the System Manager server is started.

3. Log in to the System Manager server with appropriate credentials.

Sun StorEdge A5x00 Array Module
This module enables you to monitor the state of Sun StorEdge A5000, 5100, and 5200
storage devices, and manage alarms on these devices. The following series of tables
identifies the specific rules for each Sun StorEdge A5x00 array.

TABLE C–2 Rules for Sun StorEdge A5x00

Rules Property

sunSmTreeProp tree prop

sunSmNodeName Name

timestamp_raw timestamp_raw

timestamp Name

status_change Number Of Model property/value changed.

This value changes when there is a difference between the previous
snapshot and the current snapshot.

TABLE C–3 Sun StorEdge A5x00 Sena Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current node name

entry_no Entry number

dataFormat Instance

rowstatus Row status

box_rev Box_rev

device_count Device_count

box_id Box Id

instance Instance

logical_path Logical Path
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TABLE C–3 Sun StorEdge A5x00 Sena Table (Continued)
Property Description

machine Machine

name Name

node-wwn Node-wwn

physical_path Physical Path

platform Platform

set_flg Set Flag

slot_count Slot_count

type Type

vendor_name Vendor_name

virtual_node Virtual_node

TABLE C–4 Sun StorEdge A5x00 Front Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current node name

entry_no Entry number

instance Instance

TABLE C–5 Sun StorEdge A5x00 Rear Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current node name

entry_no Entry number

entry number Instance

TABLE C–6 Sun StorEdge A5x00 Disk Backplane Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current node name
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TABLE C–6 Sun StorEdge A5x00 Disk Backplane Table (Continued)
Property Description

entry_no Entry number

byp_a_enabled Byp_a_enabled

byp_b_enabled Byp_b_enabled

fru fru

status Status

alarmRules rpho400

TABLE C–7 Sun StorEdge A5x00 Fan Tray Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fan_fail Fan_fail

fru fru

speed Speed

status Status

alarmRules rpho401

type Type

TABLE C–8 Sun StorEdge A5x00 Led Table

Property Description

sunSmTreeProp tree prop

sunSmNodeName Name

entry_no entry number

led-num Led No

state State
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TABLE C–9 Sun StorEdge A5x00 Front Slot Table

Property Description

front_slotTbl Front_slot Table

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

connect_disk connect_disk_name

id Id

loop_status Loop_status

alarmRules rpho411

power_status power-status

alarmRules rpho414

slot-num Slot-num

status Status

temperature Temperature

temperature_status Temperature_status

alarmRules rpho407

TABLE C–10 Sun StorEdge A5x00 Rear Slot Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

connect_disk connect_disk_name

id Id

loop_status Loop_status

alarmRules rpho412

power_status power-status

alarmRules rpho414

slot-num Slot-num
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TABLE C–10 Sun StorEdge A5x00 Rear Slot Table (Continued)
Property Description

status Status

temperature Temperature

temperature_status Temperature_status

alarmRules rpho408

TABLE C–11 Sun StorEdge A5x00 Disk Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

capacity Capacity

device_type Device Type

firmware_revision firmware_revision

fru Fru

hard_address Hard Address

instance Instance

logical_path logical_path

mounted_partitions Mounted Partitions

name Name

node-wwn Node Wwn

physical_path physical_path

port-wwn Port Wwn

product_name product_name

revision revision

serial_number serial_number

status Status

alarmRules rpho406

vendor_name vendor_name
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TABLE C–12 Sun StorEdge A5x00 Sena Power Supply Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fru Fru

AC_status AC_status

DC-current DC-current

DC-voltage DC-voltage

ps-instance Ps-instance

status Status

alarmRules rpho402

temperature_status Temperature_status

alarmRules rpho409

type Type

TABLE C–13 Sun StorEdge A5x00 Interconnect Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

eprom_failure Eprom_failure

fru Fru

status Status

alarmRules rpho405

TABLE C–14 Sun StorEdge A5x00 Interface_board Table

Property Description

interface_board-entry entry_no

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

360 Sun Management Center 3.6 User’s Guide • December 2005



TABLE C–14 Sun StorEdge A5x00 Interface_board Table (Continued)
Property Description

entry_no entry number

fru Fru

interface_board-instance Ib-Instance

loop Loop

loop0_fault Loop0_fault

loop1_fault Loop1_fault

status Status

alarmRules rpho400

temperature_status temperature_status

alarmRules rpho410

TABLE C–15 Sun StorEdge A5x00 Loop – Gbic Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fru Fru

loop-instance Gbic-Instance

status Status

alarmRules rpho413

loop_configuration_status Loop Configuration

TABLE C–16 Sun StorEdge A5x00 Rules

Rule Description

rpho414 Fibre Channel OFFLINE

rpho415 Fibre Channel CRC Error

rpho416 ASC 0x47

rpho417 Drive operation marginal

rpho418 Failure prediction
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TABLE C–16 Sun StorEdge A5x00 Rules (Continued)
Rule Description

rpho419 Incomplete DMA XFER on sbus

rpho420 Offline Timeout

rpho421 soc lilp map failed

Sun StorEdge T3 Array Module
This module enables you to monitor the state of Sun StorEdge T3 storage devices and
to manage alarms on these devices.

TABLE C–17 Sun StorEdge T3 Module – Basic Properties Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

rowstatus Row Status

sysId id

sysVendor vendor

sysModel model

sysRevision firmware revision

sysStatus Status of the connection between the agent and the T300 storage box

sysIpAddr IP address

sysSubNet subnet mask

sysGateway gateway

sysBootMode boot mode

sysBootDelay boot delay

sysMpSupport multi-pathing support

sysHasVolumes has volumes
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TABLE C–18 Sun StorEdge T3 Module – Advanced Properties Table

Property Description

t300name t300name

rowstatus Row Status

sysStripeUnitSize stripe unit size

sysCacheMode cache mode

sysCacheMirror cache mirror

sysReadAhead read ahead

sysReconRate reconRate

sysOndgMode ondgMode

sysOndgTimeslice ondgTimeslice

sysTftpHost tftp host

sysTftpFile tftp file

sysLastRestart ast restart time

sysDate date

sysTime time

sysTimezone time zone

TABLE C–19 Sun StorEdge T3 Module – Statistical Properties Table

Property Description

t300name t300name

sysTotalRequests total requests

sysWriteRequests write requests

sysReadRequests read requests

sysTotalBlocks total blocks

sysBlocksWritten blocks written

sysBlocksRead blocks read

sysCacheWriteHits cacheWriteHits

sysCacheWriteMisses cacheWriteMisses

sysCacheReadHits cacheReadHits
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TABLE C–19 Sun StorEdge T3 Module – Statistical Properties Table (Continued)
Property Description

sysCacheReadMisses cacheReadMisses

sysCacheRmwFlushes sysCacheRmwFlushes

sysCacheReconFlushes cacheReconFlushes

sysCacheStripeFlushes cacheStripeFlushes

clear-flag clear flag

TABLE C–20 Sun StorEdge T3 Module – Unit Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

unitType unit type

unitStandby standby

unitIsControllerUnit isControllerUnit

machine machine

platform platform

TABLE C–21 Sun StorEdge T3 Module – Disk Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE C–22 Sun StorEdge T3 Module – Disk Properties Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name
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TABLE C–22 Sun StorEdge T3 Module – Disk Properties Table (Continued)
Property Description

unitId unit id

fruStatus status

alarmRules rple400

fruDiskRole disk role

fruDiskCapacity disk capacity

fruDiskTemp temperature

fruID

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

TABLE C–23 Sun StorEdge T3 Module – Advanced Properties Table

Property Description

t300name t300name

unitId unit id

fruId fru id

fruDiskPort1State port1 state

fruDiskPort2State port2 state

fruDiskStatusCode status code

fruDiskVolId disk volid

fruDiskVolIndex disk volindex

fruDiskVolName disk volname

fruDiskIsRebuildable

fruDiskIsRoleData isRoleData

fruDiskIsRoleStandby isRoleStandby

fruDiskIsRoleUndefined sUndefined

Appendix C • Sun Management Center Software Modules 365



TABLE C–23 Sun StorEdge T3 Module – Advanced Properties Table (Continued)
Property Description

fruDiskIsExpendable isExpendable

TABLE C–24 Sun StorEdge T3 Module – Controllers

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE C–25 Sun StorEdge T3 Module – Controller Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

alarmRules rple401

TABLE C–26 Sun StorEdge T3 Module – Loopcards

Property Description

loopcards-entry entry_no

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number
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TABLE C–27 Sun StorEdge T3 Module – Loop Card Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruId

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

fruStatus status

fruLoopMode loop mode

fruLoopCable1State cable1 state

fruLoopCable2State cable2 state

fruLoopTemp temperature

alarmRules rple402

TABLE C–28 Sun StorEdge T3 Module – Power Cooling Unit Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

fruPowerPowOutputoutput state

fruPowerPowSourceinput source

fruPowerPowTemp temperature
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TABLE C–28 Sun StorEdge T3 Module – Power Cooling Unit Table (Continued)
Property Description

fruPowerFan1State fan1 state

fruPowerFan2State fan2 state

fruPowerBatState battery state

fruPowerBatLife battery life

fruPowerBatUsed battery used

fruId

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

alarmRules rple403

TABLE C–29 Sun StorEdge T3 Module – Midplane Table

Property Description

sunSmTreeProp true

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

fruId

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

fruId
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TABLE C–29 Sun StorEdge T3 Module – Midplane Table (Continued)
Property Description

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

TABLE C–30 Sun StorEdge T3 Module – Volume (Basic Properties Table)

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

volId volume id

volName volume name

volWWN volume WWN

volStatus volume status

volCacheMode cache mode

volCacheMirror cache mirror

volCapacity volume capacity

volArrayWidth drive number

volRaidLevel RAID (Redundant Array of Independent/Inexpensive Disks) level for the
volume

volDisabledDisk

volSubstitutedDisk

volInitRate

volVerifyRate
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TABLE C–31 Sun StorEdge T3 Module – Statistical Properties Table

Property Description

t300name t300name

unitId unit id

volId volume id

volTotalRequests total requests

volWriteRequests write requests

volReadRequests read requests

volTotalBlocks total blocks

volBlocksWritten blocks written

volBlocksRead blocks read

volSoftErrors soft errors

volFirmErrors firm errors

volHardErrors hard errors

volCacheWriteHits cacheWriteHits

volCacheWriteMisses cacheWriteMisses

volCacheReadHits cacheReadHits

volCacheReadMisses cacheReadMisses

volCacheRmwFlushes cacheRmwFlushes

volCacheReconFlushes cacheReconFlushes

volCacheStripeFlushes cacheStripeFlushes

clear-flag clear flag

TABLE C–32 Sun StorEdge T3 Module – Ports

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number
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TABLE C–33 Sun StorEdge T3 Module – Port (Basic Properties Table)

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

portId portId

portWWN port WWN

portStatus port status

portType port type

portFruId port fruId

portSunHost port sunHost

portFibreCount fibre count

portFibreAlpaMode ALPA mode

portFibreAlpa ALPA

TABLE C–34 Sun StorEdge T3 Module – Statistical Properties Table

Property Description

t300name 300name

unitId Unit ID

portId Port ID

portTotalRequests Total requests (read requests plus write requests)

portWriteRequests Write requests

portReadRequests Read requests

portTotalBlocks Total blocks

portBlocksWritten Blocks written

portBlocksRead Blocks read

TABLE C–35 Sun StorEdge T3 Module – Attachments Table

Property Description

sunSmTreeProp sunSmTreeProp
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TABLE C–35 Sun StorEdge T3 Module – Attachments Table (Continued)
Property Description

sunSmNodeName Current Name

entry_no entry number

TABLE C–36 Sun StorEdge T3 Module – Attachment Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

portId portId

attachId attach id

attachLun attach Lun

attachMode attach mode

attachVolId attach volid

attachVolName attach volname

TABLE C–37 Sun StorEdge T3 Module – Loops

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE C–38 Sun StorEdge T3 Module – Loops Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

loopId loop id
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TABLE C–38 Sun StorEdge T3 Module – Loops Table (Continued)
Property Description

loopStatus loop status

loopMux loop mux

loopIsAvailable isAvailable

loopIsReserved isReserved

loopIsIsolated isIsolated

loopIsTop isTop

loopIsBottom isBottom

loopIsMiddle isMiddle

TABLE C–39 Sun StorEdge T3 Module – Midplanes Table

Property Description

entry_no Entry number

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

TABLE C–40 Sun StorEdge T3 Module – Powerunits Table

Property Description

entry_no Entry number

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

TABLE C–41 Sun StorEdge T3 Module – Volumes Table

Property Description

entry_no Entry number

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name
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TABLE C–42 Sun StorEdge T3 Module – Logging Table

Property Description

t300name

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

rowstatus

logStatus

logPort

logTo

logLevel

TABLE C–43 Sun StorEdge T3 Module – Rules

Rule Description

rple201 Controller Error

rple202 Power Cooling Unit Error

rple203 Loop Card Error

rple204 Disk Error

rple205 Controller Warning

rple206 Power Cooling Unit Warning

rple207 Loop Card Warning

rple208 Disk Warning

rple209 DC error

rple210 Power supply unit disabled

rple211 Power supply off

rple212 Power supply error

rple213 Battery missing

rple214 Loop card missing

rple215 Interconnect cable missing

rple216 Loop card disabled

rple220 Disk Error
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TABLE C–43 Sun StorEdge T3 Module – Rules (Continued)
Rule Description

rple221 Power Cooling Unit Error

rple222 Power Cooling Unit Error

rple223 Controller Warning

rple224 Loop Card Warning

rple225 Disk Warning

rple226 Disk Warning

rple227 Power Cooling Unit Warning

rple400 FRU or disk. Use fruState and fruStatus to decide whether disk is
normal.

rple401 FRU or controller. Use fruState and fruStatus to decide whether
controller is normal.

rple402 FRU or loop-card. Use fruState and fruStatus to decide whether
loop-card is normal.

rple403 FRU or power cooling unit. Use fruState and fruStatus to decide
whether power cooling unit is normal.

rple404 System or basic-table, basic-entry, or sysStatus rule. If sysStatus is not
equal to OK, the T3 array has a fault.

Operating System
The software provides several modules that monitor the operating system on your
host. When the following modules are loaded, these modules are found under the
Operating System section of the Module Browser tab in the Details window:

� “File Monitoring Module Version 2.0” on page 376
� “IPv6 Instrumentation Module Version 1.0” on page 376
� “Kernel Reader (Simple) Module Version 1.0” on page 382
� “MIB-II Instrumentation Module Version 1.0” on page 394
� “MIB-II (Simple) Module Version 1.0” on page 403
� “NFS File Systems Module Version 2.0” on page 406
� “NFS Statistics Module Version 2.0” on page 406
� “Solaris Process Details Module Version 2.0” on page 408
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File Monitoring Module Version 2.0
This module enables you to monitor the files on a host. You can isolate any file or
number of files and monitor those files individually by loading multiple instances of
the File Monitoring module. This module requires you to add rows for the data
property tables. For more information, see “To Add a Row to a Data Property Table”
on page 139.

The following table lists the File Monitoring Status properties and their descriptions.

TABLE C–44 File Monitoring Properties

Property Description

Name Name of the file being monitored

Description Descriptive name provided for this file when added

Filename File being monitored

Last Modified Date and time the file last changed

File Size (Bytes) Size of the file

Size Rate (Bytes) Number of bytes written per second

IPv6 Instrumentation Module Version 1.0
This section presents information on the IPv6 Instrumentation module, which
comprises the groups that are described in the following sections:

� “IPv6 IP Group Properties” on page 376
� “IPv6 TCP Properties” on page 380
� “IPv6 UDP Properties” on page 380
� “IPv6 ICMP Properties” on page 380

IPv6 IP Group Properties
The tables that are in this section identify the IPv6 IP Group properties.

The following table identifies the properties that are shown in the IPv6 IP Group
Table.

TABLE C–45 IPv6 IP Group Table

Property Description

IPv6 Forwarding Number of forwards enabled
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TABLE C–45 IPv6 IP Group Table (Continued)
Property Description

IPv6 Default Hop Limit Hop limit (default 255)

IPv6 Interface Number of interfaces

IPv6 Route Number Route number

The following table identifies the properties that are shown in the IPv6 If Table.

TABLE C–46 IPv6 If Table

Property Description

IPv6 If Index Index

IPv6 If Descr Description

IPv6 If Lower Layer

IPv6 If Effective Mtu

IPv6 If Reasm Max Size

IPv6 If Identifier

IPv6 If Identifier Length

IPv6 If Physical Address

IPv6 If Admin Status

IPv6 If Oper Status

The following table identifies the properties that are shown in the IPv6 If Stats Table.

TABLE C–47 IPv6 If Stats Table

Property Description

IPv6 If Index

IPv6 If Stats In Receives

IPv6 If Stats In Hdr Errors Number of incoming headers that had errors

IPv6 If Stats In Too Big Errors Number of incoming packets that were too big

IPv6 If Stats In No Routes

IPv6 If Stats In Addr Errors

IPv6 If Stats In Unknown Protos
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TABLE C–47 IPv6 If Stats Table (Continued)
Property Description

IPv6 If Stats In Truncated Pkts Number of incoming packets that were
truncated

IPv6 If Stats In Discards

IPv6 If Stats In Delivers

IPv6 If Stats Out Forw Datagrams

IPv6 If Stats Out Requests

IPv6 If Stats Out Discards

IPv6 If Stats Out Frag OKs

IPv6 If Stats Out Frag Fails

IPv6 If Stats Out Frag Creates

IPv6 If Stats Reasm Reqds Reassembled

IPv6 If Stats Reasm OKs

IPv6 If Stats Reasm Fails

IPv6 If Stats In Mcast Pkts

IPv6 If Stats Out Mcast Pkts

The following table identifies the properties that are shown in the IPv6 Addr Prefix
Table.

TABLE C–48 IPv6 Addr Prefix Table

Property Description

IPv6 If Index

IPv6 Addr Prefix Prefix for physical address

IPv6 Addr Prefix Length

IPv6 Addr Prefix On Link Flag

IPv6 Addr Prefix Autonomous Flag

The following table identifies the properties that are shown in the IPv6 Addr Table.
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TABLE C–49 IPv6 Addr Table

Property Description

IPv6 If Index

IPv6 Addr Address

IPv6 Addr Pfx Length

IPv6 Addr Type

IPv6 Addr Anycast Flag

IPv6 Addr Status

The following table identifies the properties that are shown in the IPv6 Route Table.

TABLE C–50 IPv6 Route Table

Property Description

IPv6 Route Dest

IPv6 Route Pfx Length

IPv6 Route Index

IPv6 Route If Index

IPv6 Route Next Hop

IPv6 Route Type

IPv6 Route Protocol

IPv6 Route Policy

IPv6 Route Age

IPv6 Route Next Hop RDI

IPv6 Route Metric

IPv6 Route Weight

IPv6 Route Info

IPv6 Route Valid

The following table identifies the properties that are shown in the IPv6 Net to
MediaTable.
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TABLE C–51 IPv6 Net To Media Table

Property

IPv6IfIndex

IPv6NetToMediaNet Address

IPv6NetToMedia PhysAddress

IPv6NetToMedia Type

IPv6IfNetToMedia State

IPv6IfNetToMedia LastUpdated

IPv6NetToMedia Valid

IPv6 TCP Properties
The following table identifies the properties that are shown in the IPv6 Conn Table.

TABLE C–52 IPv6 Conn Table

Property Description

IPv6 Conn State Connectivity state

IPv6 Conn Local Address Connectivity local IP address

IPv6 Conn Local Port Connectivity local port number

IPv6 Conn Rem Address Connectivity remote IP address

IPv6 Conn Rem Port Connectivity remote port number

IPv6 UDP Properties
The following table identifies the properties that are shown in the IPv6 UDP Table.

TABLE C–53 IPv6 UDP Table

Property Description

IPv6 Udp Local Address IP address

IPv6 Udp Local Port Port number

IPv6 Udp If Index Index

IPv6 ICMP Properties
The following table identifies the properties that are shown in the IPv6 If ICMP Table.
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TABLE C–54 IPv6 If ICMP Table

Property Description

IPv6 If Index

IPv6 If Icmp In Msgs Number of incoming messages

IPv6 If Icmp In Errors Number of incoming errors

IPv6 If Icmp In Dest Unreachs Number of unreachable incoming destinations

IPv6 If Icmp In Admin Prohibs

IPv6 If Icmp In Time Excds

ivp6 If Icmp In Parm Problems

ivp6 If Icmp In Pkt Too Bigs

IPv6 If Icmp In Echos

IPv6 If Icmp In Echo Replies

IPv6 If Icmp In Router Solicits

IPv6 If Icmp In Router Advertisements

IPv6 If Icmp In Neighbor Solicits

IPv6 If Icmp In Neighbor Advertisements

IPv6 If Icmp In Redirects

IPv6 If Icmp In Group Memb Queries

IPv6 If Icmp In Group Memb Responses

IPv6 If Icmp In Group Memb Reductions

IPv6 If Icmp Out Msgs

IPv6 If Icmp Out Errors

IPv6 If Icmp Out Dest Unreachs

Ipv6 If Icmp Out Admin Prohibs

IPv6 If Icmp Out Time Excds

IPv6 If Icmp Out Parm Problems

IPv6 If Icmp Out Pkt Too Bigs

IPv6 If Icmp Out Echos

IPv6 If Icmp Out Echo Replies

IPv6 If Icmp Out Router Solicits
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TABLE C–54 IPv6 If ICMP Table (Continued)
Property Description

IPv6 If Icmp Out Router Advertisements

IPv6 If Icmp Out Neighbor Solicits

IPv6 If Icmp Out Neighbor Advertisments

IPv6 If Icmp Out Redirects

IPv6 If Icmp Out Group Memb Queries

IPv6 If Icmp Out Group Memb Responses

IPv6 If Icmp Out Group Memb Reductions

Kernel Reader (Simple) Module Version 1.0
The Kernel Reader (Simple) module generates a warning alarm if the module finds
any disk with an increasing wait queue while busy.

A warning alarm occurs when the disk is over 75% busy and the average queue length
is over 10 with an increasing wait queue. The warning alarm is on until the disk is not
over 70% busy and the average queue length is no longer than 8. Similarly, this
module generates a warning alarm if 90% of swap space is in use. The alarm remains
open until the swap space in use is less than 80% of the total swap space.

The following table provides default alarm thresholds for applicable Kernel Reader
modules.

TABLE C–55 Alarm Thresholds for the Kernel Reader Module

Alarm Threshold Message Condition

Error If file system kpctUsed is > 98

Warning If file system kpctUsed is > 90

Error If file system inode percentage is > 90

Warning If file system inode percentage is > 80

User Statistics Table
The following table provides a brief description of the properties for User Statistics.
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TABLE C–56 User Statistics Properties

Property Description

Console User User currently logged in on the console

Number Of Users Number of unique users currently logged in

Number Of User Sessions Number of currently active user sessions

Max Console User Login name of the user that logged into the system
console the most times since the last reboot

Interprocess Communication Tables
The following tables describe interprocess communication properties.

The following table describes the shared memory properties.

TABLE C–57 IPC Shared Memory Properties

Property Description

Total Shared
Memory Segments

Total number of shared memory segments initially available for use.

Available Shared
Memory Segments

Number of currently available shared memory segments.

Shared Memory
Segments Used

Shared memory segments used as a percentage of the total units.

The following table describes semaphores properties.

TABLE C–58 IPC Semaphores Properties

Property Description

Total Semaphores
Available

Total number of semaphores currently available.

Semaphores Used Semaphores used as a percentage of the total.

The following table provides a brief description of the properties for System Load
Statistics.
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TABLE C–59 System Load Statistics Properties

Property Description

1 Min Load
Average

Load average over the last 1 minute

5 Min Load
Average

Load average over the last 5 minutes

15 Min Load
Average

Load average over the last 15 minutes

Disk Statistics Managed Objects Tables
The following tables provide a brief description of the properties for Disk Statistics.

The following table provides a brief description of the properties for Disk Details.

TABLE C–60 Disk Details Properties

Property Description

Disk Name Name of the disk, such as sd0

Disk Alias Name of the disk, such as c0t0d0

Read Operation Per Sec Read operations per second

Writes Operation Per Sec Write operations per second

Operation Per Sec (read + write) Operations per second (read and write)

Number Of Bytes Read Number of bytes read

Number Of Bytes Written Number of bytes written

Number Of Bytes Transferred (read +
write)

Number of bytes transferred (read and write)

Average Number Of Transactions
Waiting

Average number of transactions waiting

Average Number Of Transactions
Running

Average number of transactions running

The following table provides a brief description of the properties for Disk Service
Time.

384 Sun Management Center 3.6 User’s Guide • December 2005



TABLE C–61 Disk Service Time Properties

Property Description

Diskname Name of the disk , such as sd0

Disk Alias Name of the disk, such as c0t0d0

Percentage Of
Time There Is A
Transaction
Waiting For
Service

Percentage of time there is a transaction waiting for service (wait queue
length)

Percentage Of
Time The Disk Is
Busy

Percentage of time the disk is busy (transaction running)

Average Wait
Service Time

Average wait service time

Average Run
Service Time

Average run service time

Average Service
Time

Average service time

Rule 404 Meta Disk Rule

The following table provides a brief description of the properties for I/O error
statistics.

TABLE C–62 I/O Error Statistics Properties

Property Description

Device The name of the device in a descriptive format

Software Errors The total number of software errors

Hardware Errors The total number of hardware errors

Transport Errors The total number of transport errors

Total Errors Total number of errors

Under the I/O Error Statistics Table, there are the following two tables.

TABLE C–63 Device Error Table

Property Description

Device The name of the device in descriptive format
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TABLE C–63 Device Error Table (Continued)
Property Description

Software Errors Total number of software errors

Hardware Errors Total number of hardware errors

Transport Errors Total number of transport errors

Total Errors Total number of errors

TABLE C–64 Tape Error Table

Property Description

Device The name of the device in descriptive format

Software Errors Total number of software errors

Hardware Errors Total number of hardware errors

Transport Errors Total number of transport errors

Total Errors Total number of errors

File System Usage Table
The following table provides a brief description of the properties for file system usage.

TABLE C–65 File System Usage Properties

Property Description

Index Mount point index

Mount Point Mount point for the file system

Disk Name Name of the device (/dev/dsk/...)

Size (KB) Total size of the file system in Kbytes

Free (KB) Available disk space in Kbytes

Free KB (Non Root) Available disk space for non-superusers in Kbytes

Percent Used Percentage of disk space used

Total Inodes Total size of the file system in Kbytes

Available Inodes Available disk space for the file system in Kbytes

Percentage Of Inodes Used Percentage of inodes used
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Note – The Find All Recent Files (>2 or >10Meg) probe commands for the UFS
Filesystem Usage and VXFS Filesystem Usage folders find only files that were created
or modified less than 24 hours ago. The Find All Files (>2 or >10Meg) probe
commands for UFS Filesystem Usage and VXFS Filesystem Usage find all files,
regardless of the date/time they were created or modified. For more information
about the probe command, see “To Probe a Property” on page 142.

CPU Statistics Managed Object Tables
The tables that are in this section provide a brief description of the properties for CPU
Statistics managed objects.

The following table provides a brief description of the properties for CPU Utilization.

TABLE C–66 CPU Usage Properties

Property Description

CPU Number CPU number

% CPU Idle Time Percentage of time spent by CPU on idle mode

% CPU User Time Percentage of time spent by CPU on user mode

% CPU Kernel Time Percentage of time spent by CPU on kernel mode

% CPU Wait Time Percentage of time spent by CPU on wait mode

% CPU Wait Time On I/O Percentage of time spent by CPU on wait mode for I/O

% CPU Wait Time On Swap Percentage of time spent by CPU on wait mode for
swap

% CPU Wait Time On Pio Percentage of time spent by CPU on wait mode for Pio

Times Idle Thread Scheduled Percentage of idle time spent by CPU on threads
scheduled

Rule 403 Meta CPU Rule

The following table provides a brief description of the properties for CPU processes.

TABLE C–67 CPU Process Table

Property Description

Processes in Run
Queue

Processes in run queue
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TABLE C–67 CPU Process Table (Continued)
Property Description

Processes Waiting Waiting processes

Processes
Swapped

Swapped processes

Total Number of
CPUs

Total number of CPUs

The following table provides a brief description of the properties for CPU I/O.

TABLE C–68 CPU I/O Properties

Property Description

CPU Number Central Processing Unit (CPU) number

Physical Block Reads Number of physical block reads

Physical Block Writes Number of physical block writes

Logical Block Reads Number of logical block reads

Logical Block Writes Number of logical block writes

Raw I/O Reads Number of raw I/O reads

Raw I/O Writes Number of raw I/O writes

Bytes Read By Rdwr() Number of bytes read by Rdwr()

Bytes Written By Rdwr() Number of bytes written by Rdwr()

Terminal Input Characters Number of terminal input characters

Chars Handled In Canonical Mode Number of chars handled in canonical mode

Terminal Output Characters Number of terminal output characters

Physical Block Writes Number of physical block writes

Procs Waiting For Block I/O Number of processes that are waiting for block I/O

The following table provides a brief description of the properties for CPU Interrupts.

TABLE C–69 CPU Interrupts Properties

Property Description

CPU Number CPU number

Context Switches Number of context switches
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TABLE C–69 CPU Interrupts Properties (Continued)
Property Description

Traps Number of traps

Device Interrupts Number of device interrupts

Interrupts As Threads Number of interrupts as threads

Interrupts
Blocked/Preempted/Released

Number of interrupts that were blocked, pre-empted or
released

The following table provides a brief description of the properties for CPU system calls.

TABLE C–70 CPU System Call Properties

Property Description

CPU Number CPU number

System Calls Number of system calls

Read+Readv System Calls Number of read+ready system calls

Write+Writev System Calls Number of Write+Writev system calls

Forks Number of forks

Vforks Number of Vforks

Execs Number of executables

Msg Count Number of message count

Semaphore Ops Count Number of semaphore operation count

Pathname Lookups Number of pathname lookups

Ufs_iget() Calls Number of ufs_iget() calls

Directory Blocks Read Number of directory block reads

Inodes Taken With Attached Pages Number of indexes taken with attached pages

Inodes Taken With No Attached
Pages

Number of indexes taken with no attached pages

Inode Table Overflows Number of Inode table overflows

File Table Overflows Number of file table overflows

Proc Table Overflows Number of process table overflows

The following table provides a brief description of miscellaneous CPU properties.
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TABLE C–71 CPU Miscellaneous Properties

Property Description

CPU Number CPU number

Involuntary Ctx Switches Number of involuntary context switches

Thread_create()s Number of thread_create()s

Cpu Migrations By Threads Number of CPU migrations by threads

Xcalls To Other Cpus Number of Xcalls to other CPUs

Failed Mutex Enters (adaptive) Number of failed mutex enters (adaptive)

Rw Reader Failures Number of read/write reader failures

Rw Write Failures Number of read/write write failures

Loadable Module Loaded Number of loadable module loaded

Loadable Module Unloaded Number of loadable module unloaded

Tries To Acquire RW Lock Number of tries to acquire read/write lock

The following table provides a brief description of the properties for CPU Regwindow.

TABLE C–72 CPU Regwindow Properties

Property Description

CPU Number CPU number

User Overflows Number of user overflows

User Underflows Number of user underflows

System Overflows Number of system overflows

System Underflows Number of system underflows

System User Overflows Number of system user overflows

The following table provides a brief description of the properties for CPU Pageinfo.

TABLE C–73 CPU Pageinfo Properties

Property Description

CPU Number CPU number

Reclaims Number of reclaims

Reclaims From Free List Number of reclaims from free list
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TABLE C–73 CPU Pageinfo Properties (Continued)
Property Description

Pageins Number of pageins

Pages Paged In Number of pages that were paged in

Pageouts Number of pageouts

Pages Paged Out Number of pages that were paged out

Swapins Number of swap ins

Pages Swapped In Number of pages that were swapped in

Swapouts Number of swap outs

Pages Swapped Out Number of pages that were swapped out

Pages Zero Filled On Demand Number of pages zero filled on demand

Pages Freed By Daemon Number of pages fixed by daemon

Pages Examined By Pageout Daemon Number of pages examined by the pageout daemon

Revolutions Of The Page Daemon
Hand

Number of revolutions of the page daemon hand

Times Pager Scheduled Number of times pager scheduled

The following table provides a brief description of the properties for CPU Faults.

TABLE C–74 CPU Faults Properties

Property Description

CPU Number CPU number

Minor Page Faults Via
hat_fault()

Number of minor page faults through hat_fault()

Minor Page Faults Via as_fault() Number of minor page faults through as_fault()

Major Page Faults Number of major page faults

Copy-on-write Faults Number of copy-on write faults

Protection Faults Number of protection faults

Faults Due To Software Locking Req Number of software locking faults

as_fault()s In Kernel addr Space Number of in kernel addr space
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Memory Usage Statistics Table
The following table provides a brief description of the properties for Memory Usage
Statistics.

TABLE C–75 Memory Usage Statistics Properties

Property Description

Physical Memory Available (MB) Physical memory that is available in Mbytes

Physical Memory In Use (MB) Physical memory in use in Mbytes

Percent Memory Used Percentage of memory used

Physical Memory Free (MB) Physical memory that is free in Mbytes

Percent Memory Free Percentage of memory that is free

Swap Statistics Table
The following table provides a brief description of the properties for Swap Statistics.

TABLE C–76 Swap Statistics Properties

Property Description

Available KB (Anon Memory Not Reserved) Swap available. Total reserved swap
space.

Reserved KB (Anon Memory Reserved But Not
Allocated)

Swap reserved

Allocated KB (Anon Memory Not Free) Swap allocated

Used KB Swap used

Total KB (Used + Available) Swap total

Percent Swap Used Percentage of swap used

Rule 405 Meta Swap Rule

Streams Statistics Managed Objects Table
The following section provides the various Streams Statistics properties for the
following managed objects:

� Stream Head Cache
� Queue Cache
� Streams Messages
� Linkinfo Cache
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� Strevent Cache
� Syncq Cache
� Qband Cache

The following table briefly describes the managed objects.

TABLE C–77 Streams Statistics Managed Objects

Properties Description

Stream Head Cache Kernel statistics for streams head cache

Queue Cache Kernel statistics for queue cache

Streams Msgs Kernel statistics for streams messages

Linkinfo Cache Kernel statistics for link information cache

Strevent Cache Kernel statistics for streams event cache

Syncq Cache Kernel statistics for synoq cache

Qband Cache Kernel statistics for qband cache

All of the Streams Statistics managed objects have the same properties. The following
table presents these common properties.

TABLE C–78 Streams Statistics Table Properties

Property Description

The Name Of The Cache Name of the cache

Current Usage (total - avail) Cache’s current usage

Maximum Capacity Maximum capacity of the cache

Cumulative Total Of Allocations Number of total cache allocations

Number of Allocation Failures Number of allocation failures

Percent Used Percentage of cache used

Software Rules Table
The following table provides a brief description of the properties for Software Rules.

TABLE C–79 Software Rules Properties

Property Description

Rule rknrd105 Software rule (refer to rule rknrd105 in Appendix D
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TABLE C–79 Software Rules Properties (Continued)
Property Description

Rule rknrd106 Software rule (refer to rule rknrd106 in Appendix D)

Zones Table
The following table provides a brief description of the properties for zones.

TABLE C–80 Zones Properties

Property Description

Zone ID Zone identification number

Zone Name Name of the zone

Status State of the zone

Root Dir Directory in global zone that is root directory for a local zone

IP Address IP address of the zone

Autoboot Specifies whether the zone must automatically reboot when the system
reboots

MIB-II Instrumentation Module Version 1.0
This section presents information on the MIB-II Instrumentation module. The MIB-II
Instrumentation module includes the property tables described in the following
sections:

� “MIB-II System Group Table” on page 394
� “MIB-II Interfaces Group Tables” on page 395
� “MIB-II IP Group Table” on page 396
� “MIB-II ICMP Group Table” on page 399
� “MIB-II TCP Group Tables” on page 400
� “MIB-II UDP Group Tables” on page 402

MIB-II System Group Table
The following table provides a brief description of the properties for MIB-II System
Group.
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TABLE C–81 MIB-II System Group Properties

Property Description

System Description MIB-II system description or the description of the host (read-write)

System OID Object identifier or the Object ID (OID) of the software system

Time Since System Is
Up

Time in microseconds since the system booted

System Contact The contact name for this system

System Name The qualified host name on which the agent is running (read-write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily offered

MIB-II Interfaces Group Tables
The following tables provide a brief description of the properties for the MIB-II
Interface group.

The following table provides a brief description of the properties for MIB-II Interfaces
Group.

TABLE C–82 MIB-II Interfaces Group Properties

Property Description

Number of
Interfaces

Number of interfaces to the machine, including the loopback

The following table provides a brief description of the properties for MIB-II Interfaces.

TABLE C–83 MIB-II Interface Properties

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

IF Largest MTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF Physical Address Physical address of the interface

IF Admin Status Desired state of the interface
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TABLE C–83 MIB-II Interface Properties (Continued)
Property Description

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and running)
when the operational state has changed last time

IF In Octets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In NonUnicast Pkts Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown Protos Number of packets with unsupported protocol that were received on
the interface

IF Out Octets Number of octets that are transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out NonUnicast
Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because of
errors

IF Out Queue Length Length of the output packet queue

IF Specific Reference to the MIB definitions specific to the particular media

MIB-II IP Group Table
The following tables provide a brief description of the properties for MIB-II IP.

The following table provides a brief description of the properties for MIB-II IP Group.

TABLE C–84 MIB-II Group Properties

Property Description

IP Forwarding Indicates whether this entity is a gateway

IP Default TTL Default Time-to-Live inserted into the IP headers

IP In Receives Number of datagrams received

IP In Header
Errors

Number of input datagrams that are discarded because of errors in IP
headers
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TABLE C–84 MIB-II Group Properties (Continued)
Property Description

IP In Address
Errors

Number of input datagrams that are discarded because of errors in
destination IP address

IP Forwarded
Datagrams

Number of forwarded datagrams

IP In Unknown
Protos

Number of locally addressed datagrams that were discarded because of
unsupported protocols

IP In Discards Number of input datagrams that were discarded

IP In Delivers Number of input datagrams that were successfully delivered

IP Out Requests Number of datagrams that were supplied to IP for transmission

IP Out Discards Number of output IP datagrams that were discarded

IP Out No Routes Number of output IP datagrams that were discarded because no route
destination was found

IP Reassemble
Timeouts

Maximum time in seconds for which the received fragments were held for
reassembly

IP Reassemble
Requireds

Number of IP fragments received that required reassembly

IP Reassemble
OKs

Number of IP datagrams that were successfully reassembled

IP Reassemble
Fails

Number of failures detected by the reassembly algorithm

IP Fragmentation
OKs

Number of IP datagrams that were successfully fragmented

IP Fragmentation
Fails

Number of IP datagrams that have failed fragmentation

IP Fragmentation
Creates

Number of IP datagram fragments that were generated due to
fragmentation

The following table provides a brief description of the properties for IP Addresses.

TABLE C–85 IP Addresses Properties

Property Description

IPAT IP Address IP address to which this entry’s addressing information pertains

IPAT IfIndex Index in the interface table for the corresponding interface

IPAT Net Mask Subnet mask associated with the IP address
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TABLE C–85 IP Addresses Properties (Continued)
Property Description

IPAT Broadcast
Address

Value of the least significant bit in the IP broadcast address

IPAT Reassemble
Max Size

Size of the largest IP datagram that can be reassembled by this entity

The following table provides a brief description of the properties for IP Route.

TABLE C–86 IP Route Properties

Property Description

IP Route
Destination

Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next hop of
this route is reached

IP Route Metric1 Primary routing metric for the route that is specific to the routing 1
protocol

IP Route Metric2 Alternate routing metric for the route that is specific to the routing 2
protocol

IP Route Metric3 Alternate routing metric for the route that is specific to the routing 3
protocol

IP Route Metric4 Alternate routing metric for the route that is specific to the routing 4
protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routing mechanism through which this route was learned

IP Route Age Number of seconds since the route was last updated

IP Route Mask Mask to be logical and with the destination address before being
compared to the route destination

IP Route Metric5 Alternate routing metric for the route that is specific to the routing 5
protocol

IP Route Info Reference to MIB definitions specific to the routing protocol

The following table provides a brief description of the properties for IP NetToMedia.
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TABLE C–87 IP NetToMedia Properties

Property Description

IPN2M IfIndex Index of the interface in the interface table on which this entry’s
equivalence is effective

IPN2M
PhysAddress

Media-dependent physical address

IPN2M
NetAddress

IP address corresponding to the physical address

IPN2M Type Type of mapping

MIB-II ICMP Group Table
The following table provides a brief description of the properties for MIB-II ICMP
Group.

TABLE C–88 MIB-II ICMP Group Properties

Property Description

ICMP In Messages Number of ICMP messages received

ICMP In Errors Number of ICMP messages received with errors

ICMP In Dest
Unreachs

Number of ICMP destination unreachable messages received

ICMP In Time
Exceeds

Number of ICMP time exceeded messages received

ICMP In
Parameter
Problems

Number of messages received that describe ICMP parameter problems

ICMP In Src
Quenchs

Number of ICMP source quench messages received

ICMP In Redirects Number of ICMP redirect messages received

ICMP In Echos Number of messages received that describe ICMP echo requests

ICMP In Echo
Reps

Number of messages received that describe ICMP echo replies

ICMP In
Timestamps

Number of messages received that describe ICMP timestamp requests

ICMP In
Timestamp Reps

Number of messages that relate to ICMP timestamp replies
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TABLE C–88 MIB-II ICMP Group Properties (Continued)
Property Description

ICMP In Address
Masks

Number of ICMP address mask request messages received

ICMP In Address
Mask Reps

Number of ICMP address mask reply messages received

ICMP Out
Messages

Number of ICMP messages that were attempted to be sent

ICMP Out Errors Number of ICMP messages that were not sent due to problems

ICMP Out Dest
Unreachs

Number of ICMP destination unreachable messages sent

ICMP Out Time
Exceeds

Number of ICMP time exceeded messages sent

ICMP Out
Parameter
Problems

Number of messages sent that relate to ICMP parameter problems

ICMP Out Src
Quenchs

Number of ICMP source quench messages sent

ICMP Out
Redirects

Number of ICMP redirect messages sent

ICMP Out Echos Number of messages sent that relate to ICMP echo requests

ICMP Out Echo
Reps

Number of number of messages sent that relate to ICMP echo replies

ICMP Out
Timestamps

Number of request messages sent for ICMP timestamps

ICMP Out
Timestamp Reps

Number of ICMP timestamp reply messages sent

ICMP Out
Address Masks

Number of ICMP address mask request messages sent

ICMP Out
Address Mask
Reps

Number of ICMP address mask reply messages sent

MIB-II TCP Group Tables
The following tables provide a brief description of the properties for MIB-II TCP.

The following table provides a brief description of the properties for MIB-II TCP
Group.

400 Sun Management Center 3.6 User’s Guide • December 2005



TABLE C–89 MIB-II TCP Group Properties

Property Description

TCP
Retransmission
Algorithm

Algorithm used to determine the timeout value to be used for
retransmitting unacknowledged octets

TCP Retransmit
Min Timeout

Minimum value permitted by TCP implementation for the retransmission
timeout

TCP Retransmit
Max Timeout

Maximum value permitted by TCP implementation for the retransmission
timeout

TCP Max
Connections

Limit on the number of TCP connections

TCP Active Opens Number of times TCP connections have transitioned to SYN-SENT from
CLOSED state

TCP Passive
Opens

Number of times TCP connections have transitioned to SYN-RCVD from
LISTEN state

TCP Attempt Fails Number of times TCP connections have transitioned from SYN-SENT or
SYN-RCVD to COLSED state and from SYN-RCVD to LISTEN state

TCP
Established-to-Resets

Number of times TCP connections have transitioned from ESTABLISHED
or CLOSE-WAIT to CLOSED state

TCP Current
Established

Number of TCP connections for which the current state is ESTABLISHED
or CLOSE-WAIT

TCP In Segments Number of segments received

TCP Out
Segments

Number of segments sent

TCP
Retransmitted
Segments

Number of segments retransmitted

TCP In Errors Number of segments that were received in error

TCP Out With
Reset Flag

Number of segments sent containing the RST flag

The following table provides a brief description of the properties for TCP Connections.

TABLE C–90 TCP Connections Properties

Property Description

TcpConn State State of this TCP Connection

TcpConn Local Address Local IP address for this TCP connection
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TABLE C–90 TCP Connections Properties (Continued)
Property Description

TcpConn Local Port Local port number for this TCP connection

TcpConn Remote Address Remote IP address for this TCP connection

TcpConn Remote Port Remote port number for this TCP connection

MIB-II UDP Group Tables
The following tables provide a brief description of the properties for MIB-II UDP.

The following table provides a brief description of the properties for MIB-II UDP
Group.

TABLE C–91 MIB-II UDP Group Properties

Property Description

UDP In
Datagrams

Number of UDP datagrams that were delivered to UDP users

UDP No Port
Datagrams

Number of received UDP datagrams for which there is no application at
the destination port

UDP In Errors Number of received UDP datagrams that could not be delivered

UDP Out
Datagrams

Number of UDP datagrams sent

The following table provides a brief description of the properties for UDP.

TABLE C–92 UDP Properties

Property Description

UDP Local
Address

The local IP address for this UDP listener

UDP Local Port The local port number for this UDP listener
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MIB-II (Simple) Module Version 1.0

Note – The MIB-II (simple) module is used to identify a Sun Management Center
agent. If this module is not loaded, the agent can only be created as a ping host or as
an SNMP host.

The tables that are in this section provide a brief description of the properties for
Simple MIB-II managed objects.

System Group
The following table provides a brief description of the properties for System Group.

TABLE C–93 System Group Properties

Property Description

System
Description

MIB-II system description or the description of the host (read-write)

System OID Object identifier or the Object ID (OID) of the software system

Time Since Up Time in microseconds since the system is up

System Contact The contact name for the system

System Name The qualified host name on which the agent is running (read-write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily offered

Interfaces Group
The Number of Interfaces group property indicates the number of interfaces to the
machine, including the loopback. Additional interfaces properties are described in the
following table.

TABLE C–94 Interfaces Table

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface
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TABLE C–94 Interfaces Table (Continued)
Property Description

IF Type Type of the interface

IF Largest MTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF Physical
Address

Physical address of the interface

IF Admin Status Desired state of the interface

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and running)
when the operational state has changed last time

IF In Octets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In nonUnicast
Pkts

Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown
Protos

Number of packets with unsupported protocol that were received on the
interface

IF Out Octets Number of octets that are transmitted out on the interface

IF Out Unicast
Pkts

Number of unicast packets transmitted out on the interface

IF Out nonUnicast
Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because of
errors

IF Out Queue
Length

Length of the output packet queue

IF Specific Reference to the MIB definitions specific to the particular media

IP Group
The IP Forwarding group property indicates whether this entity is a gateway.
Additional IP route properties are described in the following table.
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TABLE C–95 IP Route Table

Property Description

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next
hop of this route is reached

IP Route Metric1 Primary routing metric for the route that is specific to the routing 1
protocol

IP Route Metric2 Alternate routing metric for the route that is specific to the routing 2
protocol

IP Route Metric3 Alternate routing metric for the route that is specific to the routing 3
protocol

IP Route Metric4 Alternate routing metric for the route that is specific to the routing 4
protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routing mechanism through which this route was learned

IP Route Age Number of seconds since the route was last updated

IP Route Mask Mask to be logical and with the destination address before being
compared to the route destination

IP Route Metric5 Alternate routing metric for the route that is specific to the routing 5
protocol

IP Route Info Reference to MIB definitions specific to the routing protocol

The following table describes the IP address properties.

TABLE C–96 IP Address Table Properties

Property Description

IPAT IP Address IP Address Table Entry IP Address in MIB-II

IPAT IfIndex

IPAT Net Mask

IPAddTab R MaxSize
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NFS File Systems Module Version 2.0
The NFS File Systems module enables you to monitor the NFS file systems on hosts
that are running the Solaris 8, Solaris 9, or Solaris 10 operating systems. The NFS File
Systems module monitors the amount of disk space occupied by mounted or
unmounted file systems. The module monitors the amount of used and available
space as well as the remaining total capacity.

When loading the NFS File Systems module, you can define the file systems that you
want to monitor by using pattern matching. Patterns can be used to filter which NFS
file systems are monitored by file system or mount point.

The following table provides a brief description of the properties for NFS File System
usage.

TABLE C–97 File System Usage Properties

Property Description

NFS Filesys Name of the NFS file system

Size Total size of the NFS file system in Kbytes

Used Used disk space for the NFS file system in Kbytes

Available Available disk space for the NFS file system in Kbytes

% Used Percentage of NFS disk space used

Rate Percentage capacity change per second

Mount Point Mount point for the NFS file system

Entry Index Entry index of the NFS file system

NFS Statistics Module Version 2.0
This section presents property tables for NFS Statistics:

� RPC Information Table
� NFS Information Table

You can use the NFS Statistics module to monitor statistical information on the remote
procedure calls (RPC) and Sun’s distributed computing file system (NFS) calls. The
number of RPC and NFS calls that the client made and the server received are
displayed in the main console window along with the status of the transaction activity
on the local host. The following tables list some of the properties monitored by this
module with both the server and the client statistics.

RPC Information Table
The following table provides a brief description of the properties for RPC Information.
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TABLE C–98 RPC Server and Client Information Properties

Property Description

RPC Calls Total number of RPC calls made by the host

Bad RPC Calls Total number of calls rejected by the RPC layer

Bad RPC Calls % Percentage of rejected calls compared to the total number of calls made
(bad RPC Calls/RPC calls)

RPC Call Rate Number of RPC calls that are made per second

NFS Information Tables
The following table provides a brief description of the properties for NFS information.

TABLE C–99 NFS Server and Client Information Properties

Property Description

NFS Calls Total number of NFS calls sent by the host

Bad NFS Calls Total number of NFS calls rejected

Bad NFS Calls % Percentage of rejected NFS calls compared to the total number of sent calls
(bad NFS calls/NFS calls)

NFS Call Rate Number of NFS calls that were sent per second

The following table provides a brief description of the properties for NFS server
statistics.

TABLE C–100 NFS Server Statistics

Property Description

Server NFS Calls Number of bad server NFS calls since the last init

Server Bad NFS
Call %

Bad NFS calls as a percent of the total NFS calls made

Server NFS Call
Rate

Rate at which server NFS calls are being made per second

The following table provides a brief description of the properties for NFS client
statistics.
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TABLE C–101 NFS Client Statistics

Property Description

NFS Calls Client NFS calls

Bad NFS Calls Number of bad client NFS calls since the last init

Bad NFS % Bad NFS calls as a percentage of the total NFS calls made

NFS Call Rate Rate at which client NFS calls are being made per second

Solaris Process Details Module Version 2.0
The parameters for the Solaris Process Details module are listed in the following table.
This table is displayed when you try to load the module.

TABLE C–102 Solaris Process Details Parameters

Property Description

Module Name Name of the module (not editable)

Module
Description

Description of the module (not editable)

Version Version of the module (not editable)

Enterprise SNMP enterprise in which the module is loaded (not editable)

Module Type Type of the module (not editable)

Number of
Processes

Number of processes that is obtained by the module based on the selection
criteria. One of the given numbers can be selected by the user.

Selection Criteria Selection criteria by which the processes are sorted and selected. For
example, the user can select the top 10 processes using this function.

The following table provides a brief description of the properties for Solaris Process.

TABLE C–103 Process Properties

Property Description

PS Process ID Process ID of the process

PS Parent Process ID Process ID of the parent of the process

PS User ID Login ID of the user of the process

PS User Name Login name of the user of the process
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TABLE C–103 Process Properties (Continued)
Property Description

PS Effective User ID Effective user ID of the process

PS Group ID Real group ID of the process

PS Effective Group ID Effective group ID of the process

PS Session ID Process ID of the session leader of the process

PS Process Group ID Process ID of the process group leader of the process

PS TTY Controlling terminal for the process

PS Start Time Starting time of the process

PS Time Cumulative execution time of the process

PS State State of the process

PS Wait Channel Address of an event for which the process is waiting

PS Scheduling Class Scheduling class of the process

PS Address Memory address of the process

PS Size Total size of the process in virtual memory

PS Priority Priority of the process

PS Nice Nice value of the process, which is used for priority computation

PS Percent CPU Time Percent CPU time

PS Percent Memory Percent memory

PS Command Base name of the executable file for the process

PS Command Line Full command name of the process, including the arguments

Local and Remote Application Modules
The software enables you to monitor local and remote applications. An example of a
local application would be a print spooler. An example of a remote application would
be an HP printer that is equipped with a JetDirect card.

When the following modules are loaded, they are found under the Local Applications
section on the Module Browser tab in the Details window:

� “Agent Statistics Module Version 2.0” on page 410
� “Data Logging Registry Module Version 2.0” on page 414
� “Logview ACL Version 1.0” on page 415
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� “Print Spooler Module Version 3.0” on page 415

When the following modules are loaded, they are found under the Remote Systems
section on the Module Browser tab in the Details window:

� “HP JetDirect Module Version 2.0” on page 417
� “MIB-II Proxy Monitoring Module Version 2.0” on page 417

The local and remote applications modules are described in the following sections.

Agent Statistics Module Version 2.0
This section presents the following information on Agent Statistics:

� “Object Statistics Table” on page 412
� “Commands Executed Table” on page 412
� “Transactions Performed Table” on page 412
� “Sun Management Center Process Statistics Table” on page 412
� “Sun Management Center Total Process Statistics Table” on page 413

The Agent Statistics module monitors the health of the agent installed on a host. This
module monitors the objects, processes, and execution of processes by the agent.

TABLE C–104 Agent Statistics Main Sections

Agent Statistics
Tables Description

Object Section Displays data on the objects that are loaded onto the agent. Status field
displays the current status of the TOE and binary objects loaded into and
used by the agent.

Execution Section Displays data on the number of Tcl or TOE commands invoked by the
agent interpreter. Also displays data on the number of asynchronous
transactions initiated by the agent. Status field displays a brief description
of the current status of the objects listed.

The following table provides a brief description of the Agent Statistics managed
objects.

TABLE C–105 Agent Statistics Section Properties

Property Description

Object Statistics TOE Count – Number of TOE objects loaded into the agent binary object
buffer

Count – Number of binary object buffers used by the agent
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TABLE C–105 Agent Statistics Section Properties (Continued)
Property Description

Commands
Executed

Total – Total number of commands that have been executed by the agent

Rate (#/sec) – Number of commands executed by the agent per second

Transactions
Performed

Total – Total number of transactions performed by the agent

Rate (#/sec) – Number of transactions performed by the agent per second

PA Process
Statistics

Process statistics pertaining to the PA

PA Total Process
Statistics

Total process statistics pertaining to the PA

The following lists default alarm thresholds for applicable Agent Statistics modules.

TABLE C–106 Agent Statistics Alarm Thresholds

Agent Statistics Condition

Error If toeCount > 6000

Warning If toeCount > 5000

Error If bobcount > 1200

Warning If bobcount > 1000

Warning If commands rate > 6000

Warning If transactions rate > 8

Error If process size > 35000

Warning If process size > 30000

Error If rss > 25000

Warning If percentage CPU time > 90

Warning If totalstats.count > 15

Error If totalstats.size > 40000

Warning If totalstats.size > 35000

Warning If totalstats.rss > 35000

The following sections describe the individual property tables for Agent Statistics.
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Object Statistics Table
The Objects section displays information about the Objects that are loaded onto the
agent. The Status field displays the current status of the TOE and binary objects
loaded into and used by the agent.

The following table provides a brief description of the properties for Object Statistics.

TABLE C–107 Object Statistics Properties

Property Description

Total TOE Objects Number of TOE objects loaded into the agent

Total Bobs Number of binary object buffers used by the agent

Commands Executed Table
The following table provides a brief description of the properties for commands
executed.

TABLE C–108 Executed Commands Properties

Property Description

Total Commands Total number of commands that have been executed by the agent

Rate (/sec) Number of commands executed by the agent per second

Transactions Performed Table
The following table provides a brief description of the properties for performed
transactions.

TABLE C–109 Transactions Performed Properties

Property Description

Total Transactions Total number of transactions performed by the agent

Transaction Rate
(/sec)

Number of transactions performed by the agent per second

Sun Management Center Process Statistics Table
The software monitors the Sun Management Center process statistics. The following
table provides a brief description of the properties for Sun Management Center
process statistics.
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TABLE C–110 Sun Management Center Process Statistics Properties

Property Description

Process ID Identification number of the process

Process Unique Id Unique identification number of the process

Process Name Name of the process

Process Status Status of the process

Process State State of the process

User ID User ID of the process

Virtual Size Total size of the process

Resident Set Size Resident size of the process

Start Time
Seconds

Startup time of the process in seconds since January 1, 1970

Start Date Startup date of the process

Start Time Startup time of the process

CPU Time CPU time used by the process

Percent CPU Time Percentage of CPU time used by the process

Context Switches Context switches of the process

System Calls System calls made by the process

Command Line Command line of the process

Sun Management Center Total Process Statistics Table
The software monitors the total Sun Management Center process statistics.

The following table provides a brief description of the properties for total Sun
Management Center process statistics.

TABLE C–111 Total Sun Management Center Process Statistics Properties

Property Description

Number of
Processes

Number of agent and child processes

Total Virtual Size Total virtual size of agent and children

Total Res Size Total resident set size of agent and children
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Agent Update Module Version 1.0
The Agent Update module enables you to update agents across your enterprise using
a single feature. When loaded, information about this module appears in the Local
Applications section of the Module Browser window.

TABLE C–112 Agent Update Data Properties

Property Description of Value

Server Name Name of Sun Management Center server

HTTP Server Port Port number on which the web server is
running

Update Image Name The name of the agent update image file on
this server

Product Layers Installed Agent, Console, and Server as appropriate

TABLE C–113 Addons List

Column Description

Addon Name Name of Sun Management Center component

Addon Version Version of component

Data Logging Registry Module Version 2.0
The Data Logging Registry consists of the registry table.

The following table provides a brief description of the properties for Data Logging
Registry.

TABLE C–114 Data Logging RegistryProperties

Property Description

Log Destination
State

State of the logged file destination.

Module Name Module name for data value (data from this module is logged in the
registry)

Instance Name Module instance name for data value.

Property Name Property name for data value

Logging Interval Logging interval for data value
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TABLE C–114 Data Logging RegistryProperties (Continued)
Property Description

File Logging File logging status.

Logging
Destination

The logging destination for data value.

Data Cache Data cache status

Cache Size
(samples)

Size of data cache

Logview ACL Version 1.0
The Logview module creates a file list that allows you to specify which user or group
can access this file in the logviewer. This list provides the following information:

Instance name
File name
User name
Group name

Print Spooler Module Version 3.0
The Print Spooler module monitors the status of the printer daemon and print queue
on the local host as well as the printer devices installed on it.

� “Printer LPsched” on page 415
� “Printer Devices Table” on page 416
� “Printer Queues Table” on page 416

The following table describes the print spooler managed objects.

TABLE C–115 Print Spooler Properties

Property Description

Lpsched Status Status of the lpsched process

Printer Devices Table lists information about the printer devices

Printer Queues Table lists information about the printer queue

Printer LPsched
The printer daemon section displays data on the LP Request Scheduler. The Line
Printer’s Schedule (LPsched) state property describes the current status of the printer.
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Printer Devices Table
The Printer Devices table lists the printers that are already added to the table.

The instance name or alias of the printer is displayed in the Name field. The
description of the printer is displayed in the Description field. The name of the host on
which the printer is installed is displayed in the Host Name field. If you are running a
console that shows data monitored by an agent on a print server host, the path name
of the printer device is displayed in the Device field. The printer state displays in the
Printer State field.

The following table provides a brief description of the properties for Printer Devices.

TABLE C–116 Printer Devices Properties

Property Description

Row Status Status of the row

Printer name Name of the printer device

Description Description of the row

Host name Name of the host to which the device is attached

Device name Alphanumeric device name

Device state State of the device

Printer Queues Table
The Print Queues table lists the print queues on the local host and displays the status
of each queue. The following table provides a brief description of the properties for
Printer Queues.

TABLE C–117 Printer Queues Properties

Property Description

Printer Queue
Name

Name of the printer queue

Printer Queue
State

Current status of the printer queue (values are “accepting” and “not
accepting”)

# of Printer Queue
Jobs

Total number of jobs in the queue

Current Printer
Job

Number of jobs currently spooled in the queue
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TABLE C–117 Printer Queues Properties (Continued)
Property Description

Printer Queue
Size

Total size (in Kbytes) of the jobs currently spooled in the queue

HP JetDirect Module Version 2.0
Agents can monitor HP printers that are equipped with a JetDirect card by proxy
using the HP JetDirect module. Multiple HP printers can be monitored by loading
multiple instances of this module.

The following table provides a brief description of the properties for Printer Status.

TABLE C–118 General Printer Status Properties

Property Description

Status Display LED status display

SNMP Get Status Status of SNMP Get

For platform-specific information, see your supplement.

MIB-II Proxy Monitoring Module Version 2.0
The MIB-II Proxy Monitoring module monitors the MIB-II parameters for remote
systems. The various categories that monitor the MIB-II parameters on remote systems
are listed in the following sections, which list MIB-II group tables:

� “MIB-II System Group Table” on page 394
� “MIB-II Interfaces Group Tables” on page 395
� “MIB-II IP Group Table” on page 396
� “MIB-II ICMP Group Table” on page 399
� “MIB-II TCP Group Tables” on page 400
� “MIB-II UDP Group Tables” on page 402

For more information about the properties of these parameters, see “IPv6
Instrumentation Module Version 1.0” on page 376, which lists the properties for local
systems. The same functionality is applied on remote systems by the MIB-II Proxy
Monitoring module. For more information on the definition of MIB-II, see the
standards documentation RFC1213 (Request For Comments 1213).
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Advanced System Monitoring Modules
Advanced System Monitoring (ASM) is a licensed value-added software product. You
choose to install it when you install the Sun Management Center 3.6 software. ASM
provides additional modules that support more complete system monitoring
capabilities. ASM includes the following modules, which are described in this section:

� “Directory Size Monitoring Module Version 2.0” on page 418
� “Fault Manager Module Version 1.0” on page 419
� “File Scanning Module Version 2.0” on page 421
� “Hardware Diagnostic Suite Version 2.0” on page 422
� “Health Monitor Module Version 2.0” on page 423
� “Kernel Reader Module Version 2.0” on page 426
� “Process Monitoring Module Version 2.0” on page 427
� “Service Management Facility Module Version 1.0” on page 429

Directory Size Monitoring Module Version 2.0
This module enables you to isolate and monitor the size of any directory and its
subdirectories on a host on which an agent is installed. The subdirectories and links
can be viewed recursively using a window that is accessible from the modules pop-up
menu.

Note – To monitor several directories individually, either load multiple instances of the
Directory Size Monitoring module or add rows for additional directories in the
properties table. See “To Monitor Directory Size” on page 138 for more information.

The following table provides a brief description of the properties for Directory Size
Monitoring.

TABLE C–119 Directory Size Monitoring Properties

Property Description

Instance Name Single word or alpha-character string that is used internally within the Sun
Management Center agent to identify uniquely a particular module or a
row within a module

Directory Name Name of the directory being monitored

Directory Directory Existing Check
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TABLE C–119 Directory Size Monitoring Properties (Continued)
Property Description

Directory Size
(KB)

Current size of the directory in Kbytes

Rate (KB/sec) Rate at which the directory is changing size in Kbytes per second

Fault Manager Module Version 1.0
The Fault Manager module handles hardware and software faults effectively. This
module also displays a detailed fault report or a message article for the selected fault.

The Fault Manager module has the following managed objects:

� Fault Management Daemon table
� FMD Configuration table
� FMD Fault Events table

The following table provides a brief description of the properties for the fault
manager.

TABLE C–120 Fault Manager Properties

Property Description

Fault Management
Daemon Shows the details of the Fault Management Daemon.

FMD
Configuration

Shows the details of the modules loaded.

FMD Fault Events Shows the latest 20 faults with their message IDs. An alarm will be
generated for every new fault.

The following table provides a brief description of the properties for Fault
Management Daemon.

TABLE C–121 Fault Management Daemon Properties

Property Description

Property Properties of the Fault Management Daemon. Properties are FMD program
path, FMD program version, and FMD process id.

Value Values of the properties of Fault Management Daemon.

The following table provides a brief description of the properties for FMD
configuration.
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TABLE C–122 FMD Configuration Properties

Property Description

Module Name Name of the FMD module. Examples of FMD modules are
cpumem-diagnosis, cpumem-retire, and fmd-self-diagnosis.

Version Version of the module.

Status Status of the module. The status can be active or failed. An alarm is
generated for this property when the value changes from active to failed.

Description Description of the module.

The following table provides a brief description of the properties for FMD fault events.

TABLE C–123 FMD Fault Events Properties

Property Description

Time Time at which the diagnosis of the fault happened

UUID Unique ID for the fault event

SUNW-MSG-ID Message identifier that is used to access a corresponding knowledge article
located at http://www.sun.com/msg/

� To View a Fault Report

1. Navigate through the topology or hierarchy view until you have accessed the
FMD Fault Events table of the Fault Manager module.

2. Select a fault for which you want to view a fault report.

3. Press mouse button 3 and choose Show Fault Report from the pop-up menu.

The Probe Viewer shows the detailed fault report for the selected fault.

� To View a Message Article
The message article contains information such as the fault type, severity, description,
impact, and suggested action. This article helps the user to take appropriate action for
a specific fault.

1. Navigate through the topology or hierarchy view until you have accessed the
FMD Fault Events table of the Fault Manager module.

2. Select a fault for which you want to view a message article.

Steps

Steps
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3. Press mouse button 3 and, from the pop-up menu, choose Show Message Article
at http://www.sun.com/msg.

A browser opens with a message article at the following site:

http://www.sun.com/msg/<SUNW-MSG-ID>

Where <SUNW-MSG-ID> is the message identifier and is the last column of the
FMD Fault table.

Note – The message article does not open in the browser if the Java Console is not
installed on your system.

File Scanning Module Version 2.0
The File Scanning module scans files on a host for user-specified patterns. Multiple
instances of the File Scanning module can be loaded to scan multiple files. This
module requires you to add rows for the data property tables. For more information,
see “To Add a Row to a Data Property Table” on page 139.

The File Scanning module has the following managed objects:

� File ID Table
� File Statistics Table
� Scan Table

The following table provides a brief description of the properties for file scanning.

TABLE C–124 File Scanning Properties

Property Description

File ID Name of the pattern used in the file scan

File Stats State of the pattern listed

Scan Table Name of the pattern used in the file scan

The following table provides a brief description of the properties for file ID.

TABLE C–125 File ID Properties

Property Description

Filename Full path name of the file to be scanned

Scan Mode Mode in which the file is being scanned
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TABLE C–125 File ID Properties (Continued)
Property Description

Start Time Time the file scan was first started

The File Statistics table displays summary information on the file that is to be scanned.
The following table provides a brief description of the properties for file statistics.

TABLE C–126 File Statistics Properties

Property Description

Modification Time Date and time when the file was last modified

File Size Size of the file in bytes

Number of Lines Number of lines that are in the file

Lines Per Second Rate at which the file is changing in lines per second

The following table provides a brief description of the properties for scan.

TABLE C–127 Scan Table Properties

Property Description

Row Status Status of the row

Pattern Name Name of the pattern that was used in the file scan

Pattern
Description

Name of the pattern entry to be displayed in the name field of the Scan
Results section. To scan the fault messages in the syslog file, prefix the
description with FMA:

Regexp Pattern Regular expression pattern to be used when scanning the file for entries.
To scan the fault messages in the syslog file, specify the pattern in this
format: <token>:<value>, where <token> is the fault parameter and <value>
is the value of the fault parameter.

Pattern State State of the pattern listed (on/off). The off state indicates that the listed
pattern is not used in the file scan

Matches Number of lines that contain the pattern

Hardware Diagnostic Suite Version 2.0
The Hardware Diagnostic Suite tests the system for hardware faults. When the module
is loaded and the Hardware Diagnostic Suite software is installed, the Applications tab
on the Details window allows you to initiate the tests. For more information about the
Hardware Diagnostic Suite, see Sun Management Center Hardware Diagnostic Suite 2.0
User’s Guide.
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Health Monitor Module Version 2.0
The Health Monitor module monitors the health of your host. When alarm conditions
occur, this module offers suggestions, if necessary, on how to improve the performance
of the system.

For example, this module monitors the swap space that is available, reserved,
allocated, and used. Sample alarm messages, from lowest to highest severity, include:

� No Worries: sufficient swap space available
� There is lots of unused swap space
� Not much swap left: perhaps add some more
� Swap space shortage: add some more now
� Dangerous swap space shortage: add more immediately

This section describes properties of the following Health Monitor module managed
objects:

� Swap Table
� Kernel Contention Table
� NFS Table
� CPU Table
� Disk Table
� RAM Table
� Kernel Memory Table
� Directory Cache Table

The Health Monitor module tracks the system properties for the above as described in
the following table.

TABLE C–128 Health Monitor Properties

Property Description

Swap Details the swap space

Kernel Contention Monitors the kernel contention (mutex) properties

NFS Provides NFS client information

CPU Provides information on the power of the CPU

Disk Presents the disc I/O information

RAM Random access memory (RAM) information

Kernel Memory Information on kernel memory

Directory Cache Cache of the directory

Swap Table
The following table provides a brief description of the properties for Swap.
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TABLE C–129 Swap Properties

Property Description

Swap Available KB Swap space value available

Swap Reserved KB Swap space value reserved

Swap Allocated KB Swap space value allocated

Swap Used KB Swap space value used

Swap Rule Rule for swap

Kernel Contention Table
The following table provides a brief description of the properties for Kernel
Contention (mutex).

TABLE C–130 Kernel Contention Properties

Property Description

Spins On Mutexes Spins on mutexes (lock not acquired on first try) - Sum for all CPUs

Number Of CPUs Number of CPUs

Spins On Mutexes
Rule

Spins on mutexes (lock not acquired on first try) - Sum for all CPUs

NFS Table
The following table provides a brief description of the properties for NFS client
information.

TABLE C–131 NFS Client Information Properties

Property Description

Calls Total number of RPC calls received

Badcalls Total number of calls rejected by the RPC layer

Retrans Call retransmitted due to a timeout

Badxids Reply from server not corresponding to any outside call

Timeouts Call timed-out while waiting for a reply from server

Newcreds Number of times authentication information was refreshed

Badverfs Calls failed due to a bad verifier in response
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TABLE C–131 NFS Client Information Properties (Continued)
Property Description

Timers Number of times that calculated timeouts exceed the minimum specified
timeout value for a call.

Nomem Failure to allocate memory

Can’t Send Failure to send NFS/RPC rule

NFS/RPC Rule Value of the NFS/RPC rule

CPU Table
The following table provides a brief description of the properties for the central
processing unit (CPU).

TABLE C–132 CPU Properties

Property Description

Processes In Run
Queue

Number of processes in run queue

Processes Waiting Number of processes blocked for resources

Processes
Swapped

Number of processes that can be run but swapped

CPU Power Rule CPU power rule

Disk Table
The following table provides a brief description of the properties for disk.

TABLE C–133 Disk Properties

Property Description

Disk Name Name of the disk

Disk Alias Name of the disk, such as c0t0d0

Percent Disk Wait Average number of transactions waiting for service

Percent Disk Busy Percent of time disk is busy

Service Time (ms) Average service time in milliseconds

Disk Rule Disk rule
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RAM Table
The following table provides a brief description of the properties for random access
memory (RAM).

TABLE C–134 RAM Properties

Property Description

Handspread Value of hand spread (one of kernel parameters) pages

Scan rate Page scan rate

Real Memory rule Real memory rule

Kernel Memory Table
The following table provides a brief description of the properties for Kernel Memory.

TABLE C–135 Kernel Memory Properties

Property Description

Total Kernel Allocation Fails Value of kernel allocation failure

Physical Memory Free Value of free physical memory

Kernel Memory Rule Value of kernel memory rule

Directory Cache Table
The following table provides a brief description of the properties for Directory Cache.

TABLE C–136 Name Cache Statistics Properties

Property Description

Cache Hits Number of times a previously accessed page is found

Cache Misses Number of times a previously accessed page is missed

DNLC Rule Directory name lookup cache rule

Kernel Reader Module Version 2.0
The Kernel Reader module monitors kernel statistics and all kernel information
including CPU statistics, system load statistics, disk statistics, file system usage, and so
on. This section includes properties and their descriptions for all Kernel Reader
managed objects:
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� User Statistics Table
� Interprocess Communication Tables
� Disk Statistics Managed Objects Tables
� I/O Error Statistics Table
� Filesystem Usage Table
� CPU Statistics Managed Object Tables
� Memory Usage Statistics Table

Process Monitoring Module Version 2.0
The following section describes the Process Monitoring module parameters and their
property descriptions. This module requires you to add rows for the data property
tables. For more information, see “To Add a Row to a Data Property Table” on page
139.

When a matching process is found, the %CPU and a count of the number of processes
that match is displayed. If you want to change the module parameters, you can edit all
the parameters except for the entry name by accessing the pop-up menu. See “To
Access a Pop-Up Menu” on page 91 for more information.

Process Statistics Table
The following table provides a brief description of the properties for Process Statistics.

Note – When you add a row to the process statistics table, you must provide the
information in the first five rows in the following table. See “To Add a Row to a Data
Property Table” on page 139 for more information.

TABLE C–137 Process Statistics Properties

Property Description

Entry Name Name of the process statistics table entry (must be a unique name).

Name Pattern Pattern to match the name of the binary for the process that you want to
monitor.

Argv Pattern Pattern to match the arguments of the command that executes the process.

User Specification User name that is executing the process.

Entry Description Description of the entry (required field).

Process Command Command used to initiate the process, if applicable.
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TABLE C–137 Process Statistics Properties (Continued)
Property Description

Process Count Number of processes currently running that match the patterns.

% System CPU
Usage

Percentage CPU used by the system processes. This value is a
time-weighted average that is taken at different time intervals. Do not
confuse this percentage with the value that might result after you enter the
UNIX ps command.

% User CPU
Usage

Percentage CPU used by the user processes.

Virtual Size Total size of the processes in Kbytes.

Resident Set Size Resident size of the processes in Kbytes.

Monitoring State Toggle between on (row is enabled) and off (row is disabled). When the
row is disabled, all the entries are displayed as 0 (zero).

Microstate Information Table
The following table provides a brief description of the properties for Microstate
Information.

TABLE C–138 Microstate Information Properties

Property Description

Entry Name Name of the entry (must be a unique name).

CPU wait time Percentage of time for CPU wait.

Text page fault
time

Percentage of time for text page faults.

Data page fault
time

Percentage of time for data page faults.

Major page faults Number of major page faults per second (text and data faults).

Characters in I/O Number of characters read and written per second.

Involuntary
context switches

Number of involuntary context switches per second.

CPU time for
reaped children

Percentage of CPU time used by child processes that have detached from
their parent processes.

User lock time Percentage of time spent for user locks.

System trap time Percentage of time spent for system traps.

Total swaps Percentage of time spent on swaps.
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TABLE C–138 Microstate Information Properties (Continued)
Property Description

Entry Description Description of the entry (required field).

Executable code
Rule

Rule that applies to executable code.

File access rule Rule that applies to file access.

Note – You might see extremely high percentages on a per-CPU basis if the following
facts are true:

� A particular process has a number of n threads that are waiting to become active.

� User Lock Time is 100% times the number of n threads.

Service Management Facility Module
Version 1.0
The Service Management Facility (SMF) module monitors and displays the services
running on a host. You can view the current state of a service. However, you cannot
create, delete, or modify the properties of a service. You can enable or disable a service
when certain conditions are met. For details, see “Enabling or Disabling a Service”
on page 431.

The SMF module describes the following details for each service.
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TABLE C–139 Service Details

Field Description

FMRI Fault Management Resource Identifier. This identifier identifies each
service on the system.

The syntax of FMRI is svc://host/category/service:instance

where host is the host name on which the service is running.

category is the category under which the service belongs. The category
can be application, device, milestone, network, platform, site, or
system.

service:instance identifies the specific service.

An example of FMRI is
svc://localhost/network/smtp:sendmail.

Time Date and time that the service starts.

Description Description of the service.

Service State Current state of the service. The current state can accept one of the
following values:
� Online. The service is running.
� Offline. The service is not running or is available to run.
� Disabled. The service is not running.
� Maintenance. The service has encountered an error that an

administrator must solve.
� Degraded. Some of the dependency services are not running.
� Uninitialized. The service is not running. This state is the initial

state for all services.

Note – Even if the SMF module is disabled, you can change the state of
a service.

For more information about SMF, see Managing Services (Overview) and Managing
Services (Tasks) in System Administration Guide: Basic Administration.

� To View the Details of a Service

1. Navigate through the topology or hierarchy view until you have accessed the
Service Management Facility module.

The SMF module displays services based on their category. The details that are
displayed for each service are: start time of the service, state of the service, FMRI
(Fault Management Resource Identifier), and description of the service.

2. Select a service.

Steps
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3. Press mouse button 3 and choose Service Details from the pop-up menu.

The Probe Viewer appears that shows the service details, dependencies for the
selected service, services that depend on the selected service, and the processes in
the selected service.

Enabling or Disabling a Service
You can enable or disable a service when the following conditions are met:

� You are assigned the Service Management profile in the /etc/user_attr file.

� You are given local access to the SMF module by using es-config -M smf -l
<username>. For more information about this, see Chapter 9, “Sun Management
Center Administration,” in Sun Management Center 3.6 Installation and Configuration
Guide.

� The FMRI of the selected service does not match the FMRI of the services in the
/var/opt/SUNWsymon/cfg/smf-excl-d.dat file. If this file is empty, you can
enable or disable any service.

Caution – By default, the /var/opt/SUNWsymon/cfg/smf-excl-d.dat file
contains essential services such as Sun Management Center services, Physical or
Logical network services, Milestone services, and Filesystem services. These services
cannot be disabled through this module. You can delete the relevant entries in the
smf-excl-d.dat file to disable these services.

Note – If the /var/opt/SUNWsymon/cfg/smf-excl-d.dat file does not exist, you
cannot enable or disable any service.

� To Enable or Disable a Service

Caution – Ensure that you disable the appropriate service. If you disable the agent
service, the application might hang. You will have to restart the agent from the
command line.

1. Navigate through the topology or hierarchy view until you have accessed the
Service Management Facility module.

2. Select a service.

3. To enable a service, select online from the Service State list.

Steps
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4. To disable a service, select disabled from the Service State list.

� To Set Alarms
You can set alarms on the Service State field.

1. Navigate through the topology or hierarchy view until you have accessed the
Service Management Facility module.

2. If a service has encountered an error that must be solved by the administrator,
select maintenance from the Service State list.

When the state of the service is changed to maintenance, it generates alarms.

Steps
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APPENDIX D

Sun Management Center Software
Rules

This appendix lists the Sun Management Center rules for the following modules:

� “Kernel Reader” on page 434
� “Health Monitor” on page 436

Rules Concepts
A rule is an alarm check mechanism that allows for complex or special purpose logic
in determining the status of a monitored host or node.

There are two types of rules:

� Simple rules are based on the rCompare rule, in which monitored properties are
compared to the rule. If the rule condition becomes true, an alarm is generated. For
example, a simple rule can be the percentage of disk space used. If the percentage
of disk space used is greater than or equal to the percentage specified in the rule,
then an alarm is generated.

� Complex rules are based on multiple conditions. For example, one complex rule
states that an alert alarm is generated when the following conditions are met:

� The disk is over 75% busy
� The average queue length is over 10
� The wait queue is increasing

Note – Any user-customized Solstice SyMON™ 1.x rules must be ported to the Sun
Management Center environment before the rules can be used in Sun Management
Center software.
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Kernel Reader
The following table lists the Kernel Reader simple rules.

TABLE D–1 Kernel Reader Simple Rules

Property Description

avg_1min Load average over the last minute

avg_5min Load average over the last 5 minutes

avg_15min Load average over the last 15 minutes

cpu_delta Difference between the previous and current time

cpu_idle CPU idle time

cpu_kernel CPU kernel time

cpu_user CPU user time

cpu_wait CPU wait time

ipctused Percent of inodes used

kpctused Percent of Kbytes used

mem-inuse Physical memory in use (Mbytes)

numusers Number of users

numsessions Number of user sessions

swap_used Swap used (Kbytes)

wait_io CPU wait time breakdown

wait_pio CPU wait time breakdown

wait_swap CPU wait time breakdown

The following table lists the Kernel Reader complex rules.
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TABLE D–2 Kernel Reader Complex Rules

Rule ID Description Type of Alarm

rknrd100 This rule covers a transitory event. The rule generates
an alert alarm when the disk is over 75% busy, the
average queue length is over 10, and the wait queue is
increasing. The alert alarm remains until the disk is
less than 70% busy and the average queue length is
less than 8.

Alert

rknrd102 This rule covers a transitory event. The rule generates
an alert alarm if 90% of swap space is in use. The event
causing the alarm remains until swap space in use is
less than 80% of the total swap space.

Alert

rknrd103 This rule covers a transitory event. The rule generates
an alert alarm if swapping and paging is high for a
given CPU. This behavior indicates that a CPU might
be thrashing. An alert alarm is generated when CPU
exceeds 1 swap-out, 10 page-ins, and 10 page-outs per
second. The alert alarm stays on if CPU exceeds 1
swap-out, 8 page-ins, and 8 page-outs per second.

Alert

rknrd105 File System Full error. This rule looks for a file system
full error message in the syslog
(/var/adm/message).

Alert alarm that is
closed
immediately

rknrd106 No swap space error. This rule looks for a no swap
space error message in the syslog
(/var/adm/message).

Alert alarm that is
closed
immediately

rknrd400 This rule checks for a continuous CPU load over six
per CPU for four hours.

Informational

rknrd401 This rule checks for disks that are busy more than 90%
of the file for x hours. The parameters field holds the
last time CPU load was below six, and is initialized to
some date in the year 2001.

Informational

rknrd402 This rule checks if available swap space drops below
10% for x hours. The parameters field indicates the last
time that the CPU load was below six. This field is
initialized to some date in the year 2001.

Informational

rknrd403 This rule is not currently supported. Informational

rknrd404 An informational alarm is generated if rule rknrd401
gets triggered 4 times.

Informational

rknrd405 An informational alarm is generated if rule rknrd402
gets triggered 4 times.

Informational
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Health Monitor
The following table lists the Health Monitor complex rules.

TABLE D–3 Health Monitor Complex Rules

Rule ID Description Type of Alarm

rhltm000 This rule checks whether there is enough swap space. Critical, Alert,
Caution

rhltm001 CPU power is wasted each time a CPU has to wait for
a lock to become free. This event is counted because
the kernel uses mutually exclusive locks to
synchronize its operation and to keep multiple CPUs
from concurrently accessing critical code and data
regions.

Critical, Alert,
Caution

rhltm002 NFS remote procedure call timeouts may be associated
with duplicate responses after the call is retransmitted.
These timeouts indicate that the network is okay but
the server is responding slowly.

Critical, Alert,
Caution

rhltm003 The run queue length is divided by the number of
CPUs because every CPU takes a job off the run queue
in each time slice.

Critical, Alert,
Caution

rhltm004 A busy disk or a slow disk reduces system throughput
and increases user response times. This rule identifies
the disks that are loaded so that the load can be
rebalanced.

Critical, Alert,
Caution

rhltm005 RAM rule based on residency time for an unreferenced
page. The virtual memory system indicates that the
system needs more memory when the system scans to
look for idle pages to reclaim for other uses.

Critical, Alert,
Caution

rhltm006 This rule refers to the problem with kernel memory
allocation that occurs when login attempts or network
connections fail unexpectedly. There are two possible
causes: Either the kernel has reached the extent of its
address space, or the free list does not contain any
pages to allocate. The repeated failures signify a
problem that might otherwise be overlooked.

Critical, Alert,
Caution

rhltm007 A global cache of directory path name components
exists. This cache is called the directory name lookup
cache (DNLC). If this cache does not exist, directory
entries must be read from disk and be scanned to
locate the right file.

Critical, Alert,
Caution
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APPENDIX E

Alternative Methods for Accessing
Java Console Functions

You can use alternative methods for accessing the Java Console. These alternative
methods are for users with disabilities and are part of Sun’s compliance with the
United States government’s Section 508 regulations. For example, users with vision
impairment might use software to read the product screens. Thus the product has
descriptions of images, field names and screens. In addition, users, who cannot use a
mouse, can use keyboard shortcuts to use the product.

The the following features enable you to perform management functions by using
either a command-line interface (CLI) or the Java Console:

� Associated tooltips for all images
� Associated Accessible Name for all fields
� An Accessible Description for all screens

In addition, the Java Console enables you to perform functions by using your
keyboard as well as your mouse.

This chapter describes the following features that are provided for the Java Console:

� “General Keyboard Navigation” on page 437
� “Keyboard Shortcuts” on page 438
� “Mnemonics” on page 439
� “Images and Graphs” on page 440

General Keyboard Navigation
The Java Console indicates the active window component, called the focus, by either a
blinking cursor or, in the case of buttons or check boxes, a blue border. On some
screens, a default button might be identified by a black border. To change focus or
activate a button, use the appropriate mechanism:
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� To move the focus from field to field within a window, use the Tab key. To move
the focus backward through the fields, use Shift+Tab. If the focus is in an element
such as a field that allows tabs to be used, then use Ctrl+Tab and Ctrl+Shift+Tab to
move the focus through the fields.

� Within a group of components, use the arrow keys to move up and down. For
example, after you have tabbed to a particular list-item field, use the arrow keys to
move among the list items.

� To select a button on a window, change focus to the button, then use the spacebar
to activate the button.

� When a default button is identified on a window, press the Return key to activate
that function.

� To navigate through a hierarchical topology, use the up and down arrow keys to
move between levels. Use the left arrow key to expand a level and the right arrow
key to collapse a level.

Keyboard Shortcuts
Keyboard shortcuts are keystroke combinations that activate a menu item from the
keyboard even if the menu for that command is not currently displayed. Keyboard
shortcuts usually consist of a modifier key and a character key, like Ctrl+Z, or a few
special keys, such as F1 and Delete. Unlike mnemonics, keyboard shortcuts do not
display menus. They perform the indicated actions directly.

Table E–1 provides a list of the standard keyboard shortcuts that the Java Console
supports.

TABLE E–1 Common Java Console Navigation and Activation Keys

Keyboard
Operation Action

Tab Navigates to the next focusable component.

Shift+Tab Navigates to the previous focusable component.

Control+Tab Navigates to the next focusable component. This navigation works even if
the component that previously had focus accepts tabs.

Left Arrow Moves focus left one character or component.

Right Arrow Moves focus right one character or component.

Up arrow Moves focus up one line or component.

Down arrow Moves focus down one line or component.
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TABLE E–1 Common Java Console Navigation and Activation Keys (Continued)
Keyboard
Operation Action

Page Up Moves up one pane of information.

Page Down Moves down one pane of information.

Home Moves to the beginning of the data. In a table, moves to the beginning of a
row.

End Moves to the end of the data. In a table, moves to the last cell in a row.

Return Activates the default command button.

Escape Dismisses a menu or dialog box without changes. Cancels a drag-and-drop
operation in progress.

Spacebar Activates the component that has keyboard focus.

Mnemonics
Mnemonics provide another keyboard alternative to the mouse. A mnemonic is an
underlined alphanumeric character in a menu title, menu item, or other interface
component. A mnemonic reminds you how to activate the equivalent command by
simultaneously pressing the Alt key and the character key that corresponds to the
underlined letter or numeral.

When the keyboard focus is not in a text element, you do not always need to use the
Alt key. For example, to choose the Exit command from the File menu, you can hold
down the Alt key and press F to display the File menu, then release the Alt key, and
press X.

After you have displayed a menu with a keyboard sequence, any subsequent keypress
activates a command only from that menu. For example, you can press Alt+F to
display the File menu and then type A to activate the Save As command. Alternately,
you can press Alt+E to display the Edit menu, and then type A to activate the Select
All command.

All menu items in Sun Management Center 3.6 have mnemonics. A given letter might
apply to a different function, depending on the menu or the window.
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Images and Graphs
Throughout the Java Console, images indicate screen navigation. These images contain
alternative text that you can display when you move your mouse over the image or
use other similar technology. In addition, some graphs also provide a text-only view of
the data in tabular format. Look for this feature on the graph windows.
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APPENDIX F

Linux Agent Support

This appendix lists the modules, add-ons, and commands supported by the Linux
agent.

Supported Modules
The following modules are supported by the Linux agent:

� Agent Statistics
� Agent Update
� File Monitoring
� Volume System Monitoring
� Kernel Reader (Simple)
� MIB-II (Simple)
� Data Logging Registry
� MCP Manager

Note – The File Monitoring module monitors the ext3 and raiser file systems. This
module is implemented in the core software.

Supported Add-ons
The Linux agent supports only the Volume System Monitoring add-on. All the other
modules are implemented in the core software.
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Supported Commands
The following commands are supported by the Linux agent:

� es-start
� es-stop
� es-config
� es-dt
� es-inst (remote installation is not supported)
� es-uninst
� es-makeagent
� es-load-default
� es-platform
� es-run
� es-trapdest
� es-validate
� es-setup
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Glossary

administrative domain An arbitrary collection of hosts and networks that the Sun
Management Center monitors as a single hierarchal entity. You can
choose to divide your enterprise into several domains, each domain to
be managed by different users.

agent A software process, usually corresponding to a particular local
managed host, that carries out manager requests. An agent makes local
system and application information available to remote users.

alarm An abnormal event that is detected by a Sun Management Center
agent and that might indicate current or impending problems. The
agent passes information about the abnormal event to the Sun
Management Center server. The server passes this information on as
an alarm when the abnormal event matches a predefined alarm
threshold.

alarm acknowledgment Sun Management Center users can acknowledge alarms, indicating
that the alarm does not represent a serious problem or that the
problem is being resolved. Acknowledged alarms take a lower priority
than unacknowledged alarms.

Attribute Editor A window that provides information about the selected object. In
addition, the Attribute Editor enables you to customize various
monitoring criteria for that object. The monitoring criteria are
dependent on the type of object. There are Attribute Editors for
domains, hosts, modules, and data properties.

autonomous agents Agents that can work independently from each other.

bus A point-to-point network component. Used by the software to
represent a network link to which many other hosts can be connected.

community A string that is similar to a password and that is used to authenticate
access to an agent’s monitored data.
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complex alarm A complex alarm is based on a set of conditions being true. Unlike
simple alarms, you cannot set thresholds for complex alarms.

composite object Hardware that has multiple instances of the Solaris operating
environment running inside a single chassis. These objects are
“composites” from the Sun Management Center point of view because
the objects consist of several parts shown inside a group or container.
These parts include the following:

� One object for each instance of the Solaris operating environment

� Two objects that represent an active and backup system controller

� One object that represents the hardware chassis and related
equipment such as fans and power supplies

console window A graphical user interface component of Sun Management Center
software used to view information and status for monitored hosts and
managed objects and to interact with Sun Management Center agents.
All Sun Management Center functions are available from a Java
Console. Some functions are also available from a web console.

developer environment A demonstration environment in which developers can test
customized modules designed to work with the Sun Management
Center software. See the Sun Management Center 3.5 Developer
Environment Reference Manual for more information.

Discovery A Sun Management Center tool available from the main console
window that is used to find hosts, routers, networks, and Simple
Network Management Protocol (SNMP) devices that can be reached
from the Sun Management Center server.

dynamic loadable
modules

A Sun Management Center agent module that can be loaded or
unloaded at runtime, enabling monitored properties to be displayed
on the main console window without having to restart the console or
agent.

event A change in the state of a managed object.

file scanning The act of scanning a file, usually a log file, for certain patterns
(regular expressions) that might be indicative of problems or
significant information. Sun Management Center agents use file
scanning to assist in the monitoring of systems and applications when
these components do not provide direct access to status information.

FMD (Fault Management Daemon). A daemon process running on Solaris 10
that monitors hardware and software faults in the system.

FMRI (Fault Management Resource Identifier). A unique identifier that
identifies each service on the system.
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graphical user interface The graphical user interface, or GUI, is a window that provides the
user with a method of interacting with the computer and its special
applications, usually with a mouse or other selection device. The
window usually includes such things as windows, an intuitive method
of manipulating directories and files, and icons.

hierarchy view A window view that defines objects in a hierarchy or tree relationship.
Objects are grouped depending on the rank of the object in the
hierarchy.

hop The number of routers through which a packet goes before reaching its
destination.

instance A single word or alpha-character string that is used internally within
the Sun Management Center agent to identify uniquely a particular
module or a row within a module.

manage In Sun Management Center software, manage is defined as being able
to observe (monitor) and manipulate the object. For example,
management privileges include acknowledging and closing alarms,
loading and unloading modules, changing alarm thresholds, and so
on. Management privileges are similar to read, write, and execute
access.

MCP (Module Configuration Propagation). MCP refers to the process of
copying scripts and module configuration files from one host to
another host or group of hosts.

MIB Management information base. A MIB is a hierarchical database
schema that describes the data that is available from an agent. Sun
Management Center agents use the MIB to store monitored data that
can be accessed remotely.

module A software component that can be loaded dynamically to monitor data
resources of systems, applications, and network devices.

monitor In Sun Management Center software, monitor is defined as being able
to observe objects, alarms, and properties. Monitoring privileges are
similar to read-only access. Contrast with manage.

NAT (Network Address Translation). A network configuration feature that
enables an IP address to appear as a different IP address, often used for
security or efficiency reasons.

node A workstation or server.

object A particular resource, such as a computer host, network interface, or
software process, that Sun Management Center software can monitor
or manage. A managed object is an object that you can manipulate. For
example, you can acknowledge and turn off an alarm condition for an
object that you can manage. A monitored object is an object that you
can observe but not acknowledge or otherwise manage.
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production environment One of two environments in which Sun Management Center software
is deployed. The production environment is a real environment (as
opposed to a test environment) in which you manage and monitor
your hardware.

remote server context A collection of Sun Management Center agents and a particular server
layer with which the remote agents are associated.

request caching The consolidation of duplicate outstanding requests that originated
from multiple consoles. This strategy eliminates the execution of
redundant requests.

rule An alarm check mechanism that allows for complex or special purpose
logic in determining the status of a monitored host or node.

seed The password used to generate the Sun Management Center security
keys. The seed is an alpha-numeric string of up to eight characters.
This string is not necessarily a UNIX password. You can select your
own seed, or accept the default seed (maplesyr) provided by the Sun
Management Center software. If you select your own seed, be sure to
record the seed for later reference.

segment An object that represents a network segment and that is used as a basis
for a local network.

server The collection of programs and processes (SNMP-based trap, event,
topology, configuration, and Java server) that work on behalf of a Sun
Management Center user to help manage a particular set of networks,
hosts, and devices. The server usually sends requests to Sun
Management Center agents, accepts collected data from the agents,
and passes the data to the main console window for display.

server context A Sun Management Center sever layer and its associated agents.

simple alarm Alarms that are based on one condition becoming true. You can set
alarm thresholds for simple alarms.

SNMP (Simple Network Management Protocol). A simple protocol that
enables networked entities (hosts, routers, and so on) to exchange
monitoring information.

SNMPv2 usec SNMP version 2, user-based security model security standards.

Sun Management
Center superuser

A valid user on a server host. The superuser decides what the agents
are in the context of the server. By default, the superuser password is
used as a seed for security key generation.

Sun Management
Center user

Members of the symon group in the /etc/group file.

topology view The view that displays the members of the object selected in the
hierarchy view.
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URL (Uniform Resource Locator). A URL is a textual specification that
describes a resource that can be accessed through the network.

zone A virtualized operating system environment that you can set up for
systems that run the Solaris 10 Operating System. Every Solaris system
contains a global zone, the default zone for the system.
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Index

A
access control, 258, 263
accessing command-line interface, 326
accessing help for command-line

interface, 326-327
accessing System Manager server through

SSH, 354-355
accessing System Manager server through web

console, 354
accessing the command-line interface, 325-326
ACL, 258, 263
Actions tab, 155, 249-250
adding

application to Tools menu, 335-338
objects to administrative domains, 61-76,

77-88
property from graph clipboard, 145
row to a data property table, 138-139, 139,

140-141
Address process property, 107
administrative domain

creating, 53
default, 52
definition, 50
definition of, 37
deleting, 58
example, 50
hierarchy examples, 50
home, 52
initiating a discover objects request

for, 79-83
listing, 93
members, 37

administrative domain (Continued)
multiple, 50
populating, 54, 61-76, 77-88
remote, 58
security, 41
setting security for, 56
switching between, 93
viewing, 55

agent
definition of, 33
detailed description of, 36
health, 162
interacting with console and server, 34
SNMP, 41

agent down alarm notification, 241
agent down notification, 192-194
agent layer, See agent
Agent Statistics

Configuration manager, 329
Event manager, 329
Sun Management Center server, 329
Topology manager, 329
Trap handler, 329

agent update task, 215
alarm limits, 154, 248
alarm threshold creation, 198-199, 243-244,

253-254, 265
alarms, 255-256

accessing from Details window, 186-187
accessing from main console

window, 184-185
accessing from web interface, 242
acknowledged, 180
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alarms (Continued)
acknowledging, 190
adding notes to, 191-192
adding suggested fixes, 192
alert, 181, 433, 436
black icon, 180
black splat, 181
blue icon, 181
categories of, 183, 240
caution, 436
caution indicator, 181
changing pending actions for, 196
complex, 40
critical, 436
critical indicator, 181
defining action scripts, 197
definition of, 39
deleting, 190-191
determining the severity of, 179
disabled indicator, 181
down indicator, 180
filtering the alarms table, 188-189
generation of, 433
gray icon, 181
icons, 180
indeterminate status indicator, 181
notifying users about agent status, 192-194
notifying users about host status, 192-194
off indicator, 181
pages, 249
red alarm icon, 179
red icon, 181
registering actions for, 194-195
running manual actions for, 195-196
seeing, 100, 232, 241
sending email when alarm occurs, 195, 196,

254-255, 255-256
severities, 100, 232, 241
severity levels, 180
simple, 39, 154-155, 248
simple rules, 433
sorting alarms table, 187-188
sorting in Domain Status Details

window, 187
states, 184
threshold, 154-155, 248
unacknowledged, 180
updating alarms table, 188

alarms (Continued)
viewing activity log, 189-190
viewing suggested fixes, 192
windows, 155
yellow icon, 181

Alarms tab in the Attribute Editor, 154-155, 248
Alarms tab in the Details window, 102
alternative methods for users with

disabilities, 437-440
applications, viewing specific information, 121
ARCHIVELOGMODE, 343-345
archiving the database, 343-345
Attribute Editor, 129

Actions tab, 155, 249-250
Alarms tab, 154-155, 248
definition, 153, 238, 247
History tab, 157, 250-251
Info tab, 154
module, 174
opening, 157, 158
Refresh tab, 156
Security tab, 266

attributes, changing, 73-74
auto-negotiate feature, 270
automatic notification of an alarm

condition, 195, 254-255, 255-256

B
backing up database

cold, 342-343
offline, 344-345
online, 343-345
silent (non-interactively), 344-345

black splat, 181
Browser Details window, See Details window
buttons

Hide Details, 111
Show Details, 111

C
changing, module parameters, 176
changing object attributes, 73-74
changing object name, 74
circular log files, 334
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class A, B, and C networks, 347
Class process property, 107
CLI, See command-line interface
closing, Sun Management Center session, 52
cold backup, 342-343
command-line interface, 291

accessing help for, 326-327
accessing in Solaris or Linux, 325-326
accessing in Windows, 326
alarm command parameters

ack, 313
command, 313
domain, 313
mgtObj, 313
note, 313
property, 314
propInst, 314
qualifier, 314
severity, 314
state, 314

alarm commands
ackAlarms, 314
delAlarms, 315
getAlarms, 315
runAlarmAction, 316
setAlarmAction, 316

aliases, 295
basic commands, 294

alias, 301
attrib, 302
browse, 302
cd, 302
clear, 301
data, 302
end, 302
exit, 302
goto, 303
help, 303
history, 304
kill, 303
list, 304
locate, 305
login, 304
logout, 305
more, 305
quit, 305
reset, 306
set, 306

command-line interface, basic commands
(Continued)

status, 306
unalias, 307
unset, 307

command overview, 294
controlling output screen size, 327
executing in background, 294
executing in foreground, 294
exiting from, 328
extended commands, 294
input from keyboard, 295
input from shell file, 295
interaction modes, 292
module commands

disableModule, 308-310
enableModule, 308
getLoadedModules, 309
getModule, 309
getModules, 309
loadModule, 309
unloadModule, 310

object attribute command parameters
attributes, 311
mgtObj, 311
property, 311
propInst, 311
rowValues, 311
values, 311

object attribute commands
addRow, 311
delRow, 311
getAttributes, 312
setAttributes, 312

output format specifications, 295
output to background, 295
output to batch mode input file, 295
output to file, 295
output to screen, 295
parameters

a, 298
-about, 298
append, 298, 299
-b, 297, 298
bad syntax examples, 297
columns, 298
f, 298
general syntax, 296
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command-line interface, parameters
(Continued)

good syntax examples, 297
-h, 297
height, 299
history, 299
input file format, 297
log, 299
logmode, 300
m, 299
more, 300
ncols, 300
o, 300
overview, 295
prompt, 300
serverHost, 300
specified at startup, 296
specified in command, 296
specified in file, 296
style, 300
t, 300

recording commands in file, 327
recording output in file, 327-328
system requirements, 292
topology command parameters

agentPort, 317
arch, 317
domain, 317
domainmode, 317
family, 317
fullDesc, 317
isPolled, 317
mode, 318
nodemode, 318
pollType, 317
readInfo, 318
targetHost, 318
targetIP, 318
topoCfg, 318
topoType, 318
url, 318
validity, 318
writeInfo, 318

topology commands
createEntity, 319
createGroup, 319
delTopoObject, 319
export, 320

command-line interface, topology commands
(Continued)

getAgentPort, 320
getAllTopoObjects, 320
getCurrentDomain, 320
getDomains, 321
getTopoObject, 321
import, 322
setCurrentDomain, 321

Command process property, 107
CommandLine process property, 107
commands

es-backup, 342-343
es-config, 343-345
es-restore, 345

complex alarms, 40
complex rule

alert alarm generation, 433
definition, 433

composite object
creating, 68-70
definition, 62

Config Reader, 102
special instructions for Details window, 123

Configuration manager, 264
agent statistic, 329

configuring
ARCHIVELOGMODE, 343-345
Details Process display, 108, 122
online backup, 343-345

connecting objects, 71
console

alternative methods for accessing, 437-440
definition of, 33
detailed description, 34
interacting with server and agent, 34
main window, 42
menus, 90-91
multiple consoles, 34
navigating, 95-96
overview, 90-93
pop-up menus, 91
search, 92
starting, 45
tool tips, 92
viewing administrative domains, 93

console layer, See console
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copying
data property to graph, 129
groups, 72-73
module, 128
objects, 71
to graph clipboard, 145

CPU% process property, 107
CPU thrashing, 435
creating

a module object, 66-67
administrative domains, 53-54
alarm threshold, 198-199, 243-244, 253-254
composite objects, 68-70
groups, 67-68
links between objects, 71
monitored modules, 66-67
nodes, 64-66
objects with Discovery manager, 79-83
segments, 70
server component object, 330

creating graph template, 147
critical, alarms, 436
customized menu items, adding, 335-338
customizing alarm actions, 197, 255-256
cutting objects, 74-75

D
data

displaying, 136-137
probing, 136, 142
refreshing, 137

data property
Attribute Editor, 153, 238, 247
displaying, 136-137
graphing, 144
probing, 142
refresh interval, 158-159, 252
sampling points, 159-160
tool tip, 92

data property table
adding row to, 138-139, 139, 140-141
checkbox cell editor, 134
combo box cell editor, 134
editable cells, 134
large, 136
modules with user adjustments, 135

data property table (Continued)
multiple page, 136
noneditable cells, 134
row context menu, 135
selecting a row, 137
selecting adjoining rows, 138
selecting row ranges or groups, 138
sorting, 135
standard format, 134
text cell editor, 134

database, backup and recovery, 342-345
dataviews

copying to dataview clipboard, 223-224, 224
creating, 222
creating from context menu, 223
creating from options menu, 223
definition of, 221
deleting, 225
example creating scalar, 226
example creating vector, 227-228
navigating dataviews window, 222
opening

empty window, 225
existing dataview, 225

saving, 225-226
scalar, 226
tables, types of, 226
vector, 227

default administrative domain, 52
default port numbers, 330, 331
default privileges

overriding, 268
topology manager, Sun Management Center

default security privileges, 261
defining a group job, 203-204
defining a job task, 207-208
defining an alarm action script, 197, 255-256
deleting

administrative domains, 58
discover request, 87
events from event database, 333
objects, 75-76

deleting a group job, 206
deleting objects, 74-75
Details page

Actions tab in the Attribute Editor, 249-250
Alarms tab in Attribute Editor, 248
History tab in the Attribute Editor, 250-251
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Details Process display
configuring, 108, 122
selecting columns, 122

Details window
Actions tab in the Attribute Editor, 155
Alarms tab, 102, 104
Alarms tab in Attribute Editor, 154-155
Applications tab, 105
disk total, 109
Hardware information types, 108
History tab in the Attribute Editor, 157
Info tab, 102, 103
Info tab in Attribute Editor, 154
memory hardware total, 109
Module Browser tab, 102, 103-104
Module Manager tab, 104
monitoring log messages, 119-120
moving columns in Process display, 123
overview, 101-114
Process Statistics window, 107
processors total, 109
Refresh tab in the Attribute Editor, 156
Solaris Process Details module, 105
sorting columns in Process display, 122
starting, 115-116
tape devices total, 109
View Logs tab, 104-105
View Processes, 105

developer environment, definition of, 44
developing modules, 44
Directory Size Monitoring module

adding table rows, 135
defining a directory, 138-139
list files, 136, 142

disabilities, alternative methods for users
with, 437-440

disabling
module, 128, 173

disabling SNMPv1 communication, 272-273
disabling SNMPv2c communication, 272-273
discovering hardware, 84-85
discovering objects by name, 84-85
discovering software, 84-85
discovery

deleting request, 87
filtering requests, 84-85
logs, 87-88
methods of, 80

discovery (Continued)
modifying request, 86-87
overview, 77
request ID, 78
scheduling request, 86
server context, 82
setting preferences for, 83-84
starting, 79
starting request, 87
stopping request, 87
timeout, 82

Discovery Manager, See discovery
disk

busy, 433, 435
complex rules, 433
load, 436

disks, total in Details window, 109
displaying data, 136-137
document type declaration, 285-286
domain, See administrative domain
Domain Manager, 53
DTD, see document type declaration, 285-286
Dynamic Reconfiguration, special instructions

for Details window, 123

E
editing

graph axes, 150
module, 128

EGroup process property, 107
enabling

module, 128, 172
enabling or disabling a service, 431-432
Entity Desc property, 103
Entity Event Destination property, 103
Entity Family property, 103
Entity Full Desc property, 103
Entity Trap Destination property, 103
es-backup command, 343
es-config command, 343
es-restore command, 345
esadm, 261, 267
esadm, 259
esdomadm, 260, 267
esdomadm, 259
esops, 267
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esops, 259
EUser process property, 106
Event manager, 264, 333

agent statistic, 329
events, deleting from event database, 333
exiting from command-line interface, 328

F
fault reports, viewing, 420
File Monitoring module

adding row to table, 139
adding table rows, 135

File Scanning module, adding table rows, 135
file system full, 435
filtering, log messages, 117-119
finding objects, 92
finding specific log messages, 120

G
general group, 67
graph

applying template, 148
copying data property to, 129
data property, 144
editing axes, 150
historical data, 157, 250-251
multiple data properties, 145
opening, 147
overview, 43
sampling points, 159-160
saving, 147
template, 147, 148

Group ID process property, 106
group operations, See managing jobs
groups, 50

copying, 72-73
creating, 67-68
general and IP-based, 67
object definition, 62
pasting, 72-73
security, 41

H
hand icon, 111
hardware

modules relating to, 354
monitored by Sun Management Center

software, 31
pathnames displayed, 111
platform-specific information, 46
resources displayed, 109
views of, 110-111

Hardware Diagnostics Suite, 102, 331
hardware information, 46
Health Monitor rules, 436
helpful hints

displaying levels of details, 115, 125
Search function is case-sensitive, 113
searching in multiple instances, 113
using tool tips, 92
viewing long messages in table cells, 115

Hide Details button, 111
hierarchy view, 42, 93, 95-96
history interval, setting, 159-160
History tab, 157, 250-251
home administrative domain, 52

setting, 52-53
host

Details window, 101-114
security, 41, 130

host down alarm notification, 241
host down notification, 192-194
Hostname property, 103

I
ICMP ping, See ping command
import/export utility

CLI interface, 279-284
definition of, 275
document type declaration, 285-286
file format, 285
files, 284-289
head information, 286
how used, 275
software structure, 276-277
starting, 277-278
starting import, 278-279

increasing virtual size, 331
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indeterminate status, 181
Info tab

Entity Desc property, 103
Entity Event Destination property, 103
Entity Family property, 103
Entity Full Desc property, 103
Entity Trap Destination property, 103
Hostname property, 103
IP Address property, 103
Netmask property, 103
Operating System property, 103
Target Hostname property, 103
Target IP Address property, 103

Info tab in the Attribute Editor, 154
Info tab in the Details window, 102
installation, default administrative domain, 52
installing Sun Management Center, 45
Internet Explorer, 229
IP Address property, 103
IP addresses within server contexts, 264
IP-based group, 67

J
Java console, See console
Java security classes, 257
job definition, 201

K
kernel memory allocation, 436
Kernel Reader

creating alarm, 198-199, 243-244, 253-254
displaying data, 136-137
example data property display, 136
rules, 434

L
load, 436
loading modules, 128, 169-170
local applications, modules relating to, 409
log files, refreshing view, 120
log files, viewing, 117, 120, 121

log messages
filtering, 117-119
finding specific messages, 120

log view, 42
logical host configuration, 112-114
logical view, 112-114
lookup service, 331

M
main console, See console
main console window, 42
managed objects

composite, 62
group, 62
module, 62
node, 62
overview, 61
segment, 62
types of, 62

management information base, See MIB
managing jobs

creating a configuration task, 213-214
creating a data property task, 210
creating a filter, 217-218
creating a module table task, 212
creating a module task, 208-210
creating an agent update task, 215
defining a job, 203-204
defining a task, 207-208
deleting filters, 219
deleting jobs, 206
deleting tasks, 216
Manage Jobs window, 202
modifying filters, 219
modifying tasks, 216
removing job request, 206
setting schedules, 205-206
stopping current job, 206
suspending job, 206
updating the file set, 214
viewing job status, 204-205

masking of network addresses, 348
MCP, See module configuration task
Memory% process property, 107
memory hardware, total in Details

window, 109
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menu, View Columns, 122
message articles, viewing, 420-421
messages, viewing, 42
MIB

modules, 38
SNMP, 338-339

modifying objects, 73-74, 74
Module Browser tab, overview, 125-130
Module Browser tab in the Details window, 102
module configuration task, 213-214
modules, 174

adjusting table rows, 135
Agent Statistics, 162, 410
Agent Update, 163
changing description, 176
changing parameters, 176
Config Reader, 163
copying, 128
creating a monitored module, 66-67
current version, 353
Data Logging Registry, 163, 414
data properties, 153, 238, 247
data property tables, 135
definition, 125
definition of, 38
Details window, 101-114
developing, 44
Directory Size Monitoring, 135, 163
disabling, 128, 173
displaying rules for, 174
dynamic, 39
Dynamic Reconfiguration, 163
editing, 128
enabling, 128, 172
Fault Manager, 163, 419-421
File Monitoring, 135, 164
File Scanning, 135, 164, 421-422
hardware, 354
Health Monitor, 164, 423
HP JetDirect, 164, 417
icon for multi-instance, 162
in alphabetical listing, 353
Kernel Reader, 164, 426
Kernel Reader Simple, 164
loaded by default, 162
loading, 128, 169-170
loading a scheduled module, 172
local applications, 409

modules (Continued)
MIB, 38
MIB-II Instrumentation, 164, 394
MIB-II Proxy Monitoring, 165, 417
multi-instance, 162
NFS File Systems, 165, 406
NFS Statistics, 165, 406
number of instances loaded, 169
object definition, 62
operating system, 375
Print Spooler, 135, 165, 415
Process Monitoring, 135, 165, 427
remote systems, 410
rules, 174
schedule, 174
security, 41, 130, 174
security permissions, 174
Service Management Facility (SMF), 166
Service management facility (SMF), 429-432
Solaris Process Details, 166, 408
testing, 44
that load automatically, 353
that load multiple times, 353
unloading, 128, 173
using ’Add Row’, 353
Volume System Monitoring, 167

monitored hardware, 31
monitored software properties, 31, 39
monitoring

log messages, 119-120
objects, methods of, 64
real-world environments, 44
server components, 330

monitoring data properties, overview, 133
moving columns in Details Process display, 123
moving groups, 72-73
moving objects, 74-75
Mozilla, 229

N
navigating, administrative domains, 93
Netmask

ANDing, 348
property, 103

Netscape Navigator, 229
NFS remote procedure, 436
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Nice process property, 107
node

creating, 64-66
object definition, 62

notifying you when a host or agent is
down, 241

notifying you when an alarm occurs, 195,
254-255

O
objects

alarms, 100, 232, 241
copying, 71
creating automatically with Discovery

manager, 79-83
cutting and pasting, 74-75
delete, 75-76
Details window, 101-114
linking two objects, 71
modifying, 73-74
moving, 71, 74-75
pasting, 71
renaming, 74

octets in network addressing, 347
online backup, 343-345
opening

Attribute Editor, 157, 158
graphs, 147

operating system
modules relating to, 375
property, 103

P
paging, 200
pasting

groups, 72-73
objects, 71, 74-75

permissions, security, 257
pfiles process statistic, 107
PGroup process property, 107
physical view, 43, 110-111

refresh details, 111
pictures of system hardware, 110-111
PID process property, 106

ping command, 80
platform-specific information, 46
pldd process statistic, 107
pmap process statistic, 107
populating administrative domains, 54

manually, 55, 61-76
using Discovery, 54, 77-88
using Discovery at repeated intervals, 55

port addresses, within server contexts, 264
PPID process property, 106
Print Spooler module

adding row to table, 140-141
adding table rows, 135

printer monitoring, 165
Priority process property, 107
probe a monitored data property, 142
Process display, configuring, 108, 122
Process Monitoring module, adding table

rows, 135
process property

Address, 107
Class, 107
Command, 107
CommandLine, 107
CPU%, 107
EGroup, 107
EUser, 106
Group ID, 106
Memory%, 107
Nice, 107
PGroup, 107
PID, 106
PPID, 106
Priority, 107
Session ID, 107
Size, 107
Start time, 107
State, 107
Time, 107
UID, 106
User, 106
Wait Channel, 107

Process Statistics window, 107
processes view, 43
processors, total in Details window, 109
production environment, definition of, 44
property, See data property
pstack process statistic, 107
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Q
queue length, complex rules, 433

R
rCompare rule, 40
recovery, of your database, 342-345
refresh data, 137
refresh interval

setting, 158-159, 252
Refresh tab, 156
refreshing log file view, 120
registry service, 331
relationships, inclusive, 261
remote administrative domains

definition of, 58
viewing, 60

remote server access, 263
remote server context, 36
remote systems, modules relating to, 410
rhltm000, 436
rhltm001, 436
rhltm002, 436
rhltm003, 436
rhltm004, 436
rhltm005, 436
rhltm006, 436
rhltm007, 436
rknrd100, 435
rknrd102, 435
rknrd103, 435
rknrd105, 435
rknrd106, 435
rknrd401, 435
rknrd402, 435
rknrd403, 435
rknrd404, 435
rknrd405, 435
router forwarding rule, 348
routing tables, 80
row

adding, 138-139, 139, 140-141
rule

alarms, 39
complex, 433
CPU power, 436
disk busy, 435

rule (Continued)
disk loaded, 436
Health Monitor, 436
kernel memory allocation, 436
Kernel Reader, 434
no swap space error, 435
overview, 36
rCompare, 40
run queue length, 436
simple, 433
Solstice SyMON 1.x software, 433
Sun Management Center 2.1 software, 433
swap space, 435, 436
time for an unreferenced page, 436
user-customized, 433

run queue length, 436
running UNIX commands on data, 136, 142

S
same server context, 36
sampling points for data property, 159-160
saving graph, 147
scalar dataviews, 226

creating, 226
scheduling a discover request, 86
search pattern, 119
Search window in Details Logical view, 112
searching for specific log messages, 120
Section 508, 437-440
security, 41

access control (ACL) categories, 258, 263
accessing on a module, 265-267
adding user-defined group, 267
adding users, 265
deleting users, 267-268
granting administrator privileges, 267
specifying ACL, 263
using key functions, 265

default privileges
default privileges, 261

for a module, 174
functions

administrator, 260
general, 260
operator, 260

host, 130
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security (Continued)
layers in Sun Management Center
software, 257
module, 130
permissions, 257
remote, 58
setting for a host or module, 131
Sun Management Center users, 258
tab, 266

segment
creating, 70
object definition, 62

selecting alarm notification actions, 196
selecting columns in Details Process

display, 122
server

access, 263
context, 264
context limitations, 264
definition of, 33
detailed description of, 34
interacting with console and agent, 34
interaction with agents, 36
interacts with multiple consoles, 35
remote access, 263

server component as monitored object, 330
server context, 58

definition of, 36
discovery process, 82
limitations, 264

server layer, See server
service details, viewing, 430-431
Session ID process property, 107
setting

home administrative domain, 52-53
refresh interval, 158-159, 252

setting alarms, 432
setting group job schedules, 205-206
setting host security, 131
setting module security, 131
Show Details button, 111
silent backup, 344-345
simple alarms thresholds, 39
simple rules

alarm generation, 433
monitored properties, 433

Size process property, 107
Smart delete, 333

SMsystemCommand, 336
SNMP, 41

encryption, 268
MIBs for Sun Management Center

Modules, 338-339
SNMP communication, 272-273
SNMP encryption, enabling, 270-271
SNMP ping, See ping command
SNMPv1 communication, disabling, 272-273
SNMPv2c communication, disabling, 272-273
SNMPv3, 273
software, views of, 112-114
software properties monitored by Sun

Management Center software, 31, 39
Solaris Process Details module, 105
sorting columns in Details Process display, 122
splat, black, 181
Start time process property, 107
starting, 45

Details window, 115-116
discovery, 79, 87

State process property, 107
statistics

Detail Process Statistics window, 107
pfiles, 107
pldd, 107
pmap, 107
pstack, 107

stopping discover request, 87
subnets, 348
Sun Management Center

agent, 33
architecture, 33
changes, 32-33
component layers, 33
concepts, 37
console, 33
features, 31
getting started, 45
installing, 45
Java security classes, 257
monitoring, 64
overview, 31
remote access, 263
rules, 433
security layers, 257
server, 33

context limitations, 264
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Sun Management Center (Continued)
server access, 263
server agent statistic, 329
server context, 264
user functions, 260
user security, 258

Sun Management Center Session, closing, 52
SunMC, See Sun Management Center
suspending a group job, 206
swap space, 435, 436

error, 435
in use, 435

switching between administrative domains, 93
syslog, 435
System Manager server

accessing through SSH, 354-355
accessing through web console, 354

T
tape devices, total in Details window, 109
Target Hostname property, 103
Target IP Address property, 103
testing modules, 44
text pattern includes UNIX regular

expressions, 119
Time process property, 107
timeout, discovery process, 82
tool tips, 92
Tools Menu, customizing, 335-338
Topology manager, 264

agent statistic, 329
exiting, 331
function, 331-332
system resource requirement, 331-332
Virtual Size limit, 331-332

topology view, 42, 93, 96-100
Trap handler, 35, 264

agent statistic, 329
troubleshooting, 329-345

U
UID process property, 106
UNIX regular expressions in text patterns, 119

unloading
a module, 128
module, 173

User process property, 106
users, 258

default functions, 260
using graph template, 148

V
var/adm/message, 435
vector dataviews, 227

creating, 227-228
view

hierarchy, 42
of administrative domain, 93
topology, 42

View Columns pull-down menu, 122
viewing

error messages, 42
log files, 117, 120, 121

viewing administrative domains, 93
viewing application information, 121
viewing fault reports, 420
viewing group job status, 204-205
viewing hosts

hierarchy view, 95-96
topology view, 96-97

viewing managed objects, hierarchy view, 95
viewing message articles, 420-421
viewing service details, 430-431
virtual size, increasing, 331

W
Wait Channel process property, 107
web interface

accessing data property attributes, 251
alarm categories, 240
alarms status summary, 240
attribute editor, 238

Actions tab, 249-250
Alarms tab, 248
History tab, 250-251
Info tab, 248
Refresh tab, 250
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web interface (Continued)
browsers supported, 229
creating an alarm, 243-244, 253-254
defining alarm action scripts, 254-255
details

Browser tab, 237
displaying, 234
filtering alarms, 242-243
Info tab, 236
Log tab, 238

down alarm notification, 241
email notification for critical alarm, 254-255
main console, 230
modifying alarm actions, 256
module data properties, 247
setting a history interval, 252-253
setting a refresh interval, 252
starting, 232-233
viewing alarm information, 242

Z
zone, 33
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